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Commands

You can start a command by using one of the following methods:
B Click the command name on a menu, toolbar, status bar, or shortcut menu.
B Enter the command name or command alias at the Command prompt and press ENTER

or SPACEBAR.

The acad.pgp file lists the command aliases. To access the acad.pgp, on the Tools menu, click
Customize » Edit Program Parameters (acad.pgp).

In this Command Reference, near the beginning of each command description is a command
access section that lists the specific ways you can start that command.






3D Commands

3D

Quick Reference

Creates 3D polygon mesh objects in common geometric shapes that can be
hidden, shaded, or rendered.

Access Methods

E2 Command entry: 3d

Summary
Enter an option

[Box/Cone/DIsh/DOme/Mesh/Pyramid/Sphere/Torus/Wedge]:
Box
Creates a 3D box polygon mesh.

Specify corner point of box:
Specify length of box: Specify a distance
Specify width of box or [Cube]: Specify a distance or enter c



Width

Specifies the width of the box. Enter a distance or specify a point relative to
the corner point of the box.

height Il,d—'f:';-_...__ ]

angle—— ___f '

Specify height of box: Specify a distance

Specify rotation angle of box about the Z axis or [Reference]: Specify an angle
orenterr

Rotation Angle Rotates the box about the first corner specified. If you enter
0, the box remains orthogonal to the current X and Y axes.

Reference Aligns the box with other objects in the drawing or relative to an
angle you specify. The base point for the rotation is the first corner of the box.

Specify the reference angle <0>: Specify a point, enter an angle, or press Enter

You can define a reference angle by specifying two points or an angle from
the X axis on the XY plane. For example, you can rotate the box to align two
specified points on the box with a point on another object. After defining a
reference angle, specify a point for the reference angle to align with. The box
then rotates around the first corner relative to the angle of rotation specified
for the reference angle.

If you enter 0 as a reference angle, the new angle alone determines the rotation
of the box.

Specify the new angle: Specify a point or enter an angle

To specify the new angle of rotation, specify a point relative to the base point.
The base point for the rotation is the first corner of the box. The box rotates
by the angle between the reference angle and the new angle. If you want to
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align the box with another object, specify two points on the target object to
define the new angle of rotation for the box.

If the reference angle of rotation is O, the box rotates the angular distance
entered relative to the first corner of the box.

Cube
Creates a cube using the length for the width and height of the box.

length—=__

Specify rotation angle of box about the Z axis or [Reference]: Specify an angle
or enterr

Rotation Angle Rotates the cube about the first corner of the box. If you enter
0, the box remains orthogonal to the current X and Y axes.

Reference Aligns the box with other objects in the drawing or relative to an
angle you specify. The base point for the rotation is the first corner of the box.

Specify the reference angle <0>: Specify a point, enter an angle, or press Enter

You can define a reference angle by specifying two points or an angle from
the X axis on the XY plane. For example, you can rotate the box to align two
specified points on the box with a point on another object. After defining a
reference angle, specify a point for the reference angle to align with. The box
then rotates around the first corner relative to the angle of rotation specified
for the reference angle.

If you enter 0 as a reference angle, the new angle alone determines the rotation
of the box.

Specify the new angle: Specify a point or enter an angle

To specify the new angle of rotation, specify a point relative to the base point.
The base point for the rotation is the first corner of the box. The box rotates
the angular distance between the reference angle and the new angle. If you
want to align the box with another object, specify two points on the target
object to define the new angle of rotation for the box.

If the reference angle of rotation is O, the box rotates the angular distance
entered relative to the first corner point of the box.

Cone

Creates a cone-shaped polygon mesh.
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Specify center point for base of cone: Specify a point (1)

Specify radius for base of cone or [Diameter]: Specify a distance or enter d
Radius for Base

Defines the base of the cone by its radius.

Specify radius for top of cone or [Diameter] <0>: Specify a distance, enter d, or
press Enter

base raduus

Radius for Top Defines the top of the cone by its radius. A value of O produces
a cone. A value greater than 0 produces a truncated cone.

Specify height of cone: Specify a distance

Enter number of segments for surface of cone <16>: Enter a value greater than
1 or press Enter

Diameter for Top Defines the top of the cone by its diameter. A value of O
produces a cone. A value greater than O produces a truncated cone.

Specify diameter for top of cone <0>: Specify a distance or press Enter

Specify height of cone: Specify a distance

Enter number of segments for surface of cone <16>: Enter a value greater than
1 or press Enter

Diameter for Base
Defines the base of the cone by its diameter.

Specify diameter for base of cone: Specify a distance
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Specify radius for top of cone or [Diameter] <0>: Specify a distance, enter d, or
press Enter

top diameter —=

base diameter

Radius for Top Defines the top of the cone by its radius. A value of O produces
a cone. A value greater than 0 produces a truncated cone.

Specify height of cone: Specify a distance

Enter number of segments for surface of cone <16>: Enter a value greater than
1 or press Enter

Diameter for Top Defines the top of the cone by its diameter. A value of O
produces a cone. A value greater than O produces a truncated cone.

Specify diameter for top of cone <0>: Specify a distance

Specify height of cone: Specify a distance

Enter number of segments for surface of cone <16>: Enter a value greater than
1 or press Enter

Dish
Creates the lower half of a spherical polygon mesh.
Specify center point of dish: Specify a point (1)

Specify radius of dish or [Diameter]: Specify a distance or enter d
Radius Defines the dish by its radius.

Enter number of longitudinal segments for surface of dish <16>: Enter a value
greater than 1 or press Enter

Enter number of latitudinal segments for surface of dish <8>: Enter a value
greater than 1 or press Enter

Diameter Defines the dish by its diameter.

Specify diameter of dish: Specify a distance

Enter number of longitudinal segments for surface of dish <16>: Enter a value
greater than 1 or press Enter

Enter number of latitudinal segments for surface of dish <8>: Enter a value
greater than 1 or press Enter
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radius diameter

Dome
Creates the upper half of a spherical polygon mesh.

Specify center point of dome: Specify a point (1)
Specify radius of dome or [Diameter]: Specify a distance or enter d
Radius Defines the dome by its radius.

Enter number of longitudinal segments for surface of dome: Enter a value greater
than 1 or press Enter

Enter number of latitudinal segments for surface of dome <8>: Enter a value
greater than 1 or press Enter

Diameter Defines the dome by its diameter.

Specify diameter of dome: Specify a distance

Enter number of longitudinal segments for surface of dome <16>: Enter a value
greater than 1 or press Enter

Enter number of latitudinal segments for surface of dome <8>: Enter a value
greater than 1 or press Enter

radius diameter |

Mesh

Creates a planar mesh whose M and N sizes determine the number of lines
drawn in each direction along the mesh. The M and N directions are similar
to the X and Y axes of an XY plane.

Specify first corner point of mesh: Specify a point (1)

Specify second corner point of mesh: Specify a point (2)

Specify third corner point of mesh: Specify a point (3)

Specify fourth corner point of mesh: Specify a point (4)

Enter mesh size in the M direction: Enter a value between 2 and 256
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Enter mesh size in the N direction: Enter a value between 2 and 256

Pyramid

Creates a pyramid or a tetrahedron.

Specify first corner point for base of pyramid: Specify a point (1)
Specify second corner point for base of pyramid: Specify a point (2)
Specify third corner point for base of pyramid: Specify a point (3)

Specify fourth corner point for base of pyramid or [Tetrahedron]: Specify a
point (4) or enter t

apex paoint

Fourth Corner Point
Defines the fourth corner point of the base of a pyramid.

Specify apex point of pyramid or [Ridge/Top]: Specify a point (5) or enter an
option

The Z value of the point specified determines the height for the pyramid's
apex, top, or ridge line.

Apex Point Defines the top of the pyramid as a point (apex).

Ridge Defines the top of the pyramid as a ridge line. The two endpoints must
lie in the same direction as the base points to prevent a self-intersecting
wireframe.
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Specify first ridge end point of pyramid: Specify a point (1)
Specify second ridge end point of pyramid: Specify a point (2)

L ridge points

[

Top Defines the top of the pyramid as a rectangle. If the top points cross, they
create a self-intersecting polygon mesh.

Specify first corner point for top of pyramid: Specify a point
Specify second corner point for top of pyramid: Specify a point
Specify third corner point for top of pyramid: Specify a point
Specify fourth corner point for top of pyramid: Specify a point

Tetrahedron

Creates a tetrahedral polygon mesh.

Specify apex point of tetrahedron or [Top]: Specify a point or enter t
Apex Point Defines the top of the tetrahedron as a point (apex).

Top Defines the top of the tetrahedron as a triangle. If the top points cross,
they create a self-intersecting polygon mesh.

Specify first corner point for top of tetrahedron: Specify a point (1)
Specify second corner point for top of tetrahedron: Specify a point (2)
Specify third corner point for top of tetrahedron: Specify a point (3)

S
top points >
A2
|

1 \
/
/ I% \
/ H“““X
Lo =

10 | Chapter T 3D Commands



Sphere
Creates a spherical polygon mesh.

Specify center point of sphere: Specify a point (1)
Specify radius of sphere or [Diameter]: Specify a distance or enter d

Radius Defines the sphere by its radius.

Enter number of longitudinal segments for surface of sphere <16>: Enter a value
greater than 1 or press Enter

Enter number of latitudinal segments for surface of sphere <16>: Enter a value
greater than 1 or press Enter

radius

Diameter Defines the sphere by its diameter.
Specify diameter of sphere: Specify a distance

Enter number of longitudinal segments for surface of sphere <16>: Enter a value
greater than 1 or press Enter

Enter number of latitudinal segments for surface of sphere <16>: Enter a value
greater than 1 or press Enter

diameter
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Torus

Creates a toroidal polygon mesh that is parallel to the XY plane of the current
ucs.

Specify center point of torus: Specify a point (1)
Specify radius of torus or [Diameter]|: Specify a distance or enter d

forus radius

The radius of the torus is measured from its center point to its outside edge,
not to the center of the tube.

Radius
Defines the torus by its radius.

torus radius

fube radius—

Specify radius of tube or [Diameter]: Specify a distance or enter d

The radius of the tube of the torus is measured from the center of the tube to
the outside edge of the tube.
Radius Defines the tube by its radius.

Enter number of segments around tube circumference <16>: Enter a value greater
than 1 or press Enter

Enter number of segments around torus circumference <16>: Enter a value
greater than 1 or press Enter

Diameter Defines the tube by its diameter.

Specify diameter of tube: Specify a distance

Enter number of segments around tube circumference <16>: Enter a value greater
than 1 or press Enter

Enter number of segments around torus circumference <16>: Enter a value
greater than 1 or press Enter
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Diameter

Defines the torus by its diameter.

torus diameter

fube diameter —

Specify diameter of torus: Specify a distance
Specify radius of tube or [Diameter]: Specify a distance or enter d

The radius of the tube of the torus is measured from the center of the tube to
the outside edge of the tube.
Radius Defines the tube by its radius.

Enter number of segments around tube circumference <16>: Enter a value greater
than 1 or press Enter

Enter number of segments around torus circumference <16>: Enter a value
greater than 1 or press Enter

Diameter Defines the tube by its diameter.

Specify diameter of tube: Specify a distance

Enter number of segments around tube circumference <16>: Enter a value greater
than 1 or press Enter

Enter number of segments around torus circumference <16>: Enter a value
greater than 1 or press Enter

Wedge

Creates a right-angle, wedge-shaped polygon mesh with a sloped face tapering
along the X axis.

Specify corner point of wedge: Specify a point (1)

Specify length of wedge: Specify a distance

Specify width of wedge: Specify a distance

Specify height of wedge: Specify a distance

Specify rotation angle of wedge about the Z axis: Specify an angle

The base point for the rotation is the corner point of the wedge. If you enter
0, the wedge remains orthogonal to the current UCS plane.
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3DALIGN

Quick Reference
Aligns objects with other objects in 2D and 3D.

Access Methods

Button

£ Ribbon: Home tab » Modify panel » 3D Align
£ Menu: Modify » 3D Operations » 3D Align
£ Toolbar: Modeling

E Command entry: 3dalign

Summary

You can specify one, two, or three points for the source object. Then, you can
specify one, two, or three points for the destination.
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Select objects: Select the objects to align and press Enter
Specify source plane and orientation . . .

The selected object is moved and rotated so that the base points, and the X
and Y axes of the source and destination align in 3D space. 3DALIGN works
with dynamic UCS (DUCS), so you can dynamically drag the selected objects
and align them with the face of a solid object.

Specify base point or [Copy]: Specify a point or enter c to create a copy

The base point of the source object will be moved to the base point of the
destination.

Specify second point or [Continue] <C>: Specify a point on the object’s X axis, or
press Enter to skip forward to specifying destination points

The second point specifies a new X axis direction within a plane parallel to
the XY plane of the current UCS. If you press Enter instead of specifying a
second point, the X and Y axes are assumed to be parallel with the X and Y
axes of the current UCS.

Specify third point or [Continue] <C>: Specify a point on the object’s positive XY
plane, or press Enter to skip forward to specifying destination points

The third point fully specifies the orientation of the X and Y axes of the source
object that will be aligned with the destination plane.

Specify destination plane and orientation . . .
Specify first destination point: Specify a point
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This point defines the destination of the base point of the source object.

Specify second source point or [eXit] <X>: Specify a point for the X axis of the
destination or press Enter

The second point specifies a new X axis direction for the destination within
a plane parallel to the XY plane of the current UCS. If you press Enter instead
of specifying a second point, the X and Y axes of the destination are assumed
to be parallel with the X and Y axes of the current UCS.

Specify third destination point or [eXit] <X>: Specify a point for the destination’s
positive XY plane, or press Enter

The third point fully specifies the orientation of the X and Y axes of the
destination plane.

NOTE If the destination is a plane on an existing solid object, you can define the
destination plane with a single point by turning on dynamic UCS.

3DARRAY

Quick Reference
Creates a 3D matrix of objects in a rectangular or polar arrangement.

Access Methods

()

Button

£ Ribbon: Home tab » Modify panel » 3D Array.
£ Menu: Modify » 3D Operations » 3D Array
£ Toolbar: Modeling

E Command entry: 3darray

Summary

For 3D rectangular arrays, in addition to columns and rows, you also specify
the number of levels in the Z direction. For 3D polar arrays, you specify the
axis of rotation with any two points in space.
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T
HH 1
Select objects: Use an object selection method

——object
<7 selected
The entire selection set is treated as a single element in the array.
Enter type of array [Rectangular/Polar] <R>: Enter an option or press Enter
o=
*f:?r\?
A
G
s

levels

4

columns %}_\_L raws

(

Rectangular Array Copies objects in a matrix of rows (X axis), columns (Y
axis), and levels (Z axis). An array must have at least two rows or two columns
or two levels.

Enter the number of rows (—) <1>: Enter a positive value or press Enter
Enter the number of columns (| | |') <1>: Enter a positive value or press Enter

Enter the number of levels ( . . . ) <1>: Enter a positive value or press Enter
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Specifying one row requires that more than one column be specified, and vice
versa. Specifying one level creates a two-dimensional array.

If you specify more than one row, the following prompt is displayed:
Specify the distance between rows (—): Specify a distance

If you specify more than one column, the following prompt is displayed:
Specify the distance between columns ( | | | ): Specify a distance

If you specify more than one level, the following prompt is displayed:
Specify the distance between levels (. . . ): Specify a distance

Positive values generate the array along the positive X, Y, and Z axes. Negative
values generate the array along the negative X, Y, and Z axes.

Polar Array Copies objects about an axis of rotation.

Enter the number of items in the array: Enter a positive value

Specify the angle to fill (+=ccw, -=cw) <360>: Specify an angle or press Enter

The specified angle determines how far the objects are arrayed about the axis
of rotation. A positive number produces a counterclockwise array rotation. A
negative number produces a clockwise array rotation.

Rotate arrayed objects? [Yes/No] <Y>: Entery or n, or press Enter
Entering y or pressing Enter rotates each array element.
Specify center point of array: Specify a point (1)

Specify second point on axis of rotation: Specify a point (2)

.'H""\-.\_
% ‘\ {.“I'h-\.
(R | —
~ 4 <=
AW
% <
A =
<] <>
objects rotated objects not rotated

3DCLIP

Quick Reference

Starts an interactive 3D view and opens the Adjust Clipping Planes window.
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Access Methods
E2 Command entry: 3ddip

Summary

The Adjust Clipping Planes window is displayed.

Adjust Clipping Planes Window

Quick Reference

Access Methods
E Command entry: 3dclip

Sets clipping planes for the display in 3D Orbit view. Use the Adjust Clipping
Planes toolbar, or right-click in the Adjust Clipping Planes window and select
an option from the shortcut menu.

Click the Close button in the upper-right corner of the window to see the
effect of the clipping planes. As you rotate the view, different portions of the
objects are clipped as they pass in and out of the clipping planes.

To turn clipping planes off, right-click in the drawing area or the Adjust
Clipping Planes window, and check or clear Front Clipping On and Back
Clipping On.

Adjust Clipping Planes Shortcut Menu
To choose any of the following options, right-click in the Adjust Clipping

Planes window.

Adjust Front Clipping ﬁ Adjusts only the front clipping plane. The
line near the bottom of the window adjusts the front clipping plane. If a check
mark is displayed next to Front Clipping On, you can see the clipping in the
3D Orbit view as you move the line up or down.

Adjust Back Clipping 5 Adjusts only the back clipping plane. The line
near the top of the window adjusts the back clipping plane. If a check mark
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is displayed next to Back Clipping On, you can see the clipping in the 3D
Orbit view as you move the line up or down.

Create Slice 7 Causes the back and front clipping planes to move
together, which shows you a “slice” of the objects in the 3D Orbit view. Adjust
the front and back clipping planes, and then choose Create Slice. You can
then move the front and back clipping planes as one unit.

Q\E‘:-&*
Pan e Displays the pan cursor, a hand cursor that you can use to pan

the clipping plane. Hold down the pick button and drag the cursor in any
direction. The pan cursor stays active until you click another button.

Zoom % Displays the zoom cursor, a magnifying-glass cursor that you
can use to enlarge or reduce the clipping plane. To enlarge the image, hold
down the pick button and drag the cursor toward the top of Adjust Clipping
Planes window. To reduce the image, hold down the pick button and drag
the cursor toward the bottom of the window.

Front Clipping On ﬁ Turns the front clipping plane on or off. A check
mark indicates that the front clipping plane is on, and you can see the results
of moving the line that adjusts the front clipping plane. Choose this option
again to turn the front clipping plane off and remove the check mark.

Back Clipping On 5 Turns the back clipping plane on or off. A check
mark indicates that the back clipping plane is on, and you can see the results
of moving the line that adjusts the back clipping plane. Choose this option
again to turn the back clipping plane off and remove the check mark.

Reset Resets the window and clipping plane to the extents of the drawing.
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3DCONFIG

Quick Reference
Sets options that affect 3D display performance.

Access Methods

e;

Button

£ Ribbon: Render tab » Visual Styles panel » Performance Tuner

EE Command entry: 3dconfig

Summary

The Adaptive Degradation and Performance Tuning dialog box is displayed.

If you enter -3dconfig at the Command prompt, options are displayed.

Adaptive Degradation and Performance Tuning Dialog Box

Quick Reference

Controls 3D display performance. (This dialog box can also be accessed from
the Performance Settings button on the System tab of the Options dialog box.)

These settings control hardware acceleration, effects available through your
system's graphics card, and software performance settings. With adaptive
degradation turned on, effects are reduced automatically to maintain an
acceptable level of performance.
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T Adaptive Degradation and Performance Tuning (=3

[V] Adaptive degradation Hardware and performance tuning
Degrade when FPS is below: The current hardware configuration
= is being managed by the
5 = Performance Tuner.

{ 1) Uncheck items that should not degrade.

é‘ (Only & few recommended)
Fast Silhouettes - Move Up
View-Dependent Objects Check for Updates

Line Antialiasing =[| | Move Down
Lighting
Transparency Quality
Full Shadows
Transparency
Discard Backfaces
Ground Shadows

@ Learn about adaptive degradation. Remind me when a new display driver is
- available.
[ OK ] [ Cancel ] [ Help ]

Turns adaptive degradation on and off. With adaptive degradation on, if
performance goes below the level you specify, effects are turned off or turned
down in a certain order until performance returns to an acceptable level.

Degrade When FPS Is Below

Sets the level at which adaptive degradation begins in frames per second (FPS).
The default speed is 5 FPS. Enter a number or choose a number from the list.

Degradation Chain Order

Specifies the order in which effects are degraded. Items at the top are degraded
first. Items that are not checked are not degraded. Click Move Up or Move
Down to move a selected item up or down in the chain.

Move Up Moves the selected item up in the chain.

Move Down Moves the selected item down in the chain.

Hardware and Performance Tuning

Specifies hardware settings and performance tuning. The performance tuner
reads your system and decides whether to use software or hardware
implementation for features that support both. Features that work with your
system are turned on, and features that cannot work with your system are
turned off. A log file displays the results. You can make manual changes.

View Tune Log
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Displays the Performance Tuner log.
Manual Tune

Displays the Manual Performance Tuning dialog box.

Check for Updates

Checks for updated versions of the graphics card and driver database that is
used for performance tuning.

Get Download Info

This button is displayed after you have checked for updates and when a new
driver is available and recommended.

Displays a Web page that describes the certification program for graphics cards
and display drivers. You can download the latest list of certified cards and
drivers at any time.

Graphics hardware certification indicates which graphics card and driver
combinations that Autodesk has tested to ensure that it supports real-time 3D
shading, shadows, smooth-line display, and texture compression features of
AutoCAD 2007 (and later) based products. Autodesk certified graphics hardware
is better suited for the 3D display features of AutoCAD 2007 and later releases,
and non-certified graphics hardware may not support these features or may
cause problems during use.

Graphics card information for the current system is available in the
Performance Tuner Log, which you can view by clicking the View Tune Log
button in this dialog box.

Remind Me When a New Driver Is Available

Specifies that a notification bubble is displayed when a new driver is available.

Performance Tuner Log

Quick Reference

Access Methods

e

Button
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£ Ribbon: Render tab » Visual Styles panel » Performance Tuner
£ Menu: Tools » Options (Options dialog box, System tab)
EE Command entry: options

Summary

Lists the features that have been disabled, if any. Information includes the
system configuration, 3D graphics device, and driver. If your 3D device is
certified, Autodesk has tested it with the performance tuner.

& Performance Tuner Log IEI
Performance Tuner Results Log s
WVersion:

Date of Last Tune: 1271372008

Machine Configuration
2.4 GH=z
1023 MB

Brocessor Speed
BRRM

m

3D Device
Hame
Manufacturer
Chip set
Memory
Driver

Your machine contains a 2D Device that is not certified.

2s more graphics cards and 30 display drivers are tested,
they are added to a list on the Rutodesk webaite.

¥ou can check for updates and download the latest
certification list at any time. Run the 3DCONFIG command and
click the Check for Updates button.

Current application driver: Software

Current Effect Status:

Enhanced 3D Performance: HNot recommended and off
Gooch shader: Software erulation in use i
Save Log As... ] I Close
Save Log As

Displays a standard file selection dialog box.
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Manual Performance Tuning Dialog Box

Quick Reference

Access Methods

e:

Button

£ Ribbon: Render tab » Visual Styles panel » Performance Tuner
£ Menu: Tools » Options (Options dialog box, System tab)
E2 Command entry: options

Sets options that affect 3D display performance. These options are set
automatically by the performance tuner. You can set them manually in this
dialog box.
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hﬂ Manual Performance Tuning (=3

Hardware settings

Current Effect Status: Value
i\ Gooch hardware shader ON

|| Emuiate unsupported hardware effects in software

when plotting,

General settings
Discard back faces

[~] smooth faces by default
Transparency quality:

Dynamic tessellation

Surfaces: r/}
Curves: r/}
Low detail High detail
Less memory Mare memory

Mumber of tessellations to cache:

5 =

[ Reset to Recommended Values ]

[ OK ] [ Cancel ] [ Help ]

Sets a driver for the graphics card and sets options for hardware acceleration.
Enable Hardware Acceleration

Uses hardware acceleration. When this check box is cleared, hardware
acceleration is not used, and all the items in this dialog box are unavailable.
For information on why hardware acceleration might not be available, see
Hardware Acceleration Troubleshooting in the Driver and Peripheral Guide.

B Green check mark indicates a graphics card that is certified and can run
all features.

B Yellow warning indicates a graphics card that is certified and cannot run
all features. If the graphics card is unknown, the performance tuner displays
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the yellow warning, and you can use hardware acceleration at your own
risk.

B Red alert indicates a graphics card that is not certified. The check box is
cleared, and Enable Hardware Acceleration is unavailable.

Driver Name

Sets a driver for the graphics card. (Autodesk or other custom drivers that
might be installed). If no drivers are certified for the graphics card, “no certified
drivers” is displayed. Changes to the driver might affect the Hardware Effects
List.

Hardware Effects List

Lists features available for the current driver and indicates their status. A green
check mark indicates a feature that is supported; you can turn it on or off. A
yellow warning indicates that the feature is not recommended; you can turn
it on or off. A red alert indicates that the feature is not supported and cannot
be turned on.

B Enhanced 3D performance (formerly known as Geometry Acceleration).
Enables a more efficient use of the graphic card when working with 3D
objects.

NOTE If you experience problems with precision, turn this option off.

B Gooch hardware shader. Enables the use of Gooch shading. With this
option on the details of a 3D object are shown by softening the contrast
between lighted areas and shadowed areas by using warm and cool colors
as a substitute to light and dark colors.

B Per-pixel lighting. Enables the computation of colors for individual pixels.
With this option on the 3D objects and lighting effects appear smoother
in the viewport.

B Full shadow display. Enables shadows to be displayed in the viewport.

NOTE Enhanced 3D performance effect must be turned on.

B Texture compression. Enables the use of texture compression to reduce
the amount of video memory required to open and display a drawing that
contains materials with images or has attached images.
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NOTE With this option turned on, the time it takes to load the images might
increase the first time that they are accessed, and there is a reduction in the
quality of the images when they are displayed in the viewport or plotted.

B Enhanced 2D precision. Enables the Enhanced 2D precision effect. With
this option turned on, the precision artifacts that can be seen at extreme
zoom levels are removed.

NOTE This option is only available if you are working on a Windows Vista
platform. Turn on this option only if you experience problems with precision
because it will decrease the graphics card performance.

Emulate Unsupported Hardware Effects in Software When Plotting

Controls whether software emulation is used for unsupported hardware effects
when plotting shaded viewports with shadows and other effects that are not
supported by your graphics card.

WARNING It is recommended that you not use any type of remote access
application, such as NetMeeting, Remote Desktop, or VMWare in conjunction
with hardware acceleration. Most remote access applications do not support
hardware acceleration, and as a result, can cause general display failure and
instability. Prior to using a remote access application with AutoCAD, check with
the software vendor to see if it supports hardware acceleration and if not, disable
hardware acceleration prior to starting the remote access software or use the
/NOHARDWARE command line switch to start AutoCAD in Software mode.

General Settings

Sets performance-related options that are not hardware dependent.
Discard Back Faces

When selected, the back faces of objects are not drawn.

Smooth Faces by Default

When selected, the facets in a polyface mesh object are made smooth when
displayed in the viewport and in a rendering. This is useful when using objects
that were imported through 3DSIN or when using PFACE objects. Note that
when you select this option, all objects in the drawing are made smooth. If
you don’t want all objects to be smooth, recreate the model using a different
object type.

Transparency Quality
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Adjusts the transparency quality used when viewing or rendering a model.
The transparency quality used is dependent on if software or hardware
acceleration are used, or if a model is being rendered. The default quality is
Medium.

Software acceleration

B Low quality produces a screen-door effect to achieve transparency without
sacrificing speed.

B Medium quality uses a combination of the screen-door effect and alpha
blending.

B High quality uses simple alpha blending, which can cause graphical artifacts
to appear based on the current draw order.

Hardware acceleration

B Low quality uses simple alpha blending, which can cause graphical artifacts
to appear based on the current draw order.

B Medium quality uses a two-pass algorithm to draw all opaque objects,
followed by all transparent objects. The transparent objects are drawn
using simple alpha blending, which can cause graphical artifacts to appear
based on the current draw order. The graphical artifacts are less noticeable
due to the opaque objects being drawn prior to the transparent objects.

B High quality improves on medium quality by sorting transparent objects
to decrease the appearance of graphical artifacts. However, the sorting does
not completely eliminate all graphical artifacts.

Rendering

B Low quality disables the use of transparency for all materials, and the
materials are rendered as opaque instead.

B Medium quality enables transparency for materials, but the actual material
opacity used is the square root of the specified material opacity.

B High quality enables transparency and the opacity assigned to a material
is mapped directly to Mental Ray rendering engine.

Drawing Settings

Sets performance values on a drawing level.
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Dynamic Tessellation

Sets the options that determine the smoothness of the objects in a drawing.
Objects are drawn using many short lines (or triangles when drawing spheres).
These lines are called tessellation lines. Objects in your drawing appear smoother
when you use more tessellation lines.

Surface Tessellation

Determines the amount of detail for surfaces in your drawing. The low end
of the slider provides fewer tessellation lines and uses less memory.

Curve Tessellation

Determines the amount of detail for curves in your drawing. The low end of
the slider provides fewer tessellation lines and uses less memory.

Number of Tessellations to Cache

Configures your system according to memory and performance requirements.
The 3D cache always stores at least one tessellation. When this option is set
to 1, the tessellation for all viewports is the same; some objects in the drawing
may be regenerated as you zoom in and out. Setting this option to 2 or more
is useful when you have more than one viewport with different views.
Increasing the number requires more memory.

Reset to Recommended Values

Resets the values to the defaults based on the performance tuner’s evaluation
of the graphics card.

-3DCONFIG

Quick Reference
If you enter -3dconfig at the Command prompt, the following prompts are
displayed.

Enter option: [Adaptive degradation/Dynamic tessellation/General
options/acceLeration/Plot emulation/eXit] <Adaptive degradation>:

The prompt is redisplayed until you enter x (Exit) or press ESC.
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Adaptive Degradation

Turns off or minimizes display effects when performance drops below the
minimum you specify.

Enter mode [ON/OFF] <ON>:

If Adaptive Degradation is on, the following prompt is displayed.

Enter speed to maintain (1-60 fps) <5>:

The main prompt is redisplayed.

Dynamic Tessellation

Sets the options that determine the smoothness of the objects in a drawing.
Objects are drawn using many short lines (or triangles when drawing spheres).
These lines are called tessellation lines. Objects in your drawing appear smoother
when you use more tessellation lines.

Enter mode [ON/OFF] <ON>:
If dynamic tessellation is on, the following prompt is displayed.

Enter option [Surface tessellation/Curve tessellation/Tessellations to cache/eXit]
<Surface tessellation>:

The prompt is redisplayed.

Surface Tessellation Enter tolerance <92>: Enter a value between 0 and 100

Determines the amount of detail for surfaces in your drawing. A higher setting
provides more detail but uses more tessellation lines and more memory.

The Dynamic Tessellation prompt is redisplayed.

Curve Tessellation Enter tolerance <87>: Enter a value between 0 and 100

Determines the amount of detail for curves in your drawing. A higher setting
provides more detail but uses more tessellation lines and more memory.

The Dynamic Tessellation prompt is redisplayed.

Number of Tessellations to Cache Enter number of tessellations to cache
<6>: Enter a value between 1 and 10

Configures your system according to memory and performance requirements.
The 3D cache always stores at least one tessellation. When this option is set
to 1, the tessellation for all viewports is the same; some objects in the drawing
may be regenerated as you zoom in and out. Setting this option to 2 or more
is useful when you have more than one viewport with different views.
Increasing the number requires more memory.

The Dynamic Tessellation prompt is redisplayed.
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General Options
Sets performance-related options that are not hardware dependent.

Configure: General options

Enter option [Discard backfaces/Transparency quality/eXit] <Discard
backfaces>:

Discard Back Faces Enter mode [ON/OFF| <ON>: Enter on to discard back faces

Discards back faces when drawing objects. You cannot see the effect of
discarding back faces on some objects, such as spheres, because you cannot
see the back face even when it is present. The effect of discarding back faces
is visible on objects such as those that don't have a top. Discarding back faces
enhances performance.

The General Options prompt is redisplayed.

Transparency Quality Adjusts the transparency quality. At the Low setting,
a screen-door effect achieves transparency without sacrificing speed. At the
Medium setting, the default in software mode, blending improves image
quality. The High setting, the default in hardware mode, produces an image

free of visual artifacts at the cost of drawing speed. Materials must also be
turned on for transparency to be visible.

The General Options prompt is redisplayed.

Acceleration
Specifies whether to use software or hardware acceleration in 3D.
Enter option [Hardware/Software/eXit] <Hardware>:

If you select Hardware, you can also specify whether geometry acceleration
are turned on or off.

Hardware Enter option [Driver name/Enhanced 3D performance/gOoch
hardware shader/Smooth line display/Per-pixel lighting/Full-shadow
display/Texture compression/eNhanced 2D performance/eXit] <Driver name>:

Specifies hardware acceleration. The hardware graphics card performs most
of the drawing tasks in 3D to increase performance.

Enter driver name <AcadDM10.hdi>:
The available drivers are AcadDM10.hdi and direct3d10.hdi.

When you select Hardware, the default driver is set to the AcadDM10.hdi driver
that is included with the program.

If you select the Driver Name option, you can select a driver from a list of
available hardware-accelerated drivers found in the Drv directory. If you want
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to use a hardware driver from another vendor, it must be supported by the
Heidi® Graphics System.

For information on why hardware acceleration might not be available, see
Hardware Acceleration Troubleshooting in the Driver and Peripheral Guide.

Software Specifies software acceleration. The software graphics system performs
all of the drawing tasks in 3D.

Geometry Acceleration Enter mode [ON/OFF] <ON>:

Using geometry acceleration makes more efficient use of the graphics card
when working with 3D objects.

Per-pixel lighting Enter mode [ON/OFF] <ON>:

Enables the computation of colors for individual pixels. With this option on
the 3D objects and lighting effects appear smoother in the viewport.

NOTE When Geometry Acceleration is turned off, per-pixel lighting cannot be
displayed in the viewport.

Shadows Enabled Enter mode [ON/OFF] <ON>:
Enables the display of shadows.

NOTE When Geometry Acceleration is turned off, full shadows cannot be displayed
in the viewport.

Texture Compression Enter mode [ON/OFF] <ON>:

Enables the use of texture compression to reduce the amount of video memory
required to open and display a drawing that contains materials with images
or has attached images.

NOTE With this option on the time it takes to load the images may increase the
first time that they are accessed and there is a reduction in the quality of the images
when they are displayed in the viewport or plotted.

Plot Emulation

Turns on or off the use of software emulation for unsupported hardware effects
during the plotting of a drawing with shaded viewports. The use of software
emulation happens when it is turned on, and hardware acceleration is disabled
or is enabled, but does not support Shadows.

Enter mode [ON/OFF] <ON>:

The main prompt is redisplayed.
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Exit

Exits the command.

3DCORBIT

Quick Reference

Rotates the view in 3D space with continuous motion.
Access Methods

Button

£ Ribbon: View tab » Navigate panel » Continuous Orbit.

£ Menu: View » Orbit » Continuous Orbit

£ Toolbar: 3D Navigation

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigation Modes » Continuous Orbit (3).

E Command entry: 3dcorbit

Summary

You can view your entire drawing or select one or more objects before starting
the command.

Selecting one of more objects before starting this command limits the display
to those objects only.

While the command is active, right-click to display additional options from
a shortcut menu.

Click in a drawing area and drag the pointing device in any direction to start
the objects moving in the direction that you're dragging. Release the button
on the pointing device and the objects continue their orbit in the direction
that you specified. The speed set for the cursor movement determines the
speed at which the objects spin.

You can change the direction of the continuous orbit by clicking and dragging
again. You can also change the display of the continuous orbit by right-clicking
in the drawing area and choosing an option from the shortcut menu. For
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example, you can choose Visual Aids » Grid to add a grid to the view without
exiting Continuous Orbit.

3DDISTANCE

Quick Reference
Starts the interactive 3D view and makes objects appear closer or farther away.

Access Methods

[©]

[
Button

£ Menu: View » Camera » Adjust Distance

£ Toolbar: 3D Navigation

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigation Modes » Adjust Distance (4).

EE Command entry: 3ddistance

Summary

3DDISTANCE changes the cursor to a line with one arrow pointing up and
one pointing down. Click and drag the cursor vertically toward the top of the
screen to move the camera closer to the objects, making them appear larger.
Click and drag the cursor vertically toward the bottom of the screen to move
the camera away from the objects, making them appear smaller.

3DDWF

Quick Reference

Creates a 3D DWF or 3D DWFx file of your 3D model and displays it in the
DWEF Viewer.
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Access Methods
Button

£ Ribbon: Output tab » Export to DWF/PDF panel » 3D DWF
£ Toolbar: Standard
E Command entry: 3ddwf

Summary

The Export 3D DWF dialog box (a standard file selection dialog box) is
displayed. After you enter a file name and click Save, the DWF file viewer is
launched and your DWF file is displayed.

You can also change publishing settings from the 3D DWF Publish dialog box.

NOTE The File Type control on the Export 3D DWF dialog box lists 3D DWF (*.dwf)
and 3D DWFx (*.dwfx) when you use the 3DDWF command.

3D DWF Publish Dialog Box

Quick Reference

Access Methods

£ Toolbar: Standard

Shortcut menu: Issue the 3DDWF command and click Tools » Options
from the Export 3D DWF dialog box.

EE Command entry: 3ddwf
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Summary

Allows you to publish a three-dimensional model as a DWF or DWFx file. 3D
DWF Publishing, a technology preview in AutoCAD® 2006, is now a standard
AutoCAD feature.

Objects to Publish

Specifies whether all model space objects or selected model space objects are
published to the DWF file.

All Model Space Objects All model space objects are published to the 3D
DWEF or 3D DWFx file.

Select Model Space Objects Allows you to create a selection set of model
space objects, including external references, which are published to the 3D
DWEF or 3D DWFx file after you click OK.

Select Objects Active only when Select Model Space Objects is enabled.
Clicking this button minimizes the dialog boxes and lets you select objects in
the drawing workspace. When object selection is completed, press Enter and
the 3D DWF or 3D DWFx Publish dialog box reappears reporting the number
of objects selected for publishing.

3D DWF Organization

Specifies how to group objects in the DWF or DWEFx file for viewing in
Autodesk® DWF™ Viewer.

Group by Xref Hierarchy Arrange objects by xref hierarchy in the viewer. If
unchecked, externally referenced files are listed in the viewer like any other
objects.

Options
These options let you specify if materials are published in the DWF file.

Publish with Materials Most materials that you have assigned to your model
will not be published to the 3D DWF or 3D DWFx file. Materials with
procedural maps and some material properties will not export to the 3D DWF
or 3D DWFx file. If your material contains texture mapping, only the Diffuse
Map gets published along with its scale and orientation data. Including
materials will not significantly affect the size of your 3D DWF or 3D DWFx
files. Default=active.

3D DWEF Publish Dialog Box | 37



NOTE Materials that are not supported in 3D DWF or 3D DWFx include Bump,
Opacity, and Reflection mapping, as well as all forms of procedural materials,
which include Checker, Marble, Noise, Speckle, Tile, Waves and Wood.

3DDWFPUBLISH

Quick Reference
Obsolete

Access Methods
EE Command entry: 3ddwfpublish

Summary

The Export 3D DWF dialog box (a standard file selection dialog box) is
displayed.

Refer to the 3DDWF command.

3DFACE

Quick Reference
Creates a three-sided or four-sided surface in 3D space.
Access Methods

i

Button

£ Menu: Draw » Modeling » Meshes » 3D Face
E Command entry: 3dface

Summary
Specify first point or [Invisible]: Specify a point (1) or enter i
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First Point Defines the start point for the 3D surface. After entering the first
point, enter the remaining points in a natural clockwise or counterclockwise
order to create a normal 3D face. If you locate all four points on the same
plane, a planar face is created that is similar to a region object. When you
shade or render the object, planar faces are filled.

Invisible Controls which edges of a 3D face are visible, allowing for accurate
modeling of objects with holes. Entering i or invisible before the first point of
an edge makes the edge invisible.

The invisible specification must precede any object snap modes, XYZ filters,
or coordinate input for that edge. You can create a 3D face in which all edges
are invisible. Such a face is a phantom; it does not appear in wireframe
presentations but can hide material in line drawings. 3D faces do appear in
shaded renderings.

You can combine 3D faces to model complex 3D surfaces.

visible edges invizgible edges

Specify second point or [Invisible]: Specify a point (2) or enter i

Specify third point or [Invisible] <exit>: Specify a point (3), enteri, or press Enter
Specify fourth point or [Invisible] <create three-sided face>: Specify a point (4),
enter i, or press Enter

The Third Point and Fourth Point prompts are repeated until you press Enter.
Specify points 5 and 6 at these repeating prompts. When you finish entering
points, press Enter.
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3DFLY

Quick Reference

Changes the 3D view in a drawing interactively to create the appearance of
flying through the model.

Access Methods

BN
A

Button

£ Ribbon: Render tab » Animations panel » Fly.

£ Toolbar: 3D Navigation

£ Menu: View » Walk & Fly » Fly

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigations Modes » Fly (7).

E Command entry: 3dfly

Summary

3DFLY activates a fly mode in the current viewport. You can leave the XY
plane as though you're flying through or around the model. On the keyboard,
use the four arrow keys, the W (forward), A (left), S (back), and D (right) keys,
and the mouse to determine the direction of your fly. For more information,
see Walk and Fly Navigation Mappings Balloon on page 73.

By default, the Position Locator window opens and displays your position in
the drawing from a top view.

To control walk and fly settings, use the Walk and Fly Settings dialog box. To
specify settings for animating a 3D walk or fly, see Animation Settings Dialog
Box on page 71.

3DFORBIT

Quick Reference

Rotates the view in 3D space without constraining roll.
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Access Methods

&

Button

£ Ribbon: View tab » Navigate panel » Free Orbit
£ Menu: View » Orbit » Free Orbit

£ Toolbar: 3D Navigate

Pointing device: Press Shift+Ctrl and click the mouse wheel to temporarily
enter 3DFORBIT mode.

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigations Modes » Free Orbit (2).

EE Command entry: 3dforbit

Summary

Selecting one of more objects before starting this command limits the display
to those objects only.

While the command is active, right-click to display additional options from
a shortcut menu.

3DFORBIT activates a 3D Free Orbit view in the current viewport. If the user
coordinate system (UCS) icon is on, a shaded 3D UCS icon representing the

current UCS appears in the 3D Orbit view. You can view your entire drawing
or select one or more objects before starting the command.

The 3D Free Orbit view displays an arcball, which is a circle divided into four
quadrants by smaller circles. When the Enable Orbit Auto Target option is
deselected in the shortcut menu, the target of the view stays stationary. The
camera location, or point of view, moves around the target. The center of the
arcball, not the center of the objects you're viewing, is the target point. Unlike
3DORBIT, 3DFORBIT does not constrain the change in view along the XY axis
or Z direction.

NOTE You cannot edit objects while the 3DFORBIT command is active.

Moving your cursor over different parts of the arcball changes the cursor icon,
indicating the direction in which the view rotates. See 3D Free Orbit Cursor
Icons on page 42.

While the command is active, you can access additional 3DORBIT options
from a shortcut menu by right-clicking in the drawing area, or choosing
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buttons on the 3D Navigation toolbar. See 3D Orbit Shortcut Menu on page
50.

TIP While in 3D Orbit mode, you can temporarily enter 3D Free Orbit mode by
pressing and holding the Shift key.

3D Free Orbit Cursor Icons

Quick Reference

View rotation is determined by the placement and appearance of the cursor
as follows:

Sphere Encircled by Two Lines When you move the cursor inside the arcball,
it changes to a small sphere encircled by two lines. If you click and drag in
the drawing area you can move freely around the objects. It works as if your
cursor is grabbing a sphere surrounding the objects and dragging it around
the target point. You can drag horizontally, vertically, and diagonally using
this method.

b
o

Circular Arrow When you move the cursor outside the arcball, it becomes a
circular arrow. Clicking outside the arcball and dragging the cursor around
the arcball causes the view to move around an axis that extends through the
center of the arcball, perpendicular to the screen. This is called a roll.

(=

Horizontal Ellipse When you move the cursor over one of the small circles
on the left or right side of the arcball, it becomes a horizontal ellipse. Clicking
and dragging from either of these points rotates the view around the vertical
or Y axis through the middle of the arcball.
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Vertical Ellipse When you move the cursor over one of the small circles on
the top or bottom of the arcball, it becomes a vertical ellipse. Clicking and
dragging from either of these points rotates the view around the horizontal
or X axis through the middle of the arcball.

—@-

3DMESH

Quick Reference
Creates a free-form polygon mesh.

Access Methods
EE Command entry: 3dmesh

Summary

The mesh density controls the number of facets, and is defined in terms of a
matrix of M and N vertices, similar to a grid consisting of columns and rows.
3DMESH is a legacy method for creating mesh, designed primarily for operation
under program control rather than by manual entry.

To take advantage of smoothing, creasing, and refinement capabilities, use
the MESH command.

List of Prompts

The following prompts are displayed.

Size of mesh in M direction Sets the M direction value. Enter a value between
2 and 256.
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Size of mesh in N direction Sets the N direction value. Enter a value between
2 and 256.

M times N equals the number of vertices that you must specify.

Location for vertex (0, 0) Sets the coordinate location of the vertex. Enter a
2D or 3D coordinate.

The location of each vertex in the mesh is defined by m and n, the row and
column indices of the vertex. Defining vertices begins with vertex (0,0). You
must supply the coordinate locations for each vertex in row m before specifying
vertices in row m + 1.

Vertices may be any distance from each other. The M and N orientation of a
mesh depends on the position of its vertices.

open mesh

3DMESH polygon meshes are always open in both M and N directions. You
can close a mesh with PEDIT.

closed mesh

44 | Chapter1 3D Commands



3DMOVE

Quick Reference

In a 3D view, displays the 3D Move gizmo to aid in moving 3D objects a
specified distance in a specified direction.

Access Methods

&

Button

£ Ribbon: Home tab » Modify panel » 3D Move
£ Menu: Modify » 3D Operations » 3D Move

£ Toolbar: Modeling
EE Command entry: 3dmove

Summary

With the 3D Move gizmo, you can move selected objects and subobjects freely
or constrain the movement to an axis or plane.

1
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If the default gizmo (DEFAULTGIZMO) is 3D Move, the 3D Move gizmo is
displayed whenever you select an object in a view with a 3D visual style. If
you are working in a viewport with 2D Wireframe set as the visual style,
3DMOVE temporarily changes the visual style to 3D Wireframe for the duration
of the command.

The 3D Move gizmo is displayed at the center of the selected 3D object or
objects by default. You can use the shortcut menu to change its location.

You can also align the 3D Move gizmo with the plane of a face or object by
using the Align Gizmo With » Face option on the shortcut menu. The
direction of the move operation is then constrained relative to this workplane.

When the 3D Move gizmo is displayed, the 3D Move Gizmo shortcut menu
offers options for aligning, moving, or changing to another gizmo.

List of Prompts

The following prompts are displayed.

Select objects Selects the 3D objects you want to move. When you have
selected the objects, press Enter.

When you have selected an object, the gizmo is displayed. You can constrain
the movement by clicking one of the following locations on the gizmo:

B Move along an axis. Click an axis to constrain the movement to that axis.

Z
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B Move along a plane. Click the area between the axes to constrain the
movement to that plane.

Z

Stretch point When you are specifying the move using the gizmo, sets the
new location of the selected objects. Drag and click to move the objects
dynamically.

Copy When you are specifying the move using the gizmo, creates a copy of
the selected objects instead of moving them. You can make multiple copies
by continuing to specify locations.

Base point Specifies the base point of the 3D objects you want to move.

B Second point. Specifies where the 3D object or objects will be dragged.
You can also move the cursor to indicate a direction and then enter a
distance.

Displacement Specifies a relative distance and direction for the placement of
the selected 3D objects using coordinate values that you enter at the command
prompt.

3D Move Gizmo Shortcut Menu

Quick Reference

Displays options to set the constraint of a 3D object, switch gizmos, and move
or align the gizmo.
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Access Methods

Shortcut menu: Right-click the 3D Move gizmo

List of Options

The following options are available in this shortcut menu.
Move Activates the 3D Move gizmo.

Rotate Activates the 3D Rotate gizmo.

Scale Activates the 3D Scale gizmo.

Set Constraint Sets whether the change is constrained to a specific axis.
B X, Y or Z. Restricts the change to the designated axis.

B XY, YX, or ZX. Restricts the change to a plane that is defined by the selected
axes.
Relocate Gizmo Moves the gizmo to the point you specify.

Align Gizmo With Sets the alignment for the change. Choices include
B World UCS (default)

H Current UCS

B Face

Custom Gizmo Allows you to define the current gizmo by specifying one,
two, or three points, or an object.

Respect Dynamic UCS When relocating the gizmo, as you move the cursor,
temporarily aligns the XY plane of the UCS with the faces or edges.
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3DORBIT

Quick Reference

Rotates the view in 3D space, but constrained to horizontal and vertical orbit
only.

Access Methods

4

Button

£ Ribbon: View tab » Navigate panel » Constrained Orbit.

£ Toolbar: 3D Navigate

£ Menu: View » Orbit » Constrained Orbit

Pointing device: Press Shift and click the mouse wheel to temporarily enter
3D Orbit mode.

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigations Modes » Constrained Orbit (1).

E Command entry: 3dorbit

Selecting one of more objects before starting this command limits the display
to those objects only.

While the command is active, right-click to display additional options from
a shortcut menu.

3DORBIT activates a 3D Orbit view in the current viewport. You can view
your entire drawing or select one or more objects before starting the command.

When 3DORBIT is active, the target of the view stays stationary and the camera
location, or point of view, moves around the target. However, it appears as if
the 3D model is turning as the mouse cursor is dragged In this way, you can
specify any view of the model.

The 3D Orbit cursor icon appears. If you drag the cursor horizontally, the
camera moves parallel to the XY plane of the world coordinate system (WCS).
If you drag the cursor vertically, the camera moves along the Z axis.

NOTE You cannot edit objects while the 3DORBIT command is active.
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While the command is active, you can access additional 3DORBIT options
and modes from a shortcut menu by right-clicking in the drawing area, or
choosing buttons on the 3D Navigation toolbar. See 3D Orbit Shortcut Menu
on page 50.

3D Orbit Shortcut Menu

Quick Reference

When the 3DORBIT command (or any 3D navigation command or mode) is
active, you can access the options on the 3D Orbit shortcut menu. To access
the 3D Orbit shortcut menu, right-click in the 3D Orbit view.

Current Mode: Current

Displays the current mode.

Other Navigation Modes

Choose one of the following 3D navigation modes:

B Constrained Orbit (1). Constrains orbiting to the XY plane or the Z
direction.

B Free Orbit (2). Allows orbiting in any direction, without being constrained
to the XY plane or the Z direction. See 3DFORBIT.

B Continuous Orbit (3). Changes the cursor to a sphere with two continuous
lines encircling it and enables you to set the objects into continuous
motion. See 3DCORBIT.

B Adjust Distance (4). Simulates moving the camera closer to the object or
farther away. See 3DDISTANCE.

B Swivel (5). Changes the cursor to an arched arrow and simulates the effect
of swiveling the camera. See 3DSWIVEL.

B Walk (6). Changes the cursor to a plus sign and enables you to "walk
through" a model at a fixed height above the XY plane, by dynamically
controlling the location and target of the camera. See 3DWALK.

B Fly (7). Changes the cursor to a plus sign and enables you to "fly through"
a model without being restricted to a fixed height above the XY plane. See
3DFLY.
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B Zoom (8). Changes the cursor to a magnifying glass with plus (+) and
minus (-) sign and simulates moving the camera closer to an object or
farther away. Works like the Adjust Distance option. See 3DZOOM.

B Pan (9). Changes the cursor to a hand cursor and moves the view in the
direction that you drag. See 3DPAN.

TIP You can switch to any mode by using the shortcut menu or by entering
the number displayed after its name.

Enable Orbit Auto Target

Keeps the target point on the objects you are viewing rather than on the center
of the viewport. This feature is turned on by default.

Animation Settings

Opens the Animation Settings dialog box, where you can specify settings for
saving an animation file.

Zoom Window

Changes the cursor to a window icon so that you can select a specific area to
zoom in on. When the cursor changes, click a starting point and end point
to define the zoom window. The drawing is zoomed in and focused on the
area you selected.

Zoom Extents

Centers the view and sizes it to display all objects.

Zoom Previous

Displays the previous view.

Parallel

Displays objects so that two parallel lines in a drawing never converge. The
shapes in your drawing always remain the same and do not appear distorted
when they are closer.

Perspective

Displays objects in perspective so that all parallel lines converge at one point.
Objects appear to recede into the distance, and parts of the objects appear
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larger and closer to you. The shapes are somewhat distorted when the object
is very close. This view correlates more closely to what your eyes see.
SeePERSPECTIVE.

Reset View

Resets the view back to the view that was current when you first started
3DORBIT.

Preset Views

Displays a list of predefined views such as Top, Bottom, and SW Isometric.
Choose a view from the list to change the current view of your model.
Named Views

Displays a list of named views in the drawing. Choose a named view from the
list to change the current view of your model.

Visual Styles

Provides methods for shading objects. For more information about visual
styles, see Use a Visual Style to Display Your Model.

B 3D Hidden. Displays the objects using 3D wireframe representation and
hides lines representing back faces.

B 3D Wireframe. Displays the objects using lines and curves to represent the
boundaries.

B Conceptual. Shades the objects and smooths the edges between polygon
faces. The effect is less realistic, but it can make the details of the model
easier to see.

B Realistic. Shades the objects and smooths the edges between polygon faces.

Visual Aids

Provides aids to visualizing the objects.

B Compass. Draws a 3D sphere composed of three lines representing the X,
Y, and Z axes.

B Grid. Displays a two-dimensional array of lines similar to graph paper. This
grid is oriented along the X and Y axes.
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NOTE Before starting 3DORBIT, you can use the GRID command to set system
variables that control the grid display. The number of major grid lines
corresponds to the value you set using the Grid Spacing option of the GRID
command, which is stored in the GRIDUNIT system variable. Ten horizontal
lines and ten vertical lines are drawn between the major lines.

B UCS Icon. Displays a shaded 3D UCS icon. Each axis is labeled X, Y, or Z.
The X axis is red, the Y axis is green, and the Z axis is blue.

3DORBITCTR

3DPAN

Quick Reference
Sets the center of rotation in 3D Orbit view.

Access Methods
EE Command entry: 3dorbitctr

Starts 3D Orbit view and uses a center of rotation that you specify with your
pointing device. If you specify a point outside the current view, 3DORBITCTR
ignores the specified point and uses the default center of rotation.

3DORBITCTR overrides the AutoTarget option in the 3DORBIT command.

Quick Reference

When a drawing is in a Perspective view, starts the interactive 3D view and
enables you to drag the view horizontally and vertically.

Access Methods
%
-

Button
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£ Toolbar: 3D Navigation

£ Menu: View » Pan

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigation Modes » Pan (9).

E Command entry: 3dpan

Moves in the direction that you drag. You can drag the view vertically,
horizontally, or diagonally. 3DPAN changes the cursor to a hand cursor.

You can view your entire drawing or select objects before entering 3DPAN.

3DPOLY

Quick Reference
Creates a 3D polyline.
Access Methods

)

Button

£ Ribbon: Home tab » Draw panel » 3D Polyline.
£ Menu: Draw » 3D Polyline
EE Command entry: 3dpoly

Summary

A 3D polyline is a connected sequence of straight line segments created as a
single object. 3D polylines can be non-coplanar; however, they cannot include
arc segments.
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Specify start point of polyline: Specify a point (1)

Specify endpoint of line or [Undo]: Specify a point or enter an option

Specify endpoint of line or [Undo]: Specify a point or enter an option

Specify endpoint of line or [Close/Undo]: Specify a point or enter an option
Endpoint of Line Draws a straight line from the previous point to the specified
new point. The prompt is repeated until you press Enter to end the command.

new point———

) {f\-. A
previous
point dfl%

Undo Deletes the last line created. You can continue drawing from the previous

point.

P P
o /\
= =%
before Undo after Undo

Close Draws a closing line from the endpoint back to the first point, and then
ends the command. To be closed, a 3D polyline must contain at least two
lines.

<
closing %
segment §

3DPRINT

Quick Reference
Sends a 3D model to a 3D printing service.

Access Methods

=

Button
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£ Ribbon: Output tab » 3D Print panel » Send to 3D Print Service.
£ Menu: Application menu » Publish » Send to 3D Print Service
EE Command entry: 3dprint

Summary

The 3DPRINT command opens the 3D Printing - Prepare Model for Printing
dialog box. You can

B Learn about preparing 3D models for printing

H Continue

If you click Continue, the following prompt displays:

Select solids or watertight meshes: Select 3D solids or watertight meshes. Press
Enter.

As you select solids or watertight meshes, note the following:

B You can select uniformly scaled blocks and xrefs that contain solids or
watertight meshes. Non-uniformly scaled blocks and xrefs cannot be
included in the selection set.

B Only solids and watertight meshes within selected blocks and xrefs are
included in the STL file. All other geometry is discarded.

B Watertight meshes are converted and optimized based on the current value
of the SMOOTHMESHCONVERT system variable.

No other command prompts display. However, the following display in the
order listed:

B Send to 3D Print Service Dialog Box
B Create STL File Dialog Box

B The Autodesk 3D Printing Website
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http://usa.autodesk.com/adsk/servlet/item?id=11626181&siteID=123112

Send to 3D Print Service Dialog Box

Quick Reference

Access Methods

E Command entry: 3dprint
Summary

Objects
The following buttons allow you to change the selection set:
Select Objects

Displays the canvas where you can add or remove objects from the selection
set. Objects that you have already selected are removed from the selection set
and replaced by newly selected objects.

To add objects to the selection set, select the objects.

To remove objects from the selection set, shift-select the objects.
Quick Select

Displays the Quick Select Dialog Box.

Use the Quick Select Dialog Box.

Output Dimensions

As part of the 3D printing process, selected 3D solids and watertight meshes
within a bounding box are saved as an STL file. This file can be used by a 3D
printing service to output a physical model.

You can select blocks or external references (xrefs) that contain 3D solids and
watertight meshes. However, only 3D solids and watertight meshes within
selected blocks or xrefs are included in the STL file. Other objects are not
included when you save the STL file.

You can modify the dimensions of the bounding box and specify the scale of
3D solids and watertight meshes within the bounding box. If you modify this
option, the proportions of these objects are unaffected.

You can modify the following options. All of these options are based on one
another. If you modify one, the others are automatically adjusted.
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Scale

Specifies the scale of selected 3D objects within the bounding box.
Length (X)

Specifies the X dimension of the model bounding box.

Width (Y)

Specifies the Y dimension of the model bounding box.

Height (Z)

Specifies the Z dimension of the model bounding box.

Output Preview

Provides a dynamic preview of selected 3D solids and watertight meshes. If
you modify output dimensions, the output preview remains unaffected.

The following buttons provide options for viewing the output preview:
Zoom Extents

Sets the display so that the image fits within the preview window. This dialog
box is resizeable. If desired, you can enlarge the preview.

Pan

Moves the image horizontally and vertically within the preview window. You
can also pan by holding down the scroll wheel of your mouse as you move
the mouse.

Zoom

Changes the magnification of the preview. To zoom in or out, select this
button, then hold the left mouse button and drag upwards or downwards.

You can also roll the mouse scroll wheel to zoom or out at any time.
Orbit

Rotates the image within the preview window as you drag the image with the
mouse.
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Create STL File Dialog Box

Quick Reference

Access Methods

E Command entry: 3dprint
EE Command entry: stlout
Summary

The Create STL File dialog box is a standard file selection dialog box). It displays
when you use the 3DPRINT or STLOUT commands. Use this dialog box to
save your drawing as an STL file.

The STL file format is preferred by 3D printing service providers. If you have
prepared your drawing for 3D printing, you can save it with the STLOUT
command, rather than the 3DPRINT command.

The FACETRES system variable determines how the solid is triangulated. Setting
FACETRES to a higher value creates a finer mesh that more accurately represents
the model. This also results in a much larger file. When you use the 3DPRINT
command, the FACETRES system variable is set to 10, the highest value
available.

3DROTATE

Quick Reference

In a 3D view, displays the 3D Rotate gizmo to aid in revolving 3D objects
around a base point.

Access Methods

Button

£ Ribbon: Home tab » Modify panel » 3D Rotate
£ Menu: Modify » 3D Operations » 3D Rotate
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£ Toolbar: Modeling
E Command entry: 3drotate
Summary

With the 3D Rotate gizmo, you can rotate selected objects and subobjects
freely or constrain the rotation to an axis.

If you are working in a viewport with 2D Wireframe set as the visual style,
3DROTATE temporarily changes the visual style to 3D Wireframe for the
duration of the command.

The 3D Rotate gizmo is displayed at the center of the selected object or objects
by default. You can adjust the axis of rotation by using the shortcut menu to
change the location of the gizmo.

When the 3D Rotate gizmo is displayed, the 3D Rotate Gizmo shortcut menu
offers options for aligning, moving, or changing to another gizmo.
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List of Prompts

The following prompts are displayed.

Select objects Specifies the objects that you want to rotate.
Base point Sets the center point of the rotation.

Pick a rotation axis On the 3D Scale gizmo, specifies the axis of rotation.
Move the mouse until the axis path you want to select turns yellow, then click
to select it.

{ T L
Specify angle start point or type an angle Sets the relative start point of the
rotation. You can also enter an angle value.

Specify angle end point Rotates the object about the specified axis. Click to
end the rotation.

3D Rotate Gizmo Shortcut Menu
Quick Reference

Displays options to set the constraint of a 3D object, switch gizmos, and move
or align the gizmo.
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e

Access Methods
Shortcut menu: Right-click the 3D Rotate gizmo

List of Options

The following options are available in this shortcut menu.
Move Activates the 3D Move gizmo.

Rotate Activates the 3D Rotate gizmo.

Scale Activates the 3D Scale gizmo.

Set Constraint Sets whether the change is constrained to a specific axis.

B X, Y or Z. Restricts the change to the designated axis.

Relocate Gizmo Moves the gizmo to the point you specify.

Align Gizmo With Sets the alignment for the change. Choices include
B World UCS (default)

B Current UCS

m Face

Custom Gizmo Allows you to define the current gizmo by specifying one,
two, or three points, or an object.

Respect Dynamic UCS When relocating the gizmo, as you move the cursor,
temporarily aligns the XY plane of the UCS with the faces or edges.
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3DSCALE

Quick Reference
In a 3D view, displays the 3D Scale gizmo to aid in resizing 3D objects.

Access Methods

N

Button

£ Ribbon: Home tab » Modify panel » 3D Scale
EE Command entry: 3dscale
Summary

With the 3D Scale gizmo, you can resize selected objects and subobjects along
an axis or plane, or resize the objects uniformly.

When the 3D Scale gizmo is displayed, the 3D Scale Gizmo shortcut menu
offers options for aligning, moving, or changing to another gizmo.

List of Prompts

The following prompts are displayed.

Select objects Specifies the objects to be scaled.

Specify base point Specifies the base point for the scaling.

Pick a scale axis or plane Specifies whether the object is scaled uniformly or
only along a specific axis or plane. You have the following choices:

B Scale uniformly. Click the area closest to the vertex of the 3D Scale gizmo.
The interior region of all axes of the gizmo is highlighted.
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B Constrain the scale to a plane. Click between the parallel lines between
the axes that define the plane.

B Constrain the scale to an axis. Click the axis.

Z

Specity scale factor Specifies the amount of change. Drag to dynamically
modify the size of the selected objects or enter a scale value. For example,
enter 2 to double the size of the selection.

Copy Creates and scales a copy of the selected objects.

Reference Sets a scale based on a ratio.

B Reference length. Sets the relative amount that represents the current size
in the scale ratio.
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B New Length. Sets the relative value used to calculate the new size. For
example, if the reference length is 1 and the new length is 3, the size of
the selected objects is tripled.

B Points. Specifies the relative value used to calculate the new size based on
two points that you specify.

3D Scale Gizmo Shortcut Menu

Quick Reference

Displays options to set the constraint of a 3D object, switch gizmos, and move
or align the gizmo.

Access Methods
Shortcut menu: Right-click the 3D Scale gizmo

List of Options

The following menu options are displayed when you right-click the 3D Scale
gizmo.

Move Activates the 3D Move gizmo.
Rotate Activates the 3D Rotate gizmo.
Scale Activates the 3D Scale gizmo.

Set Constraint Sets whether the change is constrained to a specific axis.
B X, Y or Z. Restricts the change to the designated axis.

B XY, YX, or ZX. Restricts the change to a plane that is defined by the selected
axes.
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3DSIN

B XYZ. Applies the scaling uniformly to all axes.

NOTE Unlike most other objects, mesh objects support non-uniform scale.

Relocate Gizmo Moves the gizmo to the point you specify.

Align Gizmo With Sets the alignment for the change. Choices include
B World UCS (default)

m Current UCS

B Face

Custom Gizmo Allows you to define the current gizmo by specifying one,
two, or three points, or an object.

Respect Dynamic UCS When relocating the gizmo, as you move the cursor,
temporarily aligns the XY plane of the UCS with the faces or edges.

Quick Reference
Imports an Autodesk 3ds MAX (3DS) file.

Access Methods

2

Button

£ Menu: Insert » 3D Studio
EE Command entry: 3dsin

Summary

Data that can be imported from a 3ds MAX file includes meshes, materials,
mappings, lights, and cameras. Procedural materials, smoothing groups, and
keyframe data cannot be imported. For lights and materials, use
CONVERTOLDLIGHTS and CONVERTOLDMATERIALS.
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The 3D Studio File Import dialog box (a standard file selection dialog box) is

displayed. After you choose a file to import, the 3D Studio File Import Options
dialog box is displayed.

3D Studio File Import Options Dialog Box

Quick Reference

Access Methods

2

Button

£ Menu: Insert » 3D Studio
E Command entry: 3dsin
Summary

Lists available and selected 3D obijects, saves 3D objects to layers, and handles
objects that use multiple materials.

3D Studio File Import Options ==
Available Objects Selected Objects
Object Name: Type: Object Name: Type:
Global Settings -
BUTTD1 Mesh
BUTTOZ Mesh
BUTTO32 Mesh
BUTTD4 Mesh
BUTTOS Mesh
Add Al Add Remove Remove 4
Saveto Layers: Multiple Material Objects:
@ By Object @ Always Prompt
By Material Split by Material
By Object Color Assign First Material
Single Layer Dont Assign a Material
oK Cancel Help
Available Objects

Displays the names of all objects in the specified Autodesk® 3ds MAX® (3DS)
file. You can select up to 70 objects.

Object Name and Type Displays the type and assigned name of each object.
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Add All Adds all of the objects in the Available Objects list to the Selected
Objects list.

Add Adds the objects currently selected in the Available Objects list to the
Selected Objects list.

Selected Objects

Displays the selected 3ds MAX objects to import.

Object Name and Type Displays the type and assigned name of each object.

Remove Removes objects selected in the Selected Objects list and returns them
to the Available Objects list.

Remove All Removes all objects from the Selected Objects list and returns
them to the Available Objects list.

Save to Layers
Controls how 3ds MAX obijects are assigned to layers in the drawing.

By Object Creates a layer for each object in the 3ds MAX file and places the
object on that layer. The name of the layer is the same as the name of the
object.

By Material Creates a layer for each material in the 3ds MAX file and places
objects to which that material is attached on that layer. The name of the layer
is the same as the name of the material.

By Object Color Creates a layer for each object color in the 3ds MAX file.
Each 3ds MAX object is placed on the layer corresponding to its color. The
name of the layer is COLORnn, where nn is the 3ds MAX color index. If the
3ds MAX file contains objects with no color, these objects are placed on a
layer called COLORNONE.

Single Layer Creates a single layer called AVLAYER and places all objects on
that layer.
Multiple Material Objects

3ds MAX assigns materials by face, element, or object. AutoCAD assigns
materials by object only. When AutoCAD encounters a 3ds MAX object
assigned multiple materials, AutoCAD must find a way to handle the
assignment.
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Always Prompt

Displays the Material Assignment Alert dialog box for each object with multiple
materials. The dialog box displays the name of the object. The options you
select determine how 3DSIN handles the assignment. The options are as
follows:

Split Object by Materials Splits the object into multiple objects, one for each
material. This preserves the material assignments that were made in the 3ds
MAX file. It also increases the complexity of the drawing geometry.

Assign First Material Assigns the first material assigned to each
multiple-material object to the entire object. See the 3ds MAX documentation
for an explanation of how the first-assigned material is determined.

Select a Material Assigns one of the materials that was assigned to the object
in the 3ds MAX file to the entire object. Select the material from the list below
this option, or choose NONE to revert to the AutoCAD default material.
Split by Material

Splits all objects with multiple materials into multiple objects, one for each
material. This preserves the material assignments that were made in the 3ds
MAK file. It also increases the complexity of the drawing geometry.

Assign First Material

Assigns the first material assigned to each multiple-material object to the entire
object. See the 3ds MAX documentation for an explanation of how the
first-assigned material is determined.

Don't Assign a Material

Assigns no material to each multiple-material object. This option loses all
material assignment information but preserves the 3ds MAX geometry. The
object reverts to the AutoCAD default material.

3DSOUT

Quick Reference

Obsolete
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For best results, it is recommended that you import DWG files into 3ds MAX
instead.

Access Methods

E Command entry: 3dsout

3DSWIVEL

Quick Reference
Changes the target of the view in the direction that you drag.

Access Methods
0]
=

£ Toolbar: 3D Navigation

£ Menu: View » Camera » Swivel

Pointing device: Press Ctrl and click the mouse wheel to temporarily enter
3DSWIVEL mode.

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigations Modes » Swivel (5).

EE Command entry: 3dswivel

Summary

Simulates panning with a camera in the direction that you drag. The target
of the view changes. You can swivel the view along the XY plane or along the
Z axis.

3DWALK

Quick Reference

Changes the 3D view in a drawing interactively to create the appearance of
walking through the model.
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Access Methods
"
Button

£ Toolbar: 3D Navigation

£ Menu: View » Walk and Fly » Walk

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigation Modes » Walk (6).

E Command entry: 3dwalk

Summary

3DWALK activates a walk mode in the current viewport. On the keyboard,
use the four arrow keys or the W (forward), A (left), S (back), and D (right)
keys to determine the direction of your walk. To specify the direction of the
view, you drag the mouse in the direction you want to look. For more
information, see Walk and Fly Navigation Mappings Balloon on page 73.

By default, the Position Locator window opens and displays your position in
the drawing from a top view.

To control walk and fly settings, use the Walk and Fly Settings dialog box. To
specify settings for animating a 3D walk or fly, see Animation Settings Dialog
Box on page 71.

Animation Settings Dialog Box

Quick Reference

Specifies settings for recording an animation of 3D navigation.

ﬁ Animation Settings ==l
Settings
isual style: Resolution:
As displayed 'I lEZU x 240 ']
Frame rate (FPS): Erei
30 - WMV 7
OK ] I Cancel I [ Help ]
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Settings Determines the settings for an animation file.

Visual Style

Displays a list of visual styles and render presets that you can apply to an
animation file.

Resolution
Displays a list of resolutions. The default value is 320 x 240.
Frame Rate (FPS)

Specifies a frame rate (in seconds). Values are between 1 and 60. The default
value is 30.

Format

Specifies a list of animation output formats. Available formats are AVI, MPG,
WMV, and MOV.

Position Locator Window

Quick Reference

Displays the top-view position of a 3D model when in a walk or fly navigation.
Zoom In Zooms in to the display in the Position Locator window.
Zoom Out Zooms out from the display in the Position Locator window.

Zoom Extents Zooms to the extents of the display in the Position Locator
window.

Preview Displays your current location in the model. You can drag the position
indicator to change your position. You can also drag the target indicator to
change the direction of the view.

Position Indicator Color Sets the color of the dot that shows your current
position.

Position Indicator Size Sets the size of the indicator. You can choose Small,
Medium, or Large.

Position Indicator Blink Turns the blinking effect on or off.

Position Z Specifies the Z coordinate for the position indicator. You can
modify the setting by entering a new value.
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Target Indicator Displays an indicator that shows the target of the view.
Target Indicator Color Sets the color of the target indicator.

Target Z Specifies the Z coordinate for the target position indicator. You can
modify the setting by specifying a point in the drawing area or entering a new
value.

Preview Transparency Sets the transparency of the preview window. You
can choose a value from O to 95.

Preview Visual Style Sets the visual style of the preview.

Walk and Fly Navigation Mappings Balloon

Quick Reference

The Walk and Fly Navigation Mappings balloon displays the keyboard and
mouse controls that control walk and fly modes.

Press TAB to turn the display of the balloon on and off. You can specify
whether to display the instructions, and how often, in the Walk and Fly
Settings dialog box.

The controls are as follows:

B Up arrow/W key. Moves the camera forward so that you appear to be
walking (or flying) forward.

B Down arrow/S key. Moves the camera backward.

B Left arrow/A key. Moves the camera to the left, so that you appear to be
moving to the left.

B Right arrow/D key. Moves the camera to the right.
B Drag mouse. Sets the target so that you look or turn.

B F key. Toggles between fly (3DFLY) and walk (3DWALK) modes.
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|- Navigate in Walk and Fly modes using the
“ keyboard and the mouse

Mowe through the model using the keyboard and
lock around and tumn using the mouse.

h

The following actions are available:

Tab: Show this topic

Up amow! W key: Move forward
Down amow! S key: Move backward
Left amowd A key - Move left

Right amow/ D key: Move right

Drag mouse: Look around & turn

F key-Toggle Fly mode

Don't show me this again o

3DZOOM

Quick Reference
Zooms in and out in a perspective view.

Access Methods

Q

Button

£ Toolbar: 3D Navigation

£ Menu: View » Zoom

Pointing device: Scroll the mouse wheel to zoom in and out.

Shortcut menu: Start any 3D navigation command, right-click in the drawing
area, and click Other Navigation Modes » Zoom (8).

E Command entry: 3dzoom
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In a parallel view, 3DZOOM displays the following prompt:
Press ESC or Enter to exit, or right-click to display shortcut-menu.

Zooming in a perspective view simulates moving the camera closer to the
target or farther away. Objects appear closer or farther away, but the position
of the camera does not change.

Enter option [All/Extents/Window/Previous] <real time>:
All Zooms to display the entire drawing.

Extents Zooms to display the drawing extents and results in the largest possible
display of all the objects

Window Zooms to display an area specified by two points of a rectangular
window.

Previous Zooms to display the previous view.

Real Time Using the pointing device, zooms interactively.
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ABOUT

ACISIN

Quick Reference
Displays information about AutoCAD

Access Methods

£ Menu: Help » About
EE Command entry: about (or 'about for transparent use)

Summary

Copyright information and product information is displayed. Product
information includes the version number and service pack, serial number, license
type and expiration date, and the text of the license agreement. You can save
the product information as a text file.

Quick Reference

Imports an ACIS (SAT) file and creates 3D solid, body, or region objects.
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Access Methods
ACIS

Button

£ Menu: Insert » ACIS File
E Command entry: acisin

Summary

The Select ACIS File box is displayed. Select the file to import in the File Name
list. The SAT (ASCII) ACIS file is imported into the drawing.

NOTE ACISIN imports SAT files up to ACIS version 7.0.

ACISOUT

Quick Reference
Exports a body object, solid, or region to an ACIS file.

Access Method

E Command entry: acisout
Select objects: Use an object selection method

Summary

Selected objects that are not solids or regions are ignored, and the Create ACIS
File dialog box is displayed. Enter the name of the file you want to create. The
selected objects are exported to an ASCII file.

NOTE When exchanging SAT files to earlier versions of AutoCAD, you need to set
the ACISOUTVER on page 2022 system variable to the ACIS version used for that
release. For example, to export SAT files to AutoCAD Release 14, set ACISOUTVER
to 16.
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ACTBASEPOINT

Quick Reference
Inserts a base point in an action macro.

Access Methods

&

Button

£ Ribbon: Manage tab » Action Recorder panel » Insert Base Point.
EE Command entry: actbasepoint

Summary

During the time of recording, if you enter actbasepoint at the Command
prompt, the following prompt is displayed:

Specify a base point: Specify a point

Inserts a base point in an action macro, which requests a user-defined point
when the action macro is played back. The inserted base point is represented
by a node with an icon that displays a crosshairs and a small black silhouette
of a person in the lower right corner. This icon is followed by the point
specified in an italic font. You can insert a base point by selecting an action
macro or the command node in the Action tree.

A base point establishes a point location with absolute coordinates, which is
used by the prompts that follow in the action macro.

NOTE A base point is not compatible with older releases. When you play back
the action macro in an older version, an error message is displayed and the action
macro is removed from the location of available action macros.

ACTMANAGER

Quick Reference

Manages action macro files.
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Access Methods

e

Button

£ Ribbon: Manage tab » Action Recorder panel » Manage Action Macros
E Command entry: actmanager (or 'actmanager for transparent use)

Summary
The Action Macro Manager on page 80is displayed.

Use the Action Macro Manager to copy, rename, modify, or delete action
macro files.

Action Macro Manager

Quick Reference

Access Methods

[BE
=)

Button

£ Ribbon: Manage tab » Action Recorder panel » Manage Action Macros
EE Command entry: actmanager (or 'actmanager for transparent use)

Summary

The Action Macro Manager is displayed.
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ﬂ Action Macro Manager (==
Action Macros
lpctocoos
ActMacre02
ActMacrc003 -
R:
ActMacre004
CreateBolt
Modify...
o) )

Your recorded action macro (ACTM) files are listed in the Action Macro
Manager. You can manage the files with the following options:
List of Options

The following options are available in this dialog box.

Copy

Creates a duplicate copy of an action macro.
Rename

Renames an action macro.

Modify

Displays the selected action macro in the Action Macro dialog box on page
84.

Delete

Moves the selected action macro (ACTM) file to the Windows Recycle Bin.
You can select and delete one or more action macros.

Options

Displays the Options dialog box on page 1241 (Files tab). From the Files tab, you
can locate the paths used to record and play back your (ACTM) files from the
Action Recorder Settings node.

Close

Action Macro Manager | 81



Closes the Action Macro Manager dialog box.

NOTE When a single action macro is selected, you can use Copy, Rename, Modify,
and Delete. But, when multiple action macros are selected, you can only use
Delete.

ACTRECORD

Quick Reference
Starts the Action Recorder.

Access Methods

—
O
LY

Button

£ Ribbon: Manage tab » Action Recorder panel » Record

£ Menu: Tools » Action Recorder » Record

Shortcut menu: Right-click in the drawing area and click Action Recorder
» Record.

EE Command entry: actrecord

Summary

The Action Recorder Preferences dialog box on page 83 controls the behavior
of the Action Recorder panel when playing back or recording an action macro.

You can create an action macro by recording most of the commands that you
are already familiar with.
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Action Recorder Preferences Dialog Box

Quick Reference
Access Methods

B

Button

£ Ribbon: Manage tab » Action Recorder panel » Preference

Summary

Customizes the settings used for the Action Recorder.

A Action Recorder Preferences [3a)
Action Recorder panel
Expand on playback
| Expand on recording

| Prompt for action macro name

QK |[ Cancel |[ Help

ACTSTOP

Quick Reference

Stops the Action Recorder and provides the option of saving the recorded
actions to an action macro file.

Access Methods

]

Button

£ Ribbon: Manage tab » Action Recorder panel » Stop
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£ Menu: Tools » Action Recorder » Stop

Shortcut menu: Right-click in the drawing area and click Action Recorder
» Stop.

EE Command entry: actstop (or 'actstop for transparent use)

Summary

The Action Macro dialog box on page 84 is displayed.

If you enter -actstop at the Command prompt, options are displayed on page
86.

You can use this command to stop the recording or playback of an action
macro based on the current state of the Action Recorder. When the recording
of an action macro is stopped, the recorded actions are saved to an action
macro file.

Action Macro Dialog Box

Quick Reference

Access Methods

]

Button

£ Ribbon: Manage tab » Action Recorder panel » Stop

£ Menu: Tools » Action Recorder » Stop

Shortcut menu: Right-click in the drawing area and click Action Recorder
» Stop.

EE Command entry: actstop (or 'actstop for transparent use)

Summary

Saves or renames the current action macro and defines the playback behavior
for the action macro.
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ﬂ Action Macro @

Action Macro Command Name:

ActMacre003

File Name:

ActMacre005.actm

Folder Path:
Ch\Users\admin\appdata\roaming\autodeskiautocad 20100 18.0\enu\s:

Description:

Restore pre-playback view
When pausing for user input
[C] Once playback finishes

Check for inconsistencies when playback begins

» CK ][ Cancel |[ Help

List of Options
The following options are available in this dialog box.

Action Macro Command Name
Specifies the command name for the current action macro.

File Name
Displays the file name for the current action macro.

Folder Path
Displays the location where the current action macro file is stored or will be
saved to.

Description
Specifies a description for the current action macro. The description is displayed
in a tooltip when the cursor hovers over the top node of the action macro in
the Action tree.

Restore Pre-Playback View
Defines how the view, prior to the playback of an action macro, is restored.
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When Pausing for User Input Restores the view prior to the playback of an
action macro when a request for user input occurs.

Once Playback Finishes Restores the view prior to the playback of an action
macro when playback is complete.

Check for Inconsistencies When Playback Begins
Specifies if the action macro should be scanned for inconsistencies between
the current drawing state and the drawing state when the macro was recorded.

More Options
Controls the display of additional options in the Action Macro dialog box.

B Restore Pre-Playback View

B Check for Inconsistencies When Playback Begins

-ACTSTOP

Quick Reference

Stops the Action Recorder and provides the option of saving the recorded
actions to an action macro file

Access methods

EE Command entry: -actstop (or '-actstop for transparent use)

List of Prompts

If you enter -actstop at the Command prompt, the following prompts are
displayed:

Enter action macro name <ActMacro001>: Press ENTER, or enter a name for the
action macro

Enter an option [“Description”/“Settings” /Exit] <Exit>: Enter an option and press
ENTER

Description

Specifies a description for the current action macro.

Settings
Defines the behavior of the action macro during playback.

B Restores the original view before a request for input.
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B Restores the view prior to the playback of an action macro when a request
for user input occurs.

B Restores the original view after playback is complete.

B Restores the view prior to the playback of an action macro when playback
is complete.

B Prompts during playback if inconsistencies are found.
Specifies if the action macro should be scanned for inconsistencies between
the current drawing state and the drawing state when the macro was
recorded.

Exit
Stops and saves the action macro recording with the specified name.

ACTUSERINPUT

Quick Reference
Pauses for user input in an action macro.

Access Methods

o
2

Button

£ Ribbon: Manage tab » Action Recorder panel » Pause for User Input.
E Command entry: actuserinput (or 'actuserinput for transparent use)

Summary

The next recorded action is set to pause for user input when the action macro
is played back. When a pause for user input is added to an action, the icon
for the action in the Action tree displays a small black silhouette of a person
in the lower-right corner and the text assigned to the action node is displayed
in italic font.

You can insert a pause for user input by selecting the value node in the Action
tree that you want to pause and provide input for during playback.
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ACTUSERMESSAGE

Quick Reference
Inserts a user message into an action macro.

Access Methods

=

Button

£ Ribbon: Manage tab » Action Recorder panel » Insert Message.

EE Command entry: actusermessage (or 'actusermessage for transparent
use)

Summary

The Insert User Message dialog box on page 88 is displayed.

If you enter -actusermessage at the Command prompt, options are displayed
on page 89.

You can insert a message into an action macro by selecting an action in the
Action tree, and then entering the text that you want displayed during
playback.

Insert User Message Dialog Box

Quick Reference

Access Methods

Sl

Button

£ Ribbon: Manage tab » Action Recorder panel » Insert Message.
E Command entry: actusermessage (or 'actusermessage for transparent
use)
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Summary

Inserts a user message that is displayed when the action macro is played back.

A0 Insert User Message (=)

Cancel | [ Help

-ACTUSERMESSAGE

Quick Reference
Inserts a user message into an action macro

Access Methods

E2 Command entry: -actusermessage (or '-actusermessage for transparent
use)

Summary
Inserts a user message that is displayed when the action macro is played back.

Click Close to continue playback.

List of Prompts

Enter a message to display during playback <exit>: Enter a message and press
ENTER, or press ENTER to exit the command

NOTE You can enter a maximum of 256 characters for the user message.
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ADCCLOSE

Quick Reference

Closes DesignCenter.
EE Command entry: adcclose

Closes the DesignCenter™ window.

ADCENTER

Quick Reference
Manages and inserts content such as blocks, xrefs, and hatch patterns.

Access Methods

[=]]
od
=

Bution

£ Ribbon: Insert tab » Content panel » DesignCenter
£ Toolbar: Standard

£ Menu: Tools » Palettes » DesignCenter

EE Command entry: adcenter

Summary

The DesignCenter is displayed.

NOTE The DesignCenter Online (DC Online tab) is disabled by default. You can
enable it from the CAD Manager Control utility.
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DesignCenter Window

Quick Reference

Access Methods

[o]=]
oo
=

Bution

£ Ribbon: Insert tab » Content panel » DesignCenter
£ Toolbar: Standard

£ Menu: Tools » Palettes » DesignCenter

E Command entry: adcenter

Summary

Browses, finds, and previews content, and inserts content, which includes
blocks, hatches, and external references (xrefs).

Use the buttons in the toolbar at the top of DesignCenter for display and
access options.

When you click the Folders tab or the Open Drawings tab, the following two
panes are displayed from which you can manage drawing content:

m Content area (right pane) on page 92

B Tree view (left pane) on page 95

NOTE The DesignCenter Online (DC Online tab) is disabled by default. You
can enable it from the CAD Manager Control utility.
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Content Area (DesignCenter)

Displays the content of the "container" currently selected in the tree view. A
container is a network, computer, disk, folder, file, or web address (URL)
containing information accessible by DesignCenter. Depending on the
container selected in tree view, the content area typically displays the
following:

Folders containing drawings or other files
Drawings

Named objects contained in drawings (named objects include blocks, xrefs,
layouts, layers, dimension styles, table styles, multileader styles, and text
styles)

Images or icons representing blocks or hatch patterns
Web-based content

Custom content developed by third-party applications

From the content area, you can insert blocks or hatch patterns or attach
external references in a drawing by dragging, by double-clicking, or by
right-clicking and choosing Insert Block, Attach Xref, or Copy. You can drag

or right-click to add other content to drawings, such as layers, dimension
styles, and layouts. You can drag blocks and hatches from DesignCenter to
tool palettes.
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NOTE You can access relevant content area and tree view options on a shortcut
menu by right-clicking in the tree view or the content area.

Load
Displays the Load dialog box (a standard file selection dialog box). Use Load

to navigate to files on local and network drives or on the Web, and then to
select content to load in the content area.

Back

Returns to the most recent location in the history list.

Forward

Returns to the next later location in the history list.

Up

Displays the contents of the container one level above the current container.

Stop (DC Online tab)

Stops the current transfer.

Reload (DC Online tab)

Reloads the current page.

£ o
<
Search =

Displays the Search dialog box, where you can specify search criteria to locate
drawings, blocks, and nongraphical objects within drawings.

Search also displays custom content saved on your desktop.

Favorites

Displays the contents of the Favorites folder in the content area. The Favorites
folder contains shortcuts to items you access often. You can add items to
Favorites either by right-clicking the content area or right-clicking an item in
the tree view, and then clicking Add to Favorites. To delete an item from
Favorites, use the Organize Favorites option on the shortcut menu and then
use the Refresh option on the shortcut menu.
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NOTE The DesignCenter folder is automatically added to Favorites. This folder
contains drawings with discipline-specific blocks that you can insert in drawings.

Home

Returns DesignCenter to your home folder. On installation, the home folder
is set to ...\Sample\DesignCenter. Change the home folder using the shortcut
menu in the tree view.

Tree View Toggle

Displays and hides the tree view. Hide the tree view if you need more space
in your drawing area. When the tree view is hidden, you can use the content
area to navigate to containers and to load content.

The Tree View Toggle button is not available while you're using the History
list in the tree view.
Preview

Displays and hides a preview of the selected item in a pane below the content
area. If there is no preview image saved with the selected item, the Preview
area is empty.

Description

Displays and hides a text description of the selected item in a pane below the
content area. If a preview image is also displayed, the description is displayed
below it. If there is no description saved with the selected item, the Description
area is empty.

Views

Provides different display formats for the content that is loaded in the content
area. You can select a view from the Views list or click the Views button
repeatedly to cycle through the display formats. The default view varies for
the type of content currently loaded in the content area.

Large Icon Displays the names of the loaded content in large icon format.
Small Icon Displays the names of the loaded content in small icon format.
List View Displays the names of the loaded content in a list.

Detail View Displays additional information about the loaded content. You
can sort the items by name, size, type, and other properties, depending on
the type of content that is loaded in the content area.
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Refresh (Shortcut Menu Only)

Refreshes the display in the content area to reflect any changes you have
made. Right-click the content area background and click Refresh on the
shortcut menu.

Autodesk Seek Design Content

Opens a web browser and displays the Autodesk Seek (SEEK on page 1630) home
page. Product design information available on Autodesk Seek depends on
what content providers, both corporate partners and individual contributors,
publish to Autodesk Seek (SHAREWITHSEEK on page 1641). Such content could
include 3D models, 2D drawings, specifications, brochures, or descriptions of
products or components.

Tree View (DesignCenter)

Displays the hierarchy of files and folders on your computer and network
drives, a list of open drawings, custom content, and a history of the last
locations you accessed. Select an item in the tree view to display its contents
in the content area.

NOTE In the sample\designcenterfolder are drawings containing discipline-specific
blocks that you can insert in drawings. These drawings are called symbol library
drawings.

Use the buttons in the toolbar at the top of DesignCenter to access tree view
options.

Folders Displays the hierarchy of files and folders on your computer and
network drives, including My Computer and Network Neighborhood.

You can use ADCNAVIGATE to navigate to a specific file name, directory
location, or network path in the DesignCenter tree view. See ADCNAVIGATE
on page 99.

Open Drawings Displays all drawings open in the current work session,
including drawings that are minimized.

History Displays a list of the files that you opened most recently in
DesignCenter. With the history displayed, right-click a file to display
information about the file or to delete the file from the History list.

DC Online Accesses the DesignCenter Online web page. When you establish
a web connection, two panes are viewed on the Welcome page. The left side
displays folders containing symbol libraries, manufacturer sites, and additional
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content libraries. When a symbol is selected, it is displayed on the right side
and can be downloaded into your drawing.

Search Dialog Box

Quick Reference

Access Methods

[]]
od
=

Bution

£ Ribbon: Insert tab » Content panel » DesignCenter
£ Toolbar: Standard

£ Menu: Tools » Palettes » DesignCenter

E Command entry: adcenter

Searches for content such as drawings, hatch patterns, and blocks.

ﬂ Search: 'Drawings' named 'Taisei Detail Plan.dwg’ ==
Look for [meings v] In (C) -
Search subfolders
Drawings | Date Modfied | Advancad
Search Mow

Search forthe word(s) Taisei Detail Plan.dwg - o

In the fieldie) [File Name - ~
Mame In File Size Type File Modfied

CA\Program Filesh... BIKE AutoCAD Drawing  12/13/2008 3.25 ...

1 item (s} found

Look For

Specifies the type of content to search for. The content type you specify
determines which tabs are displayed in the Search dialog box and the search
fields it provides. The Date Modified and Advanced tabs are displayed only
when the Drawings option is selected in Look For.

96 | Chapter 2 A Commands



In

Specifies a search path name. To enter multiple paths, separate them with
semicolons. Use Browse to select a path from a tree view list.

Browse

Displays a tree view in the Browse for Folder dialog box, in which you can
specify the drives and folders to search.

Search Subfolders

Includes subfolders in the search path.
Search Now

Starts the search based on criteria you specify.
Stop

Stops the search and displays the accumulated results in the Search Results
panel.

New Search

Clears the Search For the Word(s) box and places the cursor in the box.
Search Results Panel

Displays the results of the search in resizable columns at the bottom of the
window. Double-click an item to load it into DesignCenter.

Search Tabs (Search Dialog Box)

Display search fields relevant to the type of content specified in the Look For
list. The name of the tab reflects the content type. You can use wild-card
characters to extend or limit your search patterns.

Search for the Word(s)

Specifies the text string to look for in the field you specify. Use the asterisk
and question mark wild-card characters to broaden your search.

W * (Asterisk): Matches any string and can be used anywhere in the search
string.

B 7 (Question mark): Matches any single character; for example, ?BC matches
ABC, 3BC, and so on.

This option is available on the Drawings tab and, when available, the Custom
Content tab.
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In the Field(s)

Specifies the property fields to search. For drawings, all fields other than File
Name are derived from the information entered in the Drawing Properties
dialog box (DWGPROPS on page 672).

This option is available on the Drawings tab and the Custom Content tab.

NOTE Custom content developed by third-party applications may not provide
fields for searches using the Search dialog box.

Search for the Name

Specifies the name of the drawing, block, layer, xref, or other content type
that you want to find.

This option is available on all tabs except Drawings and Custom Content.

Date Modified Tab (Search Dialog Box)
Finds content that was created or modified during a certain time period.

All Files Finds all the files that match the criteria you specify on other tabs,
regardless of creation date or date modified. This is the default setting.

Find All Files Created or Modified Finds files created or modified during a
specific time period. The search locates files that match the criteria you specify
on this and other tabs.

Between

Searches for files created or modified between the dates you specify.

During the Previous Month(s)

Searches for files created or modified within the number of months you specify.
During the Previous Day(s)

Searches for files created or modified within the number of days you specify.

Advanced Tab (Search Dialog Box)

Finds content within drawings; this tab is available only when you select
Drawings in Look For.

Containing

Specifies the type of text in a drawing that you want to search for. For example,
you can search for text contained within a block attribute, such as a
manufacturer's catalog number.
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Containing Text
Specifies the text you want to search for.
Size Is

Specifies a minimum or maximum file size. Select At Least or At Most, and
enter a value in KB.

ADCNAVIGATE

Quick Reference

Loads a specified DesignCenter drawing file, folder, or network path.

EE Command entry: adcnavigate
Enter pathname <current>:

The path or drawing file name you specify is loaded in the tree view of the
DesignCenter Folders tab.

At the prompt, you can enter a path in any of the following formats:
W Folder path: c:\project files\electrical
B Folder path and a file name: c:\project files\electrical\circuit2.dwg

B UNC (universal naming convention) network path: \\server!\campus_project

DesignCenter is displayed, with the Folder tab active, and the path or drawing
file that you specified is loaded.

ADCNAVIGATE supports remote domains or workgroups if you have the target
domain or workgroup mapped to a drive letter.

ADJUST

Quick Reference

Adjusts the fade, contrast and monochrome settings of the selected image or
underlay (DWF, DWFx, PDE, or DGN).
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Access Methods

Pa

Button

£ Ribbon: Insert tab » Reference panel » Adjust.
E Command entry: adjust

Summary

With the ADJUST command, you can control several display settings for
selected images and underlays (DWF, DWFx, PDF, and DGN underlays). To
confirm the settings, use the Properties palette.

List of Prompts

The list of prompts depends on whether you select one or more images, or
one or more underlays.

Images

Fade Controls the fade effect in the image. Values range from 0 through 100.
The greater the value, the lighter that the image appears. This setting works
indirectly with the contrast effect; a higher contrast value blends the image
into the background when fade is set to a higher value.

Contrast Controls the contrast, and indirectly the fading effect in the image.
Values range from O through 100. The greater the value, the stronger the
contrast.

Brightness Controls the brightness, and indirectly, the contrast in the image.
Values range from O through 100. The greater the value, the brighter the image
and the more pixels that become white when you increase contrast.

Underlays

Fade Controls the fade effect in the underlay. Values range from 0 through
100. The greater the value, the lighter that the linework in the underlay
appears. This setting works indirectly with the contrast effect; a higher contrast
value blends the underlay into the background when fade is set to a higher
value.

Contrast Controls the contrast, and indirectly the fading effect in the underlay.
Values range from 0 through 100. The greater the value, the stronger the
contrast.
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ALIGN

Monochrome Controls the color saturation of all areas while maintaining
the luminance. When turned on, the underlay appears in shades of gray
starting at black if the background color luminance is 50 percent or more. If
the background color luminance is less than 50 percent, then the colors are
inverted, with the darkest areas displaying as white, and the lightest areas
displaying as black.

Quick Reference

Aligns objects with other objects in 2D and 3D

£ Menu: Modify » 3D Operations » Align

E2 Command entry: align

Select objects: Select the objects to align and press ENTER

ALIGN Using One Pair of Points Specify first source point: Specify a point (1)

Specify first destination point: Specify a point (2)
Specify second source point: Press ENTER

When you select only one source point and destination point pair, the selected
objects move in 2D or 3D from the source point (1) to the destination point

(2).

1 /:2
z_u/

iwo points specified

ALIGN Using Two Pairs of Points Specify first source point: Specify a point
(1)

Specify first destination point: Specify a point (2)

Specify second source point: Specify a point (3)

Specify second destination point: Specify a point (4)

Specify third source point: Press ENTER

Scale objects based on alignment points [Yes/No] <No>: Entery or press ENTER
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objects selected four points specified result

When you select two point pairs, you can move, rotate, and scale the selected
objects in 2D or 3D to align with other objects.

The first set of source and destination points defines the base point for the
alignment (1, 2). The second set of points defines the angle of rotation (3, 4).

After you enter the second set of points, you are prompted to scale the object.
The distance between the first and second destination points (2, 4) is used as
the reference length to which the object is scaled. Scaling is available only
when you are aligning objects using two point pairs.

NOTE If you use two source and destination points to perform a 3D alignment
on nonperpendicular working planes, you get unpredictable results.

ALIGN Using Three Pairs of Points Specify first source point: Specify a point
)

Specify first destination point: Specify a point (2)

Specify second source point: Specify a point (3)

Specify second destination point: Specify a point (4)

Specify third source point: Specify a point (5)

Specify third destination point: Specify a point (6)

objects selected six points specified result
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When you select three point pairs, you can move and rotate the selected
objects in 3D to align with other objects.

The selected objects move from the source point (1) to the destination point
2).

The selected object is rotated (1 and 3) so that it aligns with the destination
object (2 and 4).

The selected object is then rotated again (3 and 5) so that it aligns with the
destination object (4 and 6).

AMECONVERT

Quick Reference

Converts AME solid models to AutoCAD solid objects.

EE Command entry: ameconvert
Select objects: Use an object selection method

The objects you select must be Advanced Modeling Extension (AME) Release
2 or 2.1 regions or solids. All other objects are ignored.

Because of increased accuracy in the new solid modeler, AME models may
look slightly different after conversion. This difference is noticeable where
the previous version of the solid modeler identified the surfaces of two different
shapes as so close as to be considered in the same plane. The new solid
modeler's finer tolerance may interpret these surfaces as being slightly offset.
This phenomenon is most apparent with aligned features such as fillets,
chamfers, and through-holes.

Holes might become blind holes when the new modeler, with its much finer
approximation capability, interprets what was once a through-hole as being
slightly less wide than the solid. Typically, the length of the remaining solid
material is the difference between the tolerance of the previous modeler and
that of the new modeler.
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Likewise, updated fillets or chamfers can occasionally be placed slightly below
the surface, creating a hole through the solid, leaving the original shape
unaltered. Also, drawing fillets or chamfers slightly above the original surface
creates an uneven transition between the solid and the fillet or chamfer.

ANIPATH

Quick Reference

Saves an animation file of a camera moving or panning in a 3D model.
Access Methods

£ Ribbon: Tools tab » Animations panel » Animation Motion Path.

£ Menu: View » Motion Path Animations
EE Command entry: anipath

Summary

The Motion Path Animation dialog box on page 104 is displayed.

Motion Path Animation Dialog Box

Quick Reference

Access Methods

LI

£ Ribbon: Tools tab » Animations panel » Animation Motion Path.
£ Menu: View » Motion Path Animations
E Command entry: anipath

Summary

Specifies settings for a motion path animation and creates an animation file.
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A path object must be created first and then selected as the camera path or
the target path. A path object can be a line, arc, elliptical arc, circle, polyline,
3D polyline, or spline.

ﬂ Motion Path Animation @
Camera Animation settings
Link camera to: Frame rate (FPS): 30 s
Eat Number of frames: 30 <
'] Duration (seconds): 1 <
Target Visual style:
[Hs displayed V]
Link target to:
Format: Resolution:
Point G
¢ @ Path [y -] [s0x200 -]
[None v] Corner deceleration [ Reverse

When previewing show camera preview

Preview... oK Cancel ] ’ Help

Camera

Link Camera To Links a camera to a static point or a motion path in a
drawing.

Point

Links a camera to a static point in a drawing.
Path

Links a camera to a motion path in the drawing.
Pick Point/Select Path

Selects either the point where a camera is located or the path along which a
camera travels, depending on whether Point or Path was selected.

Point/Path List

Displays a list of named points or paths to which you can link a camera. To
create a path, you can link a camera to a line, arc, elliptical arc, circle, polyline,
3D polyline, or spline.
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NOTE When you create a motion path, a camera is automatically created. If you
delete an object that you specified as a motion path, the named motion path is
also deleted.

Target
Link Target To Links a target to a point or a path.

If the camera is linked to a point, the target must be linked to a path. If the
camera is linked to a path, you can link the target to either a point or a path.

Point

If the camera is linked to a path, links the target to a static point in the
drawing.

Path
Links the target to a motion path in the drawing.
Pick Point/Select Path

Selects either the point or a path for the target, depending on whether Point
or Path was selected.

Point/Path List

Displays a list of named points or paths to which you can link the target. To
create a path, you can link a target to a line, arc, elliptical arc, circle, polyline,
3D polyline, or spline.

Animation Settings

Controls the output of the animation file.

Frame Rate (FPS)

The speed at which the animation will run, measured in frames per second.
Specify a value from 1 to 60. The default value is 30.

Number of Frames
Specifies the total number of frames in the animation.

With the frame rate, this value determines the length of the animation. When
you change this number, the Duration value is automatically recalculated.

Duration (seconds)

Specifies the duration (in sections) of the animation.
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When you change this number, the Number of Frames value is automatically
recalculated.

Visual Style

Displays a list of visual styles and render presets that you can apply to an
animation file. See VISUALSTYLES on page 1928 and RENDERPRESETS on page
1552 for more information.

Format
Specifies the file format for the animation.

You can save an animation to an AVI, MOV, MPG, or WMV file format for
future playback. The MOV format is available only if Apple QuickTime Player
is installed. The WMV format is available and is the default selection only if
Microsoft Windows Media Player 9 or later is installed. Otherwise, AVI is the
default selection.

Resolution

Defines the width and height of the resulting animation in screen display
units. The default value is 320 x 240.

Corner Deceleration

Moves a camera at a slower rate as it turns a corner.
Reverse

Reverses the direction of an animation.

When Previewing Show Camera Preview

Enables the display of the Animation Preview dialog box so you can preview
the animation before you save it.

Preview

Displays the movement of the camera for the animation in the viewport. If
“When Previewing Show Camera Preview” is checked, the Animation Preview
dialog box on page 108 also displays a preview of the animation.
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Animation Preview Dialog Box

Quick Reference

Access Methods

LI

£ Ribbon: Tools tab » Animations panel » Animation Motion Path.
¥ Menu: View » Motion Path Animations
EE Command entry: anipath

Summary

Previews a motion path animation that you created with a motion path or
3D navigation.

At Animation Preview (==

> Current - |

Preview Displays a preview of the animation you set up either in the Motion
Path Animation dialog box or when walking or flying through an animation
and recording it from the ribbon.

Play Plays the animation preview. The Play button is disabled when an
animation is already playing.

Record Records the animation, starting from the current frame displayed in
the Preview region. All frames following the current frame are overwritten.
The Overwrite Confirmation warning is displayed to confirm that you intend
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to overwrite the existing frames. The Record button is disabled when an
animation is playing.

Pause Pauses the animation at the current frame displayed in the Preview
region. After pausing an animation, the Pause button is disabled.

Save Opens the Save As dialog box. You can save an animation to an AVI,
MOV, MPG, or WMV file format for future playback. Once you save the
animation, you are returned to the drawing. The Save button is disabled when
an animation is playing.

Visual Style Specifies the visual style displayed in the Preview region. The
visual style is initially set to Current, which is the visual style defined in the
active viewport. Choose from a list of preset and user-defined visual styles.

Slider Moves frame-by-frame through the animation preview. You can move
the slider to a specific frame in the animation. A tooltip displays the current
frame and total number of frames in the animation.

ANNOUPDATE

Quick Reference

Updates existing annotative objects to match the current properties of their
styles.

E Command entry: annoupdate

When a non-annotative text object is updated to an annotative text style, the
object becomes annotative and supports the current annotation scale. If the
text style has a fixed Paper Height, the object is set to that height. If the text
style’s Paper Height is set to 0, the size of the text does not change. The Paper
Height value is inferred by dividing the model height by the current annotation
scale.

If an annotative object is updated to a non-annotative style, the object becomes
non-annotative and any alternate scale representationsare removed.

Select objects: Use an object selection method
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ANNORESET

Quick Reference

Resets the locations of all alternate scale representations of the selected
annotative objects.

Access Methods

Button

£ Ribbon: Annotate tab » Annotation Scaling panel » Sync Scale Positions
£ Menu: Modify » Annotative Object Scale » Synchronize Multiple-Scale

Positions
E Command entry: annoreset

Summary

The location of each scale representation of an annotative object can be
adjusted using grips. For each selected annotative object, all alternate scale
representations are returned to the location of the object’s current scale
representation.

List of Prompts
The following prompts are displayed.

Select objects: Use an object selection method

APERTURE

Quick Reference
Controls the size of the object snap target box.

Access Methods

E Command entry: aperture (or 'aperture for transparent use)
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Object snap target height (1-50 pixels) <current>: Enter a value (1-50) or press
ENTER

Object snap applies only to objects inside or crossing the object snap target
box. The APBOX on page 2028 system variable controls whether the object snap
target box is displayed. The number of pixels you enter using APERTURE
controls the size of the object snap box. The higher the number, the larger
the target box. You can also change this setting in the Options dialog box,
Drafting tab.

Yo —
) )
\ \ i target box

) target box

APERTURE controls the object snap target box, not the pickbox displayed at
the Select Objects prompt. The object selection pickbox is controlled by the
PICKBOX on page 2248 system variable.

APPLOAD

Quick Reference

Loads and unloads applications and defines which applications to load at
startup.

Access Methods

&

Button

£ Ribbon: Manage tab » Applications panel » Load Application.
£ Menu: Tools » Load Application

EE Command entry: appload

Summary

The Startup Suite option loads the specified applications each time the product
first starts. Application files can be dragged from the files list, or from any
application with dragging capabilities.

The Load/Unload Applications dialog box is displayed.
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Load/Unload Applications Dialog Box

Quick Reference

£ Menu: Tools » Load Application
E Command entry: appload

Loads and unloads applications and specifies applications to be loaded at
startup.

At Load/Unload Applications ==

Lookin: || AutoCAD 2010 ~- @ F e

Name Date modified Type Size
J AdlmRes
J CER
) Drv
. en-US
| Express
J Fonts

. Help -

File name: | - Load

Files of type: [MoCJ\D Apps ("ang” lsp;” dvb; ™ dbo” vhbe™ v]

Loaded Applications | History list [] Add to History
File: Path i Unload

d gram filesautoc 010%sup..
acapp.ax C:\Program Files®\AutoCAD 20100 il

| [ Close ] [ Help ]

The options at the top of this dialog box are derived from the standard file
selection dialog box. Following are descriptions of the additional options
provided by the Load/Unload Applications dialog box:

Load Loads or reloads the applications that are currently selected either in
the files list or on the History List tab. Load is unavailable until you select a
file that you can load. ObjectARX, VBA, and DBX applications are loaded
immediately, but LSP, VLX, and FAS applications are queued and then loaded
when you close the Load/Unload Applications dialog box.
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If you select a file that is already loaded, Load reloads the application when
applicable. You cannot reload ObjectARX applications. In this case, you must
first unload the ObjectARX application and then load it again. The Load option
is also available from a shortcut menu by right-clicking a file on the History
List tab.

Loaded Applications

Displays an alphabetical list (by file name) of currently loaded applications.
LISP routines are displayed in this list only if you loaded them in the
Load/Unload Applications dialog box. You can drag files into this list from
the files list or from any application with dragging capabilities, such as
Microsoft® Windows® Explorer.

If you use the AutoCAD web browser to load an application, the web browser
downloads the application to a temporary location on your machine. This is
the location from which AutoCAD loads the application, as displayed in this
list.

You can also unload certain applications from this list. See the Unload option
for details. Files that you cannot unload are not available for selection.

History List

Displays an alphabetical list (by file name) of applications that you previously
loaded with Add To History selected. You can drag files into this list from the
files list, or from any application with dragging capabilities, such as Windows
Explorer. If Add To History is not selected when you drag files into this list,
the dragged files are loaded but not added to the history list.

You can load and remove applications from this list, but to unload applications,
you must use the Loaded Applications tab. See the Load, Unload, and Remove
options.

Add to History
Adds any applications that you load to the history list.

You may prefer to clear this option when loading applications with the
AutoCAD web browser, because these applications are unavailable once the
cache for the application's temporary location is emptied.

Unload/Remove

Unloads the selected applications or removes them from the History List.
Unload is available only when a file is selected on the Loaded Applications
tab. Remove is available only when you select a file on the History List tab.
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LISP applications cannot be unloaded, nor can ObjectARX applications that
are not registered for unloading.

Note that Remove does not unload the selected application. The Remove
option is also available from a shortcut menu by right-clicking an application
on the History List tab.

Startup Suite

Contains a list of applications that are loaded each time you start AutoCAD.
You can drag application files from the files list, or from any application with
dragging capabilities such as Windows Explorer, into the Startup Suite area
to add them to the Startup Suite.

You cannot add applications that you load with the AutoCAD web browser
to the Startup Suite.

Contents

Displays the Startup Suite dialog box. You can also add files to the Startup
Suite by clicking the Startup Suite icon or by right-clicking an application on
the History List tab and clicking Add to Startup Suite on the shortcut menu.

Status Line

Displays messages that indicate the status of loading and unloading operations.

Startup Suite Dialog Box

Quick Reference

£ Menu: Tools » Load Application
EE Command entry: appload

Adds and removes application files from the Startup Suite. These are the
applications that are loaded each time you start AutoCAD.
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ARC

P Startup Suite =
List of applications:
File Path
AcApp an CAProgram Filesh\AutoCAD 2010%

List of Applications

Displays an alphabetical list (by file name) of the application files to load at
startup.

Add

Displays the Add File to Startup Suite dialog box. You can use this dialog box
to select files to add to the startup suite.

Remove

Removes selected files from the Startup Suite.

Quick Reference
Creates an arc.

Access Methods

[

Button

£ Ribbon: Home tab » Draw panel » 3-Point.
£ Menu: Draw » Arc

£ Toolbar: Draw f/‘

E Command entry: arc
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Specify start point of arc or [Center]: Specify a point, enter c, or press ENTER to
start tangent to last line, arc, or polyline

To create an arc, you can specify combinations of center, endpoint, start point,
radius, angle, chord length, and direction values.
Start Point

Specifies the starting point of the arc.

NOTE If you press ENTER without specifying a point, the endpoint of the last
drawn line or arc is used and you are immediately prompted to specify the endpoint
of the new arc. This creates an arc tangent to the last drawn line, arc, or polyline.

Specify second point of arc or [Center/End]:

Second Point

Draws an arc using three specified points on the arc's circumference. The first
point is the start point (1). The third point is the endpoint (3). The second
point (2) is a point on the circumference of the arc.

Specify end point of arc: Specify a point (3)

You can specify a three-point arc either clockwise or counterclockwise.

Center
Specifies the center of the circle of which the arc is a part.

Specify center point of arc:

Specify end point of arc or [Angle/chord Length]:

End Point Using the center point (2), draws an arc counterclockwise from
the start point (1) to an endpoint that falls on an imaginary ray drawn from
the center point through the third point (3).

N
IR
2

The arc does not necessarily pass through this third point, as shown in the
illustration.
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Angle Draws an arc counterclockwise from the start point (1) using a center
point (2) with a specified included angle. If the angle is negative, a clockwise
arc is drawn.

Specify included angle: Specify an angle

included
angle —

=\
2 1=

Chord Length Draws either a minor or a major arc based on the distance of
a straight line between the start point and endpoint.

If the chord length is positive, the minor arc is drawn counterclockwise from
the start point. If the chord length is negative, the major arc is drawn
counterclockwise.

Specify length of chord: Specify a length

P

2 B

1
length of chord

End

Specifies the endpoint of the arc.

Specify end point of arc:

Specify center point of arc or [Angle/Direction/Radius]:

Center Point Draws an arc counterclockwise from the start point (1) to an
endpoint that falls on an imaginary ray drawn from the center point (3)
through the second point specified (2).

imaginary ray“ 2 \
." Y

5 -

Angle Draws an arc counterclockwise from the start point (1) to an endpoint
(2), with a specified included angle. If the angle is negative, a clockwise arc is
drawn.

Specify included angle: Enter an angle in degrees or specify an angle by moving the
pointing device counterclockwise

ARC | 117



angle j
2 H“-‘\

Direction Begins the arc tangent to a specified direction. It creates any arc,
major or minot, clockwise or counterclockwise, beginning with the start point
(1), and ending at an endpoint (2). The direction is determined from the start
point.

Specify tangent direction for the start point of arc:

direction

Radius Draws the minor arc counterclockwise from the start point (1) to the
endpoint (2). If the radius is negative, the major arc is drawn.

Specify radius of arc:

B

radius

Center
Specifies the center of the circle of which the arc is a part.

Specify center point of arc:

Specify start point of arc:

Specify end point of arc or [Angle/chord Length]:

End Point Draws an arc counterclockwise from the start point (2) to an
endpoint that falls on an imaginary ray drawn from the center point (1)
through a specified point (3).

T N

" q

Angle Draws an arc counterclockwise from the start point (2) using a center
point (1) with a specified included angle. If the angle is negative, a clockwise
arc is drawn.

Specify included angle:
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Chord Length Draws either a minor or a major arc based on the distance of
a straight line between the start point and endpoint.

If the chord length is positive, the minor arc is drawn counterclockwise from
the start point. If the chord length is negative, the major arc is drawn
counterclockwise.

Specify length of chord:

.

2 3

11
length of chord

Tangent to Last Line, Arc, or Polyline

Draws an arc tangent to the last line, arc, or polyline drawn when you press
ENTER at the first prompt.

e _ﬁ_\.

Specify end point of arc: Specify a point (1)

ARCHIVE

Quick Reference
Packages the current sheet set files for archive.

Access Methods
o9

Button
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£ Menu: Application menu » Publish » Archive
E Command entry: archive

Summary

The Archive a Sheet Set dialog box is displayed.

If you enter -archive at the Command prompt, options are displayed.

Archive a Sheet Set Dialog Box

Quick Reference

Packages the current sheet set files for archive.
Access Methods

0

Button

£ Menu: Application menu » Publish » Archive
EE Command entry: archive

Summary

The Sheets tab lists the sheets to be included in the archive package in sheet
order and according to subset organization. The Files Tree tab lists the files to
be included in the package in a hierarchical tree format. The Files Table tab
displays the files to be included in the package in a table format.

All files to be included in the archive package are indicated by a check mark
next to the file name. To remove a file from the archive package, select the
check box. Right-click in the file display area to display a shortcut menu, from
which you can clear all check marks or apply check marks to all files.

NOTE Make sure that the files to be archived are not currently open in any
application.
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Sheets Tab

Lists the sheets to be included in the archive package in sheet order and
according to subset organization. A sheet set must be open in the Sheet Set
Manager. Archive can be selected from the shortcut menu displayed when
the top-level sheet set node is right-clicked, or archive can be entered at the

Command prompt.

A Archive a Sheet Set

i
55 Curent shest set: IRD Addtion

Sheets | Files Treel Files Table

==

= 5 IRD Addition
[¥ T-01 TITLE SHEET
EE) Achitectural

[¥] AS-01 ARCH SITE PLAN
[# A-01 MAIN AND SECOND FLOOR PLAN
[Vl A-02 ELEVATIONS
v/ A-03 DOORS WINDOWS AND ROOMS
[¥ A-04 REFLECTED CEILING PLANS
[¥] A-05 SECTIONS AND DETAILS

< 1

m

Enter notes to include with this archive:

]
:

[ View Report ] [ Modify Archive Setup... ] [

)

Files Tree Tab

Lists the files to be included in the archive package in a hierarchical tree
format. By default, all files associated with the current drawing (such as related
xrefs, plot styles, and fonts) are listed. You can add files to the archive package
or remove existing files. Related files that are referenced by URLs are not

included in the archive package.

Included

Reports the number of files included in the package and the size of the package.
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A Archive a Sheet Set

ey
552 Cument shest set: IRD Addition

Sheets| Files Tree | Files Table

[

>

£ S Sheet Drawings
B ¥ T-01.dwg
[, ¥ AS-01.dwg
B W AD1.dwg
B v A2dwg o
B ¥ A03.dwg
B ¥ A04.dwg
&, ¥ A-05.dwg

wlE 2 oentdu.

Included 27 file(s). 4659KB Add File

Enter notes to include with this archive:

g

[ View Report ] l Modify Archive Setup ] [ Help

Files Table Tab

Displays the files to be included in the archive package in a table format. By
default, all files associated with the current drawing (such as related xrefs, plot
styles, and fonts) are listed. You can add files to the archive package or remove
existing files. Related files that are referenced by URLs are not included in the

archive package.

Included Reports the number of files included in the package and the size

of the package.

o
152 Curent sheet set: IRD Addition

Sheets | Files Tree | Files Table

A Archive a Sheet Set =)

W [%, AS-01.dwg C:A\Program Files'Au AutoCA AutoCAD : 2

| F&, Buiding Section C:\Program Files\Au AutoCA AutoCAD 21 ™
4| I +

Filename Path Type \Version ! *
W [%, AD1.dwg C:A\Program Files'Au AutoCA AutoCAD 1|E|
] [%, AD2dwa C\Program Files\Au AutoCA AutoCAD £ 1
W [%, AD3dwg CA\Program Filesh\Au AutoCA AutoCAD ; 2
[w] [%, A04.dwg C\Program Files'\Au AutoCA AutoCAD 2 1
2] E%, AD5dwg CA\Program Filesh\Au AutoCA AutoCAD £ 1

Included 27 file(s). 4653KB Add a File

Enter notes to include with this archive

5

View Report I [ Modify Archive Setup. ] [ Help

]
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Add a File

Opens a standard file selection dialog box, in which you can select an
additional file to include in the archive package. This button is available on
both the Files Tree tab and the Files Table tab.

Enter Notes to Be Included with This Archive

Provides a space where you can enter notes related to the archive package.
The notes are included in the archive report. You can specify a template of
default notes to be included with all your archive packages by creating an
ASCII text file called archive.txt. This file must be saved to a location specified
by the Support File Search Path option on the Files tab in the Options dialog
box.

View Report

Displays report information that is included with the archive package. Includes
any archive notes that you entered. If you have created a text file of default
notes, the notes are also included in the report.

Save As Opens a File Save dialog box, in which you can specify a location in
which to save a report file. Note that a report file is automatically included
with all archive packages that you generate; by choosing Save As, you can
save an additional copy of a report file for reference purposes.

Modify Archive Setup

Displays the Modify Archive Setup dialog box, in which you can specify options
for the archive package.

Modify Archive Setup Dialog Box

Quick Reference

E Command entry: archive
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A Modify Archive Setup =)

;%,_B Cument sheet set: IRD Addition
Archive type and location Actions
Archive } type:

) -]
File format :
[ Keep existing drawing file formats - ]

|| Set default plotter to ‘none’
|| Prompt for passward

[] Purge drawings

Archive file folder:
C:\Program Files\AutoCAD 2010%Sample’\Sheet Sets\Arcl + E

Archive file name:

Prompt for a filename - ]

Path options Include options
(@ Use organized folder structure [ Include forts
Source root folder: Include files from data links

C:\Program Files'AutoCAD 20100Sample*Sheset Setsh ~ E Include textures from materials
Include photometric web files
Include unloaded file references
Include sheet set data and files

() Place allfiles in one folder
() Keep files and folders as is

[ ok | [ Canced ][ Hep

Archive Type and Location
Specifies the type and location of archive package created.
Archive Package Type

Specifies the type of archive package created.

Archive Package Type Description

Folder Creates an archive package of uncom-
pressed files in a new or existing folder.

Self-Extracting Executable Creates an archive package of files as a
compressed, self-extracting executable file.
Double-clicking the resulting EXE file de-
compresses the archive package and re-
stores the files.

Zip Creates an archive package of files as a
compressed ZIP file. To restore the files,

124 | Chapter 2 A Commands



Archive Package Type Description

you need a decompression utility such as
the shareware application PKZIP or WinZip.

File Format

Specifies the file format to which all drawings included in the archive package
will be converted. You can select a drawing file format from the drop-down
list.

Archive File Folder

Specifies the location in which the archive package is created. Lists the last
nine locations in which archive packages were created. To specify a new
location, click Browse and navigate to the location you want.

If this field is left blank, the archive file is created in the folder containing the
sheet set data (DST) file.

Archive File Name

Specifies the method for naming the archive package. Displays the default file
name for the archive package. This option is not available if the archive
package type is set to Folder.

Archive File Name Type Description

Prompt for a File Name Displays a standard file selection dialog box
where you can enter the name of the
archive package.

Overwrite if Necessary Uses a logical default file name. If the file
name already exists, the existing file is
automatically overwritten.

Increment File Name if Necessary Uses a logical default file name. If the file
name already exists, a number is added to
the end. This number is incremented each
time a new archive package is saved.

Path Options
Provides options for the archive.

Use Organized Folder Structure
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Duplicates the folder structure for the files being transmitted. The root folder
is the top-level folder within a hierarchical folder tree.

The following considerations apply:

B Relative paths remain unchanged. Relative paths outside the source root
folder retain up to one level of the folder path above them, and are placed
in the root folder.

B Absolute paths within the root folder tree are converted to relative paths.
Absolute paths retain up to one level of the folder path above them, and
are placed in the root folder.

B Absolute paths outside the root folder tree are converted to No Path and
are moved to the root folder or to a folder within the root folder tree.

B A fonts folder is created, if necessary.
B A PlotCfgs folder is created, if necessary.

B A SheetSets folder is created to hold all support files for sheet sets, if
necessary. The sheet set data (DST) file, however, is placed in the root
folder.

This option is not available if you're saving an archive package to an Internet
location.
Source Root Folder

Defines the source root folder for relative paths of drawing-dependent files,
such as xrefs. This option determines the source root folder for the Use
Organized Folder Structure option.

The source root folder also contains the sheet set data (DST) file when a sheet
set is archived.

Place All Files in One Folder

All files are installed to a single, specified target folder when the archive
package is created.

Keep Files and Folders As Is

Preserves the folder structure of all files in the archive package. This option is
not available if you're saving an archive package to an Internet location.

Actions

Specifies the actions applicable to the archive package.
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Set Default Plotter to 'None'
Changes the printer/plotter setting in the archive package to None.
Prompt for Password

Opens the Archive—Set Password dialog box, where you can specify a password
for your archive package.

Purge Drawings

Does a complete purge of all the drawings in the archive.

NOTE As the purge is done in silent mode, you will not receive any notifications
when the drawings have been removed.

Include Options

Specifies the various options available with the archive package.

Include Fonts

Includes any associated font files (TXT and SHX) with the archive package.
Include Files from Data Links

Adds external files referenced by a data link to the transmittal package.
Include Textures from Materials

Includes textures with materials that are attached to objects or faces.
Include Photometric Web Files

Includes photometric web files that are associated with web lights in the
drawing.

Includes all unloaded external file references. The unloaded file references are
listed in the Files Tree and Files Table and report under their appropriate
category.

Include Sheet Set Data and Files

Includes the sheet set data (DST) file, label block drawing files, callout block
drawing files, and drawing template (DWT) files with the archive package.
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Archive - Set Password Dialog Box

Quick Reference

EE Command entry: archive

Ao Archive - Set Password ==

Password for compressed archive:

Password corfimation:

Password for Compressed Archive Package

Provides a space for an optional password for the archive package. When
others attempt to open the archive package, they must provide this password
to access the files. Password protection cannot be applied to folder archive
packages.

Password Confirmation

Provides a space to confirm the password that you entered in the Password
field. If the two passwords do not match, you are prompted to reenter them.

-ARCHIVE

Quick Reference
If you enter -archive at the Command prompt, the following prompts are
displayed.

Sheet Set name or [?] <current>: Enter a predefined sheet set name, enter ? to display
a list of sheet sets, or press ENTER

The sheet set name specifies a sheet set to use for the archive package. This
option is available only when a sheet set is open.
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AREA

Enter an option [Create archive package/Report only] <Create>: Enter an option
or press ENTER
Password (press ENTER for none): Enter a password or press ENTER

You are only prompted for a password if you selected Prompt for Password in
the archive setup.

Quick Reference
Calculates the area and perimeter of objects or of defined areas.

Access Methods

=
Button

£ Ribbon: Home tab » Utilities panel » Area
£ Menu: Tools » Inquiry » Area
EE Command entry: area

Summary

Specify first corner point or [Object/Add Area/Subtract Area] <Object>: Select
an option

The area and perimeter of the specified object displays at the Command prompt
and in the tooltip.
Specify Corner Points

Calculates the area and perimeter defined by specified points. All points must
lie in a plane parallel to the XY plane of the current user coordinate system
(UCS).

Specify next point or [Arc/Length/Undo]: Select the next corner point of the object

A rubberband line from the first specified point to the cursor is displayed.
Once the second point is specified, a line segment and a polygon with green
fill are displayed.
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Continue to specify points to define a polygon and then press ENTER to
complete the definition of the perimeter. The area to be calculated is
highlighted in green.

If you do not close the polygon, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated, that
line length is added.

Specify next point or [Arc/Length/Undo]: Select the next corner point of the object
Specify next point or [Arc/Length/Undo/Total] <Total>

! 5
2
3 4
defining an area and
perimeter
area defined
Specify an Object

Calculates the area and perimeter of a selected object. You can calculate the
area of circles, ellipses, splines, polylines, polygons, regions, and 3D solids.

NOTE 2D solids (created with the SOLID on page 1690 command) do not have an
area reported.

Select object:

If you select an open polyline, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated that
line length is ignored.

The centerline of a wide polyline is used to make area and perimeter

calculations.
open polyline area defined
selected
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The centerline of a wide polyline is used to make area and perimeter (or length)
calculations.

wide polyline

Add Area

Turns on Add mode and keeps a running balance of the total area as you
continue to define areas. You can use the Add Area option to calculate
individual areas and perimeters of defined areas and objects and the total area
of all defined areas and objects.

Specify first corner point or [Object/Subtract area]: Specify a point or enter an
option

If you select the option to select an object, you will see the following command
prompt:

(ADD mode) Select objects: Select an object

You can also select to specify the points. A rubberband line from the first
specified point to the cursor is displayed

Specify first corner point or [Object/Subtract area]: Specify a point or enter an
option

(ADD mode)Specify next point or [Arc/Length/Undo]: Specify a point or enter
an option

(ADD mode)Specify next point or [Arc/Length/Undo]: Specify a point or enter
an option

(ADD mode)Specify next point or [Arc/Length/Undo/Total]: Specify a point or
press ENTER for Total

3

defined area to
be added
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new ared

Specify points to define a polygon (3). The area to be added is highlighted in
green. Press ENTER. AREA calculates the area and perimeter and returns the
total area of all the areas defined by selecting points or objects since Add mode
was turned on.

If you do not close the polygon, the area is calculated as if a line were drawn
from the last point entered to the first. When the perimeter is calculated, that
line length is added.

Subtract Area

Similar to the Add Area option, but subtracts areas and perimeters. You can
use the Subtract Area option to subtract a specified area from a total area.

Specify first corner point or [Object/Add Area]: Specify a point or enter an option

If you select the option to select an object, you will see the following command
prompt:

(SUBTRACT mode) Select objects: Select an object

You can also specify the area to be subtracted with points. A rubberband line
from the first specified point to the cursor is displayed.

Specify first corner point or [Object/Add area): Specify a point

(SUBTRACT mode)Specify next point or [Arc/Length/Undo]: Specify a point or
enter an option

(SUBTRACT mode)Specify next point or [Arc/Length/Undo]: Specify a point or
enter an option

(SUBTRACT mode)Specify next point or [Arc/Length/Undo/Total]: Specify a
point or press ENTER for Total

oo R
'\\_J __// I'\,___/'l—\_/
selected area to be remaining area

subtracted

The specified area to be subracted is highlighted in red.

The total area and perimeter displays at the Command prompt and in the
tooltip.
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ARRAY

Quick Reference
Creates multiple copies of objects in a pattern.

Access Methods

[
OO

Button

£ Ribbon: Home tab » Modify panel » Array.

00

£ Toolbar: Modify O
£ Menu: Modify » Array
E2 Command entry: array

Summary

You can create copies of objects in a regularly spaced rectangular or polar
array.

The Array dialog box is displayed. You can create rectangular or polar arrays
by choosing the appropriate option. Each object in an array can be manipulated
independently. If you select multiple objects, the objects are treated as one
item to be copied and arrayed.

If you enter -array at the Command prompt, options are displayed.
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Array Dialog Box

Quick Reference

Access Methods

Q0
[

Button

£ Ribbon: Home tab » Modify panel » Array.
£ Menu: Modify » Array

[

£ Toolbar: Modify DD
E Command entry: array

Creates multiple copies of objects in a pattern. Use the Rectangular Array
option to create an array of rows and columns of copies of the selected object.
Use the Polar Array option to create an array by copying the selected objects
around a center point.

A Array =
Polar @ Select objects
D objects selected
E Rows: 4 [T} Calumns 4
Offset distance and direction
cooo
— cooo
1.0000
Row cffset: %, 3 cooo
Column offset 1.0000 ﬁ
Angle of amay: 0 E

1)  Bydsfault, f the row offset is negative.
5 rows are added downward. I the 0l
column offset is negative, columns are

TP addedtothelef. Cancsl

Rectangular Array

Creates an array of rows and columns of copies of the selected object.
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Rows
Specifies the number of rows in the array.

If you specify one row, you must specify more than one column. If you specify
a large number of rows and columns for the array, it might take a while to
create the copies. By default, the maximum number of array elements that
you can generate in one command is 100,000. The limit is set by the
MAXARRAY setting in the registry. To reset the limit to 200,000, for example,
enter (setenv "MaxArray" "200000") at the Command prompt.

Columns

Specifies the number of columns in the array.

If you specify one column, you must specify more than one row. If you specify
a large number of rows and columns for the array, it might take a while to
create the copies. By default, the maximum number of array elements that
you can generate in one command is 100,000. The limit is set by the
MAXARRAY setting in the registry. To reset the limit to 200,000, for example,
enter (setenv "MaxArray" "200000") at the Command prompt.

Offset Distance and Direction

Provides a space for you to specify the distance and direction of the array's
offset.

Row Offset

Specifies the distance (in units) between rows. To add rows downward, specify
a negative value. To specify row spacing with the pointing device, use the Pick
Both Offsets button or the Pick Row Offset button.

Column Offset

Array Dialog Box | 135



Specifies the distance (in units) between columns. To add columns to the left,
specify a negative value. To specify column spacing with the pointing device,
use the Pick Both Offsets button or the Pick Column Offset button.

Angle of Array

Specifies the angle of rotation. This angle is normally 0, so the rows and
columns are orthogonal with respect to the X and Y drawing axes of the current
UCS. You can change the measurement conventions for angles using UNITS
on page 1883. The ANGBASE on page 2025 and ANGDIR on page 2026 system
variables affect the angle of arrays.

Pick Both Offsets

Temporarily closes the Array dialog box so that you can use the pointing
device to set the row and column spacing by specifying two diagonal corners
of a rectangle.

Pick Row Offset

Temporarily closes the Array dialog box so that you can use the pointing
device to specify the distance between rows. ARRAY prompts you to specify
two points and uses the distance and direction between the points to specify
the value in Row Offset.

Pick Column Offset

Temporarily closes the Array dialog box so that you can use the pointing
device to specify the distance between columns. ARRAY prompts you to specify
two points and uses the distance and direction between the points to specify
the value in Column Offset.

Pick Angle of Array

Temporarily closes the Array dialog box so that you can specify the angle of
rotation by entering a value or using the pointing device to specify two points.
You can change the measurement conventions for angles using UNITS on
page 1883. The ANGBASE on page 2025 and ANGDIR on page 2026 system variables
affect the angle of arrays.

Polar Array

Creates an array by copying the selected objects around a specified center
point.
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Center Point

Specifies the center point of the polar array. Enter coordinate values for X and
Y, or choose Pick Center Point to use the pointing device to specify the
location.

Pick Center Point

Temporarily closes the Array dialog box so that you can use the pointing
device to specify the center point in the drawing area.

Method and Values

Specifies the method and values used to position objects in the polar array.
Method

Sets the method used to position objects. This setting controls which of the
Method and Value fields are available for specifying values. For example, if
the method is Total Number of [tems & Angle to Fill, the related fields are
available for specifying values; the Angle Between Items field is not available.

Total Number of Items

Sets the number of objects that appear in the resultant array. The default value
is 4.

Angle to Fill

Sets the size of the array by defining the included angle between the base
points of the first and last elements in the array. A positive value specifies
counterclockwise rotation. A negative value specifies clockwise rotation. The
default value is 360. A value of O is not permitted.

Angle Between Items
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Sets the included angle between the base points of the arrayed objects and
the center of the array. Enter a positive value. The default direction value is
90.

NOTE You can choose the Pick buttons and use the pointing device to specify
the values for Angle to Fill and Angle Between Items.

Pick Angle to Fill Temporarily closes the Array dialog box so that you can
define the included angle between the base points of the first and last elements
in the array. ARRAY prompts you to select a point relative to another point
in the drawing area.

Pick Angle Between Items Temporarily closes the Array dialog box so that
you can define the included angle between the base points of the arrayed
objects and the center of the array. ARRAY prompts you to select a point
relative to another point in the drawing area.

Rotate Items as Copied

Rotates the items in the array, as shown in the preview area.

More/Less

Turns the display of additional options in the Array dialog box on and off.
When you choose More, additional options are displayed, and the name of
this button changes to Less.

Object Base Point

Specifies a new reference (base) point relative to the selected objects that will
remain at a constant distance from the center point of the array as the objects
are arrayed. To construct a polar array, ARRAY determines the distance from

the array's center point to a reference (base) point on the last object selected.
The point used depends on the type of object, as shown in the following table.

Base point settings by object

Object type

Default base point

Arc, circle, ellipse

Center point

Polygon, rectangle

First corner

Donut, line, polyline, 3D polyline, ray, spline

Starting point

Block, paragraph text, single-line text

Insertion point
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Base point settings by object

Object type Default base point
Construction lines Midpoint
Region Grip point

Set to Object's Default

Uses the default base point of the object to position the arrayed object. To
manually set the base point, clear this option.

Base Point

Sets anew X and Ybase point coordinate. Choose Pick Base Point to temporarily
close the dialog box and specify a point. After you specify a point, the Array
dialog box is redisplayed.

NOTE To avoid unexpected results, set the base point manually if you are
constructing a polar array and do not want to rotate the objects.

Select Objects

Specifies the objects used to construct the array. You can select objects before
or after the Array dialog box is displayed. To select objects when the Array
dialog box is displayed, choose Select Objects. The dialog box temporarily
closes. When you finish selecting objects, press ENTER. The Array dialog box
is redisplayed, and the number of objects selected is shown below the Select
Objects button.

NOTE If you select multiple objects, the base point of the last selected object is
used to construct the array.

Preview Area

Shows a preview image of the array based on the current settings in the dialog
box. The preview image is dynamically updated when you move to another
field after changing a setting.

Preview

Closes the Array dialog box and displays the array in the current drawing.
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Pick or press ESC to return to dialog box or <Right-click to accept array>: Click
anywhere in the drawing area or press escape to return to the Array dialog box or
right-click to accept the array.

-ARRAY

Quick Reference

If you enter -array at the Command prompt, the following prompts are
displayed.

Select objects: Use an object selection method
Enter the type of array [Rectangular/Polar] <current>: Enter an option or press
ENTER

Rectangular

Creates an array of rows and columns of copies of the selected objects.

ODDOF

| | —distance between

1P | ODDDﬁm

object selected | distance between columns

Enter the number of rows (---) <1>:Enter a nonzero integer or press ENTER
Enter the number of columns (lIl) <1>:Enter a nonzero integer or press ENTER

If you specify one row, you must specify more than one column and vice
versa.

The selected object, or cornerstone element, is assumed to be in the lower-left
corner, and generates the array up and to the right.

The specified distance between the rows and columns includes the
corresponding lengths of the object to be arrayed.

Enter the distance between rows or specify unit cell (---):
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To add rows downward, specify a negative value for the distance between
rows. ARRAY skips the next prompt if you specify two points for the opposite
corners of a rectangle.

Specify the distance between columns (IIl):

To add columns to the left, specify a negative value for the distance between
columns. Rectangular arrays are constructed along a baseline defined by the
current snap rotation. This angle is normally O, so the rows and columns are
orthogonal with respect to the X and Y drawing axes. The Rotate option of
the SNAP on page 1687 command changes the angle and creates a rotated array.
The SNAPANG on page 2291 system variable stores the snap rotation angle.

If you specify a large number of rows and columns for the array, it might take
a while to create the copies. By default, the maximum number of array
elements that you can generate in one command is 100,000. The limit is set
by the MAXARRAY setting in the registry. To reset the limit to 200,000, for
example, enter (setenv "MaxArray" "200000") at the Command prompt.

Polar

Creates an array by copying the selected objects around a specified center

al O
C=0
Qe
C50

polar array with objects polar array angle to
rotated fill=180; objects not
rotated

Specify center point of array or [Base]: Specify a point or enter b to specify a new
base point
Center Point Creates an array defined by a center point.

Base Specifies a new reference (base) point relative to the selected objects that
will remain at a constant distance from the center point of the array as the
objects are arrayed.

Specify the base point of objects: Specify a point

Enter the number of items in the array: Enter a positive integer or press ENTER
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ARX

If you enter a value for the number of items, you must specify either the angle
to fill or the angle between items. If you press ENTER (and do not provide the
number of items), you must specify both.

Specify the angle to fill (+=ccw, -=cw) <360>: Enter a positive integer for a
counterclockwise rotation or a negative integer for a clockwise rotation

You can enter 0 for the angle to fill only if you specify the number of items.

If you specify an angle to fill without providing the number of items, or if
you specify the number of items and enter 0 as the angle to fill or press ENTER,
the following prompt is displayed:

Angle between items: Specify an angle

If you specified the number of items and entered O as the angle to fill or pressed
ENTER, ARRAY prompts for a positive or negative value to indicate the
direction of the array:

Angle between items (+=ccw, -=cw): Enter a positive integer for a counterclockwise
rotation or a negative integer for a clockwise rotation

ARRAY determines the distance from the array's center point to a reference
point on the last object selected. The reference point used is the center point
of a circle or arc, the insertion base point of a block or shape, the start point
of text, and one endpoint of a line or trace.

Rotate arrayed objects? <Y>: Entery or n, or press ENTER

In a polar array, the reference point of the last object in the selection set is
used for all objects. If you defined the selection set by using window or crossing
selection, the last object in the selection set is arbitrary. Removing an object
from the selection set and adding it back forces that object to be the last object
selected. You can also make the selection set into a block and replicate it.

Quick Reference

Loads, unloads, and provides information about ObjectARX applications.

E: Command entry: arx
Enter an option [?/Load/Unload/Commands/Options]:
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? - List Applications

Lists the currently loaded ObjectARX applications, which can be third-party
programs or internal applications such as Render.

Load

Displays the ObjectARX/DBX File dialog box (a standard file selection dialog
box). This option loads the specified ObjectARX application.

Unload

Unloads the specified ObjectARX application.

Enter ARX/DBX file name to unload:

Commands

Lists the AcEd-registered commands (AcEd-registered commands are described
in the ObjectARX Developer's Guide).

Options

Presents developer-related ObjectARX application options. These options are
explained in greater detail in the ObjectARX Developer's Guide.

Enter an option [Group/CLasses/Services]: Enter an option or press ENTER
Group Causes the specified group of commands to be the first group searched
when resolving the names of AutoCAD commands.

Classes Displays a class hierarchy of C++ classes derived from objects registered
in the system.

Services Lists the names of all registered services.

ATTACH

Quick Reference

Inserts an external reference, image, or underlay (DWF, DWEFx, PDF, or DGN
files) in the current drawing.
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Access Methods

—

Button

£ Ribbon: Insert tab » Reference panel » Attach
E Command entry: attach
Summary

The Attach command opens the Select Reference File dialog box (a standard
file selection dialog box). If Views » Preview is selected, a preview of the
selected file is displayed.

- ATTACH

Quick Reference

Inserts an external reference, image, or underlay (DWF, DWEx, PDF, or DGN
files) in the current drawing.

Access Methods

E2 Command entry: - attach

Summary

Attach an external reference, image, or underlay (DWF, DWFx, PDF, or DGN)
file from the command line.

List of Prompts

The list of prompts differs depending on whether you are attaching an

underlay, an image, or an external reference.

DWF and DWFx Underlay Prompts

Path to File Enters the location of the DWF or DWFx file including the file
name.

Sheet name Enters a sheet name.
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? Enters multiple sheets.
* Lists sheets available in the DWF or DWFx file.

Insertion point Specify the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units

Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

PDF Underlay Prompts

Path to File Enters the location of the PDF file including the file name.
Page Number Enters a page number.

? Enters multiple pages.

* Lists pages available in the PDF file.

Insertion Point Specifies the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units

Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

DGN Underlay Prompts

Path to File Enters the location of the DGN file including the file name.
Name of Model Enters a model name.

? Enters multiple models.

* Lists pages available in the DGN file.

Insertion Point Specifies the location of the lower, left-hand corner of the
underlay by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the underlay’s height and width in units

Scale Factor Resizes the underlay. For example, if the base image size is 36 x
24 and you enter a scale factor of 2, the underlay will display at 72 x 48.
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Rotation Sets an angle of rotation for the underlay.

Image Prompts
Path to File Enters the location of the image file including the file name.

Insertion Point Specifies the location of the lower, left-hand corner of the
image by clicking on screen or entering the X,Y coordinates.

Base Image Size Displays the image’s height and width in units

Scale Factor Resizes the image. For example, if the base image size is 36 x 24
and you enter a scale factor of 2, the underlay will display at 72 x 48.

Rotation Sets an angle of rotation for the underlay.

External Reference Prompts

Path to File Enters the location of the external reference file including the
file name.

Reference Type Selects whether to attach this file as an underlay or an overlay.
Press Enter to attach the file as an underlay (attachment).

NOTE Unlike attached external references, overlaid external references are not
included when the drawing is attached or overlaid as an external reference to
another drawing.

Insertion Point Specifies the location of the lower, left-hand corner of the
external reference by clicking on screen or entering the X,Y coordinates.

Scale Sets the scale factor for the X,Y, and Z axes. The scale for the Z axis is
the absolute value of the specified scale factor.

B Specify scale factor for XYZ axes: Enter a nonzero value
B Specify insertion point:

B Specify rotations angle <0>:

X, Y, Z Sets the X, Y, and Z scale factor.
B Specifies scale factor for XYZ axes: Enter a nonzero value

B Specifies insertion point:

W Specifies rotations angle <0>:

Rotate Sets the rotation angle for both the individual blocks and the entire
array.
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PScale Sets the scale factor for the X, Y, and Z axes to control the display of
the block as it is dragged into position.

PX, PY, PZ Sets the scale factor for the X, Y, and Z axes to control the display
of the block as it is dragged into position.

PRotate Sets the rotation angle of the block as it is dragged into position.
Base Image Size Displays the external reference’s height and width in units

Scale Factor Resizes the external reference. For example, if the base image
size is 36 x 24 and you enter a scale factor of 2, the external reference will
display at 72 x 48.

Unit Changes the type of units to scale the external reference.

ATTACHURL

Quick Reference

Attaches hyperlinks to objects or areas in a drawing.

EE Command entry: attachurl

Enter hyperlink insert option [Area/Object] <Object>: Enter a or press ENTER
Area

Creates the URLLAYER layer, draws a polyline on that layer, and attaches a
URL to the polyline.

First corner: Click in the drawing to indicate the lower-left corner of the area
Other corner: Click to indicate the upper-right corner of the area
Enter hyperlink <current drawing>: Enter a URL

The polyline that represents the area is displayed in the color assigned to
URLLAYER. The default color is red. When you move the cursor over the area
in the drawing, the cursor changes to a hyperlink cursor to indicate that a
URL is attached to the area.

Object
Attaches a URL to the selected object.

Select objects: Use an object selection method, and press ENTER to end selection
Enter hyperlink <current drawing>: Enter a URL
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ATTDEF

When you move the cursor over the object in the drawing, the cursor changes
to a hyperlink cursor to indicate that a URL is attached to the object.

Quick Reference
Creates an attribute definition for storing data in a block.

Access Methods

hS

Button

£ Ribbon: Home tab » Block panel » Define Attributes.
£ Menu: Draw » Block » Define Attributes
EE Command entry: attdef

Summary
The Attribute Definition dialog box is displayed.
If you enter -attdef at the Command prompt, options are displayed.

An attribute is an object that is created and included with a block definition.
Attributes can store data such as part numbers, product names, and so on.

Attribute Definition Dialog Box

Quick Reference

Access Methods

pS

Button

£ Ribbon: Home tab » Block panel » Define Attributes.
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¥ Menu: Draw » Block » Define Attributes
E Command entry: attdef

Summary

Defines the mode; attribute tag, prompt, and value; insertion point; and text
settings for an attribute.

A pttribute Definition =
Mode Attribute
[] Invisible Tog
[] Constart
Ny Prompt:
] Vertfy
[ Preset Diefault: @
Lock position
[ Multiple lines Tex Settings
L
Insertion Paint
5t Tt i
Spechy onscreen [ Annotative (D
""" Text height: 0.2000
------ Rotation: 0
___________ .
ok | [ Cameel | [ Heb |

Mode

Sets options for attribute values associated with a block when you insert the
block in a drawing.

The default values are stored in the AFLAGS on page 2025 system variable.
Changing the AFLAGS setting affects the default mode for new attribute
definitions and does not affect existing attribute definitions.

Invisible

Specifies that attribute values are not displayed or printed when you insert
the block. ATTDISP on page 155 overrides Invisible mode.

Constant
Gives attributes a fixed value for block insertions.

Verify
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Prompts you to verify that the attribute value is correct when you insert the
block.

Preset

Sets the attribute to its default value when you insert a block containing a
preset attribute.

Lock Position

Locks the location of the attribute within the block reference. When unlocked,
the attribute can be moved relative to the rest of the block using grip editing,
and multiline attributes can be resized.

Multiple Lines

Specifies that the attribute value can contain multiple lines of text. When this
option is selected, you can specify a boundary width for the attribute.

NOTE In a dynamic block, an attribute's position must be locked for it to be
included in an action's selection set.

Attribute
Sets attribute data.
Tag

Identifies each occurrence of an attribute in the drawing. Enter the attribute
tag using any combination of characters except spaces. Lowercase letters are
automatically changed to uppercase.

Prompt

Specifies the prompt that is displayed when you insert a block containing this
attribute definition. If you do not enter a prompt, the attribute tag is used as
a prompt. If you select Constant in the Mode area, the Prompt option is not
available.

Default
Specifies the default attribute value.
Insert Field Button

Displays the Field dialog box. You can insert a field as all or part of the value
for an attribute.

Multiline Editor Button
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When Multiple Line mode is selected, displays an in-place text editor with a
text formatting toolbar and ruler. Depending on the setting of the ATTIPE on
page 2030 system variable, the Text Formatting toolbar displayed is either the
abbreviated version, or the full version.

For more information, see the In-Place Text Editor.

NOTE Several options in the full In-Place Text Editor are grayed out to preserve
compatibility with single-line attributes.

Insertion Point

Specifies the location for the attribute. Enter coordinate values or select Specify
On-screen and use the pointing device to specify the placement of the attribute
in relation to the objects that it will be associated with.

Specify On-Screen

Displays a Start Point prompt when the dialog box closes. Use the pointing
device to specify the placement of the attribute in relation to the objects that
it will be associated with.

X
Specifies the X coordinate of the attribute's insertion point.
Y
Specifies the Y coordinate of the attribute's insertion point.
zZ

Specifies the Z coordinate of the attribute's insertion point.

Text Settings
Sets the justification, style, height, and rotation of the attribute text.
Justification

Specifies the justification of the attribute text. See TEXT on page 1818 for a
description of the justification options.

Text Style

Specifies a predefined text style for the attribute text. Currently loaded text
styles are displayed. To load or create a text style, see STYLE on page 1752.

Annotative
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Specifies that the attribute is . If the block is annotative, the attribute will
match the orientation of the block. Click the information icon to learn more
about annotative objects.

Text Height

Specifies the height of the attribute text. Enter a value, or choose Height to
specify a height with your pointing device. The height is measured from the
origin to the location you specify. If you select a text style that has fixed height
(anything other than 0.0), or if you select Align in the Justification list, the
Height option is not available.

Rotation

Specifies the rotation angle of the attribute text. Enter a value, or choose
Rotation to specify a rotation angle with your pointing device. The rotation
angle is measured from the origin to the location you specify. If you select
Align or Fit in the Justification list, the Rotation option is not available.

Boundary Width

Specifies the maximum length of the lines of text in a multiple-line attribute
before wrapping to the next line. A value of 0.000 means that there is no
restriction on the length of a line of text.

Not available for single-line attributes.

Align Below Previous Attribute Definition

Places the attribute tag directly below the previously defined attribute. If you
have not previously created an attribute definition, this option is not available.

-ATTDEF

Quick Reference

If you enter -attdef at the Command prompt, the following prompts are
displayed.

Current attribute modes: Invisible=current Constant=current Verify=current
Preset=current Lock position=current Annotative =current Multiple line =current
Enter an option to change [Invisible/Constant/Verify/Preset/Lock
position/Annotative/Multiple lines] <done>:

Enter attribute tag name: Enter any characters except spaces or exclamation points
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Enter attribute value: Enter the appropriate text or press ENTER (this prompt is
displayed only if you turned on Constant mode)

Enter attribute prompt: Enter the text for the prompt line or press ENTER (this
prompt is not displayed if you turned on Constant mode)

Enter default attribute value: Enter the appropriate text or press ENTER (this prompt
is not displayed if you turned on Constant mode)

Specify location of multiline attribute: Specify a point (this prompt is displayed
only if you turned on Multiple line mode)

Specify opposite corner: Specify a point or enter an option (this prompt is displayed
only if you turned on Multiple line mode)

Attribute Modes

The current value line indicates the current settings for each attribute mode
(either Y for on or N for off). Entering i, ¢, v, p, |, a, or m toggles the modes
on or off. Press ENTER when you have finished adjusting the mode settings.
The AFLAGS on page 2025 system variable stores the current mode settings and
can be used to set the default modes.

Invisible Specifies that attribute values are displayed when you insert the
block. ATTDISP on page 155 overrides Invisible mode.

Constant Gives attributes a fixed value for block insertions.

Verify Prompts for verification that the attribute value is correct when you
insert the block.

Preset Sets the attribute to its default value when you insert a block containing
a preset attribute.

Lock Position Locks the location of the attribute within the block reference.
When unlocked, the attribute can be moved relative to the rest of the block
using grip editing, and multiline attributes can be resized.

NOTE In a dynamic block, an attribute's position must be locked for it to be
included in an action's selection set.

Annotative Specifies that the attribute is .

Multiple Lines Specifies that the attribute value can contain multiple lines
of text. When this option is selected, you can specify a boundary width for
the attribute.
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Attribute Tag Name

Specifies the attribute tag, which identifies each occurrence of an attribute in
the drawing. The tag can contain any characters except spaces or exclamation
marks (!). Lowercase letters are automatically changed to uppercase.

Attribute Prompt

Specifies the prompt that is displayed when you insert a block containing this
attribute definition. If you press ENTER, the attribute tag is used as the prompt.
If you turn on Constant mode, this prompt is not displayed.

NOTE For single-line attributes, you can enter up to 256 characters. If you need
leading blanks in the prompt or the default value, start the string with a backslash
(\). To make the first character a backslash, start the string with two backslashes.

Default Attribute Value

Specifies the default attribute value. The default attribute value appears when
a block is inserted into your drawing. A default value is not required. If you
turn on Constant mode, the Attribute Value prompt is displayed instead.

When Multiple Line mode is off, -ATTDEF then displays the same prompts as
the TEXT command, using the attribute tag instead of requesting a text string.

Current text style: "Standard" Text height: 0.2000
Specify start point of text or [Justify / Style]: Enter an option or press ENTER
Specify paper text height <current>: Specify a height, or press ENTER

The Specify Paper Text Height prompt is displayed only if the current text
style is .

For a description of each option, see TEXT on page 1818.

NOTE For single-line attributes, you can enter up to 256 characters. If you need
leading blanks in the prompt or the default value, start the string with a backslash
(\). To make the first character a backslash, start the string with two backslashes.

When Multiple Line mode is on, -ATTDEF then displays several of the prompts
used by the MTEXT command. For a description of each option, see MTEXT
on page 1151.

Attribute Value (Constant Mode)

Specifies the value for a constant attribute. This prompt is displayed only if
you turn on Constant mode.
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ATTDEF then displays the same prompts as the TEXT command, using the
attribute tag instead of requesting a text string.

Current text style: "Standard" Text height: 0.2000
Specify start point of text or [Justify / Style]: Enter an option or press ENTER

For a description of each option, see TEXT on page 1818.

When Multiple Line mode is on, -ATTDEF then displays several of the prompts
used by the MTEXT command. For a description of each option, see MTEXT
on page 1151.

Location of Multiline Attribute (Multiple Line Mode)

Specifies the first corner of the bounding box for the multiple-line text. This
location is used as the starting point for the attribute.

Opposite Corner (Multiple Line Mode)

As you drag the pointing device to specify the opposite corner, a rectangle is
displayed to show the location and width of the multiple-line text. The arrow
within the rectangle indicates the direction of the text flow.

ATTDISP

Quick Reference

Controls the visibility overrides for all block attributes in a drawing.
Access Methods

Button

£ Ribbon: Home tab » Block panel » Retain Attribute Display

£ Menu: View » Display » Attribute Display
E Command entry: attdisp (or 'attdisp for transparent use)
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Summary
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The drawing is regenerated after you change the visibility settings unless
REGENAUTO on page 1527, which controls automatic regeneration, is off. The
current visibility of attributes is stored in the ATTMODE on page 2031 system
variable.

List of Prompts

The following prompts are displayed.

Enter attribute visibility setting [Normal/ON/OFF] <current>:
Normal Restores the visibility settings of each attribute. Visible attributes are
displayed. Invisible attributes are not displayed.

On Makes all attributes visible, overriding the original visibility settings.

Off Makes all attributes invisible, overriding the original visibility settings.

ATTEDIT

Quick Reference

Changes attribute information in a block.
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Access Methods

¥

Button

£ Ribbon: Home tab » Block panel » Edit Attributes.
£ Menu: Modify » Object » Attribute » Single
E Command entry: attedit

Summary
Select block reference: Select a block with attributes

The Edit Attributes dialog box is displayed to edit attribute values for a specific
block.

If you enter -attedit at the Command prompt, options are displayed to edit
attribute values and properties independent of a block.

Edit Attributes Dialog Box

Quick Reference

Access Methods

¥

Button

£ Ribbon: Home tab » Block panel » Edit Attributes.
£ Menu: Modify » Object » Attribute » Single
EE Command entry: attedit

Changes attribute information in a block.

To change attribute properties such as position, height, and style, use
-ATTEDIT.

Block Name

Indicates the name of the selected block. The value of each attribute contained
in the block is displayed in this dialog box.
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List of Attributes

Displays the first eight attributes contained in the block. Edit the attribute
values. If the block contains additional attributes, use Previous and Next to
navigate through the list. You cannot edit attribute values on locked layers.

Multiple-line attributes display the In-Place Text Editor on page 1157 with the
Text Formatting toolbar and the ruler. Depending on the setting of the ATTIPE
on page 2030 system variable, the Text Formatting toolbar displayed is either
the abbreviated version, or the full version.

To use a field as the value, right-click and click Insert Field on the shortcut
menu to display the Field dialog box.

Previous

Displays the previous eight attribute values. Previous is available only if the
selected block contains more than eight attributes and you used Next to display
the additional attributes.

Next

Displays the next eight attribute values. If the block contains no additional
attributes, Next is unavailable.

Ao Edit Attributes =
Block name:  CHARR
ENTER EMPLOYEE NAME
ENTER MANUFACTURER FUTURA
ENTER COLOR 129.99
ENTER ROOM NUMBER CHAIR
ENTER TYPE 4126
ENTER COST SLATE BLUE
ENTER STYLE CHAIR200
ENTER MODEL NUMBER JAUN L
[ Cancel | Frevious Nexdt Help

-ATTEDIT

Quick Reference

£ Menu: Modify » Object » Attribute » Global
EE Command entry: -attedit
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If you enter -attedit at the Command prompt, the following prompts are
displayed.

Edit attributes one at a time? [Yes/No] <Y>: Entery or press ENTER to edit
attributes one at a time, or enter n to edit attributes globally

The following prompts filter the attributes to be changed based on attribute
tag, current value, or object selection.

Yes

Edits attributes one at a time. Attributes to be edited one at a time must be
visible and parallel to the current UCS.

Enter block name specification <*>: Press ENTER, or enter a block name or a
partial block name with wild-card characters (? or *) to narrow the selection to specific
blocks

Enter attribute tag specification <*>: Press ENTER, or enter a tag or a partial tag
with wild-card characters (7 or *) to narrow the selection to specific attributes

Enter attribute value specification <*>: Press ENTER, or specify a value or a value
name with wild-card characters (? or *) to narrow the selection to specific attribute
values

Attribute values are case sensitive.
Select Attributes: Select only attributes parallel to the current UCS

R328
4 T

WA

attributes selected

The first attribute in the selection set is marked with an X. You can change
any properties of the attribute you select.

Enter an option [Value/Position/Height/Angle/Style/Layer/Color/Next] <N>:
Enter the property to change, or press ENTER for the next attribute

If the original attribute was defined with aligned or fit text, the prompt does
not include Angle. The Height option is omitted for aligned text. For each of
the options except Next, ATTEDIT prompts for a new value. The X remains
on the current attribute until you move to the next attribute.

-ATTEDIT | 159



47K

2
VAVAVAS
x on first attribute

R328
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¥ on next attribute

Value
Changes or replaces an attribute value.

Enter type of value modification [Change/Replace]: Enter c or r or press ENTER
Change Modifies a few characters of the attribute value.

Enter string to change: Enter string to change or press ENTER

Enter new string: Enter replacement string or press ENTER

Either string can be null. The ? and * characters are interpreted literally, not
as wild-card characters.

Replace Substitutes a new attribute value for the entire attribute value.
Enter new attribute value: Enter a new attribute value or press ENTER

If you press ENTER, the attribute value is empty (null).

Position

Changes the text insertion point.

R328
4.7K

— AN/

position changed

Specify new text insertion point: Specify a point or press ENTER

If the attribute is aligned, ATTEDIT prompts for both ends of a new text
baseline.
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Height
Changes the text height.

R5283

4. 7K
height changed

Specify new height <current>: Enter a value, specify a point, or press ENTER

When you specify a point, the height becomes the distance between the
specified point and the start point of the text.

Angle
Changes the rotation angle.
P
WELE
47K
VAVAVAL
angle changed

Specify new rotation angle <current>: Enter a value, specify a point, or press ENTER

If you specify a point, the text is rotated along an imaginary line between the
specified point and the start point of the text.

Style
Changes the style setting.

2225
47K

style changed

Enter new text style: Enter a style name or press ENTER
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Layer
Changes the layer.

Enter new layer name <current>: Enter a layer name or press ENTER

Color
Changes the color.

You can enter a color from the AutoCAD Color Index (a color name or
number), a true color, or a color from a color book.

Enter new color [Truecolor/COlorbook]<BYLAYER>: Enter a color, enter t, enter
co, or press ENTER

You can enter a color name, a color number between 1 and 255, or bylayer
or byblock.

True Color Specifies a true color to be used for the selected object.

Red, Green, Blue: Enter three integer values from 0 to 255 separated by commas to
specify a true color

Color Book Specifies a color from a loaded color book to be used for the
selected object.

Enter Color Book name: Enter the name of a color book that has been installed,
such as PANTONE®

If you enter a color book name, you are prompted to enter the color name in
the color book.

Enter color name: Enter the name of a color included in the selected color book, such
as PANTONE® 573

Next

Moves to the next attribute in the selection set. If there are no more attributes,
ATTEDIT ends.

No

Edits more than one attribute at a time. Global editing applies to both visible
and invisible attributes.

Editing attributes globally limits you to replacing a single text string with
another text string. If you edit attributes one at a time, you can edit any or
all of the attributes.

Performing global editing of attribute values.
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Edit only attributes visible on screen? [Yes/No] <Y>: Entery or press ENTER to
edit only visible attributes, or enter n to edit all attributes
Yes Edits only visible attributes.

Enter block name specification <*>: Press ENTER, or specify a block name or a
partial block name with wild-card characters (? or *) to narrow the selection to specific
blocks

Enter attribute tag specification <*>: Press ENTER, or specify a tag or a partial tag
with wild-card characters (? or *) to narrow the selection to specific attributes

Enter attribute value specification <*>: Press ENTER, or specify a value or a partial
value with wild-card characters (? or *) to narrow the selection to specific attribute
values

Attribute values are case sensitive. To select empty (null) attributes, which
normally are not visible and cannot be selected, enter a backslash (\).

Select Attributes: Select only attributes parallel to the current UCS

Select the attribute you want to change.

Enter string to change: Enter string to change or press ENTER

Enter new string: Enter replacement string or press ENTER

Either string can be empty (null). The ? and * characters are interpreted literally,
not as wild-card characters.

No Edits attributes whether they are visible or not. Changes to attributes are
not reflected immediately. The drawing is regenerated at the end of the
command unless REGENAUTO on page 1527, which controls automatic
regeneration, is off.

Enter block name specification <*>: Enter a full block name or a partial block name
with wild-card characters (? or *), or press ENTER to select attributes in all blocks

Enter attribute tag specification <*>: Enter a full attribute tag name or a partial
name with wild-card characters (? or *), or press ENTER to select attributes in all
attribute tags

Enter attribute value specification <*>: Enter a full attribute value or a partial value
with wild-card characters (? or *), or press ENTER to select all attributes

Attribute values are case sensitive. To select empty (null) attributes, which
normally are not visible, enter a backslash (\).

The attributes that match the specified block name, attribute tag, and attribute
value are selected.

Enter string to change: Enter the attribute value you want to change, or press ENTER
to append a new value to the existing value(s)

Enter new string: Enter the new value to replace the specified value or to append to
selected values
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Either string can be empty (null). The ? and * characters are interpreted literally,
not as wild-card characters.

ATTEXT

Quick Reference

Extracts attribute data, informational text associated with a block, into a file.
EE Command entry: attext
The Attribute Extraction dialog box is displayed.

If you enter -attext at the Command prompt, options are displayed.

Attribute Extraction Dialog Box

Quick Reference

EE Command entry: attext

Specifies the file format for the attribute information, the objects from which
you want to extract information, and the template and output file names for
the information.

Ao pttribute Extraction ==
File Format

@ Comms Delimited Fie [CDF)
Space Delimited File (SDF)
DXF Format Exract File (DXX)

Select Objects < Number found: 0

[ OupiBle.. | Dmwnoisne
0K [ cancel | [ Heb

File Format

Sets the format for the file into which you are extracting the attribute data.

Comma Delimited File (CDF)
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Generates a file containing one record for each block reference in the drawing
that has at least one matching attribute tag in the template file. Commas
separate the fields of each record. Single quotation marks enclose the character
fields.

Space Delimited File (SDF)

Generates a file containing one record for each block reference in the drawing
that has at least one matching attribute tag in the template file. The fields of
each record have a fixed width; therefore, field separators or character string
delimiters are not appropriate.

DXF Format Extract File (DXX)

Produces a subset of the AutoCAD Drawing Interchange File format containing
only block reference, attribute, and end-of-sequence objects. DXF™ format
extraction requires no template. The file name extension .dxx distinguishes
the output file from normal DXF files.

Select Objects

Closes the dialog box so you can use the pointing device to select blocks with
attributes. When the Attribute Extraction dialog box reopens, Number Found
shows the number of objects you selected.

Number Found

Indicates the number of objects you selected using Select Objects.

Template File

Specifies a template extraction file for CDF and SDF formats. Enter the file
name in the box, or choose Template File to search for existing template files
using a standard file selection dialog box. The default file extension is .txt. If
you select DXF under File Format, the Template File option is not available.

For information about creating a template file, see Attach Data to Blocks (Block
Attributes) in the User's Guide.

Output File

Specifies the file name and location for the extracted attribute data. Enter the
path and file name for the extracted attribute data, or choose Output File to
search for existing template files using a standard file selection dialog box.
The .txt file name extension is appended for CDF or SDF files and the .dxx file
name extension for DXF files.
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-ATTEXT

Quick Reference

If you enter -attext at the Command prompt, the following prompts are
displayed.

Enter extraction type or enable object selection [Cdf/Sdf/Dxf/Objects] <C>:
Enter an option or press ENTER

CDF: Comma-Delimited File Generates a file containing one record for each
block reference in the drawing. Commas separate the fields of each record.
Single quotation marks enclose the character fields.

In the Select Template File dialog box, enter the name of an existing attribute
extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .txt for CDF or SDF format.

SDEF: Space-Delimited File Generates a file containing one record for each
block reference in the drawing. The fields of each record have a fixed width;
therefore, field separators or character string delimiters are not used.

In the Select Template File dialog box, enter the name of an existing attribute
extraction template file.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .txt for CDF or SDF format.

DXF: Drawing Interchange File Produces a subset of the AutoCAD Drawing
Interchange File format containing only block reference, attribute, and
end-of-sequence objects. DXF-format extraction requires no template. The file
name extension .dxx distinguishes the output file from normal DXEF files.

In the Create Extract File dialog box, enter the name for the output file. The
extract file's file name extension is .dxx for DXF format.

Obijects Selects objects whose attributes you want to extract.

Select object: Use an object selection method

Enter attribute extraction type [Cdf/SAdf/Dxf] <C>: Enter an option or press ENTER
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ATTIPEDIT

Quick Reference

Changes the textual content of an attribute within a block.

EE Command entry: attipedit
Select attribute to edit: Select an attribute within a block

If you select a single-line attribute, displays the In-Place Text Editor on page
1157 without the Text Formatting toolbar and the ruler. Right-click to display
options.

If you select a multiple-line attribute, displays the In-Place Text Editor on page
1157 with the Text Formatting toolbar and the ruler. Depending on the setting
of the ATTIPE on page 2030 system variable, the Text Formatting toolbar
displayed is either the abbreviated version shown, or the full version.

Text Formatting

B2 U QO v ox[m ok | ®

Use the abbreviated version for compatibility with previous AutoCAD releases
and editing operations. Use the full version for additional text formatting
options.

NOTE Not all MTEXT formatting options are available for multiline attributes even
with the full In-Place Editor.

Mask the Objects Behind Attribute Text

If the text in a multiple-line attribute overlaps other objects within the block,
you can hide those objects that interfere with the text with a background
mask. Click the Options button in the Text Formatting toolbar and click
Background Mask to display the Background Mask dialog box on page 1169.

ATTIPEDIT | 167



ATTREDEF

Quick Reference

Redefines a block and updates associated attributes.

EE Command entry: attredef

Enter the name of the block you wish to redefine:
Select objects for new block:

Select objects:

Insertion base point of new block: Specify a point

New attributes assigned to existing block references use their default values.
Old attributes in the new block definition retain their old values. Any old
attributes that are not included in the new block definition are deleted.

WARNING ATTREDEF removes any format or property changes made with the
ATTEDIT or EATTEDIT commands. It also deletes any extended data associated
with the block, and might affect dynamic blocks and blocks created by third-party
applications.

ATTSYNC

Quick Reference

Updates block references with new and changed attributes from a specified
block definition.

Access Methods

<

Button

£ Ribbon: Home tab » Block panel » Synchronize Attributes.

(|
8
£ Toolbar: Modify II

E2 Command entry: attsync
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AUDIT

List of Prompts
Enter an option [?/Name/Select] <Select>:

You are prompted for the names of blocks you want to update with the current
attributes defined for the blocks.

Use this command to update all instances of a block containing attributes
that was redefined using the BLOCK or BEDIT commands. ATTSYNC does not
change any values assigned to attributes in existing blocks.

NOTE Use the ATTREDEF command to redefine and update blocks in one
command.

Entering ? displays a list of all block definitions in the drawing. Enter the
name of the block you want to update.

Pressing ENTER allows you to use your pointing device to select the block
whose attributes you want to update.

If a block you specify does not contain attributes or does not exist, an error
message is displayed, and you are prompted to specify another block.

WARNING ATTSYNC removes any format or property changes made with the
ATTEDIT or EATTEDIT commands. It also deletes any extended data associated
with the block, and might affect dynamic blocks and blocks created by third-party
applications.

Quick Reference
Evaluates the integrity of a drawing and corrects some errors.
Access Methods
[,
?
Button

£ Menu: Application menu » Drawing Utilities » Audit
EE Command entry: audit
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Summary

List of Prompts
Fix any errors detected? [Yes/No] <N>: Entery or n, or press ENTER

For easy access, AUDIT places all objects for which it reports errors in the
Previous selection set. However, editing commands affect only the objects
that belong to the current paper space or model space.

If you set the AUDITCTL on page 2032 system variable to 1, AUDIT creates a
text file describing problems and the action taken and places this report in
the same folder as the current drawing, with the file extension .adt.

If a drawing contains errors that AUDIT cannot fix, use RECOVER on page
1512 to retrieve the drawing and correct its errors.

AUTOCONSTRAIN

Quick Reference

Applies geometric constraints to a selection set of objects based on orientation
of the objects relative to one another.

Access Methods

I

Button

£ Ribbon: Parametric tab » Geometric panel » Auto Constrain
£ Menu: Parametric » AutoConstrain

£ Toolbar: Parametric

EE Command entry: autoconstrain

List of Prompts
Select objects or [Settings] <Settings>: Select the objects to autoconstrain

You can apply geometric constraints to a selection set of geometry within the
specified tolerance set using the AutoConstrain tab in the Constraint Settings
dialog box on page 348.
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Specify the Settings option to change the types of constraints applied, the
order in which they are applied, and the applicable tolerances.

The Settings option displays the Constraint Settings dialog box with the
Autoconstrain tab on page 349 selected.

AUTOPUBLISH

Quick Reference

Publishes drawings to DWEF, DWFx, or PDF files automatically to a specified
location.

Access Methods
EE Command entry: autopublish

Summary

Publishes a drawing to a DWF, DWFx, or PDF file. The file format (DWFE,
DWEFx, or PDF) is specified in the Auto Publish dialog box on page 172.

To view information about the published drawings, click the Plotting Details
Report Available icon in the tray on the right side of the status bar. Clicking
this icon opens the Plot and Publish Details dialog box, which provides
information about your completed plot and publish jobs. This information
is also saved to the Plot and Publish log file. The shortcut menu for this icon
also provides an option to view the most recently published DWF, DWEX, or
PDF file.

List of Prompts

AutoPublish DWF Automatically publishes the drawing to a DWF, DWEX, or
PDF file. The file format (DWF, DWFx, or PDF) is specified in the Auto Publish
dialog box on page 172.

Location Specifies a directory where the published drawings are stored. Opens
Select a Folder for Generated Files dialog box (a standard file selection dialog
box on page 1225).
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Auto Publish Options Dialog Box

Quick Reference

Publishes drawings to DWEF, DWFx, or PDF files automatically to a specified
location.

Access Methods

£ Menu: Application menu » Options

Shortcut menu: Right-click in the command window, or (with no commands
active and no objects selected) right-click in the drawing area, and choose
Options. Select the Plot and Publish tab.

EE Command entry: options

Summary

Specifies options for publishing drawings to DWF, DWEX, or PDF files when
you save or close a drawing file, or issue the AUTOPUBLISH on page 171
command.

List of Options

This dialog box contains the following options:

Auto-Publish Options
Specifies where DWF or PDF files are saved when you publish drawing sheets.

Publish on Specifies when the publishing takes place.

B Save (Publishes when the drawing is saved)

B Close (Publishes when the drawing is closed)

B Prompt on Save (Publishes when the drawing is prompted to save)
|

Prompt on Close (Publishes when the drawing is prompted to close)

Location Specifies a directory where exported files are saved when you publish
drawings by selecting the following options in the list:

B Drawing folder
B DWF and PDF (sub-folder relative to Drawing folder)

B Previously selected location
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Click the [...] button to specify a new location to save the published drawings.

Include Specifies whether to publish the model, the layouts or both the model
and layouts are saved when you publish drawings.

General DWF/PDF options
Specifies options for creating a single-sheet or multi-sheet DWF, DWFx, and
PDF files.

File Format Specifies whether the DWG should be published as a DWF, DWFx,
or PDF file.

Type Specifies that a single-sheet or a multi-sheet is generated for all the sheets
listed in the Publish dialog box.

Layer Information Specifies whether layer information is included in the
published DWE, DWFx, or PDF file.

NOTE Layer information for 3D DWF entries does not get published.

Merge Control Specifies whether overlapping lines overwrite (the top line
hides the bottom line) or merge (the colors of the lines blend together).

DWF Data Options
Lists and allows you to specify the data that you can optionally include in the
published file.

Password Protection Specifies options for protecting DWF, DWFx, or PDF
files with passwords.

Block Information Specifies whether block property and attribute information
is included in the published DWF, DWEX, or PDF files.

NOTE You must set block information to Include in order for block template file
information to be available.

Block Template File Allows you to create a new block template (DXE) file,
edit an existing block template file, or use the settings of a previously created
block template file.

Create opens the Publish Block Template dialog box on page 1470, in which
you can create a new block template.

Edit opens the Select Block Template dialog box (a standard file selection
dialog box on page 1225), in which you can select an existing block template
to modify.
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B Commands

BACKGROUND

Quick Reference

Obsolete. BACKGROUND functionality has been merged into the VIEW
command.

EE Command entry: background

The Background dialog box on page 1913 is displayed

BACTION

Quick Reference
Adds an action to a dynamic block definition.

Access Methods
EE Command entry: bedit » baction

Summary

You can only use the BACTION command in the Block Editor on page 219.
Actions define how the geometry of a dynamic block reference moves or changes
when the custom properties of a block reference are manipulated in a drawing.
You associate actions with parameters.
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List of Prompts
The following prompts are displayed.

Select parameter: Select a parameter in the block definition with which to associate
the action

Select action type [Array on page 176/Move on page 176/Scale on page 177/sTretch
on page 179/Polar Stretch on page 180]: Select an action type to associate with the
parameter (the available action types depend on the type of parameter selected)

If you select a rotation parameter, a rotate on page 180 action is added to the
dynamic block definition and associated with the selected parameter.

If you select a flip parameter, a flip on page 181 action is added to the dynamic
block definition and associated with the selected parameter.

If you select a lookup parameter, a lookup on page 181 action is added to the
dynamic block definition and associated with the selected parameter.

Array

Adds an array action to the current dynamic block definition. An array action
can be associated with a linear, polar, or XY parameter. Specifies that the
selection set of objects will array when the action is triggered in a dynamic
block reference.

Specify selection set for action
Select objects: Select objects for the action's selection set
If you selected a linear or polar parameter, the following prompts are displayed:

Enter the distance between columns (lll): Enter a value for the distance between
the columns of arrayed objects

If you selected an XY parameter, the following prompts are displayed:

Enter the distance between rows or specify unit cell (---): Enter a value for the
distance between the rows or enter two values separated by a comma for each of the
two points for a unit cell for the arrayed objects

Enter the distance between columns (lll): Enter a value for the distance between
the columns of arrayed objects

Move

Adds a move action to the current dynamic block definition. A move action
can be associated with a point, linear, polar, or XY parameter. Specifies that
the selection set of objects will move when the action is triggered in a dynamic
block reference.

If you selected a point parameter, the following prompts are displayed:
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Specify selection set for action
Select objects: Select objects for the action's selection set

Specify action location or [Multiplier/Offset]: Specify a location in the block
definition

If you selected a linear or polar parameter, the following prompts are displayed:
Specify parameter point to associate with action or enter [sTart point/Second

point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify selection set for action
Select objects: Select objects for the action's selection set

Specify action location [Multiplier/Offset]: Specify a location in the block definition
for the action

If you selected an XY parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [Base point/Second
point/Xcorner/Ycorner| <Xcorner>: Specify a parameter point to associate with
the action or press Enter to associate the action with the X corner

Specify selection set for action
Select objects: Select objects for the action's selection set

Specify action location or [Multiplier/Offset/XY]: Specify a location in the block
definition for the action

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000
Offset Increases or decreases by a specified number the angle of the associated
parameter when the action is triggered.

Enter angle offset <0>: Enter a value or press Enter to select 0

XY Specifies whether the distance that is applied to the action is the XY

parameter's X distance, Y distance, or XY distance from the parameter's base
point.

Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Scale
Adds a scale action to the current dynamic block definition. A scale action
can only be associated with a linear, polar, or XY parameter. Specifies that the
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selection set of objects will scale relative to the base point defined by the scale
action when the action is triggered in a dynamic block reference.

If you selected a linear or polar parameter, the following prompts are displayed:
Specify selection set for action
Select objects: Select objects for the action's selection set

Specify action location or [Base type]: Specify a location in the block definition for
the action or enter base type to specify the type of base point

If you selected an XY parameter, the following prompts are displayed:

Select parameter: Select a parameter in the block definition to associate with the
action

Specify selection set for action
Select objects: Select objects for the action's selection set

Specify action location or [Base type/XY]: Specify a location in the block definition
for the action, enter base type to specify the type of base point, or enter xy to specify
the distance type

Base Type
Specifies the type of base point to use for the action.

Enter base point type [Dependent/Independent] <Dependent>: Enter the type
of base point for the action or press Enter to use a dependent base point
Dependent Specifies that the dynamic block reference is scaled relative to the
base point of the parameter with which the scale action is associated. An offset
can be specified for the base point, which is maintained relative to the
parameter.

Specify base point location <0,0>: Enter two values separated by a comma or press
Enter to select 0,0

Independent Specifies that the dynamic block reference is scaled relative to
an independent base point you specify. An independent base point is shown
in the Block Editor as an X marker.

Specify base point location <XY location of associated parameter's base point>:
Enter two values separated by a comma or press Enter to select the location of the
associated parameter's base point

XY

Specifies whether the distance applied to the action is the XY parameter's X
distance, Y distance, or XY distance from the parameter's base point.
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Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Stretch

Adds a stretch action to the current dynamic block definition. A stretch action
can be associated with a point, linear, polar, or XY parameter. Specifies that
the selection set of objects will stretch or move when the action is triggered
in a dynamic block reference.

If you selected a linear or polar parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [sTart point/Second
point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame

Specify opposite corner: Specify the opposite corner of the stretch frame
Specify objects to stretch
Select objects: Select objects to add to or remove from the action's selection set

Specify action location or [Multiplier/Offset]: Specify a location in the block
definition for the action

If you selected an XY parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [Base point/Second
point/Xcorner/Ycorner| <Xcorner>: Specify a parameter point to associate with
the action or press Enter to associate the action with the X corner

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame

Specify opposite corner: Specify the opposite corner of the stretch frame
Specify objects to stretch
Select objects: Select objects to add to or remove from the action's selection set

Specify action location or [Multiplier/Offset/XY]: Specify a location in the block
definition for the action.

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000

Offset Increases or decreases the angle of the associated parameter, by a
specified number, when the action is triggered.
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Enter angle offset <0>: Enter a value or press Enter to select 0

XY Specifies whether the distance that is applied to the action is the XY
parameter's X distance, Y distance, or XY distance from the parameter's base
point.

Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Polar Stretch

Adds a polar stretch action to the current dynamic block definition. A polar
stretch action can only be associated with a polar parameter. Specifies that
the selection set of objects will stretch or move when the action is triggered
in a dynamic block reference.

Specify parameter point to associate with action or enter [sTart point/Second
point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame

Specify opposite corner: Specify the opposite corner of the stretch frame

Specify objects to stretch

Select objects: Select objects to add to the action's selection set for the stretch action
Specify objects to rotate only

Select objects: Select objects that will rotate only and not stretch

Specify action location or [Multiplier/Offset]: Specify a location in the block
definition for the action

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000
Offset Increases or decreases the angle of the associated parameter, by a
specified number, when the action is triggered.

Enter angle offset <0O>: Enter a value or press Enter to select 0

Rotate

Adds a rotate action to the current dynamic block definition. A rotate action
can only be associated with a rotation parameter. Specifies that the selection

set of objects will rotate when the action is triggered in a dynamic block
reference.

Specify selection set for action
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Select objects: Select objects for the action's selection set

Specify action location or [Base type]: Specify a location in the block definition for
the action or enter base type to specify the type of base point

Base Type
Specifies the type of base point to use for the action.

Enter base point type [Dependent/Independent] <Dependent>: Enter the type
of base point for the action or press Enter to use a dependent base point
Dependent Specifies that the dynamic block reference rotates about the
associated parameter's base point.

Specify base point location <current>: Enter two values separated by a comma or
press Enter to select the current location of the parameter's base point
Independent Specifies that the dynamic block reference rotates about a
specified base point.

Specify base point location <XY location of associated parameter's base point>:
Enter two values separated by a comma or press Enter to select the location of the
associated parameter's base point

Flip

Adds a flip action to the current dynamic block definition. A flip action can
only be associated with a flip parameter. Specifies that the selection set of

objects will flip around the reflection line of the flip parameter when the
action is triggered in a dynamic block reference.

Specify selection set for action
Select objects: Select objects for the action's selection set
Specify action location: Specify a location in the block definition for the action

Lookup

Adds a lookup action to the current dynamic block definition. A lookup action
can only be associated with a lookup parameter. When you add a lookup
action to the block definition, the Property Lookup Table dialog box on page
242 is displayed.

BACTIONBAR

Quick Reference

Displays or hides action bars for a selection set of parameter objects.
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Access Methods

4
€%
D\ g >

Point  Maove Attribute
T T Definition

<y Show All Actions

£y Hide All Actions

{1 Action Parameters

£ Ribbon: Block Editor tab » Action Parameters panel
EE Command entry: bedit » bactionbar

Summary

You can only use the BACTIONBAR command in the Block Editor on page
219 and when in Action Bar mode (BACTIONBARMODE on page 2037 system
variable is set to 1). The BACTIONBAR command controls the display of action
bars for parameter objects in the Block Editor. An action bar is a toolbar-like
element that displays the actions associated with a parameter object.

List of Prompts
The following prompts are displayed.

Select parameters to show actions or [Showall on page 182/Hideall on page
182/RESet] <Show all>: Specify a parameter to show or hide the action bars
Showall

--‘./.Uu

Displays all action bars for the parameter objects in the Block Editor. This is
the default option if no constraint bars are displayed.

Hideall

_,_'JI ~

~u
Hides all action bars for the parameter objects in the Block Editor. This is the
default option if any contraint bar is displayed.

Reset
Displays all action bars for the parameter objects in the Block Editor and resets

to the default position relative to the parameters they are associated with.
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BACTIONSET

Quick Reference

Specifies the selection set of objects associated with an action in a dynamic
block definition.

Access Methods

E Command entry: bedit » bactionset
Shortcut menu: Select an action in the block definition. Right-click in the
Block Editor drawing area. Click Action Selection Set, and then click an option.

NOTE The BACTIONSET command is disabled when the BACTIONBARMODE on
page 2037 system variable is set to 1.

Re-specifies the selection set of objects associated with an action by creating
a new selection set or by adding to or removing objects from the existing
selection set. You can only use the BACTIONSET command in the Block Editor
on page 219.

Select action: Select an action in the current dynamic block definition
Specify selection set for action object [New/Modify] <New>: Enter modify to
modify the existing selection set or press Enter to create a new selection set

New

If you selected a move, scale, rotate, flip, or array action, the following prompt
is displayed:

Specify selection set for action
Select objects: Select objects for the new selection set and then press Enter

If you selected a stretch action, the following prompts are displayed:

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Select objects to stretch

Select objects: Select objects for the new selection set and then press Enter

If you selected a polar stretch action, the following prompts are displayed:

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame
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Specify objects to stretch

Select objects: Select objects to stretch

Specify objects to rotate only

Select objects: Select objects that will rotate only and not stretch

Modify

If you selected a move, scale, rotate, flip, or array action, the following prompt
is displayed:

Select objects to add to action set or [Remove]: Select objects to add to or remove
from the action's selection set that will rotate only and not stretch

If you selected a stretch action, the following prompts are displayed:

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Select objects to stretch

Select objects to add to action set or [Remove]: Select objects to add to or remove
from the action's selection set

If you selected a polar stretch action, the following prompts are displayed:

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Specify objects to stretch

Select objects to add to action set or [Remove]: Select objects to add to or remove
from the action's selection set

Specify objects to rotate only

Select objects to add to action set or [Remove]: Select objects to add to or remove
from the action's selection set that will rotate only and not stretch

BACTIONTOOL

Quick Reference

Adds an action to a dynamic block definition.
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Access Methods

|

Point Maove Attribute
i i Definition

Action Parameters =

£ Ribbon: Block Editor tab » Action Parameters panel
E Command entry: bedit » bactiontool

Summary

The BACTIONTOOL command is used in the Block Editor on page 219 by action
tools on the Actions tab of the Block Authoring palettes. Actions define how
the geometry of a dynamic block reference moves or changes when the custom
properties of a block reference are manipulated in a drawing. You associate
actions with parameters.

List of Prompts
The following prompts are displayed.
Select action type [Array/Lookup/Flip/Move/Rotate/Scale/sTretch/Polar stretch]:

Array

Oz

0d

Adds an array action to the current dynamic block definition. An array action
can be associated with a linear, polar, or XY parameter. Specifies that the
selection set of objects arrays when the action is triggered in a dynamic block
reference.

Select parameter: Select a parameter in the block definition to associate with the
action

Specify selection set for action

Select objects: Select objects for the action's selection set

If you selected a linear or polar parameter, the following prompts are displayed:

Enter the distance between columns (lll): Enter a value for the distance between
the columns of arrayed objects

Specify opposite corner: Specify a distance between columns or rows

Specify action location: Specify a location in the block definition for the action

If you selected an XY parameter, the following prompts are displayed:
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Enter the distance between rows or specify unit cell (---): Enter a value for the
distance between the rows or enter two values separated by a comma for each of the
two points for a unit cell for the arrayed objects

Enter the distance between columns (lll): Enter a value for the distance between
the columns of arrayed objects

Specify action location: Specify a location in the block definition for the action

Lookup

L

Adds a lookup action to the current dynamic block definition. A lookup action
can only be associated with a lookup parameter. When you add a lookup
action to the block definition, the Property Lookup Table dialog box on page
242 is displayed.

Select parameter: Select a lookup parameter
Flip
Dl

Adds a flip action to the current dynamic block definition. A flip action can
only be associated with a flip parameter. Specifies that the selection set of
objects flips when the action is triggered in a dynamic block reference.

Select parameter: Select a parameter in the block definition to associate with the
action

Specify selection set for action

Select objects: Select objects for the action's selection set

Move

£

+
+o%
*f

Adds a move action to the current dynamic block definition. A move action
can be associated with a point, linear, polar, or XY parameter. Specifies that
the selection set of objects moves when the action is triggered in a dynamic
block reference.

Select parameter: Select a parameter in the block definition to associate with the
action

If you selected a point parameter, the following prompts are displayed:

Specify selection set for action
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Select objects: Select objects for the action's selection set
Specify action location or [Multiplier/Offset]: Specify a location in the block
definition for the action

If you selected a linear or polar parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [sTart point/Second
point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify selection set for action

Select objects: Select objects for the action's selection set

Specify action location or [Multiplier/Offset]: Specify a location in the block
definition for the action

If you selected an XY parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [Base Point/Second
point/Xcorner/Ycorner] <Second>: Specify a parameter point to associate with the
action or press Enter to associate the action with the second point

Specify selection set for action

Select objects: Select objects for the action's selection set

Specify action location or [Multiplier/Offset/XY]: Specify a location in the block
definition for the action

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000
Offset Increases or decreases the angle of the associated parameter, by a
specified number, when the action is triggered.

Enter angle offset <0>: Enter a value or press Enter to select 0

XY Specifies whether the distance applied to the action is the XY parameter's
X distance, Y distance, or XY distance from the parameter's base point.

Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Rotate

G

Adds a rotate action to the current dynamic block definition. A rotate action
can only be associated with a rotation parameter. Specifies that the selection
set of objects rotates when the action is triggered in a dynamic block reference.

Select parameter: Select a parameter in the block definition to associate with the
action
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Specify selection set for action

Select objects: Select objects for the action's selection set

Specify action location or [Base type]: Specify a location in the block definition for
the action or enter base type to specify the type of the base point

Base Type
Specifies the type of base point to use for the action.

Enter base point type [Dependent/Independent] <Dependent>: Enter the type
of base point for the action or press Enter to use a dependent base point
Dependent Specifies that the dynamic block reference rotates about the
associated parameter's base point.

Specify base point location <current>: Enter two values separated by a comma or
press Enter to select the current location of the parameter's base point

Independent Specifies that the dynamic block reference rotates about a
specified base point.

Specify base point location <XY location of associated parameter's base point>:
Enter two values separated by a comma or press Enter to select the location of the
associated parameter's base point

Scale

=

O

Adds a scale action to the current dynamic block definition. A scale action
can only be associated with a linear, polar, or XY parameter. Specifies that the

selection set of objects scales when the action is triggered in a dynamic block
reference.

If you selected a linear or polar parameter, the following prompts are displayed:

Select parameter: Select a parameter in the block definition to associate with the
action

Specify selection set for action

Select objects: Select objects for the action's selection set

Specify action location or [Base type]: Specify a location in the block definition for
the action or enter base type to specify the type of base point

If you selected an XY parameter, the following prompts are displayed:

Select parameter: Select a parameter in the block definition to associate with the
action

Specify selection set for action

Select objects: Select objects for the action's selection set
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Specify action location or [Base type/XY]: Specify a location in the block definition
for the action, enter base type to specify the type of base point, or enter xy to specify
the distance type

Base Type
Specifies the type of base point to use for the action.

Enter base point type [Dependent/Independent] <Dependent>: Enter the type
of base point for the action or press Enter to use a dependent base point
Dependent Specifies that the dynamic block reference is scaled relative to the
base point of the parameter with which the scale action is associated. An offset
can be specified for the base point, which is maintained relative to the
parameter.

Specify base point location <0,0>: Enter two values separated by a comma or press
Enter to select 0,0

Independent Specifies that the dynamic block reference is scaled relative to
an independent base point you specify. An independent base point is shown
in the Block Editor as an X marker.

Specify base point location <XY location of associated parameter's base point>:
Enter two values separated by a comma or press Enter to select the location of the
associated parameter's base point

XY

Specifies whether the distance that is applied to the action is the XY parameter's
X distance, Y distance, or XY distance from the parameter's base point.

Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Stretch
-
[X
Adds a stretch action to the current dynamic block definition. A stretch action
can be associated with a point, linear, polar, or XY parameter. Specifies that

the selection set of objects will stretch or move when the action is triggered
in a dynamic block reference.

Select parameter: Select a parameter in the block definition to associate with the
action

If you selected a linear or polar parameter, the following prompts are displayed:
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Specify parameter point to associate with action or enter [sTart point/Second
point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Specify objects to stretch

Select objects: Select objects to add to or remove from the action's selection set
Specify action location or [Multiplier/Offset]: Specify a location in the block
definition for the action

If you selected an XY parameter, the following prompts are displayed:

Specify parameter point to associate with action or enter [sTart point/Second
point/Xcorner/Ycorner] <Xcorner>: Specify a parameter point to associate with
the action or press Enter to associate the action with the X corner

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Specify objects to stretch

Select objects: Select objects to add to or remove from the action's selection set
Specify action location or [Multiplier/Offset/XY]: Specify a location in the block
definition for the action.

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000
Offset Increases or decreases the angle of the associated parameter, by a
specified number, when the action is triggered.

Enter angle offset <O>: Enter a value or press Enter to select 0

XY Specifies whether the distance applied to the action is the XY parameter's
X distance, Y distance, or XY distance from the parameter's base point.

Enter XY distance type [X/Y/XY] <XY>: Enter the distance type or press Enter to
select XY

Polar Stretch

Adds a polar stretch action to the current dynamic block definition. A polar
stretch action can only be associated with a polar parameter. Specifies that
the selection set of objects stretches or moves when the action is triggered in
a dynamic block reference.
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BASE

Select parameter: Select a parameter in the block definition to associate with the
action

Specify parameter point to associate with action or enter [sTart point/Second
point] <Second>: Specify a parameter point to associate with the action or press
Enter to associate the action with the second point

Specify first corner of stretch frame or [CPolygon]: Specify the first corner of the
stretch frame or enter cpolygon to create a polygon of any shape as the stretch frame
Specify opposite corner: Specify the opposite corner of the stretch frame

Specify objects to stretch

Select objects: Select objects to add to or remove from the action's selection set
Specify objects to rotate only

Select objects: Select objects that will rotate only and not stretch

Specify action location or [Multiplier/Offset/XY]: Specify a location in the block
definition for the action.

Multiplier Changes the associated parameter value by a specified factor when
the action is triggered.

Enter distance multiplier <1.0000>: Enter a value or press Enter to select 1.0000

Offset Increases or decreases the angle of the associated parameter, by a
specified number, when the action is triggered.

Enter angle offset <O>: Enter a value or press Enter to select 0

Quick Reference

Sets the insertion base point for the current drawing.
Access Methods

Button

£ Ribbon: Insert tab » Block panel » Set Base Point

£ Menu: Draw » Block » Base
E2 Command entry: base (or 'base for transparent use)
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Summary

The base point is expressed as coordinates in the current UCS. When you
insert or externally reference the current drawing into other drawings, this
base point is used as the insertion base point.

List of Prompts
The following prompts are displayed.

Enter base point <current>: Specify a point or press Enter

BASSOCIATE

Quick Reference

Associates an action with a parameter in a dynamic block definition.

EE Command entry: bedit » bassociate

NOTE The BASSOCIATE command is disabled when the BACTIONBARMODE on
page 2037 system variable is set to 1.

Associates an orphaned action with a parameter. You can only use the
BASSOCIATE command in the Block Editor on page 219. An action becomes
orphaned when the parameter with which it is associated is removed from
the block definition.

Select action object: Select an action in the current block definition that is not
associated with a parameter

Select parameter to associate with action: Select a parameter to associate with
the action (if you selected a lookup action, you can select one or more lookup
parameters)

If you selected an action and parameter combination that requires that the
action be associated with a key point on the parameter, prompts are displayed
to select the parameter point to associate with the action.
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BATTMAN

Quick Reference

Manages the attributes for a selected block definition.

£ Ribbon: Insert tab » Attributes panel » Manage
£ Menu: Modify » Object » Attribute » Block Attribute Manager

£ Toolbar: Modify II N
E: Command entry: battman

Summary

The Block Attribute Manager is displayed.

If the current drawing does not contain any blocks with attributes, a message
is displayed.

This command controls all attribute properties and settings of a selected block
definition. Any changes to the attributes in a block definition are reflected in
the block references.

Block Attribute Manager

Quick Reference

Access Methods

s

L

Button

£ Ribbon: Insert tab » Attributes panel » Manage
£ Menu: Modify » Object » Attribute » Block Attribute Manager

£ Toolbar: Modify II
EE Command entry: battman
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Summary

Manages the attribute definitions for blocks in the current drawing. You can
edit the attribute definitions in blocks, remove attributes from blocks, and
change the order in which you are prompted for attribute values when inserting

a block.
A Block Attribute Manager ==
| select block Bock: [door x| [ Sme
Tag Prompt Defautt Modes Move Up
DOOR1 Enter value of door L -
Edt
“ T 3 S
Found in drawing: 1 Found in model space: 1
[ Setings.. || Aoh | [ 0K [ Caesl | [ b |

Attributes of the selected block are displayed in the attribute list. By default,
Tag, Prompt, Default, Mode, and Annotative attribute properties are displayed
in the attribute list. You can specify which attribute properties you want
displayed in the list by choosing Settings.

For each selected block, a description below the attribute list identifies the
number of its instances in the current drawing and in the current layout.

Select Block

Allows you to use your pointing device to select a block from the drawing
area. When you choose Select Block, the dialog box closes until you select a
block from the drawing or cancel by pressing ESC.

If you modify attributes of a block and then select a new block before you
save the attribute changes you made, you are prompted to save the changes
before selecting another block.

Block

Lists all block definitions in the current drawing that have attributes. Select
the block whose attributes you want to modity.

List of Attributes

Displays the properties of each attribute in the selected block.

Blocks Found in Drawing

The number of instances of the selected block in the current drawing.

Blocks Found in Current Space
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The number of instances of the selected block in the current model space or
layout.

Sync

Updates all instances of the selected block with the attribute properties
currently defined. This does not affect any values assigned to attributes in
each block.

Move Up

Moves the selected attribute tag earlier in the prompt sequence. The Move Up
button is not available when a constant attribute is selected.

Move Down

Moves the selected attribute tag later in the prompt sequence. The Move Down
button is not available when a constant attribute is selected.

Edit
Opens the Edit Attribute dialog box, where you can modify attribute properties.
Remove

Removes the selected attribute from the block definition. If Apply Changes

to Existing References is selected in the Settings dialog box before you choose
Remove, the attribute is removed from all instances of the block in the current
drawing. The Remove button is not available for blocks with only one attribute.

Settings

Opens the Block Attribute Settings dialog box, where you can customize how
attribute information is listed in the Block Attribute Manager.

Apply

Applies the changes you made, but leaves the dialog box open.
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Edit Attribute Dialog Box

Quick Reference

Access Methods

oy

L

Button

£ Ribbon: Insert tab » Attributes panel » Manage

£ Menu: Modify » Object » Attribute » Block Attribute Manager
£ Toolbar: Modify II

E Command entry: battman

List of Options

Allows you to edit attributes for a block definition.

Block Name

Displays the name of the block whose attributes are to be edited.
Auto Preview Changes

Controls whether or not the drawing area is immediately updated to display
any visible attribute changes you make. If Auto Preview Changes is selected,
changes are immediately visible. If Auto Preview Changes is cleared, changes
are not immediately visible.

Clearing Auto Preview Changes results in a small improvement in performance.
Auto Preview Changes is not available if Apply Changes to Existing References
is not selected.

The Edit Attribute dialog box contains the following tabs:
B Attribute on page 197
B Text Options on page 198

W Properties on page 199
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Attribute Tab (Edit Attribute Dialog Box)

Defines how a value is assigned to an attribute and whether or not the assigned
value is visible in the drawing area, and sets the string that prompts users to
enter a value. The Attribute tab also displays the tag name that identifies the
attribute.

A Edit Attribute ==
Active Block: door

Attribute | Test Options | Properties

Mode Data
[ Invisible Tag: DOOR1

[ Vertty
[ Preset Default: |Doorl

Prompt:  Enter value of door

[ Muttiple lines

[¥] Auto preview changes OK ] l Cancel ] l Help

Mode
Mode options determine whether and how attribute text appears.
Invisible

Displays or hides the attribute in the drawing area. If selected, hides the
attribute value in the drawing area. If cleared, displays the attribute value.

Constant

Identifies whether the attribute is set to its default value. You cannot change
this property. If a check mark is shown in the check box, the attribute is set
to its default value and cannot be changed. If the check box is empty, you
can assign a value to the attribute.

Verify

Turns value verification on and off. If selected, prompts you to verify the
values you assign to the attribute when inserting a new instance of the block.
If this option is cleared, verification is not performed.

Preset

Turns default value assignment on and off. If selected, sets the attribute to its
default value when the block is inserted. If cleared, ignores the attribute's
default value and prompts you to enter a value when inserting the block.

Multiple Lines
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Indicates whether the attribute was defined as a Multiple Lines attribute and
can contain multiple lines of text.

Data

Data options set the attribute text that is displayed.

Tag

Sets the identifier assigned to the attribute.

Prompt

Sets the text for the prompt that is displayed when you insert the block.
Default

Sets the default value assigned to the attribute when you insert the block.

Text Options Tab (Edit Attribute Dialog Box)

Sets the properties that define the way an attribute's text is displayed in the
drawing. Change the color of attribute text on the Properties tab.

o Edit Attribute ==
Active Block: door

Attribute | Text Options |Fruuemes‘

Texd Stye: [Standard -

Justfication” | Left ~ | [] Backwards [] Upside dewn

Height: 00 13/64" Width Factor: 1"
Rotation: 0.00 Oblique Angle: 0.00
[7] Annotative ‘:i:‘
[¥] Auto preview changes [ QK ] I Cancel ] l Help

Text Style

Specifies the text style for attribute text. Default values for this text style are
assigned to the text properties displayed in this dialog box.

Justification

Specifies how attribute text is justified.
Height

Specifies the height of the attribute text.
Rotation

Specifies the rotation angle of the attribute text.
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Annotative

Specifies that the attribute is . Click the information icon to learn more about
annotative objects.

Backwards

Specifies whether or not the text is displayed backwards.
Upside Down

Specifies whether or not the text is displayed upside down.
Width Factor

Sets the character spacing for attribute text. Entering a value less than 1.0
condenses the text. Entering a value greater than 1.0 expands it.

Oblique Angle

Specifies the angle that attribute text is slanted away from its vertical axis.

Properties Tab (Edit Attribute Dialog Box)

Defines the layer that the attribute is on and the color, lineweight, and linetype
for the attribute's line. If the drawing uses plot styles, you can assign a plot
style to the attribute using the Properties tab.

A Edit Attribute ==
Active Block: door

Aitribute | Tent Options | Properties

o 8

Linetype: [E‘)'La)'er v]

Color:m Lineweight: | ——— Bylayer -

Plot style: 'ByLaﬂ,'er

[¥] Auto preview changes OK ] [ Cancel ] [ Help

Layer

Specifies the layer that the attribute is on.
Linetype

Specifies the linetype of attribute text.

Color
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Specifies the attribute's text color.
Plot Style
Specifies the plot style of the attribute.

If the current drawing uses color-dependent plot styles, the Plot Style list is
not available.

Lineweight
Specifies the lineweight of attribute text.

Changes you make to this option are not displayed if the LWDISPLAY system
variable is off.

Block Attribute Settings Dialog Box

Quick Reference

Access Methods

s

L

Button

£ Ribbon: Insert tab » Attributes panel » Manage

£ Menu: Modify » Object » Attribute » Block Attribute Manager
£ Toolbar: Modify II

EE Command entry: battman

Summary

Controls the appearance of the attribute list in the Block Attribute Manager.
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A0 Black Attribute Settings ==

Display in list
Tag Justification Layer
| Prompt Height Linetype
| Default Rotation Calor
V| Modes Width Factor Lineweight
V| Annotative Oblique Angle Flot style
Style Boundary Width

Select All Clear All

/| Emphasize duplicate tags
V| Apply changes to existing references

Display in List

Specifies the properties to be displayed in the attribute list. Only the selected
properties are displayed in the list. The Tag property is always selected.

Select All

Selects all properties.

Clear All

Clears all properties.
Emphasize Duplicate Tags

Turns duplicate tag emphasis on and off. If this option is selected, duplicate
attribute tags are displayed in red type in the attribute list. If this option is
cleared, duplicate tags are not emphasized in the attribute list.

Apply Changes to Existing References

Specifies whether or not to update all existing instances of the block whose
attributes you are modifying. If selected, updates all instances of the block
with the new attribute definitions. If cleared, updates only new instances of
the block with the new attribute definitions.

You can choose Sync in the Block Attribute Manager to apply changes
immediately to existing block instances. This temporarily overrides the Apply
Changes to Existing References option.
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BATTORDER

Quick Reference

Specifies the order of attributes for a block.
EE Command entry: bedit » battorder

Displays the Attribute Order dialog box, which controls the order in which
attributes are listed and prompted for when you insert or edit a block reference.
You can only use the BATTORDER command in the Block Editor on page 219.

Attribute Order Dialog Box

Quick Reference

EE Command entry: bedit » battorder

Specifies the order in which attributes are listed and prompted for when you
insert or edit a block reference.

P Attribute Order ==

Atribute Definitions:

[ ok || cancel |[ Hel

Attribute Definitions

Lists the attribute definitions in the current block.
Move Up

Moves the selected attribute definition up in the list.

Move Down
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Moves the selected attribute definition down in the list.

BAUTHORPALETTE

Quick Reference
Opens the Block Authoring Palettes window in the Block Editor.
Access Methods

B

Button

£ Ribbon: Block Editor tab » Manage panel » Authoring Palettes
EE Command entry: bedit » bauthorpalette

Summary

Displays the Block Authoring Palettes window in the Block Editor. You can
open the Block Authoring Palettes window only from the Block Editor. If you
enter bauthorpalette at the Command prompt while the Block Editor is closed,
the following message is displayed, “BAUTHORPALETTE command only
allowed in Block Editor.”

The Block Authoring Palettes window contains the following tabs:

Parameters tab

|

B Actions tab
B Parameter Sets tab
|

Constraints tab

BAUTHORPALETTECLOSE

Quick Reference

Closes the Block Authoring Palettes window in the Block Editor.
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Access Method

E: Command entry: bedit » bauthorpaletteclose

Summary

You can close the Block Authoring Palettes window only from the Block Editor.
If you enter bauthorpaletteclose at the Command prompt while you are not
in the Block Editor, the following message is displayed,
“BAUTHORPALETTECLOSE command only allowed in Block Editor.”

BCLOSE

Quick Reference
Closes the Block Editor.
Access Methods

X

Button
£ Ribbon: Block Editor tab » Close panel » Close Block Editor
E Command entry: bedit » bclose

Shortcut menu: In the Block Editor, right-click in the drawing area. Click
Close Block Editor

Summary

Closes the Block Editor. If you have modified the block definition since it was
last saved, you are prompted to save or discard the changes.

BCONSTRUCTION

Quick Reference

Converts geometry into construction geometry.
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Access Methods

o

Button

£ Ribbon: Block Editor tab » Constraint Parameters panel » Construction

2

Geometry.
EE Command entry: bedit » bconstruction

Summary

The BCONSTRUCTION command is used in the Block Editor on page 219 to
convert geometry into construction geometry. This command also controls
the display of construction geometry and changees construction geometry
back to regular geometry.

Construction geometry is not displayed in the block reference; in the Block
Editor it is displayed with a gray dashed linetype. You cannot modify the
color, linetype, or layer of the construction geometry.

List of Prompts
The following prompts are displayed.

Select objects or [Show all on page 205/Hide all on page 205]: Select objects to
convert or revert geometry

Enter an option [Convert/Revert] <Convert>: Specify an option

Convert

Converts the valid selected objects into construction geometry and displays
the number of objects converted. Authoring objects are not converted.

Revert
Changes the selected objects back to regular geometry. The geometry is set to
the current layer.

Show All

Displays all construction geometry.

Hide All
Hides all construction geometry.
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BCPARAMETER

Quick Reference

Applies constraint parameters to selected objects, or converts dimensional
constraints to parameter constraints.

Access Methods

b1 & o B

Linear  Aligned éﬁﬂ Block
i Table

Dimensional »

£ Ribbon: Block Editor tab » Dimensional panel

EE Command entry: bedit » bcparameter

Summary

The BCPARAMETER command is used in the Block Editor on page 219. This
command applies a constraint parameter to an object or between constraint
points on object(s).

List of Prompts

The following prompts are displayed.

Select a dimensional constraint or
[LInear/Horizontal/Vertical/Aligned/ANgular/Radius/Diameter] <last>: Specify
an option

Linear

Bl

Creates a horizontal or vertical constraint parameter based on the locations
of the extension line origins and the location of the dimension line similar
to the DIMLINEAR on page 570 command.

Specify first constraint point or [Object] <Object>: Select the first constraint point
or select an object

Specify second constraint point: Select the second constraint point

Specify dimension line location: Select dimension line location

206 | Chapter 3 B Commands



Enter value or name and value <d0=8.0000>: Specify the name and value of the
dynamic constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips

Horizontal

Bl

Creates a horizontal constraint parameter by picking two constraint points.
Valid objects include lines and polyline segments.

Specity first constraint point or [Object] <Object>: Select the first constraint point
or select an object

Specify second constraint point: Select the second constraint point
Specify dimension line location: Select dimension line location

Enter value or name and value <d1=4.0000>: Specify the name and value of the
horizontal constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips

Vertical

al

Creates a vertical constraint parameter by picking two constraint points. Valid
objects include lines and polyline segments.

Specify first constraint point or [Object] <Object>: Select the first constraint point
or select an object

Specify second constraint point: Select the second constraint point
Specify dimension line location: Select dimension line location

Enter value or name and value <d1=4.0000>: Specify the name and value of the
vertical constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
Aligned

8y

Creates an aligned constraint parameter using one of the following 4 ways.

B Two constraint points
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Specify first constraint point or [Object/Point & line/2Lines] <Object>:
Select the first constraint point or select an object

Specify second constraint point: Select the second constraint point
Specify dimension line location: Select dimension line location
Enter value or name and value <d1=4.0000>: Specify the name and value of
the dimensional constraint
B A single object
Select object: Select an object
Specify dimension line location: Select dimension line location

Enter value or name and value <d1=4.0000>: Specify the name and value of
the dimensional constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
B A constraint point and a line

Specify constraint point or [Line] <Line>: Select an object to specify a constraint
point on it

Select line: Select a line
Specify dimension line location: Specify the dimension line location

Enter value or name and value <d1=4.0000>: Specify the name and value of
the dimensional constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
Or

Specify first constraint point or [Line] <Line>: Press Enter to specify the line
first

Enter
Select line: Select a line

Select constraint point: Select a constraint point
Specify dimension line location: Select dimension line location

Enter value or name and value <d1=4.0000>: Specify the name and value of
the dimensional constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
B Two lines
Select first line: Select the first line
Select second line to make parallel: Select the second line
Specify dimension line location: Specify the dimension line location
Enter number of grips [0/1/2] <1>: Specify the number of grips
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Angular

&\

Creates an angular constraint parameter by picking two lines or polyline
segments or an arc. It is similiar to an angular dimension.

B Two lines
Select first line or arc or [3Point]: Select the first line

Select second line: Select the second line
Specify dimension arc line location: Select the dimension arc line location

Enter value or name and value <ang1=45>: Specify the name and value of the
angular constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
B Polyline segments
Select first line or arc or [3Point]: Pick an arc
Specify dimension arc line location: Select the dimension arc line location

Enter value or name and value <ang1=45>: Specify the name and value of the
angular constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips
m 3Point
Select first line or arc or [3Point]: Enter 3Point
Specify angle vertex: Enter the vertex of the angle
Specify first angle constraint point: Select the first angle constraint point
Specify second angle constraint point: Select the second angle constraint point

Enter value or name and value <ang1=45>: Specify the name and value of the
angular constraint

Enter number of grips [0/1/2] <1>: Specify the number of grips

Radius

&)

Creates a radial constraint parameter for a circle, arc, or polyline arc segment.
Select arc or circle: Select an arc or a circle
Specify dimension line location: Select the dimension line location

Enter value or name and value <rad1=1.5000>: Specify the name and value of
the radial constraint

BCPARAMETER | 209



Enter number of grips [0/1] <1>: Specify the number of grips

Diameter

é\)

Creates a diameter constraint parameter for a circle, arc, or polyline arc
segment.

Select arc or circle: Select an arc or a circle
Specify dimension line location: Select the dimension line location

Enter value or name and value <dial=4.000>: Specify the name and value of the
diameter constraint

Enter number of grips [0/1/2] <2>: Specify the number of grips

BCYCLEORDER

Quick Reference

Changes the cycling order of grips for a dynamic block reference.
E Command entry: bedit » bcycleorder

Displays the Insertion Cycling Order dialog box. The BCYCLEORDER command
is available only in the Block Editor on page 219.

Insertion Cycling Order Dialog Box

Quick Reference

Specifies the grip-cycling order for the insertion point of a dynamic block
reference. When you insert a dynamic block reference in a drawing, you can
use the CTRL key to cycle through the grips that have cycling turned on in
the block definition. The grip you select as you cycle is used as the insertion
point for the block reference.
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BEDIT

T Inzertion Cycling COrder ==

Grip cycling list
Cyc... Parameter name Type Location Move Up
Visibilty State Visibilty Base Point
Lockup Lookup Base Foint
Cycling

oK ][ Cancel ][ Help

Grip Cycling List

Lists the grips in the dynamic block definition. A check mark in the cycling
column indicates that cycling is turned on for that grip.

Move Up
Moves the selected grip up in the cycling order for the dynamic block reference.
Move Down

Moves the selected grip down in the cycling order for the dynamic block
reference.

Cycling

Turns cycling on or off for the selected grip. A check mark in the cycling
column indicates that cycling is turned on for that grip.

Quick Reference
Opens the block definition in the Block Editor.
Access Methods
i
5
)

Button
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£ Ribbon: Home tab » Block panel » Block Editor. =~
i

4

R Toolbar: Standard = '

£ Menu: Tools » Block Editor

Shortcut menu: Select a block reference. Right-click in the drawing area.
Click Block Editor.

EE Command entry: bedit

Summary

The Edit Block Definition dialog box on page 212 is displayed. Select a block
definition to edit or enter a name for a new block definition to create, then
click OK to open the Block Editor. If the ribbon is active, the Block Editor
ribbon contextual tab on page 214 is displayed. Otherwise, the Block Editor
toolbar is displayed.

When the BLOCKEDITLOCK system variable is set to 1, the Block Editor cannot
be opened.

The Block Editor is a separate environment for creating and changing block
definitions for the current drawing. You can also use it to add dynamic
behavior to blocks.

Edit Block Definition Dialog Box

Quick Reference

Access Methods

§ Ribbon: Home tab » Block panel » Block Editor. =~
i

4

® Toolbar: Standard =~

£ Menu: Tools » Block Editor
EE Command entry: bedit
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Summary

In the Edit Block Definition dialog box, you can select from a list of block
definitions that are saved in the drawing to edit in the Block Editor. You can
also enter a name for a new block definition to create in the Block Editor.

When you click OK, the Edit Block Definition dialog box closes, and the Block
Editor is displayed. If you selected a block definition from the list in the Edit
Block Definition dialog box, that block definition is displayed and is available
for editing in the Block Editor. If you entered a name for a new block
definition, the Block Editor is displayed, and you can start adding objects to
the block definition.

P4 Edit Block Definition ==

Block to create or edit

CLAMP PLATE TV
3DECLIB -
4

Preview

A

AVE_GLOBAL
AVE_RENDER
CLAMP PLATE 5V
ICLAMP PLATE TV

N

INSERT AH
INSERT AV
INSERT B1 Description
INSERT C1
INSERT D1
INSERT E1
5-SPOUT = o

m

[ ok || cancel |[ Hel

List of Options
The following options are available in this dialog box.
Name

Specifies the name of the block to edit or create in the Block Editor. If you
select <Current Drawing>, the current drawing is opened in the Block Editor.
After you add dynamic elements to the drawing, you can then save it and
insert it as a dynamic block reference in a drawing.

Name List (Unlabeled)

Displays a list of block definitions that are saved in the current drawing. When
you select a block definition from the list, the name is displayed in the Name
box. When you click OK, this block definition is opened in the Block Editor.
When you select <Current Drawing>, the current drawing is opened in the
Block Editor.

Preview
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Displays a preview of the selected block definition. A lightning bolt icon
indicates that the block is a dynamic block.

Description

Displays the block definition description specified in the Block area of the
Properties palette in the Block Editor.

OK Opens the selected or new block definition in the Block Editor.

Block Editor Ribbon Contextual Tab

Quick Reference

Access Methods

£ Ribbon: Home tab » Block panel » Block Editor. o

£ Menu: Tools » Block Editor
EE Command entry: bedit
Shortcut menu: Select a block reference. Right-click in the drawing area.

Click Block Editor.

Open/Save Panel

Edit Block
Save Block

Test Block

Save As

Geometric Panel

Auto Constrain
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Opens the block definition in the Block Editor.
Saves the current block definition.

Displays a window within the Block Editor to test a dynamic
block.

Displays the Save Block As dialog box, in which you can save a
copy of the current block definition under a new name.

Applies geometric constraints to a selection set of objects based
on orientation of the objects relative to one another.



Coincident (GEOM-
CONSTRAINT on
page 790)

Colinear (GEOM-
CONSTRAINT on
page 790)

Concentric (GEOM-
CONSTRAINT on
page 790)

Fix (GEOMCON-
STRAINT on page
790)

Parallel (GEOMCON-
STRAINT on page
790)

Perpendicular (GEO-
MCONSTRAINT on
page 790)

Horizontal (GEOM-
CONSTRAINT on
page 790)

Vertical (GEOMCON-
STRAINT on page
790)

Tangent (GEOM-
CONSTRAINT on
page 790)

Smooth (GEOMCON-
STRAINT on page
790)

Symmetric (GEOM-
CONSTRAINT on
page 790)

Constrains two points together or a point to a curve (or exten-
sion of curve).

Causes two line segments to lie along the same line.

Constrains two arcs, circles, or ellipses to the same center point.

Locks points and curves in position.

Causes selected lines to lie parallel to each another. Parallel
constraints are applied between two objects.

Causes selected lines to lie 90 degrees to one another. Perpen-
dicular constraints are applied between two objects.

Causes lines or pairs of points to lie parallel to the X axis of the
current coordinate system.

Causes lines or pairs of points to lie parallel to the Y axis of the
current coordinate system.

Causes curves to be tangent to other curves. Tangential con-
straints are applied between two objects.

Creates a curvature continuous (G2) condition between two
splines that share a coincident endpoint.

Causes selected lines or circles to become symmetrically con-
strained about a selected line.
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Equal (GEOMCON-
STRAINT on page
790)

Show Constraints
Show All

Hide All

Constraint Settings

Dimensional Panel

Linear (BCPARAMET-
ER on page 206)

Horizontal (BCPARA-
METER on page 206)

Vertical (BCPARAMET-
ER on page 206)

Aligned (BCPARA-
METER on page 206)

Radius (BCPARAMET-
ER on page 206)

Diameter (BCPARA-
METER on page 206)

Angular (BCPARA-
METER on page 206)

Convert (BCPARA-
METER on page 206)

Block Table

Constraint Settings
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Resizes selected arcs and circles to the same radius, or selected
lines to the same length.

Displays relevant geometric constraints for selected objects.
Displays all geometric constraints applied in the drawing.
Hides all geometric constraints in the drawing.

Controls the display of geometric constraints on constraint bars.

Specifies a horizontal or vertical constraint based on the locations
of the extension line origins and the location of the dimension
line similar to the DIMLINEAR on page 570 command.

Specifies a horizontal constraint parameter by picking two con-
straint points.

Specifies a vertical constraint parameter by picking two constraint
points.

Specifies the dimensional constraint.

Specifies a radial constraint for a circle, arc, or polyarc segment.

Specifies a diameter constraint for a circle, arc, or polyarc seg-

ment.

Specifies an angular constraint by picking two lines or polyline
segments or an arc.

Converts a dimensional constraint into a constraint parameter.

Displays a dialog box to define variations of a block.

Controls the display of geometric constraints on constraint bars.



Manage Panel

Delete Constraints
Construction Geo-
metry

Block Constraint
Status

Parameters Manager
Authoring Palettes

Block Editor Settings

Removes all geometric and dimensional constraints from a selec-
tion set of objects.

Converts geometry into construction geometry.

Turns the constraint display status on and off and controls the
shading of objects based on their constraint level.

Controls the associative parameters used in the drawing.
Opens the Block Authoring Palettes window in the Block Editor.

Opens a dialog box where you can control the environment
settings of the Block Editor.

Action Parameters Panel

Point (BPARAMETER
on page 248)

Linear (BPARAMETER
on page 248)

Polar (BPARAMETER
on page 248)

XY (BPARAMETER on
page 248

Rotation (BPARAMET-
ER on page 248)

Flip (BPARAMETER
on page 248)

Alignment (BPARA-
METER on page 248)

Adds a point parameter to the current dynamic block definition
and defines custom X and Y properties for the block reference.

Adds a linear parameter to the current dynamic block definition
and defines a custom distance property for the block reference.

Adds a polar parameter to the current dynamic block definition
and defines custom distance and angle properties for the block
reference.

Adds an XY parameter to the current dynamic block definition
and defines custom horizontal and vertical distance properties
for the block reference.

Adds a rotation parameter to the current dynamic block defini-
tion and defines a custom angle property for the block reference.

Adds a flip parameter to the current dynamic block definition
and defines a custom flip property for the block reference.

Adds an alignment parameter to the current dynamic block
definition. Because the alignment parameter affects the entire
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Visibility (BPARAMET-
ER on page 248)

Lookup (BPARAMET-
ER on page 248)

Basepoint (BPARA-
METER on page 248)

Move (BACTION-
TOOL on page 184)

Stretch (BACTION-
TOOL on page 184)

Polar Stretch (BAC-
TIONTOOL on page
184)

Scale (BACTION-
TOOL on page 184)

Rotate (BACTION-
TOOL on page 184)

Flip (BACTIONTOOL
on page 184)

Array (BACTION-
TOOL on page 184)

Lookup (BACTION-
TOOL on page 184)

Attribute Definition

Show All Actions
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block, it is not necessary (or possible) to associate an action with
the alignment parameter.

Adds a visibility parameter to the current dynamic block defini-
tion and defines a custom visibility property for the block refer-

ence.

Adds a lookup parameter to the current dynamic block definition
and defines custom lookup properties for the block reference.

Adds a base point parameter to the current dynamic block
definition.
Adds a move action to the current dynamic block definition.

Adds a stretch action to the current dynamic block definition.

Adds a polar stretch action to the current dynamic block defini-
tion.

Adds a scale action to the current dynamic block definition.

Adds a rotate action to the current dynamic block definition.

Adds a flip action to the current dynamic block definition.

Adds a array action to the current dynamic block definition.

Adds a lookup action to the current dynamic block definition.

Creates an attribute definition for storing data in a block.

Displays all action bars for the parameter objects in the Block
Editor.



Hide All Actions Hides all action bars for the parameter objects in the Block Editor.

Visibility Panel

Visibility States Displays the Visibility States dialog box on page 281, in which
you can create, delete, rename, and make current visibility
states.

Visibility Mode Sets the BVMODE system variable, which dims or hides
objects made invisible for the current visibility state.

Make Visible Runs the BYSHOW command, so that you can make objects
visible for the current visibility state or for all visibility states.

Make Invisible Runs the BVHIDE command, so that you can make objects
invisible for the current visibility state or for all visibility
states.

Block Visibility States Specifies the current visibility state displayed in the Block
Editor.

Close Panel

Close Ends the BEDIT command and closes the Block Editor ribbon contextual tab.

Block

Editor

Block Editor

Quick Reference

Access Methods

£ Ribbon: Home tab » Block panel » Block Editor. =
i
4
£ Toolbar: Standard ~

Shortcut menu: Select a block reference. Right-click in the drawing area.
Click Block Editor.
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£ Menu: Tools » Block Editor
E Command entry: bedit

You use the Block Editor to define dynamic behavior for a block definition.
In the Block Editor, you add parameters and actions, which define custom
properties and dynamic behavior. The Block Editor contains a special authoring
area in which you can draw and edit geometry as you would in the drawing
area.

The following commands are used for creating dynamic blocks and are available
only in the Block Editor:

BACTION

BACTIONBAR on page 181
BACTIONSET
BACTIONTOOL
BASSOCIATE

BATTORDER

|

|

|

|

|

|

B BAUTHORPALETTE

B BAUTHORPALETTECLOSE
m BCLOSE

B BCPARAMETER on page 206
B BCYCLEORDER

B BCONSTRUCTION on page 204
|

BGRIPSET
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BLOOKUPTABLE
BPARAMETER

BSAVE

BSAVEAS

BTABLE on page 273
BTESTBLOCK on page 278
BVHIDE

BVSHOW

BVSTATE
When the BLOCKEDITLOCK system variable is set to 1, the Block Editor cannot
be opened.

The Block Editor also provides a Block Editor toolbar and Block Authoring
palettes that contain tools for creating dynamic blocks. The Block Authoring
Palettes window contains the following tabs:

B Parameters tab on page 223

B Actions tab on page 225

B Parameter Sets tab on page 226
B Constraints tab on page 228
Block Editor Toolbar

Provides tools for working in the Block Editor, creating dynamic blocks, and
working with visibility states.

The Block Editor toolbar is displayed when the ribbon is not active. It is also
displayed only when you enter the Block Editor with the ribbon closed.
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Edit or Create Block Definition Displays the Edit Block Definition dialog
box.

Save Block Definition Saves the current Block Definition.

Save Block As Displays the Save Block As dialog box, in which you can save
a copy of the current block definition under a new name.
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Name Displays the name of the current block definition.

Test Block Runs the BTESTBLOCK on page 278 command, which opens an
external window from the Block Editor to test a dynamic block.

Automatically Constrain Objects Runs the AUTOCONSTRAIN on page 170
command, which applies geometric constraints to a selection set of objects
based on orientation of the objects relative to one another.

Apply Geometric Constraint Runs the GEOMCONSTRAINT on page 790
command, which applies geometric relationships between objects or points
on objects.

Display / Hide Constraints Bar Runs the CONSTRAINTBAR on page 346
command, which displays or hides the available geometric constraints on an
object.

Parameter Constraint Runs the BCPARAMETER on page 206 command, which
applies constraint parameters to selected objects, or converts dimensional
constraints to parameter constraints.

Block Table Runs the BTABLE on page 273 command, which displays a dialog
box to define variations of a block.

Parameter Runs the BPARAMETER command, which adds a parameter to the
dynamic block definition.

Action Runs the BACTION command, which adds an action to the dynamic
block definition.

Define Attribute Displays the Attribute Definition dialog box, in which you
can define the mode, attribute tag, prompt, value, insertion point, and text
options for an attribute.

Authoring Palettes Executes the BAUTHORPALETTE on page 203 command
when the Authoring Palettes is inactive. Otherwise, the
BAUTHORPALETTECLOSE on page 203 command is executed.

Parameters Manager Executes the PARAMETERS on page 1325 command when
the Parameters Manager is inactive. Otherwise, the PARAMETERSCLOSE on
page 1334 command is executed.

Learn About Dynamic Blocks Displays demonstrations in the New Features
Workshop for creating dynamic blocks.

Close Block Editor Runs the BCLOSE on page 204 command, which closes
the Block Editor and prompts you to save or discard any changes to the current
block definition.
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Visibility Mode Sets the BVMODE system variable, which dims or hides
objects made invisible for the current visibility state.

Make Visible Runs the BVSHOW command, so that you can make objects
visible for the current visibility state or for all visibility states.

Make Invisible Runs the BVHIDE command, so that you can make objects
invisible for the current visibility state or for all visibility states.

Manage Visibility States Displays the Visibility States dialog box on page 281,
in which you can create, delete, rename, and make current visibility states.

Visibility State Specifies the current visibility state displayed in the Block
Editor.

Parameters Tab (Block Authoring Palettes Window)

Provides tools for adding parameters to a dynamic block definition in the
Block Editor. Parameters specify positions, distances, and angles for geometry
in the block reference. When you add a parameter to a dynamic block
definition, it defines one or more custom properties for the block.

Point Parameter Runs the BPARAMETER command, Point parameter option,
which adds a point parameter to the dynamic block definition and defines
custom X and Y properties for the block reference. A point parameter defines
an X and Y location in the drawing. In the Block Editor, a point parameter
looks similar to an ordinate dimension.

Linear Parameter Runs the BPARAMETER command, Linear parameter option,
which adds a linear parameter to the dynamic block definition and defines a
custom distance property for the block reference. A linear parameter shows
the distance between two anchor points. A linear parameter constrains grip
movement along a preset angle. In the Block Editor, a linear parameter looks
similar to an aligned dimension.

Polar Parameter Runs the BPARAMETER command, Polar parameter option,
which adds a polar parameter to the dynamic block definition and defines
custom distance and angle properties for the block reference. A polar parameter
shows the distance between two anchor points and displays an angle value.
You can use both grips and the Properties palette to change both the distance
value and the angle. In the Block Editor, a polar parameter looks similar to an
aligned dimension.

XY Parameter Runs the BPARAMETER command, XY parameter option, which
adds an XY parameter to the dynamic block definition and defines custom
horizontal and vertical distance properties for the block reference. An XY
parameter shows the X and Y distances from the base point of the parameter.
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In the Block Editor, an XY parameter displays as a pair of dimensions
(horizontal and vertical). These dimensions share a common base point.

Rotation Parameter Runs the BPARAMETER command, Rotation parameter
option, which adds a rotation parameter to the dynamic block definition and
defines a custom angle property for the block reference. A rotation parameter
defines an angle. In the Block Editor, a rotation parameter displays as a circle.

Alignment Parameter Runs the BPARAMETER command, Alignment
parameter option, which adds an alignment parameter to the dynamic block
definition. An alignment parameter defines an X and Y location and an angle.
An alignment parameter always applies to the entire block and needs no action
associated with it. An alignment parameter allows the block reference to
automatically rotate around a point to align with other objects in the drawing.
An alignment parameter affects the angle property of the block reference. In
the Block Editor, an alignment parameter looks like an alignment line.

Flip Parameter Runs the BPARAMETER command, Flip parameter option,
which adds a flip parameter to the dynamic block definition and defines a
custom flip property for the block reference. A flip parameter flips objects. In
the Block Editor, a flip parameter displays as a reflection line. Objects can be
flipped about this reflection line. A flip parameter displays a value that shows
if the block reference has been flipped or not.

Visibility Parameter Runs the BPARAMETER command, Visibility parameter
option, which adds a visibility parameter to the dynamic block definition and
defines a custom visibility property for the block reference. With visibility
parameter, you can create visibility states and control the visibility of objects
in the block. A visibility parameter always applies to the entire block and
needs no action associated with it. In a drawing, you click the grip to display
a list of visibility states available for the block reference. In the Block Editor,
a visibility parameter displays as text with an associated grip.

Lookup Parameter Runs the BPARAMETER command, Lookup parameter
option, which adds a lookup parameter to the dynamic block definition and
defines custom lookup properties for the block reference. A lookup parameter
defines a custom property that you can specify or set to evaluate to a value
from a list or table you define. It can be associated with a single lookup grip.
In the block reference, you click the grip to display a list of available values.
In the Block Editor, a lookup parameter displays as text.

Base Point Parameter Runs the BPARAMETER command, Base Point parameter
option, which adds a base point parameter to the dynamic block definition.
A base point parameter defines a base point for the dynamic block reference
relative to the geometry in the block. A base point parameter cannot be
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associated with any actions, but can belong to an action's selection set. In the
Block Editor, a base point parameter displays as a circle with crosshairs

Actions Tab (Block Authoring Palettes Window)

Provides tools for adding actions to a dynamic block definition in the Block
Editor. Actions define how the geometry of a dynamic block reference move
or change when the custom properties of a block reference are manipulated
in a drawing. You associate actions with parameters.

Move Action Runs the BACTIONTOOL command, Move action option, which
adds a move action to the dynamic block definition when you associate the
action with a point, linear, polar, or XY parameter. A move action is similar
to the MOVE command. In a dynamic block reference, a move action causes
objects to move a specified distance and angle.

Scale Action Runs the BACTIONTOOL command, Scale action option, which
adds a scale action to the dynamic block definition when you associate the
action with a linear, polar, or XY parameter. A scale action is similar to the
SCALE command. In a dynamic block reference, a scale action causes its
selection set to scale when the associated parameter is edited by moving grips
or by using the Properties palette.

Stretch Action Runs the BACTIONTOOL command, Stretch action option,
which adds a stretch action to the dynamic block definition when you associate
the action with a point, linear, polar, or XY parameter. A stretch action causes
objects to move and stretch a specified distance in a specified location.

Polar Stretch Action Runs the BACTIONTOOL command, Polar Stretch action
option, which adds a polar stretch action to the dynamic block definition
when you associate the action with a polar parameter. A polar stretch action
rotates, moves, and stretches objects a specified angle and distance when the
key point on the associated polar parameter is changed through a grip or the
Properties palette

Rotate Action Runs the BACTIONTOOL command, Rotate action option,
which adds a rotate action to the dynamic block definition when you associate
the action with a rotation parameter. A rotate action is similar to the ROTATE
command. In a dynamic block reference, a rotate action causes its associated
objects to rotate when the associated parameter is edited through a grip or
the Properties palette.

Flip Action Runs the BACTIONTOOL command, Flip action option, which
adds a flip action to the dynamic block definition when you associate the
action with a flip parameter. With a flip action you can flip a dynamic block
reference about a specified axis called a reflection line.
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Array Action Runs the BACTIONTOOL command, Array action, which adds
an array action to the dynamic block definition when you associate the action
with a linear, polar, or XY parameter. An array action causes its associated
objects to copy and array in a rectangular pattern when the associated
parameter is edited through a grip or the Properties palette.

Lookup Action Runs the BACTIONTOOL command, Lookup action option,
which adds a lookup action to the dynamic block definition. When you add
a lookup action to a dynamic block definition and associate it with a lookup
parameter, it creates a lookup table. You can use a lookup table to assign
custom properties and values to a dynamic block.

Parameter Sets Tab (Block Authoring Palettes Window)

Provides tools for adding a parameter and at least one action at the same time
to a dynamic block definition in the Block Editor. When you add a parameter
set to a dynamic block, the actions are automatically associated with the
parameter. After you add a parameter set to a dynamic block, you double-click
the yellow alert icon (or use the BACTIONSET command) and follow the
Command prompts to associate the action with a selection set of geometry.

Point Move Runs the BPARAMETER command, Point parameter option with
one grip specified, which adds a point parameter to the dynamic block
definition. Automatically adds a move action associated with the point
parameter.

Linear Move Runs the BPARAMETER command, Linear parameter option
with one grip specified, which adds a linear parameter to the dynamic block
definition. Automatically adds a move action associated with the endpoint
of the linear parameter.

Linear Stretch Runs the BPARAMETER command, Linear parameter option
with one grip specified, which adds a linear parameter to the dynamic block
definition. Automatically adds a stretch action associated with the linear
parameter.

Linear Array Runs the BPARAMETER command, Linear parameter option
with one grip specified, which adds a linear parameter to the dynamic block
definition. Automatically adds an array action associated with the linear
parameter.

Linear Move Pair Runs the BPARAMETER command, Linear parameter option
with two grips specified, which adds a linear parameter to the dynamic block
definition. Automatically adds a two move action, one associated with the
base point and one associated with the endpoint of the linear parameter.
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Linear Stretch Pair Runs the BPARAMETER command, Linear parameter

option with two grips specified, which adds a linear parameter to the dynamic
block definition. Automatically adds two stretch actions, one associated with
the base point and one associated with the endpoint of the linear parameter.

Polar Move Runs the BPARAMETER command, Polar parameter option with
one grip specified, which adds a polar parameter to the dynamic block
definition. Automatically adds a move action associated with the polar
parameter.

Polar Stretch Runs the BPARAMETER command, Polar parameter option with
one grip specified, which adds a polar parameter to the dynamic block
definition. Automatically adds a stretch action associated with the polar
parameter.

Polar Array Runs the BPARAMETER command, Polar parameter option with
one grip specified, which adds a polar parameter to the dynamic block
definition. Automatically adds an array action associated with the polar
parameter.

Polar Move Pair Runs the BPARAMETER command, Polar parameter option
with two grips specified, which adds a polar parameter to the dynamic block
definition. Automatically adds two move actions, one associated with the base
point and one associated with the endpoint of the polar parameter.

Polar Stretch Pair Runs the BPARAMETER command, Polar parameter option
with two grips specified, which adds a polar parameter to the dynamic block
definition. Automatically adds two stretch actions, one associated with the
base point and one associated with the endpoint of the polar parameter.

XY Move Runs the BPARAMETER command, XY parameter option with one
grip specified, which adds an XY parameter to the dynamic block definition.
Automatically adds a move action associated with the endpoint of the XY
parameter.

XY Move Pair Runs the BPARAMETER command, XY parameter option with
two grips specified, which adds an XY parameter to the dynamic block
definition. Automatically adds two move actions, one associated with the base
point and one associated with the endpoint of the XY parameter.

XY Move Box Set Runs the BPARAMETER command, XY parameter option
with four grips specified, which adds an XY parameter to the dynamic block
definition. Automatically adds four move actions, one associated with each
key point on the XY parameter.

XY Stretch Box Set Runs the BPARAMETER command, XY parameter option
with four grips specified, which adds an XY parameter to the dynamic block
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definition. Automatically adds four stretch actions, one associated with each
key point on the XY parameter.

XY Array Box Set Runs the BPARAMETER command, XY parameter option
with four grips specified, which adds an XY parameter to the dynamic block
definition. Automatically adds an array action associated with the XY
parameter.

Rotation Set Runs the BPARAMETER command, Rotation parameter option
with one grip specified, which adds a rotation parameter to the dynamic block
definition. Automatically adds a rotation action associated with the rotation
parameter.

Flip Set Runs the BPARAMETER command, Flip parameter option with one
grip specified, which adds a flip parameter to the dynamic block definition.
Automatically adds a flip action associated with the flip parameter.

Visibility Set Runs the BPARAMETER command, Visibility parameter option
with one grip specified, which adds a visibility parameter to the dynamic block
definition and allows visibility states to be defined. No action is necessary
with the visibility parameter.

Lookup Set Runs the BPARAMETER command, Lookup parameter option
with one grip specified, which adds a lookup parameter to the dynamic block
definition. Automatically adds a lookup action associated with the lookup
parameter.

Constraints Tab (Block Authoring Palettes Window)

Provides tools for applying geometric constraints and constraint parameters
to objects. When you apply geometric constraint to a pair of objects, the order
in which the objects are selected and the point on which each object is selected
can affect how the objects are positioned relative to each other.

Geometric Constraints

Coincident Constraint Runs the GEOMCONSTRAINT on page 790 command,
Coincident option, which constrains two points together or a point to a curve
(or extension of curve). Any constraint point on an object can be coincident
with any constraint point on another object.

Perpendicular Constraint Runs the GEOMCONSTRAINT command,
Perpendicular option, which causes selected lines to lie 90 degrees to one
another. Perpendicular constraints are applied between two objects.

Parallel Constraint Runs the GEOMCONSTRAINT command, Parellel option,
which causes selected lines to lie parallel to each other. Parallel constraints
are applied between two objects.
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Tangent Constraint Runs the GEOMCONSTRAINT command, Tangent option,
which causes the curves to be tangent to other curves. Tangential constraints
are applied between two objects.

Horizontal Constraint Runs the GEOMCONSTRAINT command, Horizontal
option, which causes the lines or pairs of points to lie parallel to the X axis
of the current coordinate system.

Vertical Constraint Runs the GEOMCONSTRAINT command, Vertical option,
which causes the lines or pairs of points to lie parallel to the Y axis of the
current coordinate system.

Colinear Constraint Runs the GEOMCONSTRAINT command, Colinear
option, which causes two line segments to lie along the same line.

Concentric Constraint Runs the GEOMCONSTRAINT command, Concentric
option, which constrains two arcs, circles, or ellipses to the same center point.
The result is the same as that of a coincident applied to the center points of

the curves.

Smooth Constraint Runs the GEOMCONSTRAINT command, Smooth option,
which creates a curvature continuous (G2) condition between two splines that
share a coincident endpoint.

Symmetric Constraint Runs the GEOMCONSTRAINT command, Symmetric
option, which causes selected lines or circles to become symmetrically
constrained about a selected line.

Equal Constraint Runs the GEOMCONSTRAINT command, Equal option,
which resizes selected arcs and circles to the same radius, or selected lines to
the same length.

Fix Constraint Runs the GEOMCONSTRAINT command, Fix option, which
locks points and curves in position.

Constraint Parameters

Aligned Constraint Runs the BCPARAMETER on page 206 command, Aligned
option, which constrains the length of a line or the distance between two
lines, a point on an object and a line, or two points on different objects.

Horizontal Constraint Runs the BCPARAMETER on page 206 command,
Horizontal option, which constrains the X distance of a line or between two
points on different objects. Valid objects include lines and polyline segments.

Vertical Constraint Runs the BCPARAMETER on page 206 command, Vertical
option, which constrains the Y distance of a line or between two points on
different objects. Valid objects include lines and polyline segments.
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Angular Constraint Runs the BCPARAMETER on page 206 command, Angular
option, which constrains the angle between two lines or polyline segments.
It is similar to an angular dimension.

Radial Constraint Runs the BCPARAMETER on page 206 command, Radial
option, which constrains the radius of a circle, arc, or polyarc segment.

Diameter Constraint Runs the BCPARAMETER on page 206 command,
Diameter option, which constrains the diameter of a circle, arc, or polyarc
segment.

-BEDIT

Quick Reference

Access Methods

E Command entry: -bedit

If you select a block in a drawing and enter -bedit at the Command prompt,
the selected block is opened in the Block Editor on page 219. If nothing is
selected, the following prompt is displayed:

List of Prompts

The following prompts are displayed

Enter block name or [?]: Enter a name or ?

Block Name

Specifies the name of a block saved in the current drawing to open in the
Block Editor or specifies the name of a new block to create.

?—List Previously Defined Blocks
Lists the block names in the text window.

Enter block(s) to list <*>: Enter a name list or press Enter

BESETTINGS

Quick Reference

Displays the Block Editor Settings dialog box.
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Access Methods

£ Ribbon: Block Editor tab » Manage panel » *! » Block Editor Settings
E Command entry: besettings

Summary

The Block Editor Settings dialog box on page 231 is displayed.

Block Editor Settings Dialog Box

Quick Reference

Access Methods

£ Ribbon: Block Editor tab » Manage panel » *! » Block Editor Settings
EE Command entry: besettings

Controls the environment settings of the Block Editor.

E Command entry: besettings

A Black Editor Settings =
Authoring Objects Parameter Font
Parameter color: Font Name: Font Style:
[.1?0 v| [eﬁs“ simplex v| Regular
Ginplcolon Parameter and Grip Size
(=T -
12 Parameter size
Parameter text alignment:
[ Horizontal -2 | 8 Grip size
Constraint Status
Unconstrained: Fully constrained:
[ MNwhite bt | [ M magenta - |
Partially constrained: Improperly constrained:
[.blue ‘| [.red v|

Highlight dependent objects during selection
Display tickmarks for parameters with value sets
Display action bars

Reset\."alues| OK ][ Cancel |[ Help
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List of Options
The following options are available in this dialog box.

Authoring Objects
Controls the color of parameter and grip objects and specifies the orientation
of the parameter text.

Parameter Color

Sets the color of the block parameters. (BPARAMETERCOLOR on page 2042
system variable)

Grip Color

Sets the color of the custom grip objects in the Block Editor. (BGRIPOBJCOLOR
on page 2039 system variable)

Parameter Text Alignment

Specifies the orientation of the parameter text. (BPTEXTHORIZONTAL on
page 2043 system variable)

Parameter Font
Sets the font for the authoring objects.

Font Name

Lists the font family name for all registered TrueType fonts and all compiled
shape (SHX) fonts in the Fonts folder. (BPARAMETERFONT on page 2042 system
variable)

Font Style

Specifies font character formatting for the authoring objects, such as italic,
bold, or regular.

Parameter and Grip Size
Controls the size of the parameter and grip objects.

Parameter Size

Specifies the text height and arrowhead size of parameters in pixels.
(BPARAMETERSIZE on page 2042 system variable)

Grip Size

Specifies the size of grip objects in pixels. (BGRIPOBJSIZE on page 2039 system
variable)
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Constraint Status
Specifies the color overrides for objects in the Block Editor to show constraint
status.

Unconstrained

Sets the color of the unconstrained objects.
Partially Constrained

Sets the color of the partially constrained objects.
Fully Constrained

Sets the color of the fully constrained objects.
Improperly Constrained

Sets the color of the over-constrained objects.

Highlight Dependent Objects During Selection

Automatically highlights all objects that are dependent on the currently
selected authoring objects. Use this option when you need to confirm or
change dependent objects. (BDEPENDENCYHIGHLIGHT on page 2038 system
variable)

Display Tickmarks for Parameters With Value Sets
Controls the display of value set markers for parameters. (BTMARKDISPLAY
on page 2043 system variable)

Display Action Bars
Controls the display of action bars for the selected parameters.
(BACTIONBARMODE on page 2037 system variable)

Reset Values
Resets the Block Editor settings to default values.

BGRIPSET

Quick Reference

Creates, deletes, or resets grips associated with a parameter.

Shortcut menu: Select a parameter in the block definition. Right-click in
the Block Editor drawing area. Click Grip Display, and then click an option.
EE Command entry: bedit » bgripset
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Specifies the number of grips displayed for a parameter. Also resets the position
of grips for a parameter to their default location. You can only use the
BGRIPSET command in the Block Editor on page 219.

Select parameter: Select a parameter in the current dynamic block definition

Enter number of grip objects for parameter or reset position
[0/1/2/4/Reposition]: Enter the number of grips to display for the parameter (the
number of grips available will vary depending on the type of parameter you selected)
or enter reposition to reposition the existing grips in the block definition to their
default locations

BHATCH

Quick Reference

Fills an enclosed area or selected objects with a hatch pattern or gradient fill.
E Command entry: bhatch

The BHATCH command has been renamed to HATCH. If you enter bhatch,
the Hatch and Gradient dialog box on page 808 is displayed. If you enter -bhatch
or -hatch, Command prompts are displayed.

BLIPMODE

Quick Reference

Controls the display of marker blips.

E Command entry: blipmode (or 'blipmode for transparent use)
Enter mode [ON/OFF] <current>: Enter on or off, or press Enter

When Blip mode is on, a temporary mark in the shape of a plus sign (+) appears
where you specify a point. BLIPMODE is off by default.
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BLOCK

+* j+
AN AN

\
objects drawn with objects drawn with
BLIPMODE on BLIPMODE off

To remove marker blips, use REDRAW, REGEN, ZOOM, PAN, or other
commands that redraw or regenerate the drawing.

Quick Reference
Creates a block definition from selected objects.

Access Methods
Lo

Button

£ Ribbon: Insert tab » Block panel » Create
£ Menu: Draw » Block » Make

Pt

£ Toolbar: Draw -

E Command entry: block

Summary

The Block Definition dialog box is displayed.

If you enter -block at the Command prompt, options are displayed.

You create a block definition by selecting objects, specifying an insertion
point, and giving it a name. You can create your own blocks or use the blocks
provided in the DesignCenter or tool palettes.
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Block Definition Dialog Box

Quick Reference

Access Methods

)

b

Button

£ Ribbon: Insert tab » Block panel » Create
£ Menu: Draw » Block » Make

Pt

£ Toolbar: Draw “‘)I
E Command entry: block

Defines and names a block.

A Block Definition @
Name
| -
Base point Objects Behavior
Specify On-screen Specify On-screen Annotative @'

ﬁ Pick point @ Select objects @

¥ 0.0000 Retain [¥] Scale uniformly

: @ Convert to block
¥ 00000 e to s 7] Alow exgloding

Delete

Z 0.0000
= & Mo objects selected
Settings Description

Block unit:

Inches -

Hyperiink -

Open in block editor 0K ] | Cancel | ‘ Help

Name

Names the block. The name can have up to 255 characters and can include
letters, numbers, blank spaces, and any special character not used by the
operating system or the program for other purposes.

The block name and definition are saved in the current drawing.

236 | Chapter 3 B Commands



NOTE You cannot use DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH_SPOT, and
OVERHEAD as valid block names.

Preview

If an existing block is selected under Name, displays a preview of the block.

Base Point

Specifies an insertion base point for the block. The default value is 0,0,0.
Specify On-Screen

Prompts you to specify the base point when the dialog box is closed.
Pick Insertion Base Point

Temporarily closes the dialog box so that you can specify an insertion base
point in the current drawing.

X
Specifies the X coordinate value.
Y
Specifies the Y coordinate value.
zZ

Specifies the Z coordinate value.

Objects

Specifies the objects to include in the new block and whether to retain or
delete the selected objects or convert them to a block instance after you create
the block.

Specify On-Screen
Prompts you to specify the objects when the dialog box is closed.
Select Objects

Closes the Block Definition dialog box temporarily while you select the objects
for the block. When you finish selecting objects, press Enter to redisplay the
Block Definition dialog box.

Quick Select

Displays the Quick Select dialog box, which defines a selection set.
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Retain

Retains the selected objects as distinct objects in the drawing after you create
the block.

Convert to Block

Converts the selected objects to a block instance in the drawing after you
create the block.

Delete
Deletes the selected objects from the drawing after you create the block.
Obijects Selected

Displays the number of selected objects.

Behavior
Specifies the behavior of the block.
Annotative

Specifies that the block is annotative. Click the information icon to learn more
about annotative objects.

Match Block Orientation to Layout

Specifies that the orientation of the block references in paper space viewports
matches the orientation of the layout. This option is unavailable if the
Annotative option is cleared.

Scale Uniformly

Specifies whether or not the block reference is prevented from being
non-uniformly scaled.

Allow Exploding

Specifies whether or not the block reference can be exploded.

Settings

Specifies settings for the block.

Block Unit

Specifies the insertion units for the block reference.

Hyperlink
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-BLOCK

Opens the Insert Hyperlink dialog box, which you can use to associate a
hyperlink with the block definition.
Description

Specifies the text description of the block.

Open in Block Editor

Opens the current block definition in the Block Editor on page 219 when you
click OK.

Quick Reference

If you enter -block at the Command prompt, the following prompts are
displayed.

Enter block name or [?]: Enter a name or ?

Block Name

Names the block. The name can have up to 255 characters and can include
letters, numbers, blank spaces, and any special character not used by Microsoft
Windows and the program for other purposes if the system variable EXTNAMES
is set to 1.

If you enter the name of an existing block, you are prompted as follows:

Block "NAME" already exists. Redefine it? [Yes/No] <N>: Entery or n, or press
Enter

By redefining a block, you automatically update all references to that block.
Attributes attached to existing block references remain unchanged in the
drawing. However, new insertions of the block do not prompt for attributes
unless the attribute definitions are included in the new block definition (use
ATTREDEF to redefine blocks that contain attributes).

Specify insertion base point or [Annotative]: Specify a point (1), enter a, or press
Enter

-BLOCK | 239



The point specified as the base point is used for subsequent insertions of the
block. Typically, a base point is the center of the block or its lower-left corner.
The base point is also the point about which you can rotate the block during
insertion. A block with O rotation is oriented according to the UCS in effect
when it was created. Entering a 3D point inserts the block at a specific
elevation. Omitting the Z coordinate uses the current elevation.

Enter a to create an block.
Create annotative block [Yes/No] <N>: Enter y or n or press Enter
If you enter yes, the block becomes annotative.

Match orientation to layout in paper space viewports [Yes/No] <N>: Enter y
or n or press Enter

If you enter yes, the block’s orientation in paper space viewports will match
the orientation of the layout.

If you specify the insertion base point, you are prompted to select the objects.
Select objects: Use an object selection method

The program defines a block using the objects selected, the insertion base
point, and the name provided, and then erases the selected objects from the
drawing. You can restore the deleted objects by entering the OOPS command
immediately after BLOCK.

objects selected
as a block

The insertion base point becomes the origin of the block's coordinate system,
which is parallel to the UCS in effect at the time that you define the block.
When you insert the block into a drawing, its coordinate system is aligned
parallel to the current UCS. Thus, you can insert a block at any orientation
in space by setting the UCS first.
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?—List Previously Defined Blocks

Lists the block names in the text window.

Enter block(s) to list <*>: Enter a name list or press Enter

In the list, external references (xrefs) are indicated with the notation
Xref: resolved

In addition, externally dependent blocks (blocks in an xref) are indicated with
the notation

xdep: XREFNAME

where xrefname is the name of an externally referenced drawing. The following
terms are used in the list:

User Blocks: Number of user-defined blocks in the list.
External References: Number of xrefs in the list.

Dependent Blocks: Number of externally dependent blocks in the list.

Unnamed Blocks: Number of unnamed (anonymous) blocks in the drawing.

BLOCKICON

Quick Reference

Generates preview images for blocks displayed in DesignCenter.

£ Menu: File » Drawing Utilities » Update Block Icons
EE Command entry: blockicon
Enter block names <*>: Specify block names, or press Enter to update all blocks

Use this command to generate icons for blocks created with an earlier release.
You can enter a series of comma-delimited block names or wild-card characters.
For example, enter b1,72, to specify that block B1 and all two-character blocks
ending with 2 should be updated.

After you enter the block names, a message is displayed describing the process
as it proceeds. Press ESC at any time to stop.
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BLOOKUPTABLE

Quick Reference

Displays or creates a lookup table for a dynamic block definition.
EE Command entry: bedit » baction
Displays the Property Lookup Table dialog box.

The current dynamic block definition must contain a lookup action and at
least one lookup parameter in order for the Property Lookup Table dialog box
to display. If a table is already defined for the lookup action, then that table
is displayed in the dialog box. If no table is defined, one is created and
displayed in the Property Lookup Table dialog box.

Property Lookup Table Dialog Box

Quick Reference

The Property Lookup Table dialog box provides a lookup table for the dynamic
block definition. You use the lookup table to control the values available for
alookup parameter (lookup property). The lookup table also allows the values
of lookup parameters to be controlled by the values of other parameters (input
properties).

The lookup table assigns property values to the dynamic block reference based
on how it is manipulated in a drawing. If Reverse Lookup is selected for a

lookup property, the block reference displays a lookup grip. When the lookup
grip is clicked in a drawing, a list of lookup properties is displayed. Selecting
an option from that list will change the display of the dynamic block reference.
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ﬁ Property Lookup Table ==
Action name:
[Lookup | £ Add Fropetes .} Audi
Input Properties Lookup Properties
Lookup
»
Custom
oK | [ cancel | [ Hep |

Action Name
Displays the name of the lookup action associated with the table.
Add Properties

Displays the Add Parameter Properties dialog box on page 244. You can add
parameter properties to the lookup table.

Audit
Checks the data in the table to ensure that each row is unique.
Input Properties

Specifies the input properties for the dynamic block. Each parameter (except
a lookup, alignment, or base point parameter) in the dynamic block can be
displayed as a column under Input Properties. When a parameter's value
matches a value in its corresponding input property column in the lookup
table, the corresponding lookup property on the right side of the table is
assigned to the block reference.

Lookup Properties

Specifies the lookup properties for the dynamic block. Each lookup parameter
in the dynamic block can be displayed as a column under Lookup Properties.
When a parameter's value matches a value in its corresponding input property
column in the lookup table, the corresponding lookup property on the right
side of the table is assigned to the block reference. The drop-down control at
the bottom of a lookup column is used to make the lookup property read-only
or to allow reverse lookup. If all the rows in the table are unique, you can set
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the lookup property to allow reverse lookup. Allow Reverse Lookup enables
the lookup property for a block reference to be set from a drop-down list that
is displayed when the lookup grip is clicked in a drawing. Selecting an option
from this list changes the block reference to match the corresponding input
property values in the table.

Add Parameter Properties Dialog Box

Quick Reference

Adds parameter properties to a lookup table.

ﬁ Add Parameter Properties ==
Parameter properties:
Mame Type
Froperty type
@) Add input properties
) Add lookup properties
0K | [ Cancel | [ Heb

Parameter Properties

Displays a list of parameters not yet added to the lookup table. Select a
parameter and click OK to add it to the lookup table.

Property Type

Specifies the type of property to add to the lookup table.

Add Input Properties

When selected, the Parameter Properties list displays the available input
property parameters that can be added to the lookup table.

Add Lookup Properties

244 | Chapter 3 B Commands



When selected, the Parameter Properties list displays the available lookup
property parameters that can be added to the lookup table.

BMPOUT

BOX

Quick Reference

Saves selected objects to a file in device-independent bitmap format.
EE Command entry: bmpout
The Create Raster File dialog box (a standard file selection dialog box) is

displayed. Enter the file name in the dialog box.

Select objects or <all objects and viewports>: Press Enter to select all objects and
viewports or use an object selection method and press Enter

A bitmap file that contains the objects you select is created. The file reflects
what is displayed on the screen. Light glyphs that are displayed in the drawing
appear in the new file, even if the Plot Glyph property of the lights is set to
No.

NOTE When the FILEDIA system variable is set to 0 (Off), Command prompts are
displayed.

Quick Reference
Creates a 3D solid box.
Access Methods

Button

£ Ribbon: Home tab » Modeling panel » Box
£ Menu: Draw » Modeling » Box
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£ Toolbar: Modeling D

E Command entry: box

List of Prompts
The following prompts are displayed.

Specify first corner or [Center]: Specify a point or enterc for center
Specify other corner or [Cube/Length]: Specify the other corner of the box or
enteran option

If the other corner of the box is specified with a Z value that differs from the
first corner, then no height prompt is displayed.

Specify height or [2Point] <default>: Specify the height or enter 2P for the 2 Point
option

Entering a positive value draws the height along the positive Z axis of the
current UCS. Entering a negative value draws the height along the negative
Z axis.

The base of the box is always drawn parallel to the XY plane of the current
UCS (workplane). The height of the box is specified in the Z-axis direction.
You can enter both positive and negative values for the height.

<9

Creates the box by using a specified center point.

Center

Specify center: Specify a point (1)
Specify other corner or [Cube/Length]: Specify a point or enter an option
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Specify height or [2Point] <default>: Specify the height or enter2P for the 2 Point
option

Cube Creates a box with sides of equal length.

Specify length: Enter a value, or pick a point to specify the length and the rotation
of the box in the XY plane

length—=~-___

Length Creates a box with length, width, and height values you specify. The
length corresponds to the X axis, the width to the Y axis, and the height to
the Z axis.

Specify length: Enter a value, or pick a point to specify the length and the rotation
of the box in the XY plane

Specify width: Specify a distance
Specify height: Specify a distance

4>

Iengln—-»

wmth

Cube
Creates a box with sides of equal length.

Specify length: Enter a value, or pick a point to specify the length and the rotation
of the box in the XY plane
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length—=__

Length

Creates a box with length, width, and height values you specify. If you enter
values, the length corresponds to the X axis, the width to the Y axis, and the
height to the Z axis. If you pick a point to specify the length, you also specify
the rotation in the XY plane.

Specify length: Enter a value, or pick a point to specify the length and the rotation
of the box in the XY plane

Specify width: Specify a distance

Specify height: Specify a distance

2Point

Specifies that the height of the box is the distance between the two specified
points.

Specify first point: Specify a point
Specify second point: Specify a point

BPARAMETER

Quick Reference

Adds a parameter with grips to a dynamic block definition.
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Access Methods

|

Point Maove Attribute
i i Definition

Action Parameters =

£ Ribbon: Block Editor tab » Action Parameters panel
E Command entry: bedit » bparameter

Summary

You can use the BPARAMETER command only in the Block Editor on page
219. A parameter defines custom properties for the block reference. After you
add a parameter, you must associate an action with the parameter to make
the block dynamic.

List of Prompts
The following prompts are displayed.

Enter parameter type
[Alignment/Base/pOint/Linear/Polar/XY/Rotation/Flip/Visibility/looKup]
<last>: Enter a parameter type

Alignment

Adds an alignment parameter to the current dynamic block definition. Because
the alignment parameter affects the entire block, it is not necessary (or possible)
to associate an action with the alignment parameter.

An alignment parameter defines an X and Y location and an angle. An
alignment parameter always applies to the entire block and needs no action
associated with it. An alignment parameter allows the block reference to
automatically rotate around a point to align with other objects in the drawing.
An alignment parameter affects the angle property of the block reference.

Specify base point of alignment or [Name]: Specify a point or enter name

When you specify the base point for the alignment parameter, an X is displayed
in the Block Editor. When the command is completed, an alignment grip is
added at this base point. The block reference automatically rotates about this
point to align with another object in the drawing.
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The parameter name is displayed in the Properties palette when you select the
parameter in the Block Editor.

Alignment type = Perpendicular
Specify alignment direction or alignment type [Type] <Type>: Specify an
alignment direction or enter type

The alignment direction specifies the direction of the grip and the angle of
alignment for the block reference.

Enter alignment type [Perpendicular/Tangent] <Perpendicular>: Specify an
alignment type

Perpendicular Specifies that the dynamic block reference aligns perpendicular
to objects in a drawing.

Tangent Specifies that the dynamic block reference aligns tangent to objects

in a drawing.

Base

&

Adds a base point parameter to the current dynamic block definition. You do
not associate any actions with a base point parameter. The base point parameter
defines the base point for the dynamic block reference in relation to the
geometry in the block. This provides a way to control the location of the base
point within the block reference when it is edited in a drawing. The base point
parameter is generally included in a selection set of the block definition's
actions.

Specify parameter location: Specify a location

Only one base point parameter is allowed in a dynamic block definition. If
you try to add another base point parameter, the following alert is displayed.

Base point parameter already exists in block definition

Point

§

Adds a point parameter to the current dynamic block definition and defines
custom X and Y properties for the block reference. You associate a move or
stretch action with a point parameter.

Specify parameter location or [Name/Label/Chain/Description/Palette]: Specify
a location or enter an option
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Specify label location: Specify a location for the parameter label
Enter number of grips [0/1] <1>: Specify the number of grips for the parameter

Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name

Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter position property label <default>: Enter a label for the position property or
press Enter to use the default label

Chain

Specifies the Chain Actions property for the parameter. The point parameter
may be included in the selection set of an action that is associated with a
different parameter. When that parameter is edited in a block reference, its
associated action may trigger a change in the values of other parameters
included in the action's selection set.

If the Chain Actions property is set to Yes, this change triggers any actions
associated with the point parameter, just as if you had edited the parameter
in the block reference through a grip or custom property.

If the Chain Actions property is set to No, the point parameter's associated
actions are not triggered by the changes to the other parameter.

Evaluate associated actions when parameter is edited by another action?
[Yes/No] <No>: Entery or press Enter
Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter
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Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No| <Yes>: Enter n or press Enter

Linear

4 b
el

Button

Adds a linear parameter to the current dynamic block definition and defines
a custom distance property for the block reference. You associate a move,
scale, stretch, or array action with a linear parameter.

Specify start point or [Name/Label/Chain/Description/Base/Palette/Value set]:
Specify a start point for the parameter or enter an option

Specify endpoint: Specify an endpoint for the parameter

Specify label location: Specify a location for the parameter label

Enter number of grips [0/1/2] <2>: Specify the number of grips for the parameter

If you specify one grip for the parameter, the grip is added to the endpoint of
the parameter.
Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name
Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter distance property label <default>: Enter a label for the distance property or
press Enter to use the default label
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Chain

Specifies the Chain Actions property for the parameter. The linear parameter
may be included in the selection set of an action that is associated with a
different parameter. When that parameter is edited in a block reference, its
associated action may trigger a change in the values of other parameters
included in the action's selection set.

If the Chain Actions property is set to Yes, this change triggers any actions
associated with the linear parameter, just as if you had edited the parameter
in the block reference through a grip or custom property.

If the Chain Actions property is set to No, the linear parameter's associated
actions are not triggered by the changes to the other parameter.

Evaluate associated actions when parameter is edited by another action?
[Yes/No] <No>: Entery or press Enter

Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Base
Specifies the Base Location property for the parameter.

Enter base location [Startpoint/Midpoint]: Specify an option
Startpoint Specifies that the start point of the parameter remains fixed when
the endpoint of the parameter is edited in the block reference.

Midpoint Specifies a midpoint base location for the parameter. This midpoint
is indicated by an X in the block definition. When you edit the linear
parameter in the block reference, the midpoint of the parameter remains fixed,
and the start point and endpoint of the parameter move simultaneously equal
distances from the midpoint. For example, if you move the grip on the
endpoint two units away from the midpoint, the start point simultaneously
moves two units in the opposite direction.

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.
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Display property in Properties palette? [Yes/No] <Yes>: Enter n or press Enter

Value Set

Specifies a value set for the parameter. Limits the available values for the
parameter in a block reference to the values specified in the set.

Enter distance value set type [None/List/Increment] <None>: Specify a value
set type or press Enter to specify no value set type
List Specifies a list of available values for the parameter in a block reference.

Enter list of distance values (separated by commas): Specify a list of values
separated by commas

Increment Specifies a value increment and minimum and maximum values
for the parameter in the block reference.

Enter distance increment: Specify an increment value for the parameter

Enter minimum distance: Specify a minimum distance value for the parameter

Enter maximum distance: Specify a maximum distance value for the parameter

Polar
o
/'\yn
Adds a polar parameter to the current dynamic block definition. Defines

custom distance and angle properties for the block reference. You associate a
move, scale, stretch, polar stretch, or array action with a polar parameter.

Specify base point or [Name/Label/Chain/Description/Palette/Value set]: Specify
a start point for the parameter or enter an option

Specify endpoint: Specify an endpoint for the parameter

Specify label location: Specify a location for the parameter label

Enter number of grips [0/1/2] <2>: Specify the number of grips for the parameter

If you specify one grip for the parameter, the grip is added to the endpoint of
the parameter.
Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name
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Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter distance property label <default>: Enter a label for the distance property or
press Enter to use the default label

Enter angle property label <default>: Enter a label for the angle property or press
Enter to use the default label

Chain

Specifies the Chain Actions property for the parameter. The polar parameter
may be included in the selection set of an action that is associated with a
different parameter. When that parameter is edited in a block reference, its
associated action may trigger a change in the values of other parameters
included in the action's selection set.

If the Chain Actions property is set to Yes, this change triggers any actions
associated with the polar parameter, just as if you had edited the parameter
in the block reference through a grip or custom property.

If the Chain Actions property is set to No, the polar parameter's associated
actions are not triggered by the changes to the other parameter.

Evaluate associated actions when parameter is edited by another action?
[Yes/No] <No>: Entery or press Enter
Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No] <Yes>: Enter n or press Enter
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Value Set

Specifies a value set for the parameter. Limits the available values for the
parameter in a block reference to the values specified in the set.

Enter distance value set type [None/List/Increment] <None>: Specify a distance
value set type or press Enter to specify no value set type

Enter angle value set type [None/List/Increment] <None>: Specify an angle value
set type or press Enter to specify no value set type

List Specifies a list of available values for the parameter in a block reference.

Enter list of distance values (separated by commas): Specify a list of values
separated by commas

Enter list of angle values (separated by commas): Specify a list of values separated
by commas

Increment Specifies a value increment and minimum and maximum values
for the parameter distance in the block reference.

Enter distance increment: Specify an increment value for the parameter distance
Enter minimum distance: Specify a minimum value for the parameter distance
Enter maximum distance: Specify a maximum value for the parameter distance

Specifies a value increment and minimum and maximum values for the
parameter angle in the block reference.

Enter angle increment: Specify an increment value for the parameter angle
Enter minimum angle: Specify a minimum value for the parameter angle

Enter maximum angle: Specify a maximum value for the parameter angle

XY
Lo

L]
Adds an XY parameter to the current dynamic block definition and defines
custom horizontal and vertical distance properties for the block reference.
You associate a move, scale, stretch, or array action with an XY parameter.

Specify base point or [Name/Label/Chain/Description/Palette/Value set]: Specify
a base point for the parameter or enter an option

Specify endpoint: Specify an endpoint for the parameter

Enter number of grips [0/1/2/4] <1>: Specify the number of grips for the parameter

If you specify one grip for the parameter, the grip is added to the endpoint of
the parameter. If you specify two grips for the parameter, a grip is added to
the base point and endpoint of the parameter. If you specify four grips for the
parameter, a grip is added to all four corners of the parameter.
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Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name

Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter horizontal distance property label <default>: Enter a label for the horizontal
distance property or press Enter to use the default label

Enter vertical distance property label <default>: Enter a label for the vertical
distance property or press Enter to use the default label

Chain

Specifies the Chain Actions property for the parameter. The XY parameter
may be included in the selection set of an action that is associated with a
different parameter. When that parameter is edited in a block reference, its
associated action may trigger a change in the values of other parameters
included in the action's selection set.

If the Chain Actions property is set to Yes, this change triggers any actions
associated with the XY parameter, just as if you had edited the parameter in
the block reference through a grip or custom property.

If the Chain Actions property is set to No, the XY parameter's associated actions
are not triggered by the changes to the other parameter.

Evaluate associated actions when parameter is edited by another action?
[Yes/No] <No>: Entery or press Enter

Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter horizontal distance property description: Enter a description for the
horizontal distance property of the parameter
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Enter vertical distance property description: Enter a description for the vertical
distance property of the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No] <Yes>: Enter n or press Enter

Value Set

Specifies a value set for the parameter. Limits the available values for the
parameter in a block reference to the values specified in the set.

Enter horizontal value set type [None/List/Increment] <None>: Specify a value
set type or press Enter to specify no value set type

Enter vertical value set type [None/List/Increment] <None>: Specify a value set
type or press Enter to specify no value set type

List Specifies a list of available values for the parameter in a block reference.

Enter list of distance values (separated by commas): Specify a list of values
separated by commas

Increment Specifies a value increment and minimum and maximum values
for the parameter in the block reference.

Enter distance increment: Specify an increment value for the parameter
Enter minimum distance: Specify a minimum distance value for the parameter

Enter maximum distance: Specify a maximum distance value for the parameter

Rotation

0

Q

Adds a rotation parameter to the current dynamic block definition and defines
a custom angle property for the block reference. Only a rotate action can be
associated with a rotation parameter.

Specify base point or [Name/Label/Chain/Description/Palette/Value set]: Specify
a base point for the parameter or enter an option

Specify radius of parameter: Specify a radius for the parameter

Specify default rotation angle or [Base angle] <0>: Specify a base angle for the
parameter

Specify label location: Specify a location for the parameter label

Enter number of grips [0/1] <1>: Specify the number of grips for the parameter
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If you specify one grip for the parameter, the grip is added to the key point
on the radius of the parameter.

Base Angle Specifies a base angle for the parameter and places the grip for
the parameter at this angle.

Specify base angle <0>: Specify a base angle for the parameter or press Enter

Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name

Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter rotation property label <default>: Enter a label for the rotation property or
press Enter to use the default label

Chain

Specifies the Chain Actions property for the parameter. The rotation parameter
may be included in the selection set of an action that is associated with a
different parameter. When that parameter is edited in a block reference, its
associated action may trigger a change in the values of other parameters
included in the action's selection set.

If the Chain Actions property is set to Yes, this change triggers any actions
associated with the rotation parameter, just as if you had edited the parameter
in the block reference through a grip or custom property.

If the Chain Actions property is set to No, the rotation parameter's associated
actions are not triggered by the changes to the other parameter.

Evaluate associated actions when parameter is edited by another action?
[Yes/No] <No>: Entery or press Enter
Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
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in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No] <Yes>: Enter n or press Enter

Value Set

Specifies a value set for the parameter. Limits the available values for the
parameter in a block reference to the values specified in the set.

Enter angle value set type [None/List/Increment] <None>: Specify an angle value
set type or press Enter to specify no value set type
List Specifies a list of available values for the parameter in a block reference.

Enter list of angle values (separated by commas): Specify a list of values separated
by commas

Increment Specifies a value increment and minimum and maximum values
for the parameter angle in the block reference.

Enter angle increment: Specify an increment value for the parameter angle

Enter minimum angle: Specify a minimum value for the parameter angle

Enter maximum angle: Specify a maximum value for the parameter angle
Flip
)

Adds a flip parameter to the current dynamic block definition. Defines a
custom flip property for the block reference. A flip parameter flips objects. In
the Block Editor, a flip parameter displays as a reflection line. Objects can be
flipped about this reflection line. A flip parameter displays a value that shows
if the block reference has been flipped or not. You associate a flip action with
a flip parameter.

Specify base point of reflection line or [Name/Label/Description/Palette]: Specify
a base point for the reflection line or enter an option

Specify endpoint of reflection line: Specify an endpoint for the reflection line
Specify label location: Specify a location for the parameter label
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Enter number of grips [0/1] <1>: Specify the number of grips for the parameter

Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name

Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter Flip property label <default>: Enter a label for the flip property or press Enter
to use the default label

Specify values for items in the flip property dropdown control:

Enter flip property value for an unflipped state <Not Flipped>: Enter a property
value to display when the parameter is unflipped or press Enter to use the default
label

Enter flipped property value for a flipped state <Flipped>: Enter a property value
to display when the parameter is flipped or press Enter to use the default label

Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No| <Yes>: Enter n or press Enter
Visibility

v

B
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Adds a visibility parameter to the current dynamic block definition and defines
a custom visibility property for the block reference. A visibility parameter
allows you to create visibility states and to control the visibility of objects in
the block. A visibility parameter always applies to the entire block and needs
no action associated with it.

Specify parameter location or [Name/Label/Description/Palette]: Specify a
location for the parameter or enter an option
Enter number of grips [0/1] <1>: Specify the number of grips for the parameter

Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name
Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter visibility property label <default>: Enter a label for the visibility property or
press Enter to use the default label
Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.

Display property in Properties palette? [Yes/No| <Yes>: Enter n or press Enter

262 | Chapter 3 B Commands



Lookup

Adds a lookup parameter to the current dynamic block definition and defines
custom lookup properties for the block reference. A lookup parameter defines
a custom property that you can specify or can be set to use a value from a list
or table you define. You associate a lookup action with a lookup parameter.
Each lookup parameter you add to the block definition can be added as a
column in the Property Lookup Table dialog box on page 242.

Specify parameter location or [Name/Label/Description/Palette]: Specify a
location for the parameter or enter an option
Enter number of grips [0/1] <1>: Specify the number of grips for the parameter

Name

Specifies the parameter name. The parameter name is displayed in the
Properties palette when you select the parameter in the Block Editor.

Enter parameter name <default>: Enter a name for the parameter or press Enter
to use the default name
Label

Specifies the parameter label, which defines the custom property name added
to the block. The parameter label is displayed in the Properties palette as a
Custom property when you select the block reference in a drawing. In the
Block Editor, the parameter label is displayed next to the parameter.

Enter lookup property label <default>: Enter a label for the lookup property or
press Enter to use the default label
Description

Specifies the description for the custom property name (parameter label). This
description is displayed in the Properties palette when you select the parameter
in the Block Editor. In a drawing, when you select the custom property name
(parameter label) for the block reference in the Properties palette, the
description is displayed at the bottom of the Properties palette.

Enter property description: Enter a description for the parameter

Palette

Specifies whether or not the parameter label is displayed in the Properties
palette when the block reference is selected in a drawing.
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Display property in Properties palette? [Yes/No] <Yes>: Enter n or press Enter

BOUNDARY

Quick Reference
Creates a region or a polyline from an enclosed area.

Access Methods

Button

£ Ribbon: Home tab » Draw panel » Boundary

£ Menu: Draw » Boundary

EE Command entry: boundary

Summary

The Boundary Creation dialog box is displayed.

If you enter -boundary at the Command prompt, options are displayed.

Each point that you specify identifies the surrounding objects and creates a
separate region or polyline.
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Boundary Creation Dialog Box

Quick Reference

Access Methods

Button

£ Ribbon: Home tab » Draw panel » Boundary
£ Menu: Draw > Boundary
EE Command entry: boundary

Summary

Defines the object type, boundary set, and island detection method for creating
aregion or polyline using a specified point within an area enclosed by objects.

Ao Boundary Creation =3

E Pick Points

| Island detection
Boundary retention

Obiject type Polyline -
Boundary set

Cumert viewport - @ New

[ ok ][ canced | [ Hebp

Pick Points

Determines a boundary from existing objects that form an enclosed area
around the specified point.

Island Detection

Controls whether BOUNDARY detects internal closed boundaries, called
islands.
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Object Type

Controls the type of the new boundary object. BOUNDARY creates the
boundary as a region or a polyline object.

Boundary Set

Defines the set of objects BOUNDARY analyzes when defining a boundary
from a specified point.

Current Viewport Defines the boundary set from everything in the current
viewport extents. Selecting this option discards any current boundary set.

New Prompts you to select the objects that define the boundary set.
BOUNDARY includes only the objects that can be used to create a region or
closed polyline when it constructs the new boundary set.

For more information about the options in this dialog box, see HATCH.

-BOUNDARY

Quick Reference
If you enter -boundary at the Command prompt, the following prompts are
displayed.

Specify internal point or [Advanced options]: Specify a point or enter a

Internal Point

Creates a region or polyline from existing objects that form an enclosed area.
Specify a point inside the area.

Advanced Options
Sets the method BOUNDARY uses to create the boundary.

Enter an option [Boundary set/Island detection/Object type]: Enter an option
or press Enter to return to the previous prompt

Boundary Set Defines the set of objects BOUNDARY analyzes when it creates
a boundary from a specified point. For information about defining a boundary
set at the Command prompt, see the HATCH Command prompt option.

Island Detection Specifies whether BOUNDARY uses objects within the
outermost boundary as boundary objects. For information about specifying
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BREAK

island detection at the Command prompt, see the HATCH Command prompt
option.

Object Type Specifies the type of object that BOUNDARY creates.

Enter type of boundary object [Region/Polyline| <current>: Enter an option or
press Enter

Quick Reference
Breaks the selected object between two points.

Access Methods

(]

Button

£ Ribbon: Home tab » Modify panel » Break
£ Menu: Modify » Break

[

£ Toolbar: Modify
EE Command entry: break

You can create a gap between two specified points on an object, breaking it
into two objects. If the points are off of an object, they are automatically
projected on to the object. BREAK is often used to create space for a block or
text.
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Select object: Use an object selection method, or specify the first break point (1) on
an object

The prompts that are displayed next depend on how you select the object. If
you select the object by using your pointing device, the program both selects
the object and treats the selection point as the first break point. At the next
prompt you can continue by specifying the second point or overriding the
first point.

Specify second break point or [First point]: Specify the second break point (2) or
enter f
Second Break Point Specifies the second point to use to break the object.

First Point Overrides the original first point with the new point that you
specify.

Specify first break point:

Specify second break point:

before break

after break

The portion of the object is erased between the two points that you specify.
If the second point is not on the object, the nearest point on the object is
selected; therefore, to break off one end of a line, arc, or polyline, specify the
second point beyond the end to be removed.

To split an object in two without erasing a portion, enter the same point for
both the first and second points. You can do this by entering @ to specify the
second point.

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object
types can be split into two objects or have one end removed.

The program converts a circle to an arc by removing a piece of the circle
starting counterclockwise from the first to the second point.
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BREP
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You can also break selected objecs at a single point with the Break at Point
tool.

Valid objects include lines, open polylines, and arcs. Closed objects such as
circles cannot be broken at a single point.

Quick Reference

Removes the history from 3D solid primitives and composite solids.

E Command entry: brep
Select objects: Use an object selection method and press Enter when you finish

The history of the selected solids is removed. The solid no longer retains a
history of the original parts from which the solid was created, and thus, its
original parts cannot be selected and modified.

If you use BREP on a solid primitive, the solid primitive is no longer a true
primitive and cannot be manipulated as such (through grips and the Properties
palette).
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Composite solid with Composite solid with
Show History setto Yes history removed and
Showi History setto Yes

BROWSER

Quick Reference

Launches the default web browser defined in your system's registry.

£ Toolbar: Web g

E Command entry: browser
Enter Web location (URL) <current>: Press Enter or enter a new location; you don't
need to enter http:// before the location

Pressing Enter displays your web browser, which automatically connects to
the location you specify. Because BROWSER does not append “http://” to web
locations, you can specify an FTP or file location to your default web browser.

BSAVE

Quick Reference

Saves the current block definition.
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Access Methods

85

Button

£ Ribbon: Block Editor tab » Open/Save panel » Save Block
EE Command entry: bedit » bsave

Summary
Saves changes to the current block definition.

You can only use the BSAVE command in the Block Editor on page 219.

BSAVEAS

Quick Reference
Saves a copy of the current block definition under a new name.

Access Methods

"

Button

£ Ribbon: Block Editor tab » Open/Save panel » Save Block As
EE Command entry: bedit » bsaveas

Summary
Displays the Save Block As dialog box on page 272.
You can only use the BSAVEAS command in the Block Editor on page 219.
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Save Block As Dialog Box

Quick Reference
Saves a copy of the current block definition under a new name.

Access Methods

T

L

Button

£ Ribbon: Block Editor tab » Open/Save panel » Save Block As
E Command entry: bedit » bsaveas

A0 Save Black As ==

Block Name
|7 Preview

1DEC32 -
3DEC32

3DECLIB

4

A

AVE_GLOBAL
AVE_RENDER
CLAMP PLATE SV
CLAMP PLATE TV
INSERT AH Description
INSERT AV
INSERT B1
INSERTC1
INSERT D1 i -
INSERT F1

m

Save block definition to drawing file

[ ok [ cancel |[ Hep

List of Options

The following options are available in this dialog box.

Block Name

Specifies a new name under which to save a copy of the current block
definition.

Block List

Displays a list of block definitions that are saved in the current drawing.
Preview

Displays a preview of the selected block definition.
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Description

Displays the block definition description specified in the Block area of the
Properties palette in the Block Editor.

Save Block Definition to Drawing File

Saves the block definition as a drawing file. Selecting a pre-existing drawing
file overwrites the saved file. By default, the block name specified is taken as
the drawing file name.

BTABLE

Quick Reference
Displays a dialog box to define variations of a block.

Access Methods

i

Button

£ Ribbon: Block Editor tab » Dimensional panel » Block Table
E Command entry: bedit » btable

Summary

You can only use the BTABLE command in the Block Editor on page 219. The
Block Properties Table dialog box on page 274 is displayed after you specify a
location point. The location point determines where the grip and table icon
are located in the block definition. The grip location determines where the
grip appears in the block reference and displays a context menu based on the
contents of the block properties table. The type of properties that can be
included in the block properties table include legacy parameters, parameter
constraints, user parameters, and attributes. The legacy action parameters that
are added to the lookup tables cannot be added to the Block Properties Table.

Each row in the table defines a different variation of the block reference, and
can be accessed by the lookup grip.
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If a block table is already created in the block editor, entering the BTABLE
command directly displays the Block Properties Table dialog box (see
BLOOKUPTABLE on page 242 command).

List of Prompts

The following prompts are displayed.

Specify parameter location or [Palette]: Specify a location point

Enter number of grips [0/1] <1>: Enter the number of grips

Palette
Specifies whether the block table item is displayed in the Properties palette
for the block reference.

Block Properties Table Dialog Box

Quick Reference

Defines the variations for a set of user-defined properties in the block definition
through a grid control.

Access Methods
Button

£ Ribbon: Block Editor tab » Dimensional panel » Block Table
EE Command entry: bedit > btable
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E Elock Properties Table @

L

=B
BlockMame radius1 diameteri width userd
3.0000 20000 0000

Block 1

Block1 .0000 5000 2.5000

< m 2

Block properties must match a row in the table

[ OK ][ Cancel ]| Help ]

NOTE You can press SHIFT+Enter to add a new line for a multiline attribute value
in the grid in the Block Properties Table dialog box.

List of Options
The following options are available in this dialog box.
Add Properties

Displays the Add Parameter Properties dialog box on page 276 where you can
add parameters already defined in the Block Properties Table.

New Properties

Displays the New Parameters dialog box on page 277 where you can create and
add new user parameters to the Block Properties Table.

Audit
Checks the Block Properties Table for errors.
Grid Control

Displays the name of parameters added to the table. You can also modify the
properties of the table.

Block Properties Must Match A Row In The Table

Specifies whether the properties added to the grid control can be modified
individually for a block reference.
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Default Value When Entering Custom Values

Displays the default values when other properties are changed without
matching a row.

Add Parameter Properties Dialog Box

Quick Reference

Adds parameter properties to the block properties table.
Access Methods
Button

£ Ribbon: Block Editor tab » Dimensional panel » Block Table
E Command entry: bedit » btable

ﬂ Add Parameter Properties =3
Parameter properties:

MName Type

Block Name Attribute

radius1 Radial

width Horizontal

height Vertical

userl Distance

user2 Distance

angle1 Angular

diameterl Diametric

[ ok ][ cameel | [ Hep
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List of Options
The following options are available in this dialog box.

Parameter Properties
Displays a list of dimensional constraint parameters, user parameters, legacy
parameters, and attribute definitions.

Name

Displays the names of parameters available to add to the block properties
table.

Type
Identifies the type of the parameter.

New Parameter Dialog Box

Quick Reference

Creates and defines a new user parameter to be added to the block properties
table.

Access Methods
Button

£ Ribbon: Block Editor tab » Dimensional panel » Block Table
EE Command entry: bedit » btable

Ao New Parameter @

Name:
userd
Value:
1.0000

Type:

Real -

/| Display in Properties palette

[ ok [ cencel |[ Hep
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List of Options

The following options are available in this dialog box.
Name

Displays the name of the new user parameter.

Value

Displays the value of the user parameter.

Type

Determines the type of the new parameter. You can select a real, distance,
area, volume, angle, or string parameter type.

Display in Properties Palette

Specifies whether to display the user parameter as a property in the Properties
palette for the block reference.

BTESTBLOCK

Quick Reference
Displays a window within the Block Editor to test a dynamic block.

Access Methods

Button

&~ "-\.I
£ Ribbon: Block Editor tab » Open / Save panel » Test Block
E Command entry: bedit » btestblock

Summary

You can only use the BTESTBLOCK command in the Block Editor on page 219.
With the Test Block window you can test a dynamic block without closing
the Block Editor. You can select the block reference and test the grips or display
the Properties palette and test the behavior when changing the properties.
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You can also insert additional copies of the block to test the inserting behavior.
You can make changes and test the block without saving the changes to the
block definition.

In the Test Block window, all AutoCAD commands operate the same way
except the BEDIT on page 211, SAVE on page 1593, SAVEAS on page 1593, and
QSAVE on page 1493 commands. The BEDIT command is not available in Test
Block window. The SAVE, SAVEAS, and QSAVE commands remove the Test
Block status from the window and the Test Block window becomes an open
drawing. A Close Test Block Window contextual panel is added to the ribbon
when you are in the test block mode.

In the Block Editor, the BCLOSE on page 204, BTESTBLOCK on page 278, and
CLOSE on page 331 commands automatically close the Test Block window and
discard the temporary file. The BTESTBLOCK command closes the current
Test Block window and opens a new window with the current definition.

NOTE Please ensure that there are entities present in the block being tested before
running the BTESTBLOCK command.

BVHIDE

Quick Reference

Makes objects invisible in the current visibility state or all visibility states in
a dynamic block definition.

Access Methods

Button

£ Ribbon: Block Editor tab » Visibility panel » Block Visibility Hide

E2 Command entry: bedit » bvhide

Shortcut menu: Select objects to hide for visibility states. Right-click in the
Block Editor drawing area. Click Object Visibility » Hide for Current State
or click Object Visibility » Hide for All States
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Summary

Makes objects invisible for the current visibility state. You can only use the
BVHIDE command in the Block Editor on page 219.

List of Prompts

The following prompts are displayed.

Select objects to hide: Select objects to hide for the current visibility state or all
visibility states

Hide for current state or all visibility states [Current/All] <Current>: Enter
currentto hide the selected objects for the current visibility state or enter all to hide
the selected objects for all visibility states in the block definition

BVSHOW

Quick Reference

Makes objects visible in the current visibility state or all visibility states in a
dynamic block definition.

Access Methods

Ch

Button

£ Ribbon: Block Editor tab » Visibility panel » Block Visibility Show

E Command entry: bedit » bvshow

Shortcut menu: Select objects to make visible for visibility states. Right-click
in the Block Editor drawing area. Click Object Visibility » Show for Current
State or click Object Visibility » Show for All States

Summary

Allows you to make objects visible for visibility states. You can only use the
BVSHOW command in the Block Editor on page 219.

List of Prompts
The following prompts are displayed

280 | Chapter 3 B Commands



Select objects to make visible: Select objects to make visible for the current visibility
state or all visibility states

Make visible for current state or all visibility states [Current/All] <Current>:
Enter current to make the selected objects visible for the current visibility state or enter
all to make the selected objects visible for all visibility states in the block definition

BVSTATE

Quick Reference
Creates, sets, or deletes a visibility state in a dynamic block.

Access Methods

Button

£ Ribbon: Block Editor tab » Visibility panel » Visibility States
E Command entry: bedit » bvstate

Summary

Displays the Visibility States dialog box on page 281. You can only use the
BVSTATE command in the Block Editor on page 219 after a visibility parameter
has been added to the block definition.

Visibility States Dialog Box

Quick Reference
Creates or modifies visibility states.

Access Methods

Button
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£ Ribbon: Block Editor tab » Visibility panel » Visibility States
EE Command entry: bedit » bvstate

ﬂ Visibility States ==
Visibility states:
New.

0K ][ Cancel ][ Help

List of Options
The following options are available in this dialog box.
Visibility States

Lists the available visibility states for the current dynamic block definition.
The order of this list is reflected in the dynamic block reference when the grip
is clicked to display the list of visibility states. The state at the top of the list
is the default state for the block reference.

Set Current

Sets the selected visibility state as the current state to display in the Block
Editor. Does not change the default visibility state that is displayed when the
block is inserted in a drawing, nor does it change the displayed visibility state
for block references already inserted and edited in the drawing.

New

Displays the New Visibility State dialog box. on page 283
Rename

Renames the selected visibility state.

Delete

Deletes the selected visibility state.

Move Up

Moves the selected visibility state up in the list.

Move Down
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Moves the selected visibility state down in the list.

New Visibility State Dialog Box

Quick Reference
Creates a new visibility state.
Access Methods

I=

Button

£ Ribbon: Block Editor tab » Visibility panel » Visibility States
EE Command entry: bedit » bvstate

A MNew Visibility State @
Visibility state name

[VisibityState1]

Visibility options for new states
Hide all existing objects in new state
Show all existing objects in new state

@ Leave visibility of existing objects unchanged in new state

[ ok [ cance |[ Hep

List of Options

The following options are available in this dialog box.
Visibility State Name

Specifies the name for the new visibility state.
Visibility Options for New States

Displays options for the new visibility state.

Hide All Existing Objects in New State

Specifies that all objects in the block definition will be hidden in the new
visibility state.

Show All Existing Objects in New State
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Specifies that all objects in the block definition will be shown in the new
visibility state.

Leave Visibility of Existing Objects Unchanged in New State

Specifies that the visibility of objects in the new visibility state will be the
same as in the current visibility state on which the new state is based.

OK Creates a new visibility state.

-BVSTATE

Quick Reference

Access Methods
E Command entry: bedit » -bvstate

List of Prompts
The following prompts are displayed.

Current visibility state: <Name of current visibility state>

Enter an option [New on page 284/Set on page 285/Delete on page 285] <New>:
Enter an option or press Enter

New

Creates a new visibility state.

Enter name of new visibility state: Enter a name for the new visibility state

Enter object visibility for new state [Hide all/Show all/Current visibility]
<Current visibility>: Enter object visibility for new state

Hide All

Specifies that all objects in the block definition will be hidden in the new
visibility state.

Show All

Specifies that all objects in the block definition will be shown in the new
visibility state.

Current Visibility

Specifies that the visibility of objects in the new visibility state will be the
same as in the current visibility state on which the new state is based.
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Set
Specifies the visibility state to set as current.

Enter visibility state name to make current or [?]: Enter the name of the visibility
state to set as the current state

Delete
Deletes a visibility state.

Enter visibility state name(s) to delete: Enter the name(s) of the visibility states to
delete
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C Commands

CAL

Quick Reference

Evaluates mathematical and geometric expressions.
E Command entry: cal (or 'cal for transparent use)

CAL is an online geometry calculator that evaluates point (vector), real, or
integer expressions. The expressions can access existing geometry using the
object snap functions such as CEN, END, and INS.

You can insert AutoLISP® variables into the arithmetic expression and assign
the value of the expression back to an AutoLISP variable.

You can use these arithmetic and vector expressions in any command that
expects points, vectors, or numbers.

Understand Syntax of Expressions

Quick Reference

CAL evaluates expressions according to standard mathematical rules of
precedence:

B Expressions in parentheses first, starting with the innermost set
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B Operators in standard order: exponents first, multiplication and division
second, and addition and subtraction last

B Operators of equal precedence from left to right

Numeric Expressions

Numeric expressions are real integer numbers and functions combined with
the operators in the following table.

Numeric operators

Operator Operation

O Groups expressions

A Indicates exponentiation
*,/ Multiplies, divides

+ - Adds, subtracts

The following are examples of numeric expressions:
3

3+0.6

(5.8"2) + PI

Vector Expressions

A vector expression is a collection of points, vectors, numbers, and functions
combined with the operators in the following table.

Vector operators

Operator Operation

O) Groups expressions

& Determines the vector product of vectors (as a vector)
[a,b,c]&[x,y,z] = [ (b*2) - (c*y), (c*X) - (a*2) , (a*y) - (b*X) ]

* Determines the scalar product of vectors (as a real number)
[a,b,c]*[x,y,z] = ax + by + cz

*/ Multiplies, divides a vector by a real number

288 | Chapter 4 C Commands



Vector operators

Operator Operation

a*[)(I)IIZ] = [a*xla*yla*z]

+, - Adds, subtracts vectors (points)
[a,b,c] + [x,y,Z] = [a+x,b+y,c+Z]

The following are examples of vector expressions:

A+[1,2,3] provides the point positioned [1,2,3] units relative to point A.
The expression

[2<45<45] + [2<45<0] - [1.02, 3.5, 2]

adds two points and subtracts a third point. The first two points are in spherical
coordinates.

Format Feet and Inches

Quick Reference

Enter feet and inches using the following format:
feet'-inches" or feet' inches" or feet'inches"

You can separate feet, inches, and fractional inches with a dash, a space, or
nothing. You can use any of the following syntax cases to enter valid feet-inch
formatted values:

m 5'or 60”

5'-9” or 5' 9” or 5'9”

5'-1/2" or 5' 1/2” or 5'1/2”
5'-9-1/2” or 5' 9-1/2” or 5'9-1/2"

5'-91/2" 0r5'91/2” or 5'9 1/2”

To designate inches for linear calculations, entering double quotes (“) is
optional. For example, instead of entering 5'9-1/2”, you could enter 5'9-1/2.
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WARNING With imperial units, CAL interprets a minus or a dash (-) as a unit
separator rather than a subtraction operation. To specify subtraction, include at
least one space before or after the minus sign. For example, to subtract 9” from
5', enter 5' -9” rather than 5'-9”.

Format Angles

Quick Reference

The default units for angles are decimal degrees. Enter angles using the
following format:

<degrees>d<minutes>'<seconds>"

You must enter 0d when entering an angle that is less than 1 degree (minutes
and seconds only). You can omit the minutes or seconds if they are zero.

Enter a number followed by r to enter angles in radians. Enter a number
followed by g to enter angles in grads.

The following examples show ways of entering angles:
5d10'20"

0d10'20"

124.6r

149

Angles entered in any format are converted to decimal degrees.

Pi radians is equal to 180 degrees, and 100 grads is equal to 90 degrees.

Use Points and Vectors

Quick Reference

Both points and vectors are pairs or triples of real numbers. A point defines a
location in space, but a vector defines a direction (or translation) in space.

Some CAL functions, such as pld and plt, return a point. Other functions,
such as nor and vec, return a vector.
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Formatting Points and Vectors

A point or vector is a set of three real expressions enclosed in brackets ([ |):
[r1,r2,r3]

The notation p1, p2, and so forth designates points. The notation v7, v2, and
so forth designates vectors. In drawings, points are displayed as dots, and
vectors are displayed as lines with arrows.

CAL supports points expressed in all formats.

Point formats

Coordinate system Point format

Polar [dist<angle]

Cylindrical [dist<angle,z]

Spherical [dist<angle1<angle2]
Relative Uses the @ prefix [@x,y,z]
WCS (instead of UCS) Uses the * prefix [*x,y,z]

You can omit the following components of a point or vector: coordinate values
of zero and a comma immediately preceding the right bracket (]).

The following are valid points:
[1,2] is the same as [1,2,0]

[,,3] is the same as [0,0,3]

[ 1is the same as [0,0,0]

In the following example, the point is entered in the relative spherical
coordinate system with respect to the (WCS). The distance is 1+2=3; the angles
are 10+20=30 degrees and 45 degrees, 20 minutes.

[@*1+2<10+20<45d20"]

The following is a valid point that contains arithmetic expressions as its
components:

[2%(1.0+3.3),0.4-1.1,2*1.4]

The following example uses the Endpoint object snap and the vector [2,0,3]
to calculate a point that is offset from a selected endpoint:
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end +[2,,3]

The calculated point is offset 2 units in the X direction and 3 units in the Z
direction relative to the selected endpoint.

Use AutoLISP Variables

Quick Reference

You can use AutoLISP variables within arithmetic expressions. The variables
must be one of the following types: real, integer, or 2D or 3D point (vector).

This example defines a point positioned 5 units in the X direction and 1 unit
in the Y direction from the point stored in AutoLISP variable a.

A+[5,1]

If you enter an AutoLISP variable with a name containing a character with
special meaning in CAL, such as +, -, ¥, or /, enclose the variable name in
apostrophes ('), for example:

'number-of-holes'

Assigning Values to AutoLISP Variables

To assign a value to an AutoLISP variable, precede the arithmetic expression
with the variable name and the equal sign (=). Later, you can use the value of
this variable for other calculations.

This example saves the values of two expressions in AutoLISP variables p1 and
RI.

Command: cal

>> Expression: P1=cen+[1,0]

>> Select entity for CEN snap: Select a circle or an arc
Command: cal

>> Expression: R1=dist(end,end)/3

>> Select entity for END snap: Select an object with an endpoint

This example uses the values of variables r1 and r1i:

Command: circle

Specify center point for circle or [3P/2P/Ttr (tangent tangent radius)]: 'cal
>> Expression: P1+[0,1]

Specify radius of circle or [Diameter] </ast>: 'cal

>> Expression: R1+0.5
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Use System Variables in Calculations

Quick Reference

You can use the getvar function to read the value of a system variable.
The syntax is
getvar (variable name)

The following example uses getvar to obtain the point that is the center of
the view in the current viewport.

getvar(viewctr)

With this method, you can also access the user system variables, USERI1-5
and USERR1-5. For example, to retrieve the value stored in USERR2, enter the
following:

getvar(userr2)

Convert Units of Measurement

Quick Reference

The cvunit function converts either a number or a point from one unit of
measurement to another. See the acad.unt file for a list of units that you can
convert. The syntax is

cvunit(value, from unit, to unit)
The following example converts the value 1 from inches to centimeters:

cvunit(1,inch,cm)
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Use Standard Numeric Functions

Quick Reference

CAL supports the standard numeric functions in the following table.

Numeric functions

Function Description

sin(angle) Sine of the angle

cos(angle) Cosine of the angle

tang(angle) Tangent of the angle

asin(real) Arcsine of the number; the number must be between -1 and 1
acos(real) Arccosine of the number; the number must be between -1 and 1
atan(real) Arctangent of the number

In(real) Natural log of the number

log(real) Base-10 log of the number

exp(real) Natural exponent of the number

exp10(real) Base-10 exponent of the number

sqr(real) Square of the number

sqrt(real) Square root of the number; the number must be nonnegative
abs(real) Absolute value of the number

round(real) Number rounded to the nearest integer

trunc(real) Integer portion of the number

r2d(angle) Angles in radians converted to degrees; for example, r2d(pi) converts

the pi radians to 180 degrees
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Numeric functions

Function Description

d2r(angle) Angles in degrees converted to radians; for example, d2r(180) con-
verts 180 degrees to radians and returns the value of pi

pi The constant pi

Calculate a Vector from Two Points

Quick Reference

The functions vec and vec1 calculate a vector from two points.
vec(pl,p2) Provides the vector from point p7 to point p2.
vecl(pl,p2) Provides the unit vector from point p7 to point p2.

The following example uses CAL to move selected objects 3 units in the
direction from the center of one selected circle to the center of another selected
circle:

Command: move

Select objects

Specify base point or displacement: 'cal

>> Expression: 3*vec1(cen,cen)

Select entity for CEN snap: Specify a circle or an arc

Specify second point of displacement or <use first point as displacement>:
Specify a point or press Enter

The following examples illustrate the meaning of vector and point calculations.

Examples of vector and point calculations

Expression Meaning

vec(a,b) Determines vector translation from point a to point b.

vecl(a,b) Determines unit vector direction from point a to point b.

L*vec1(a,b) Determines vector of length L in the direction from point a
to point b.
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Examples of vector and point calculations

Expression Meaning

a+v Determines point b, which is a translation of the point a
through vector v.

a+[5<20] Determines point b positioned 5 units away from point a un-
der the angle of 20 degrees. Note that [5<20] is a vector in
polar coordinates.

Calculate the Length of a Vector

Quick Reference

The abs function calculates the length of a vector.

abs(v) Calculates the length of vector v, a nonnegative real number.

In spherical coordinates (dist<ang<ang), the dist is the length of the vector.
The following example calculates the length of the vector [1,2,3]:
abs([1,2,3])

Obtain a Point by Cursor

Quick Reference

To enter a point using the pointing device, use the cur function. The program
prompts you to specify a point and uses the coordinate values of the point in
the expression. The point coordinate values are expressed in terms of the

current UCS. The cur function sets the value of theLASTPOINT system variable.

The following example adds the vector [3.6,2.4,0]—the result of 1.2*[3,2]—to
the point you select. This expression produces a point that is offset from the
selected point.

cur+1.2*[3,2]
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Obtain the Last-Specified Point

Quick Reference

Use the @ character in the expression to obtain the coordinate of the last
point, as shown in the following example:

Command: line

Specify first point: 'cal

>> Expression: cen+[0,1]

>> Select entity for CEN snap: Select a circle or an arc
Specify next point or [Close/Undo]: 'cal

>> Expression: @+3*vec1(cen,cen)

The first point of the line is 1 unit in the Y direction from the center of the
first selected circle. The second point of the line is 3 units away from the first
point. The direction of the line is from the center of the first selected circle
to the center of the second selected circle.

Use Snap Modes in Arithmetic Expressions

Quick Reference

You can use Snap modes as parts of arithmetic expressions. The program
prompts you to select an object and returns the coordinate of the appropriate
snap point. Using arithmetic expressions with Snap modes greatly simplifies
entering coordinates relative to other objects.

When you use these Snap modes, enter only the three-character name. For
example, when you use the Center Snap mode, enter cen. CAL Snap modes
set the value of theLASTPOINT system variable.

CAL Snap modes

Abbreviation Snap mode
END ENDPOINT
INS INSERT

INT INTERSECTION
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CAL Snap modes

Abbreviation Snap mode
MID MIDPOINT

CEN CENTER

NEA NEAREST

NOD NODE

QUA QUADRANT

PER PERPENDICULAR
TAN TANGENT

The following example uses the Center and Endpoint Snap modes in a CAL
expression:

(cen+end)/2

CAL prompts for a circle or arc and an object. It then determines the midpoint
between the center of the circle or arc and the end of the selected object.

Using the Midpoint Snap mode, in the following example CAL prompts for
an object and returns a point 1 unit in the Y direction from the midpoint of
the selected object:

mid+[,1]

The following example uses the Endpoint Snap mode to calculate the centroid
of a triangle defined by three endpoints:

(end+end+end)/3

Convert Points Between UCS and WCS

Quick Reference

Normally, the program assumes all coordinates to be relative to the current
UCS. The following functions convert points between UCS and WCS.

w2u(pl) Converts point pI expressed in the WCS to the current UCS.
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u2w(pl) Converts point p7 expressed in the current UCS to the WCS.
You can use w2u to find the WCS origin in terms of the current UCS:

w2u([0,0,0])

Filtering the X, Y, and Z Components of a Point or Vector
The following functions filter the X, ¥, and Z components of a point or vector.

Point-filter functions

Function Description

xyof(pT) X and Y components of a point; Z component is set to 0.0
xzof(pT) X and Z components of a point; Y component is set to 0.0
yzof(pT) Y and Z components of a point; X component is set to 0.0
xof(pT) X component of a point; Y and Z components are set to 0.0
yof(pT) Y component of a point; X and Z components are set to 0.0
zof(pT) Z component of a point; X and Y components are set to 0.0
rxof(p1) X component of a point

ryof(pT) Y component of a point

rzof(p1) Z component of a point

The following example provides the Z component of a point expressed in
spherical coordinates:

zof([2<45<45])

The following example provides a point whose X and Y coordinate values are
taken from point a and the Z coordinate value from point b:

xyof(a)+zof(b)
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Calculate a Pointon a Line

Quick Reference

The plt and pld functions return a point on a given line. You can specify the
position of the point on the line either by its distance from the first point or
parametrically by a t parameter.

pld(pl,p2,dist) Calculates a point on the line passing through points p7 and
p2. The parameter dist defines the distance of the point from the point p1.

plt(p1,p2,t) Calculates a point on the line passing through points p7 and p2.
The parameter t defines the parametric position of the point on the line.

The following are examples of the parameter t:

If t=0 the pointis p1

If t=0.5 the point is the midpoint between p1 and p2
If t=1 the point is p2

Rotate a Point About an Axis

Quick Reference

The rot function rotates a point about an axis and returns the resulting point.

rot(p,origin,ang) Rotates point p through angle ang about the Z axis passing
through the point origin, as shown in the following example:

ang

arigin
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rot(p,AxP1,AxP2,ang) Rotates point p through an angle ang about the axis
passing through points AxP1 and AxP2, as shown in the following example.
The axis is oriented from the first point to the second point.

A2

Obtain an Intersection Point

Quick Reference

The ill and ilp functions determine intersection points.

ill(p1,p2,p3,p4) Determines the intersection point between two lines (p1,p2)
and (p3,p4). All points are considered three-dimensional.

ilp(p1,p2,p3,p4,p5) Determines the intersection point between a line (p1,p2)
and a plane passing through three points (p3,p4,p5).

Calculate a Distance

Quick Reference

dist(p1,p2) Determines the distance between two points, p7 and p2. This is
the same as the vector expression abs(p1-p2).

dpl(p,p1,p2) Determines the shortest distance between point p and the line
passing through points p1 and p2.
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p2
shortest distance ——

dpp(p,p1,p2,p3) Determines the distance from a point p to a plane defined
by three points (p1,p2,p3).

dist(p1,p2) Determines the distance between two points, p7 and p2. This is
the same as the vector expression abs(p1-p2).

; /
N i 4 pa

pl ":., e

The following example returns half the distance between the centers of two
selected objects:

dist(cen,cen)/2

The following example finds the distance between the point 3,2,4 and a plane
you define by selecting three endpoints:

dpp([3,2,4],end, end, end)
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Obtain a Radius

Quick Reference

The rad function determines the radius of a selected object.
rad Determines the radius of a selected object. The object can be a circle, an
arc, or a 2D polyline arc segment.

The following example uses rad with the CIRCLE command. The radius of
the new circle is two-thirds of the radius of the selected polyline arc segment:

Command: circle

Specify center point for circle or [3P/2P/Ttr (tangent tangent radius)]: cen
of Select the circle

Specify radius of circle or [Diameter] </ast>: 'cal

>> Expression: 2/3*rad

>> Select circle, arc or polyline segment for RAD function: Select the circle

&rc

new circle

Center

Obtain an Angle

Quick Reference

The ang function determines the angle between two lines. Angles are measured
counterclockwise with respect to either the X axis, in the two-dimensional
case, or to a user-specified axis, in the three-dimensional case.

ang(v) Determines the angle between the X axis and vector v. The vector v is
considered 2D, projected on the XY plane of the current UCS.

ang(pl,p2) Determines the angle between the X axis and the line (p1,p2),
oriented from p7 to p2. The points are considered 2D, projected on the XY
plane of the current UCS.
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ang(apex,pl,p2) Determines the angle between lines (apex,p1) and (apex,p2).
The points are considered 2D, projected on the XY plane of the current UCS

ang(apex,pl,p2,p) Determines the angle between lines (apex,p1) and (apex,p2).
The lines are considered 3D. The last parameter, point p, is used to define the

orientation of the angle. The angle is measured counterclockwise with respect
to the axis going from apex to p.

The following examples show how angles are measured.
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ang({apex,pl,p2)

ang(apex.pl,p2p)

You can determine the angle between the two sides of a triangle using the
ang function, as shown in the following example:

Command: cal

>> Expression: ang(end,end,end)

Select the apex of the angle, and then select the two opposite vertices.
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Calculate a Normal Vector

Quick Reference

The nor function calculates the unit normal vector (a vector perpendicular to
a line or plane), not a point. The vector defines the direction of the normal,
not a location in space. You can add this normal vector to a point to obtain
another point.

nor Determines the three-dimensional unit normal vector of a selected circle,
arc, or polyline arc segment. This normal vector is the Z coordinate of the
object coordinate system (OCS) of the selected object.

nor(v) Determines the two-dimensional unit normal vector to vector v. Both
vectors are considered 2D, projected on the XY plane of the current UCS. The
orientation of the resulting normal vector points to the left of the original
vector v.

nor(p1,p2) Determines the 2D unit normal vector to line p1,p2. The line is
oriented from pT to p2. The orientation of the resulting normal vector points
to the left from the original line (p71,p2).

nor(pl,p2,p3) Determines the 3D unit normal vector to a plane defined by
the three points p1, p2, and p3. The orientation of the normal vector is such
that the given points go counterclockwise with respect to the normal.

The following illustrations show how normal vectors are calculated:
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p3
p2 O
p2
pi ©
pl1 O
nor {p1,p2) nor (pl1,p2,p3)

The following example sets the view direction perpendicular to a selected
object. The program displays the object in plan view and does not distort the
object by the parallel projection.

Command: vpoint

Current view direction: VIEWDIR=current

Specify a view point or [Rotate] <display compass and tripod>: 'cal
>> Expression: nor

>> Select circle, arc or polyline for NOR function:
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Use Shortcut Functions

Quick Reference

The functions in the table are shortcuts for commonly used expressions that
combine a function with the Endpoint Snap mode.

Shortcut functions

Function Shortcut for Description

dee dist(end,end) Distance between two endpoints

ille ill(end,end,end,end) Intersection of two lines defined by four
endpoints

mee (end+end)/2 Midpoint between two endpoints

nee nor(end,end) Unit vector in the XY plane and normal to

two endpoints

pldee (d) pld(d,end,end) Point at a distance along a line determined
by two endpoints (see pld)

pltee (t) plt(t,end,end) Point at a parametric location on a line de-
termined by two endpoints (see plt)

vee vec(end,end) Vector from two endpoints

veel vecl(end,end) Unit vector from two endpoints

CAMERA

Quick Reference

Sets a camera and target location to create and save a 3D perspective view of
objects.
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Access Methods

Button

£ Ribbon: Home tab » View panel » Create Camera.

£ Toolbar: View @

EE Command entry: camera
Current camera settings: Height=<current> Lens Length=<current>
Specify camera location <current>: Enter a value or specify a point

Sets the point from which you view objects in a model.
Specify target location: Enter a value or specify a point
Sets the target location of a camera’s lens.

Enter an option[?/Name/LOcation/Height/Target/LEns/Clipping/View/<eXit>]:

?—List Cameras
Displays a list of the currently defined cameras.

Enter camera name(s) to list <*>: Enter a name list or press Enter to list all cameras.

Name
Names a camera.

Enter name for new camera <Cameral>:

Location
Specifies the location of the camera.

Specify camera location <current>:

Height
Changes the camera height.

Specify camera height <current>:

308 | Chapter 4 C Commands



Target
Specifies the target of the camera.

Specify camera target <current>:

Lens
Changes the lens length of the camera.

Specify lens length in mm <current>:

Clipping
Defines front and back clipping planes and sets their values.

Enable front clipping plane? [Yes/No] <No>: Specify Yes to enable front clipping
Specify front clipping plane offset from target plane <current>: Enter a distance
Enable back clipping Plane? <Yes/No] <No>: Specify Yes to enable back clipping
Specify back clipping plane offset from target plane <current>: Enter a distance
View

Sets the current view to match the camera settings.

Switch to camera view? [Yes/No] <No>:

Exit

Cancels the command.

Camera Preview Dialog Box

Quick Reference

Displays a preview of a camera view.

Preview Displays a preview of a camera view defined with the CAMERA
command.

Visual Style Specifies the visual style applied to the preview.

Display This Window When Editing a Camera Specifies that the Camera
Preview dialog box is displayed when you edit a camera.
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CHAMFER

Quick Reference
Bevels the edges of objects.
Access Methods

I

Button

£ Ribbon: Home tab » Modify panel » Chamfer
£ Menu: Modify » Chamfer

£ Toolbar: Modify

E: Command entry: chamfer

Summary

The distances and angles that you specify are applied in the order that you
select the objects.

1 ’ !
T
\ J

You can chamfer lines, polylines, rays, and xlines.

You can also chamfer 3D solids and surfaces. If you select a mesh to chamfer,
you can choose to convert it to a solid or surface before completing the
operation.

List of Prompts

The following prompts are displayed.

(TRIM mode) Current chamfer Dist1 = current, Dist2 = current
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
Use an object selection method or enter an option
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First Line

Specifies the first of two edges required to define a 2D chamfer, or the edge
of a 3D solid to chamfer.

Select second line or shift-select to apply corner: Use an object selection method
or hold down Shift and select an object to create a sharp corner

If you select lines or polylines, their lengths adjust to accommodate the
chamfer line. You can hold down Shift while selecting the objects to override
the current chamfer distances with a value of 0.

If the selected objects are line segments of a 2D polyline, they must be adjacent
or separated by no more than one segment. If they're separated by another
polyline segment, CHAMFER deletes the segment that separates them and
replaces it with the chamfer.

If you select an edge on a 3D solid, you must indicate which one of the two
surfaces adjacent to the edge is the base surface.

Base surface selection...
Enter surface selection option [Next/OK (current)] <OK>: Enter n or o, or press
Enter

Entering o or pressing Enter sets the selected surface as the base surface.
Entering n selects either of the two surfaces adjacent to the selected edge.

Specify base surface chamfer distance <current>:
Specify other surface chamfer distance <current>:

After you select the base surface and the chamfer distances, select the edges
of the base surface to chamfer. You can select edges individually or all the
edges at once.

Select an edge or [Loop]: Select an edge, enter L, or press Enter

first edge selected first base surface second base surface

Edge

Selects an individual edge to chamfer.
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select edoge edge selected chamfered edge

Loop
Switches to Edge Loop mode.

Select an edge loop or [Edge]: Select an edge, enter e, or press Enter
Edge Loop Selects all edges on the base surface.

selecting edge loop edge loop selected chamfered edge
loop

Edge Switches to Edge mode.

Undo

Reverses the previous action in the command.

Polyline
Chamfers an entire 2D polyline.
Select 2D polyline:

The intersecting polyline segments are chamfered at each vertex of the polyline.
Chamfers become new segments of the polyline.

If the polyline includes segments that are too short to accommodate the
chamfer distance, those segments are not chamfered.
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o

zelected polyline result

Distance
Sets the distance of the chamfer from the endpoint of the selected edge.

Specify first chamfer distance <current>:
Specify second chamfer distance <current>:

E P

equal distances unequal distances

If you set both distances to zero, CHAMFER extends or trims the two lines so
they end at the same point.

Angle

Sets the chamfer distances using a chamfer distance for the first line and an
angle for the second line.

Specify chamfer length on the first line <current>:
Specify chamfer angle from the first line <current>:

chamfer distance
first selected ’__l:-‘
) ]
second selected 4,.' angle

Trim

Controls whether CHAMEFER trims the selected edges to the chamfer line
endpoints.

Enter Trim mode option [Trim/No trim] <current>:
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NOTE Trim sets the TRIMMODE system variable to 1; No Trim sets TRIMMODE
to 0.

If the TRIMMODE system variable is set to 1, CHAMFER trims the intersecting
lines to the endpoints of the chamfer line. If the selected lines do not intersect,
CHAMEFER extends or trims them so that they do. If TRIMMODE is set to O,
the chamfer is created without trimming the selected lines.

Method

Controls whether CHAMFER uses two distances or a distance and an angle to
create the chamfer.

Enter trim method [Distance/Angle] <current>:

Multiple

Chamfers the edges of more than one set of objects. CHAMFER displays the
main prompt and the Select Second Object prompt repeatedly until you press
Enter to end the command.

CHANGE

Quick Reference

Changes the properties of existing objects.

E Command entry: change
Select objects:

Except for zero-thickness lines, the objects selected must be parallel to the
current user coordinate system (UCS).

If you select lines and other changeable objects in the same selection set, you
get varying results depending on the object selection sequence. The easiest
way to use CHANGE is to select only lines in a selection set or select only
objects other than lines in a selection set.

Specify change point or [Properties]: Specify a new point, or press Enter to enter
new values
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Change Point or Values

Changes the selected objects. The result depends on the type of objects you
select.

Lines Moves the endpoints of the selected lines that are closest to the change
point to the new point, unless Ortho mode is on. If Ortho mode is on, the
selected lines are modified so that they become parallel to either the X or the
Y axis; their endpoints are not moved to the specified coordinate.

2 2

Crtho off Crtho on

Circles Changes the circle radius. If you selected more than one circle, the
prompt is repeated for the next circle.

Specify new circle radius <no change>:

N
."r F - "x__ -I".

Text Changes text position and other properties.

Specify new text insertion point <no change>:

Specifying a new location repositions the text. Pressing Enter leaves the text
in its original position.

Enter new text style <current>:

If the text has a fixed height, the height prompt is not displayed.

Specify new height <current>:

Specify new rotation angle <current>:

Enter new text <current>:

The next object is highlighted and prompts are displayed.

Attribute Definitions Changes the text and text properties of an attribute
that is not part of a block.
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Specify new text insertion point <no change>:

Specifying a new location repositions the text. Pressing Enter leaves the text
at its original position.

Enter new text style <current>:

If the text has a fixed height, the height prompt is not displayed
Specify new height <current>:

Specify new rotation angle <current>:

Enter new tag <current>:

Enter new prompt <current>:

Enter new default value <current>:

Blocks Changes the location or rotation of a block.

Specify new block insertion point: Specify a point (1), or press Enter

Specifying a new location repositions the block. Pressing Enter leaves the block
in its original position.

Specify new block rotation angle <current>:

The block is rotated about its insertion point to the specified angle.

Properties
Modifies properties of existing objects.

Enter property to change
[Color/Elev/LAyer/LType/1tScale/LWeight/Thickness/Material/Annotative]:

NOTE The Plotstyle option is displayed only when you are using named plot styles.

If you select several objects with different values for the property you want
to change, varies is displayed as the current value.

You can change several properties at a time. The Enter Property to Change
prompt is redisplayed after each option is completed.

Color

Changes the color of the selected objects.

Enter new color [Truecolor/COlorbook] <current>: Enter a color name or a number
from 1 through 255, enter t, enter co, enter bylayer or byblock, or press Enter
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For example, to change a color to red, enter red or 1. If you enter bylayer, the
object assumes the color of the layer on which it is located. If you enter
byblock, the object inherits the color of the block of which it is a component.
True Color Specifies a true color to be used for the selected object.

Red, Green, Blue: Enter three integer values from 0 to 255 separated by commas to
specify a true color

Color Book Specifies a color from a loaded color book to be used for the
selected object.

Enter Color Book name: Enter the name of a color book that has been installed,
such as PANTONE

If you enter a color book name, the following prompt is displayed.

Enter color name: Enter the name of a color included in the selected color book, such
as Pantone 573

Elev

Changes the Z-axis elevation of 2D objects.

Specify new elevation <current>:

You can change the elevation of an object only if all its points have the same
Z value.

z Z
Y <>
A r,/\(
< o
Sy “hx
Elev=0 Elew =2
Layer

Changes the layer of the selected objects.

Enter new layer name <current>:

Ltype
Changes the linetype of the selected objects.
Enter new linetype name <current>:

If the new linetype is not loaded, the program tries to load it from the standard
linetype library file, acad.lin. If this procedure fails, use LINETYPE to load the

linetype.
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Ltscale
Changes the linetype scale factor of the selected objects.

Specify new linetype scale <current>:

Lweight

Changes the lineweight of the selected objects. Lineweight values are
predefined values. If you enter a value that is not a predefined value, the
closest predefined lineweight is assigned to the selected objects.

Enter new lineweight <current>:

Thickness
Changes the Z-direction thickness of 2D objects.
Specify new thickness <current>:

Changing the thickness of a 3D polyline, dimension, or layout viewport object
has no effect.

o i

Material
Changes the material of the selected objects if a material is attached.

Enter new material name <ByLayer>:

Annotative
Changes the property of the selected objects.

Make annotative? [Yes/No] <current>: Enter'y or n, or press Enter

CHECKSTANDARDS

Quick Reference

Checks the current drawing for standards violations.

318 | Chapter 4 C Commands



Access Methods

4

Button

£ Ribbon: Manage tab » CAD Standards panel » Check.
£ Menu: Tools » CAD Standards » Check

® Toolbar: CAD Standards
E Command entry: checkstandards
Summary

Set standards by creating a file that defines properties for layers, dimension
styles, linetypes, and text styles, and save it as a standards file with the .dws
file name extension.

The Check Standards dialog box is displayed.

Check Standards Dialog Box

Quick Reference

Access Methods

Analyzes the current drawing for standards violations.

4

Button

£ Ribbon: Manage tab » CAD Standards panel » Check.
£ Menu: Tools » CAD Standards » Check

£ Toolbar: CAD Standards ¥

EE Command entry: checkstandards
Problem
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Provides a description of a nonstandard object in the current drawing. To fix
a problem, select a replacement from the Replace With list, and then click
Fix.

Replace With

Lists possible replacements for the current standards violation. If a
recommended fix is available, it is preceded by a check mark. If a recommended
fix is not available, no items are highlighted in the Replace With list.

Preview of Changes

Indicates the properties of the nonstandard object that will be changed if the
fix currently selected in the Replace With list is applied.

Fix
Fixes the nonstandard object using the item currently selected in the Replace
With list, and advances to the next nonstandard object in the current drawing.

This button is unavailable if a recommended fix does not exist or if an item
is not highlighted in the Replace With list.

Next Problem

Advances to the next nonstandard object in the current drawing without
applying a fix.

Mark This Problem as Ignored

Flags the current problem as ignored. If the Show Ignored Problems option is
turned off in the CAD Standards Settings dialog box, problems flagged as
ignored are not displayed the next time the drawing is checked.

Settings

Displays the CAD Standards Settings dialog box, which specifies additional
settings for the Check Standards dialog box and the Configure Standards dialog
box.

Close

Closes the Check Standards dialog box without applying a fix to the standards
violation currently displayed in Problem.
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CHPROP

Quick Reference

Changes the properties of an object.

EE Command entry: chprop

Select objects:

Enter property to change
[Color/LAyer/LType/ltScale/LWeight/Thickness/Material/Annotative]:

NOTE The Plotstyle option is displayed only when you are using named plot styles.

If you select several objects with different values for the property you want
to change, varies is displayed as the current value.

Color
Changes the color of the selected objects.

Enter new color [Truecolor/COlorbook]| <current>: Enter a color name or a number
from 1 through 255, enter t, enter co, enter bylayer or byblock, or press Enter

For example, to change a color to red, enter red or 1. If you enter bylayer, the
object assumes the color of the layer on which it is located. If you enter
byblock, the object inherits the color of the block of which it is a component.
True Color Specifies a true color to be used for the selected object.

Red, Green, Blue: Enter three integer values from 0 to 255 separated by commas to
specify a true color

Color Book Specifies a color from a loaded color book to be used for the
selected object.

Enter Color Book name: Enter the name of a color book that has been installed,
such as PANTONE®

If you enter a color book name, the following prompt is displayed.

Enter color name: Enter the name of a color included in the selected color book, such
as PANTONE® 573

Layer
Changes the layer of the selected objects.

Enter new layer name <current>:
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Ltype
Changes the linetype of the selected objects.
Enter new linetype name <current>:

If the new linetype is not loaded, the program tries to load it from the standard
linetype library file, acad.lin. If this procedure fails, use LINETYPE to load the

linetype.
Ltscale

Changes the linetype scale factor of the selected objects.

Specify new linetype scale <current>:

Lweight

Changes the lineweight of the selected objects. Lineweight values are
predefined values. If you enter a value that is not a predefined value, the
closest predefined lineweight is assigned to the selected objects.

Enter new lineweight <current>:

Thickness
Changes the Z-direction thickness of 2D objects.
Specify new thickness <current>:

Changing the thickness of a 3D polyline, dimension, or layout viewport object
has no effect.

SR i

Material
Changes the material of the selected objects if a material is attached.

Enter new material name <ByLayer>:

Annotative
Changes the property of the selected objects.

Make annotative? [Yes/No] <current>: Entery or n, or press Enter
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CHSPACE

CIRCLE

Quick Reference
Moves objects between model space and paper space.

Access Methods

=

Button

£ Ribbon: Home tab » Modify panel » Change Space
£ Menu: Modify » Change Space

E Command entry: chspace
List of Prompts
The following prompts are displayed.

Select objects:
Set the SOURCE viewport active and press Enter to continue:

Returns prompts similar to the following:

N object(s) changed from MODEL space to PAPER space.
Objects were scaled by a factor of n to maintain visual appearance.

The moved object is scaled appropriately in the new space.

When transferring objects to paper space, the SOURCE viewport that you click
determines the paper space location of the transferred objects. When
transferring objects to model space, the TARGET viewport that you click
determines the model space location of the transferred objects.

Quick Reference

Creates a circle.
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Access Methods

@

Button

£ Ribbon: Home tab » Draw panel » Center, Radius.
£ Menu: Draw » Circle

£ Toolbar: Draw @

E Command entry: circle

Specify center point on page 324 for circle or [3P/2P/Ttr (tan tan radius)]: Specify
a point or enter an option

Center Point

Draws a circle based on a center point and a diameter or a radius.

Specify radius of circle or [Diameter]: Specify a point, enter a value, enter d, or
press Enter
Radius Defines the radius of the circle. Enter a value, or specify a point.

radius

Diameter Defines the diameter of the circle. Enter a value, or specify a second
point.

diameter

Specify diameter of circle <current>: Specify a point (2), enter a value, or press
Enter
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3P (Three Points)
Draws a circle based on three points on the circumference.

Specify first point on circle: Specify a point (1)
Specify second point on circle: Specify a point (2)
Specify third point on circle: Specify a point (3)

2P (Two Points)
Draws a circle based on two endpoints of the diameter.

Specify first endpoint of circle's diameter: Specify a point (1)
Specify second endpoint of circle's diameter: Specify a point (2)

TTR (Tangent, Tangent, Radius)
Draws a circle with a specified radius tangent to two objects.

Specify point on object for first tangent of circle: Select a circle, arc, or line
Specify point on object for second tangent of circle: Select a circle, arc, or line
Specify radius of circle <current>:
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tan, tan, radius
Sometimes more than one circle matches the specified criteria. The program

draws the circle of the specified radius whose tangent points are closest to the
selected points.
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CLASSICIMAGE

Quick Reference

Manages referenced image files in the current drawing
E Command entry: classicimage

The legacy Image Manager is displayed. The IMAGE command now displays
the External References palette.

NOTE This command will be removed in future releases.

CLASSICLAYER

Quick Reference

Opens the modal Layer Properties Manager.
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EE Command entry: classiclayer

The legacy Layer Properties Manager is displayed. The LAYER command
displays the current Layer Properties Manager.

NOTE This command will be removed in future releases.

CLASSICXREF

Quick Reference

Manages referenced drawing files in the current drawing
E Command entry: classicxref

The legacy Xref Manager is displayed. The EXTERNALREFERENCES on page
736 command displays the current External References palette.

NOTE This command will be removed in future releases.

CLEANSCREENON

Quick Reference

Clears the screen of toolbars and dockable windows (excluding the command
line).

£ Menu: View » Clean Screen
EE Command entry: cleanscreenon

The screen displays only the menu bar, the Model and layout tabs at the
bottom of the drawing, the status bars, and the command line. Use
CLEANSCREENOFF to restore display of interface items except menu bar,
status bar, and the command line. Press Ctrl+0 (zero) to switch between
CLEANSCREENON and CLEANSCREENOFE. A Clean Screen button is available
in the lower-right corner of the application status bar.
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CLEANSCREENOFF

CLIP

Quick Reference
Restores display of toolbars and dockable windows (excluding the command
line).

£ Menu: View » Clean Screen
EE Command entry: cleanscreenoff

Restores the state of the display before CLEANSCREENON was used. Use
CLEANSCREENON to clear the screen of toolbars and dockable windows
(excluding the command line). Press Ctrl+0 (zero) to switch between
CLEANSCREENON and CLEANSCREENOFE. The Clean Screen button is
available in the lower-right corner of the application status bar.

Quick Reference

Crops a selected external reference, image, viewport, or underlay (DWF, DWFx,
PDF, or DGN) to a specified boundary.

Access Methods

=

Button

£ Ribbon: Insert tab » Reference panel » Clip
EE Command entry: clip

Summary

The clipping boundary determines a portion of an image, underlay, viewport,
or external reference to hide. The visibility of the clipping boundary is
controlled by the FRAME on page 2162 system variable.
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List of Prompts

The list of prompts varies depending on whether you are clipping an underlay,
image, external reference, or viewport.

Underlay and Image Prompts

The following prompts are displayed.

On Turns on clipping and displays the underlay clipped to the previously
defined boundary.

Off Turns off clipping and displays the entire PDF underlay and frame.

If you clip the underlay again while clipping is off, clipping automatically
turns on. You are prompted to delete the old boundary even when clipping
is off and the clipping boundary is not visible.

Delete Removes a predefined clipping boundary and redisplays the full original
underlay.

New Boundary Defines a rectangular or polygonal clipping boundary, or
generates a polygonal clipping boundary from a polyline.

NOTE You can only create a new clipping boundary for an underlay when the
old boundary is deleted.

Select Polyline Defines the boundary with the selected polyline. The polyline
can be open but must consist of straight line segments and cannot intersect
itself.

Polygonal Defines a polygonal clipping boundary with three or more points
that you specify for the vertices of a polygon.

Rectangular Defines a rectangular boundary with the points that you specify
for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped
either outside the boundary or inside the boundary.

External Reference Prompts

The following prompts are displayed.

Select objects: Use an object selection method and press Enter when you finish
selecting objects

Enter clipping option [ON on page 1991/OFF on page 1991/Clipdepth on page
1991/Delete on page 1991/generate Polyline on page 1991/New boundary on page
1991] <New>: Select an option or press Enter
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On
Displays the clipped portion of the external reference or block in the current
drawing.

Off
Displays all of the geometry of the external reference or block in the current
drawing, ignoring the clipping boundary.

Clipdepth

Sets the front and back clipping planes on an xref or block. Objects outside
the volume defined by the boundary and the specified depth are not displayed.
Regardless of the current UCS, the clip depth is applied parallel to the clipping
boundary.

Front Clip Point Creates a clipping plane passing through and perpendicular
to the clipping boundary.

Distance Creates a clipping plane the specified distance from and parallel to
the clipping boundary.

Remove Removes both the front and back clipping planes.

Delete

Removes a clipping boundary for the selected xref or block. To temporarily
turn off a clipping boundary, use the Off option. Delete erases the clipping
boundary and the clipdepth. The ERASE on page 696 command cannot be used
to delete clipping boundaries.

Generate Polyline

Automatically draws a polyline coincident with the clipping boundary. The
polyline assumes the current layer, linetype, lineweight, and color settings.
Use this option when you want to modify the current clipping boundary using
PEDIT on page 1355 and then redefine the clipping boundary with the new
polyline. To see the entire xref while redefining the boundary, use the Off
option.

New Boundary
Defines a rectangular or polygonal clipping boundary, or generates a polygonal
clipping boundary from a polyline.

NOTE You can only create a new clipping boundary for a selected XREF underlay
when the old boundary is deleted.

Select Polyline Defines the boundary with the selected polyline. The polyline
can be open but must consist of straight line segments and cannot intersect
itself.
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CLOSE

Polygonal Defines a polygonal clipping boundary with three or more points
that you specify for the vertices of a polygon.

Rectangular Defines a rectangular boundary with the points that you specify
for opposite corners.

Invert Clip Inverts the mode of the clipping boundary: objects are clipped
either outside the boundary or inside the boundary.

Viewport Prompts

NOTE You cannot clip a viewport in model space. You must be in paper space.

Clipping Obiject Select the viewport to clip.

Polygonal Draws a clipping boundary. You can draw line segments or arc
segments by specifying points. The following prompt is displayed:

Specify start point:

Specify next point or [Arc/Close/Length/Undo]:

The descriptions of the Next Point, Arc, Close, Length, and Undo options
match the descriptions of the corresponding options in the PLINE command.

Delete Deletes the clipping boundary of a selected viewport. This option is
available only if the selected viewport has already been clipped. If you clip a
viewport that has been previously clipped, the original clipping boundary is
deleted, and the new clipping boundary is applied.

Quick Reference
Closes the current drawing.

Access Methods

£ Menu: Application menu » Close » Current Drawing
EE Command entry: close

Summary

The current drawing is closed. If you modified the drawing since it was last
saved, you are prompted to save or discard the changes.
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You can close a file that has been opened in read-only mode if you have made
no changes or if you are willing to discard changes. To save changes to a
read-only file, you must use the SAVEAS command.

CLOSEALL

Quick Reference
Closes all currently open drawings.

Access Methods

£ Menu: Application menu » Close » Current Drawing
E2 Command entry: closeall

Summary

All open drawings are closed. A message box is displayed for each unsaved
drawing, in which you can save any changes to the drawing before closing it.

COLOR

Quick Reference
Sets the color for new objects.
Access Methods

o

Button

£ Ribbon: Home tab » Properties panel » Object Color
£ Menu: Format » Color
E Command entry: color (or 'color for transparent use)

Summary

The Select Color dialog box is displayed.
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If you enter -color at the Command prompt, options are displayed.

Select Color Dialog Box

Quick Reference

Access Methods

=

Button

£ Ribbon: Home tab » Properties panel » Object Color
£ Menu: Format » Color
E2 Command entry: color (or 'color for transparent use)

Define the color of objects. You can select from the 255 AutoCAD Color Index
(ACI) colors, true colors, and Color Book colors.

B Index Color
B True Color

Hm Color Books

Index Color Tab (Select Color Dialog Box)

Quick Reference
Specifies color settings using the 255 AutoCAD Color Index (ACI) colors.

AutoCAD Color Index (ACI) Palettes

Specifies a color from the AutoCAD Color Index. If you hover over a color,
the number of the color and its red, green, blue value are displayed below the
palette. Click a color to select it, or enter the color number or name in the
Color box.

The large palette displays colors 10 through 249.
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The second palette displays colors 1 through 9; these colors have names as
well as numbers.

The third palette displays colors 250 through 255; these colors are shades of
gray.
Index Color

Indicates the ACI color number when you hover over a color.

Red, Green, Blue

Indicates the RGB color value when you hover over a color.

Bylayer

Specifies that new objects assume the color assigned to the layer on which
you create them. When BYLAYER is selected, the color of the current layer is
displayed in the Old and New color swatches.

Byblock

Specifies that new objects use the default color (white or black, depending on
your background color) until you group the objects into a block and insert
the block. When you insert the block into a drawing, the objects in the block
inherit the current Color setting.

NOTE The BYLAYER and BYBLOCK options do not apply to the LIGHT command.

Color

Specifies a color name, BYLAYER or BYBLOCK color, or an AutoCAD Color
Index (ACI) number of 1 through 255. The New color swatch shows the most
recently selected color.

Old Color Swatch

Displays the previously selected color.

New Color Swatch

Displays the currently selected color.
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True Color Tab (Select Color Dialog Box)

Quick Reference

Specifies color settings using true colors (24-bit color) with either the Hue,
Saturation, and Luminance (HSL) color model or the Red, Green, and Blue
(RGB) color model. Over sixteen million colors are available when using true
color functionality. The options available on the True Color tab are dependent
on whether the HSL or RGB color model is specified.

HSL Color Model
Specifies the HSL color model for selecting colors.

Hue, saturation, and luminance are properties of colors. By manipulating the
values of these properties, you can specify a wide range of colors.

Hue

Specifies the hue of a color. Hues represent a specific wavelength of light
within the visible spectrum. To specify a hue, use the color spectrum or specify
a value in the Hue box. Adjusting this value affects the RGB value. Valid hue
values are from O to 360 degrees.

Saturation

Specifies the purity of a color. High saturation causes a color to look more
pure while low saturation causes a color to look washed-out. To specify color
saturation, use the color spectrum or specify a value in the Saturation box.
Adjusting this value affects the RGB value. Valid saturation values are from O
to 100%.

Luminance

Specifies the brightness of a color. To specify color luminance, use the color
slider or specify a value in the Luminance box. Valid luminance values are
from O to 100%. A value of 0% represents the color black, 100% represents
white, and 50% represents the optimal brightness for the color. Adjusting this
value also affects the RGB value.

Color Spectrum Specifies the hue and purity of a color. To specify a hue,
move the crosshairs from side to side over the color spectrum. To specify color
saturation, move the crosshairs from top to bottom over the color spectrum.

Color Slider Specifies the brightness of a color. To specify color luminance,
adjust the bar on the color slider or specify a value in the Luminance box.
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RGB Color Model

Specifies the RGB color model for selecting colors. The options available on
the True Color tab are dependent on whether the HSL or RGB color model is
specified.

Colors can be broken down into components of red, green, and blue. The
values specified for each component represent the intensity of the red, green,
and blue components. The combination of these values can be manipulated
to create a wide range of colors.

Red

Specifies the red component of a color. Adjust the slider on the color bar or
specify a value from 1 to 255 in the Red box. If this value is adjusted, it will
be reflected in the HSL color mode values.

Green

Specifies the green component of a color. Adjust the slider on the color bar
or specify a value from 1 to 255 in the Green box. If this value is adjusted, it
will be reflected in the HSL color mode values.

Blue

Specifies the blue component of a color. Adjust the slider on the color bar or
specify a value from 1 to 255 in the Blue box. If this value is adjusted, it will
be reflected in the HSL color mode values.

Color

Specifies the RGB color value. This option is updated when changes are made
to HSL or RGB options. You can also edit the RGB value directly using the
following format: 000,000,000.

True Color Stored as RGB

Indicates the value for each RGB color component.

Old Color Swatch

Displays the previously selected color.

New Color Swatch

Displays the currently selected color.
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Color Books Tab (Select Color Dialog Box)

Quick Reference

Specifies colors using third-party color books (such as PANTONE®) or
user-defined color books. Once a color book is selected, the Color Books tab
displays the name of the selected color book.

Color Book

Specifies the color book to be used when selecting colors. The list consists of
all the color books that are found in the Color Book Locations specified in
the Options dialog box, Files tab.

Displays the pages of the selected color book and the colors and color names
on each page. Color books containing up to ten colors per page are supported.
If a color book is not paginated, the colors are organized into pages containing
seven colors per page. To view color book pages, select an area on the color
slider or use the up and down arrows to browse.

RGB Equivalent

Indicates the value for each RGB color component.

Color

Indicates the currently selected color book color. You can search for a specific
color in a color book by entering the number of the color swatch and pressing
TAB. This action updates the New color swatch with the requested color
number. If the specified color is not found in the color book, the closest
number match is displayed.

Old Color Swatch

Displays the previously selected color.

New Color Swatch

Displays the currently selected color.
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-COLOR

Quick Reference

If you enter -color at the Command prompt, the following prompts are
displayed.

Enter default object color [Truecolor/COlorbook] <BYLAYER>: Enter a color,
enter t, enter co, or press Enter

You can enter a color from the AutoCAD Color Index (a color name or
number), a true color, or a color from a color book.

You can enter the color number (1 through 255) or the color name (the names
for the first seven colors). For example, you can specify the color red by
entering the ACI number 1 or the ACI name red.

You can also enter bylayer or byblock. If you enter byblock, all new objects
are drawn in the default color (white or black, depending on your background
color) until they are grouped into a block. When you insert the block in a
drawing, the objects in the block inherit the current setting of COLOR.

WARNING [f you used a mixture of color methods to draw the objects that make
up a block, inserting that block or changing its color produces complex results.

If you enter bylayer, new objects assume the color assigned to the layer on
which you create them. See the LAYER command for information about
assigning a color to a layer.

True Color

Specifies a true color to be used for the selected object.

Red, Green, Blue: Enter three integer values from 0 to 255 separated by commas to
specify a true color

Color Book

Specifies a color from a loaded color book to be used for the selected object.

Enter Color Book name: Enter the name of a color book that has been installed,
such as Pantone

If you enter a color book name, you are prompted to enter the color name in
the color book.
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Enter color name: Enter the name of a color included in the selected color book, such
as Pantone 573

COMMANDLINE

Quick Reference
Displays the Command Line window.

Access Methods

=

Button

£ Ribbon: View tab » Palettes panel » Command Line

£ Menu: Tools » Command Line

EE Command entry: commandline

Summary

Displays the Command Line window when it has been hidden.

You can display commands, system variables, options, messages, and prompts
in a dockable and resizable window called the Command Line window.

COMMANDLINEHIDE

Quick Reference

Hides the Command Line window.

£ Menu: Tools » Command Line
E Command entry: commandlinehide

Hides the Command Line window. When the Command Line window is
hidden, you can still enter commands with dynamic prompts turned on.
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COMPILE

CONE

Quick Reference

Compiles shape files and PostScript font files into SHX files.
EE Command entry: compile

The Select Shape or Font File dialog box (a standard file selection dialog box)
is displayed. Enter the SHP or PFB file name in the dialog box. The compiled
file is assigned this name with the file extension .shx.

Quick Reference
Creates a 3D solid cone.

Access Methods

O
Button

£ Ribbon: Home tab » Modeling panel » Cone
£ Menu: Draw » Modeling » Cone

o,

£ Toolbar: Modeling Q

E2 Command entry: cone

Specify center point of base or [3P/2P/Ttr/Elliptical]: Specify a point (1) or enter
an option

Specify base radius or [Diameter] <default>: Specify a base radius, enter d to
specify a diameter, or press Enter to specify the default base radius value

Specify height or [2Point/Axis endpoint/Top radius] <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Creates a 3D solid with a circular or elliptical base that tapers symmetrically
to a point or to a circular or elliptical planar face. You can control the
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smoothness of 3D curved solids, such as a cone, in a shaded or hidden visual
style with the FACETRES system variable.

Use the Top Radius option to create a cone frustum.

Initially, the default base radius is not set to any value. During a drawing
session, the default value for the base radius is always the previously entered
base radius value for any solid primitive.

3P (Three Points)

Defines the base circumference and base plane of the cone by specifying three
points.

Specify first point: Specify a point

Specify second point: Specify a point

Specify third point: Specify a point

Specify height or [2Point/Axis endpoint/Top radius| <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.
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2Point Specifies that the height of the cone is the distance between the two
specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cone axis. The axis
endpoint is the top point of the cone or the center point of the top face of
the cone frustum (Top Radius option). The axis endpoint can be located

anywhere in 3D space. The axis endpoint defines the length and orientation
of the cone.

Specify axis endpoint: Specify a point

Top Radius Specifies the top radius of the cone, creating a cone frustum.

Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.

2P (Two Points)
Defines the base diameter of the cone by specifying two points.

Specify first endpoint of diameter: Specify a point

Specify second endpoint of diameter: Specify a point

Specify height or [2Point/Axis endpoint/Top radius| <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cone is the distance between the two
specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cone axis. The axis
endpoint is the top point of the cone or the center point of the top face of
the cone frustum (Top Radius option). The axis endpoint can be located

anywhere in 3D space. The axis endpoint defines the length and orientation
of the cone.

Specify axis endpoint: Specify a point

Top Radius Specifies the top radius of the cone, creating a cone frustum.
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Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.

TTR (Tangent, Tangent, Radius)
Defines the base of the cone with a specified radius tangent to two objects.

Specify point on object for first tangent: Select a point on an object

Specify point on object for second tangent: Select a point on an object
Specify radius of circle <default>: Specify a base radius or press Enter to specify
the default base radius value

Sometimes, more than one base matches the specified criteria. The program
draws the base of the specified radius whose tangent points are closest to the
selected points.

Specify height or [2Point/Axis endpoint/Top radius] <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cone is the distance between the two
specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cone axis. The axis
endpoint is the top point of the cone or the center point of the top face of
the cone frustum (Top Radius option). The axis endpoint can be located

anywhere in 3D space. The axis endpoint defines the length and orientation
of the cone.

Specify axis endpoint: Specify a point

Top Radius Specifies the top radius of the cone, creating a cone frustum.

Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.
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Elliptical

Specifies an elliptical base for the cone.

Specify endpoint of first axis or [Center]: Specify a point
Specify other endpoint of first axis: Specify a point
Specify endpoint of second axis: Specify a point

Specify height or [2Point/Axis endpoint/Top radius] <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

Center Creates the base of the cone by using a specified center point.
Specify center point: Specify a point

Specify distance to first axis <default>: Specify a distance or press Enter to specify
the default distance value

Specify endpoint of second axis: Specify a point

Specify height or [2Point/Axis endpoint/Top radius| <default>: Specify a height,
enter an option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cone is the distance between the two
specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cone axis. The axis
endpoint is the top point of the cone or the center point of the top face of
the cone frustum (Top Radius option). The axis endpoint can be located

anywhere in 3D space. The axis endpoint defines the length and orientation
of the cone.

Specify axis endpoint: Specify a point

Top Radius Specifies the top radius of the cone, creating a cone frustum.

Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.
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Diameter
Specifies the diameter for the base of the cone.

Specify diameter <default>: Specify a diameter or press Enter to specify the default
value

Initially, the default diameter is not set to any value. During a drawing session,
the default value for the diameter is always the previously entered diameter
value for any solid primitive.

2Point Specifies that the height of the cone is the distance between the two
specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cone axis. The axis
endpoint is the top point of the cone or the center point of the top face of
the cone frustum (Top Radius option). The axis endpoint can be located

anywhere in 3D space. The axis endpoint defines the length and orientation
of the cone.

Specify axis endpoint: Specify a point
Top Radius Specifies the top radius of the cone, creating a cone frustum.

Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.

2Point

Specifies that the height of the cone is the distance between the two specified
points.

Specify first point: Specify a point
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Specify second point: Specify a point

Axis Endpoint

Specifies the endpoint location for the cone axis. The axis endpoint is the top
point of the cone or the center point of the top face of the cone frustum (Top
Radius option). The axis endpoint can be located anywhere in 3D space. The
axis endpoint defines the length and orientation of the cone.

Specify axis endpoint: Specify a point

Top Radius
Specifies the top radius of the cone, creating a cone frustum.

Specify top radius <default>: Specify a value or press Enter to specify the default
value

Initially, the default top radius is not set to any value. During a drawing session,
the default value for the top radius is always the previously entered top radius
value for any solid primitive.

CONSTRAINTBAR

Quick Reference

A toolbar-like Ul element that displays the available geometric constraints on
an object.

Access Methods

Button

£ Ribbon: Parametric tab » Geometric panel » Show

£ Menu: Parametric » Constraints Bars » Select Objects

£ Toolbar: Parametric

E Command entry: constraintbar

Select objects to show constraints or [Showall/Hideall] <Showall>:Enter the
appropriate value to show or hide constraint bars in the drawing.
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The selection preview behavior for constraint bars is as follows:

B Placing the cursor over an icon on a constraint bar highlights related
geometry.

B Placing the cursor over a constrained object (while constraint bars are
displayed) highlights the constraint icons associated with the selected
object.

The CONSTRAINTBARMODE system variable or the CONSTRAINTSETTINGS
command controls the display of geometric constraints on constraint bars,
when constraint bar are displayed.

Showall

Displays constraint bars for all objects with geometric constraints applied to
them.

Hideall

Hides constraint bars for all the objects with geometric constraints applied to
them.

Shortcut Menu Options

Apart from displaying or hiding constraint bars, you can also perform the
following actions:

Delete Deletes the geometric constraint applied for the selected object.
Hide Hides the constraint bar for the selected object.

Hide All Constraints Hides all constraint bars for objects with geometric
constraints applied to them.

Constraint Bar Settings Displays the Constraint Settings dialog box.

CONSTRAINTSETTINGS

Quick Reference

Controls the display of geometric constraints on constraint bars.
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Access Methods
e

Button

£ Ribbon: Parametric tab » Dimensional panel » *| » Constraint
Settings.
£ Menu: Parametric » Constraint Settings

£ Toolbar: Parametric
EE Command entry: constraintsettings

The Constraint Settings Dialog Box is displayed.

Constraint Settings Dialog Box

Quick Reference

The Constraint Settings dialog box includes the following:
B Geometric Tab
B Dimensional Tab

B Autoconstrain Tab

Geometric Tab
Controls the display of constraint types on constraint bars.

Constraint Bar Settings Controls the display of constraint bars or constraint
point markers for objects in the drawing editor.

For example, you can hide the display of constraint bars for Horizontal and
Vertical constraints.

Select All Selects the geometric constraint types.
Clear All Clears the selected geometric constraint types.

Only display constraint bars for object in the current plane Displays
constraint bars for geometrically constrained objects only on the current plane.
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Constraint Bar Transparency Sets the transparency level of constraint bars
in a drawing.

Show constraint bars after applying constraints to selected objects Displays
relevant constraint bars after you apply a constraint manually or when you
use the AUTOCONSTRAIN command

Dimensional Tab
Sets preferences in behavior when displaying dimensional constraints.

Show All Dynamic Constraints Display all dynamic dimensional constraints
by default.

Dimensional Constraint Format Sets the display of the dimensional name
format and lock icon

Dimension Name Format Specifies the format for the text displayed when
dimensional constraints are applied.

Set the name format to display: Name, Value, or Name and Expression.

For example: Width=Length/2

Show Lock Icon for Annotational Constraints Displays a lock icon against
an object that has an annotational constraint applied.

The check box selection is dependent on the value of the
DIMCONSTRAINTICON on page 2091 system variable.

B The check box is cleared if DIMCONSTRAINTICON is set to O or 1.
B The check box is selected if DIMCONSTRAINTICON is set to 2 or 3.

B If youselect the check box, the value of the DIMCONSTRAINTICON system
variable will be increased by 2. For example, the system variable will be
set to 2 if the old value is O.

B If you clear the check box, the value of the DIMCONSTRAINTICON system
variable will be decreased by 2. For example, the system variable will be
set to O if the old value is 2.

Show Hidden Dynamic Constraints for Selected Objects Displays dynamic
constraints that have been set to hide when selected.

Autoconstrain Tab

Controls the constraints that are applied to a selection set, and the order in
which they are applied when using the AUTOCONSTRAIN command.
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The following conditions are checked before multiple geometric constraints
are applied:

B Are the objects perpendicular or tangential to each other within the
tolerances specified in the AutoConstrain tab?

B Do they also intersect within the specified tolerances?

If the first condition is met, then tangent and perpendicular constraints are
always applied if the check boxes are cleared.

If you select the additional check boxes, then the distance tolerance is
considered for intersecting objects. If the objects do not intersect but the
nearest distance between them is within the distance tolerance specified, then
the constraint will be applied even if the check boxed are selected.

Autoconstrain Headings
B Priority — Controls the order in which constraints are applied.

B Constraint Type — Controls the type of constraint applied to objects.

B Apply — Controls the constraints that are applied when applying
constraints to multiple objects.

Move Up Changes the order of the selected item by moving it up in the list.

Move Down Changes the order of the selected item by moving it down in
the list.

Select All Selects all geometric constraint types to autoconstrain.
Clear All Clears all geometric constraint types to autoconstrain.
Reset Resets AutoConstrain settings to default values.

Tangent Objects Must Share an Intersection Point Specifies that two curves
must share a common point (as specified within the distance tolerance) for
the tangent constraint to be applied.

Perpendicular Objects Must Share an Intersection Point Specifies that lines
must intersect or the endpoint of one line must be coincident with the other
line or endpoint of the line as specified within the distance tolerance.

Tolerances Sets the acceptable tolerance values to determine whether a
constraint can be applied.

B Distance — Distance tolerance for determining whether constraints are
applied.
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B Angle — Angle tolerance for determining whether constraints are applied.

+CONSTRAINTSETTINGS

Quick Reference

Controls the tab that is displayed by default when the Constraint Settings
dialog box is invoked.

Tab Index Tab Displayed
0 Geometric tab

1 Dimensional tab
2 AutoConstrain tab

CONVERT

Quick Reference

Optimizes 2D polylines and associative hatches created in AutoCAD Release
13 or earlier.

E2 Command entry: convert

Enter type of objects to convert [Hatch/Polyline/All] <All>: Enter h for hatches,
p for polylines, or a for both

Hatch Converts all hatches in the drawing.

Enter object selection preference [Select/All] <All>: Enter s to select specific objects
to convert or a to convert all objects in the drawing

Polyline Converts all polylines in the drawing.

Enter object selection preference [Select/All] <All>: Enter s to select specific objects
to convert or a to convert all objects in the drawing

All Converts all polylines and hatches in the drawing.

Enter object selection preference [Select/All] <All>: Enter s to select specific objects
to convert or a to convert all objects in the drawing
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One or both of the following messages are displayed:

number hatch objects converted
number 2d polyline objects converted

Hatches are not updated automatically when a drawing from a previous release
is opened in Release 14 or later. Information about the rotation of a hatch
pattern may not be updated properly if you have changed the UCS since
creating the hatch. When updating hatches with CONVERT, it is recommended
that you use the Select option so that you can check your results.

In most cases, you do not need to update polylines with CONVERT. By default,
thePLINETYPE system variable specifies that polylines are updated
automatically when you open an older drawing. Polylines may be created in
the old format by third-party applications, and they may be contained in an
older drawing that was inserted as a block and then exploded.

NOTE Polylines containing curve-fit or splined segments always retain the old
format, as do polylines that store extended object data on their vertices. Editing
commands make no distinction between the two formats.

CONVERTCTB

Quick Reference

Converts a color-dependent plot style table (CTB) to a named plot style table
(STB).

EE Command entry: convertctb

Displays the Select File dialog box (a standard file selection dialog box), where
you can select the color-dependent plot style table file you want to convert.
The Save As dialog box is then displayed. If necessary, specify a new location
or name for the converted plot style table file.

CONVERTCTB saves a copy of a color-dependent plot style table as a named
plot style table, which you can then attach to drawings that use named plot
styles. The original color-dependent plot style table is not affected by
CONVERTCTB. The default location for the new named plot style table file is
in the Plot Styles folder. The default name for the new named plot style table
file is the same as the color-dependent plot style table name.
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CONVERTCTB creates one named plot style for each color that has unique
plot properties, one named plot style for each group of colors that are assigned
the same plot properties, and a default named plot style called NORMAL.

For example, if all the colors in a color-dependent plot style table have the
same plot properties, CONVERTCTB creates only two named plot styles in the
named plot style table: NORMAL, the default plot style, and STYLE 1, which
assumes the plot properties that were assigned to all the colors in the
color-dependent plot style table. However, suppose that all the colors in a
color-dependent plot style table have the same plot properties except for two
colors, BLUE and GREEN. If these colors each have unique plot properties,
CONVERTCTB creates four named plot styles in the named plot style table:
NORMAL, the default plot style; STYLE 1, which assumes the plot properties
of GREEN; STYLE 2, which assumes the plot properties of BLUE; and STYLE
3, which assumes the plot properties that were assigned to all the other colors.

CONVERTCTB gives the plot styles in the new named plot style table generic
names such as STYLE 1, STYLE 2. You can modify these generic plot style
names in the Plot Style Table Editor. Click the Edit button on the Plot Device
tab in the Page Setup dialog box. If you want to rename the plot styles, you
must do so before applying them to drawing layouts.

CONVERTOLDLIGHTS

Quick Reference

Converts lights created in previous drawing file formats to the current format.
E Command entry: convertoldlights

The lights in the drawing that were originally created in a previous drawing
file format are updated to the current drawing file format. Drawing file format
changes occur infrequently in AutoCAD-based products. For example, format
changes occurred in AutoCAD 2000, AutoCAD 2004, and AutoCAD 2007.

WARNING The conversion may not be correct in all cases. You may need to adjust
intensity, for example.
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CONVERTOLDMATERIALS

Quick Reference

Converts materials created in previous drawing file formats to the current
format.

EE Command entry: convertoldmaterials

The materials in the drawing that were originally created in a previous drawing
file format are updated to the current drawing file format. Drawing file format
changes occur infrequently in AutoCAD-based products. For example, format
changes occurred in AutoCAD 2000, AutoCAD 2004, and AutoCAD 2007.

WARNING The conversion may not be correct in all cases. You may need to adjust
material mapping, for example.

CONVERTPSTYLES

Quick Reference

Converts the current drawing to either named or color-dependent plot styles.
E2 Command entry: convertpstyles
A drawing can use either named or color-dependent plot styles, but not both.

CONVERTPSTYLES converts a currently open drawing from color-dependent
plot styles to named plot styles, or from named plot styles to color-dependent
plot styles, depending on which plot style method the drawing is currently
using.

m Converting drawings from color-dependent plot styles to named plot styles
B Converting drawings from named plot styles to color-dependent plot styles
When you convert a drawing, CONVERTPSTYLES sets thePSTYLEMODE system
variable to the appropriate setting (0 = named, 1= color-dependent).

For example, a drawing using color-dependent plot styles assigns plot properties
to objects and layers by color. In other words, all objects with the same color
have the same plot properties. CONVERTPSTYLES converts the drawing to

use named plot styles that can be applied to objects or layers independent of
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color assignment. In other words, all objects with the same color can have
different plot properties.

Converting Drawings from Color-Dependent to Named Plot Styles

A dialog box advises you to convert the drawing's plot style tables before
converting the drawing. You can convert the color-dependent plot style tables
assigned to the drawing to named plot style tables using CONVERTCTB.

The Select File dialog box (a standard file selection dialog box) is displayed,
where you select the named plot style table file to attach to the converted
drawing.

CONVERTPSTYLES requires you to select a named plot style table that was
converted using CONVERTCTB or created from a PC2 or PCP file. Normally
you should select the named plot style table that was converted from the
color-dependent plot style table that was assigned to the same drawing.

CONVERTPSTYLES attaches the selected named plot style table to model space
and to all layouts. Drawing layers are each assigned a named plot style (from
the converted plot style table) that has the same plot properties that their
color-dependent plot style had. Drawing objects that had the same
color-dependent plot style as their layer are assigned the named plot style
BYLAYER. Drawing objects that had a color-dependent plot style that was
different from their layer are assigned a named plot style that has the same
properties that their color-dependent plot style had.

After a drawing is converted to named plot styles, you can change the named
plot style table assignment or assign other named plot styles tables to model
space or layouts. You can also assign individual plot styles to drawing objects.

Converting Drawings from Named to Color-Dependent Plot Styles

A dialog box advises you that the named plot styles attached to objects and
named plot style tables attached to model space and layouts will be detached.

After a drawing is converted to color-dependent plot styles, you can assign a
color-dependent plot style table. Plot styles will be applied by color.

CONVTOSOLID

Quick Reference

Converts 3D meshes and polylines and circles with thickness to 3D solids.
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Access Methods

05

Button

£ Ribbon: Home tab » Solid Editing panel » Convert to Solid
£ Menu: Modify » 3D Operations » Convert to Solid
E Command entry: convtosolid

Summary

Take advantage of the solid modeling capabilities available for 3D solids. When
you convert mesh, you can specify whether the converted objects are smoothed
or faceted, and whether the faces are merged.

The smoothness and number of faces of the resulting 3D solid are controlled
by the SMOOTHMESHCONVERT system variable. Whereas the previous
example shows a conversion to a smooth, optimized 3D solid, the following
example shows a conversion to a faceted 3D solid in which the faces are not
merged, or optimized.
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The following tables list the objects that can be converted to solid objects and
some limitations on their conversion.

Objects that Can Be Converted to 3D Solids

Object Required properties

Mesh Encloses a volume with no gaps between edges (watertight)
Polyline Closed, uniform-width, with thickness

Polyline Closed, zero-width, with thickness

Surface Encloses a volume with no gaps between edges (such as a revolved

surface that is capped at both ends or closed mesh objects that
were converted to surfaces)

Limitations on Conversion to Solid Objects

Object Description
Polyline Cannot contain zero-width vertices.
Polyline Cannot contain segments of variable width.

Separate objects
that simulate a
closed surface

Cannot be a planar surface with contiguous edges or an exploded
3D solid box into six regions. However, you cannot convert those
separate objects back to a solid with CONVTOSOLID.
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Object Description

Planar surfaces Cannot convert separate objects, even if they enclose a volume
with contiguous without gaps.
edges

Exploded 3D solid  Cannot convert separate objects (in this case, regions).

You can select the objects to convert before you start the command.

The DELOB]J system variable controls whether the geometry used to create 3D
objects is automatically deleted when the new object is created or whether
you are prompted to delete the objects.

List of Prompts

The following prompt is displayed.

Select objects Specifies one or more objects to convert to 3D solid objects.
You can select objects with thickness or mesh objects.

If one or more objects in the selection set are invalid for the command, you
will be prompted again to select objects.

CONVTOSURFACE

Quick Reference

Converts objects to 3D surfaces.
Access Methods

s

Button
£ Ribbon: Home tab » Solid Editing panel » Convert to Surface

£ Menu: Modify » 3D Operations » Convert to Surface
E Command entry: convtosurface
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Summary

As you convert objects to solid objects, you can specify whether the resulting
object is smooth or faceted.

The smoothness and number of faces of the resulting surface are controlled
by the SMOOTHMESHCONVERT system variable. Whereas the previous
example shows a conversion to a smooth, optimized surface, the following
example shows a conversion to a faceted surface in which the faces are not
merged, or optimized.
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With the CONVTOSURFACE command, you can convert the following objects
into surfaces:

Objects That Can Be Converted to 3D Surfaces
Objects

2D solids

Regions

Open, zero-width polylines with thickness

Lines with thickness

Arcs with thickness

Mesh objects

Planar 3D faces
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COPY

N O S

objects converted to surfaces

You can select the objects to convert before you start the command.

NOTE You can create surfaces from 3D solids with curved faces, such as a cylinder,
with the EXPLODE command.

The DELOB]J system variable controls whether the geometry used to create 3D
objects is automatically deleted when the new object is created or whether
you are prompted to delete the objects.

List of Prompts

The following prompt is displayed.

Select objects Specifies one or more objects to convert to surfaces.

If one or more objects in the selection set are invalid for the command, you
will be prompted again to select objects.

Quick Reference

Copies objects a specified distance in a specified direction.
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Access Methods

o
9))

Button

£ Ribbon: Home tab » Modify panel » Copy
$ Menu: Modify » Copy
O
£ Toolbar: Modify @
Shortcut menu: Select the objects to copy, and right-click in the drawing
area. Click Copy Selection.
EE Command entry: copy
Select objects: Use an object selection method and press Enter when you finish
Current settings: Copy mode = current

Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify
a base point or enter an option

The two points you specify define a vector that indicates how far the copied
objects are to be moved and in what direction.

If you press Enter at the Specify Second Point prompt, the first point is
interpreted as a relative X, Y,Z displacement. For example, if you specify 2,3
for the base point and press Enter at the next prompt, the objects are copied
2 units in the X direction and 3 units in the Y direction from their current
position.

The COPY command repeats automatically by default. To exit the command,
press Enter.

With the COPYMODE system variable, you can control whether multiple
copies are created automatically.

1] mos

< oy

=]

<

Displacement
Specifies a relative distance and direction using coordinates.

Specify displacement <last value>: Enter coordinates to represent a vector
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Mode

Controls whether the command repeats automatically. This setting is controlled
by the COPYMODE system variable.

Enter a copy mode option [Single/Multiple] <current>: Enter s or m

Multiple

Overrides the Single mode setting. The COPY command is set to repeat
automatically for the duration of the command. This setting is controlled by
theCOPYMODE system variable.

NOTE This option is displayed only when copy mode is set to Single.

COPYBASE

Quick Reference
Copies selected objects to the Clipboard along with a specified base point.

Access Methods

B

Button

£ Menu: Edit » Copy with Base Point

Shortcut menu: End any active commands, right-click in the drawing area,
and choose Copy with Base Point.

EE Command entry: copybase

Specify base point:

Select objects:

The selected objects are copied to the Clipboard.

B Use PASTECLIP to move the copied objects from the Clipboard to a location
in the same document or to another document.

B When you paste an object copied with COPYBASE, it is placed relative to
the specified base point.
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COPYCLIP

Quick Reference
Copies selected objects to the Clipboard.

Access Methods

Ik

Button

£ Ribbon: Home tab » Clipboard panel » Copy Clip.
£ Menu: Edit » Copy

£ Toolbar: Standard IE

Shortcut menu: End any active commands, right-click in the drawing area,
and choose Copy.

EE Command entry: copyclip

Select objects:

COPYCLIP copies all objects you select to the Clipboard. You can paste the
contents of the Clipboard into a document or drawing as an OLE object.

NOTE You can also use Ctrl+C to run COPYCLIP. If the cursor is in the drawing
area, the selected objects are copied to the Clipboard. If the cursor is on the
command line or in the text window, the selected text is copied to the Clipboard.

When you copy objects to the Clipboard, information is stored in all available
formats. When you paste the Clipboard contents into a drawing, the format
that retains the most information is used. You can also use Copy and Paste
to transfer objects between drawings.

COPYHIST

Quick Reference

Copies the text in the command line history to the Clipboard.
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EE Command entry: copyhist

The text is copied to the Clipboard.

COPYLINK

Quick Reference
Copies the current view to the Clipboard for linking to other OLE applications.
Access Methods
™
[8
Button

£ Menu: Edit » Copy Link
EE Command entry: copylink

Summary

You can copy the current view to the Clipboard and then paste the contents
of the Clipboard into another document as a linked OLE object.

COPYTOLAYER

Quick Reference
Copies one or more objects to another layer.

Access Methods

Button

£ Ribbon: Home tab » Layers panel » Copy Objects to New Layer
£ Menu: Format » Layers » Copy Objects to New Layer
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227

£ Toolbar: Layers II s

E Command entry: copytolayer

Select objects to copy:

Select object on destination layer or [Name] <Name>: Select an object or enter
n

If you enter -copytolayer at the Command prompt, options are displayed.

Select Object on Destination Layer
Specifies the layer on which the selected objects are placed.

Specify Base Point or [Displacement/Exit] <eXit>: Specify a point, enter d, or
enter x
Specify Base Point Specifies the base point of the copied objects.

Specify second point of displacement or <use first point as displacement>:

Displacement Enters coordinate values that specify a relative distance and
direction.

Specify displacement <0.0000, 0.0000, 0.0000>:

Exit Cancels the command.

Name
Displays the Copy to Layer dialog box.

Specify Base Point or [Displacement/Exit] <eXit>: Specify a point, enter d, or
enter x
Specify Base Point Specifies the base point of the copied objects.

Specify second point of displacement or <use first point as displacement>:

Displacement Enters coordinate values that specify a relative distance and
direction.

Specify displacement <0.0000, 0.0000, 0.0000>:
Exit Cancels the command.

Creates duplicates of selected objects on a layer that you specify. You can also
specify a different location for the duplicated objects.
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Copy To Layer Dialog Box

Quick Reference
Specifies the layer on which the selected objects are placed.

Destination Layer

Displays a list of layers that you can select as the destination layer. You can
also enter a name to create a new layer. The new layer inherits the properties
(on/off, freeze/thaw, locked/unlocked, etc.) of the current layer.

-COPYTOLAYER

Quick Reference

If you enter -copytolayer at the Command prompt, the following prompts
are displayed.

Select objects to copy:

Specify the destination layer name or [?/= (select object)] <0>: Select an object
on the destination layer, enter?, or enter=

Specify the Destination Layer Name

Displays a list of layers that you can select as the destination layer. You can
also enter a name to create a new layer. The new layer inherits the properties
(on/off, freeze/thaw, locked/unlocked, etc.) of the current layer

N object(s) copied and placed on layer "<layer name>".

?—List Layers

Enter layer name(s) to list <*>: *

=—Layer By Object
Selects a destination layer by selecting an object on that layer.

Select an object with the desired layer name: Select an object on the destination
layer
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CUl

Quick Reference
Manages the customized user interface elements in the product.

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface
£ Menu: Tools » Customize » Interface

EE Command entry: cui

Summary

User interface elements such as workspaces, toolbars, menus, ribbon panels,
shortcut menus, and keyboard shortcuts are all managed from this dialog box.

The Customize User Interface Editor is displayed.

NOTE The XML-based CUIx file replaces the CUI file used in AutoCAD 2006
through AutoCAD 2009, and both the legacy menu (MNS) and legacy menu
template (MNU) files used in releases prior to AutoCAD 2006.

For information about customizing the different user interface elements found
in the Customize User Interface dialog box, see User Interface Customization
in the Customization Guide.

Customize User Interface Editor

Quick Reference

Access Methods

CUI

Button
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£ Ribbon: Manage tab » Customization panel » User Interface
£ Menu: Tools » Customize » Interface
EE Command entry: cui

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus, and keyboard shortcuts.

B Customize tab (Customize User Interface Editor)

B Transfer tab (Customize User Interface Editor)

For information about customizing the different user interface elements found
in the Customize User Interface Editor, see User Interface Customization in
the Customization Guide.

Customize Tab (Customize User Interface Editor)

Quick Reference

Provides an interface for customizing workspaces, toolbars, menus, ribbon
panels, shortcut menus, and other user interface elements.

NOTE When the Customize User Interface Editor is displayed using the Customize
Commands option from the Tool Palettes window or the Customize option from
the Quick Access toolbar or a toolbar, the Customizations In pane is collapsed and
the Command List pane is expanded.

Customizations In Pane

Displays a tree structure of user interface elements that can be customized,
such as workspaces, toolbars, menus, ribbon panels, partial CUIx files, and so
on.
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List box Displays a list of CUIx files that are loaded and an Open option.

Available Customizations In toolbar Contains Load Partial Customization
File and Save All Current Customization Files buttons.

Load Partial Customization File Loads a CUIx file that you can add to the
acad.cuix file.

Save All Current Customization Files Saves changes to all loaded CUIx files.

Tree View Displays the current customization file in a structured view so you
can add and modify the user interface elements.
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Dynamic Display Pane

Displays content specific to the user interface element you select in the tree
view in the left pane. Following are the types of display content you'll see in
the right pane and the corresponding information displayed in the left pane's
tree view:

Information Describes selected user interface elements that do not have
properties (such as the Toolbars node, Menus node, and Shortcut Menus node).

Properties Displays the properties of user interface elements or items selected
in the tree view. Elements or items that display properties include specific
menus, menu commands, toolbars, and toolbar buttons.

Button Image Displays the toolbar buttons of all toolbars loaded in the
program. You can edit the toolbar button, change its properties, and create a
new toolbar button.

Shortcuts Displays a list of shortcut key names and temporary override names,
their corresponding shortcut key combinations, keyboard shortcut type
(shortcut key or temporary override), and the source CUIx file name.

Toolbar Preview Displays a preview of the selected toolbar.
Panel Preview Displays a preview of the selected ribbon panel.

Quick Properties Displays a list of object types and associated properties. You
can specify which object types and properties are enabled to use with the
Quick Properties panel and rollover tooltips.

Command List Pane

Displays a list of commands that are loaded in the program.

Categories Displays filters for the command list, including All Commands,
ACAD Commands, User Defined, or Control Commands. You can also filter
the list to display commands within a specific menu.

Find Command or Text Searches the current CUIx for a selected command
or matching text string. Displays the Find and Replace dialog box.

Create a New Command Creates a new command. You can add or change
properties and create or edit a button.

Properties Pane

Displays user interface properties that you can view, edit, or delete.
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General Displays the name and description of a command or user interface
element.

B Name - Displays the name of the user interface element. The name you
enter is the label or tooltip name displayed in the program.

B Description - Displays the description for the user interface element. The
description you enter is displayed in the status bar or in a tooltip.

Properties for Ribbon Tabs and Panels:

B Display Text - Displays the name of the ribbon tab or panel.

Properties for Ribbon Tabs:

B Contextual Display Type - Specifies whether the ribbon tab replaces all
ribbon tabs on the ribbon or is merged with the ribbon tabs already
displayed on the ribbon. (Full or Merged)

Display Determines which user interface elements are displayed after start up
or when a workspace is set current.

W Start On - Specifies if the Model tab or last used layout is set current.
(Model, Layout, or Do Not Change)
B Menu Bar - Specifies the display of the menu bar. (Off or On)

W Status Bar - Specifies the display of the application and drawing status
bars. (Application Only, All Off, All On, or Drawing Status Bar Only)

B Model/Layout Tabs - Specifies the display of the Model and layout tabs
along the bottom of the drawing window. (Off, On, or Do Not Change)

B Screen Menus - Specifies the display of the screen menu. (Off, On, or Do
Not Change)

B Scroll Bars - Specifies the display of the scroll bars in the drawing window.
(Off, On, or Do Not Change)

Partial File Behavior Controls how ribbon tabs are displayed when in a CUIx

file that is being loaded as a partial customization file.

B Default Display - Specifies whether the ribbon tab is displayed on the ribbon
when in a CUIXx file that is loaded as a partial customization file. (Do Not
Add to Workspaces or Add to Woprkspaces)
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Workspace Behavior - Specifies how the ribbon tab is merged or added to
the ribbon when this CUIXx file is loaded as a partial customization file.
(Add Tab Only, Merge Tab Only, or Merge or Add Tab)

Appearance Controls the appearance of toolbars, ribbon panels, commands
on a ribbon panel, ribbon tabs, and screen menus.

Properties for Ribbon Panels:

Resize Style - Specifies the resize style for a ribbon panel when the ribbon
is reduced in size. (Collapse as Needed, Never Collapse, or Collapse Last)

Properties for a Command on Ribbon Panels:

Button Style - Specifies the orientation, size, and label display of the
command. (Large With Text (Vertical), Large With Text (Horizontal),
SmallWithText, or SmallWithoutText)

Group Name - Specifies the group name for the command when grouping
is enabled for a drop-down.

Properties for Drop-downs on Quick Access Toolbars and Ribbon Panels:

Behavior - Specifies if the button executes a command or displays a list of
commands. (Drop Down Menu with Recent, Drop Down Menu, Split with
Recent, Split, or Split with Recent (Static))

SplitButtonListStyle - Specifies how the commands on the drop-down will
be displayed. (Icon, IconText, or Descriptive)

Button Style - Specifies the orientation, size, and label display of the button
for the drop-down. (Large With Text (Vertical), Large With Text
(Horizontal), SmallWithText, or SmallWithoutText)

Grouping - Specifies whether commands under a drop-down are grouped
together using their assigned group names. (Yes or No)

Properties for Toolbars:

Default Display - Specifies whether the toolbar is displayed when in a CUIx
file that is loaded as a partial customization file. (Do Not Add to Workspaces
or Add to Woprkspaces)

Orientation - Specifies the location of the toolbar. (Floating, Top, Bottom,
Left, or Right)
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B Default X Location - Specifies the X location of the toolbar when floating.

B Default Y Location - Specifies the Y location of the toolbar when floating.

B Rows - Specifies the number of rows the items on the toolbar are displayed
in when the toolbar is floating.

Properties for a Separator on Ribbon Panels:

B Separator Style - Specifies the style for the separator. (Line or Spacer)

Properties for Screen Menus:
B Start Line - Specifies where the first line of a submenu should be displayed.

B Number of Lines - Specifies the number of lines that make up the screen
menu.

Access Controls the key combination assigned to a shortcut key.

B Key(s) - Specifies the key combination assigned to a shortcut key.

B KeyTip - Specifies the keytip character to access a command or control
from the ribbon.

Properties for Drop-downs on Quick Access Toolbars Ribbon Panels:

B ToolTip Title - Specifies the alternate title for the tooltip of a drop-down
when its Behavior property is set to Drop Down Menu.

Size Controls the size of a tablet menu.
B Rows - Specifies the number of rows for a tablet menu.

B Columns - Specifies the number of columns for a tablet menu.

Slide Specifies the slide library and slide to use for a command in an image
menu.

m Slide library - Specifies the slide library for the slide used for the command
in an image menu.

m Slide label - Specifies the slide to use for the command in an image menu.
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Shortcut Controls the key combination and macros assigned to a temporary
override key.

Key(s) - Specifies the key combination for the temporary override.

Macro 1 (Key Down) - Displays the macro to execute when the key
combination is pressed.

Macro 2 (Key Up) - Displays the macro to execute when the key
combination is released.

Command Displays the properties assigned to a command.

Name - Displays the name of the command. The name you enter is the
label or tooltip name displayed in the program.

Description - Displays the description for the command. The description
you enter is displayed in the status bar or in a tooltip.

Extended Help File - Displays the file name and ID from the extended help
file that should be displayed when the cursor continues to hover over a
toolbar, panel button, or menu item for a specified period of time.

Command Display Name - Displays the command line text string that is
shown in the command tooltip.

Macro - Displays the macro assigned to a selected command. You can
create a macro or edit an existing macro.

Tags - Displays the user-defined keywords that are associated with a
command. Tags can be used to search for commands in the menu browser.

Advanced Displays the aliases and element IDs that you can define for each
user interface element.

Aliases - Specifies a unique value for a user interface element that is used
to programmatically reference the user interface element.

Object Name - Specifies the object type associated with a double click
action.

Element ID - Displays the tag that uniquely identifies a command or user
interface element.

Images Determines which images are assigned to a command when displayed
on a user interface element.

Small Image - Specifies the small image file to use when a command is
added to a toolbar, menu, or ribbon panel.
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B Large Image - Specifies the large image file to use when a command is
added to a toolbar or ribbon panel.

Quick Properties Pane

Displays a list of object types and the properties associated to the selected
object type.

Edit Object Type List Controls which object types are used with the Quick
Properties panel or rollover tooltips. Displays the Edit Object Type List dialog
box.

Object Type List Displays a list of the object types you can use with Quick
Properties panel or rollover tooltips.

General Displays the general properties that are available for all object types
in the Properties list.

Properties List Displays the properties for the selected object type or the
general properties available for all object types.

Reset Overrides Overrides the selected general properties for all object types.

Transfer Tab (Customize User Interface Editor)

Quick Reference

Transfers user interface elements to or from a main or partial customization
(CUIx) file, where your interface element data is stored. You open a CUIx,
CUI, MNS, or MNU file to import or export user interface data. When you
open CUI, MNU, or MNS files, they are not converted automatically to a CUIx
file format until you save the new file that is created. The original CUI, MNU,
or MNS file is not modified.
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At Customize User Interface o[BS
Customizations in Main File Customizations in New File
[Main C: File (scad.cuix) v# = @ [NewFile Jive |
=75 Workspaces 5 Workspaces
¥ 2D Drafting & Annotation Default (cument) ™= Quick Access Toolbars
L* 3D Modeling {7 Ribbon
L¥ AutoCAD Classic T Toobars
=1 Quick Access Toolbars Menus
77 Ribbon B Quick Propeties
EL Toobars =Y Rollover Tootips
Menus Shortcut Menus
- Quick Properties #-{[] Keyboard Shortouts
Fa Rollover Tookips {9 Double Click Actions
Shortcut Menus {5 Mouse Buttons
() Keyboard Shorteuts i LISP Fles
) Double Click Actions {®" Legacy
{9 Mouse Buttons
1= LISP Fies
T Legacy
Drag from either file to copy content Drag from either file to copy content
[ ok | [ cace | [ ooy | [ 1o | @

Customizations In panes When you enter cuiimport at the Command prompt,
the main CUIXx file is displayed (acad.cuix by default) in the right pane. You
open a CUIx or legacy customization file in the left pane to transfer data.
When you enter cuiexport at the Command prompt, the main CUIx file is
displayed in the left pane. You open another CUIx or legacy customization
file in the right pane to transfer data.

Button Editor Dialog Box

Quick Reference

Access Methods

CLUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface
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£ Menu: Tools » Customize » Interface
Shortcut menu: Right-click any toolbar and click Customize
E Command entry: cui

Butten Editor =3l
Color Preview
e p
. Export...
[ ]
m
|| Undo
u [FlGad
L]
||

Modifies or creates custom images used for commands.

Color Palette
Sets the current color used by the editing tools.

Standard Color Swatches Color swatches used to set of the standard 16 colors
current.

More Opens the Select Color dialog box.

Editing Tools
Provides tools for editing a custom image.
Pencil Edits one pixel at a time using the current color.

Line Creates lines using the current color. Click and drag to set the start point
and draw the line. Release to complete the line.

Circle Creates circles using the current color. Click to set the center and drag
to set the radius. Release to complete the circle.

Erase Sets pixels to white. Click and drag over colored pixels to change them
to white.

Editing Area

Provides a close-up view of the image for editing.
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Preview

Displays a preview of the image currently being edited. The preview displayed
shows the actual size of the image.

Clear

Clears the editing area.

Undo

Undoes the last editing action.

Grid

Displays a grid in the editing area. Each grid square represents a single pixel.

Save

Displays the Save Image dialog box, which allows you to save the customized
image to the working customization file.

Import

Imports an externally stored image for editing. Images are stored in the working
customization file as bitmap (BMP) files.

Export

Exports the customized image to an external local or network storage location.

NOTE When exporting an image, the Create File dialog box defaults to the folder
defined under Custom Icon Location of the Files tab in the Options dialog box.
Images that are located in this folder can be migrated with the Migrate Custom
Settings dialog box.
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Image Manager Dialog Box

Quick Reference

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface

Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E Command entry: cui

hﬂ CLI Editor - Image Manager ==
- Impoit....
Mame Dimensions  Referenced By
Preview
[ ak. ] [ Cancel ] [ Help ]

Manages the images that are in the selected customization file.

Loaded Customization Files List

Lists the customization files that are currently loaded.

Custom Images List

Lists the images that are stored in the customization file selected from the
Loaded Customization Files list.
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Import

Imports an externally stored image into the selected customization file from
the Loaded Customization Files list.

Export

Exports the selected custom images from the Custom Images list to an external
local or network storage location.

Delete

Permanently deletes the selected image from the Custom Images list and the
customization file.

Preview

Displays a preview of the selected image in the Custom Images list.

Save Image Dialog Box

Quick Reference

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface
£ Menu: Tools » Customize » Interface

Shortcut menu: Right-click any toolbar and click Customize
E Command entry: cui

A Save Image ==
Cancel

Saves the customized image to the working customization file.

Save Image Dialog Box | 381



Image Name

Displays the name of the customized image being saved.

Find and Replace Dialog Box - CUI

Quick Reference

Access Methods

=

||
CUl

Button

£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface
EE Command entry: cui

Locates and replaces commands or command properties (command names,
descriptions, or macros).

® Find tab (Find and Replace dialog box)

B Replace tab (Find and Replace dialog box)

Find Tab (Find and Replace Dialog Box)

Quick Reference

Searches for commands or command properties in either the Command List
pane or the Available Customizations in <file name> pane.
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A1 Find and Replace (==
Find Replace

Find what: Dimension, Linear -

/| lgnore case

Restrict Search to:

Main CUI File | Find Selected Command | [ FndNed | [ Cose |

Find What Displays the search string you want to locate. If you select a
command in the Command List pane, this box displays that string. You can
also enter a string. Any previous strings entered in this box are stored in the
drop-down list.

Ignore Case Locates all commands or command properties regardless of their
case (for example, the program would search for both LINE and line).

Restrict Search To Limits the search to the CUIx file you select from the
drop-down list. By default, the main CUIx file (acad.cuix by default) is searched.

Find Selected Command When a command is selected in the Command List
pane, locates the next interface element in the tree view that references the
selected command.

Find Next Locates the next instance of the search string in the Name,
Description, or Macros box in the Properties pane. If you search in the
Command List pane, only commands in the list are located. If you search in
the tree view in the Customizations In pane, the search starts in the tree view
and continues to the commands in the Command List pane.

Replace Tab (Find and Replace Dialog Box)

Quick Reference

Replaces a search string with a new search string.
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ﬂ Find and Replace (==
Find Replace

Find what: Dimension, Linear -

Replace with:

lgnore case
[ Restrict Search to:

Main CUI File Replace Replace Al [ Find Next ] I Close I

Find What Displays the search string you want to locate. If you select a
command in the Command List pane, this box displays that string. You can
also enter a string. Any previous strings entered in this box are stored in the
drop-down list.

Replace With Displays the string that will replace the string you searched for.

Ignore Case Locates all commands or command properties regardless of their
case (for example, the program would replace both LINE and line).

Restrict Search To Limits the search to the CUIx file you select from the
drop-down list. By default, the main CUIx file (acad.cuixby default) is searched.

Replace Replaces a single instance of the search string. In the Customize User
Interface dialog box, the location of the search string is displayed in the
Command List pane, tree view, and Properties pane.

Replace All Replaces all instances where the search string is found. You cannot
undo this operation.

Find Next Locates the next instance of the search string in the Name,
Description, or Macros boxes in the Properties pane. If you search in the
Command List pane, only commands in the list are located. If you search in
the tree view in the Customizations In pane, the search starts in the tree view
and continues to the commands in the Command List pane.
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Shortcut Keys Dialog Box

Quick Reference

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface

Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E Command entry: cui

Shortcut Keys

Press new shortcut key:
|

Currently assigned to:
[unassigned]

[ ok | [ canca

Adds and modifies the key combination assigned to a shortcut or temporary
override key.

Press New Shortcut Key

Assigns a key combination to a shortcut or temporary override key. Shortcut
keys can be assigned key combinations that start with Ctrl or Ctrl+Shift, and
temporary override keys can be assigned key combinations that start with the
Shift key.
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Long String Editor Dialog Box

Quick Reference

Access Methods

CUI

Button

£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface

Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E Command entry: cui

Long String Editor

OK Cancel

Adds and modifies the macro assigned to a command.

Macro

Displays the macro for the selected command.

Tag Editor Dialog Box

Quick Reference

Access Methods

CUI

Button
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£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface

Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E Command entry: cui

Tag Editor @

MName: 3D Adjust Clip Planes

Tags: |Add a Tag

[ ok | [ cancel

Adds and modifies tags for a command.

Name

Displays the name of the selected menu item when adding or modifying tags
from the menu browser, or the name of the command when using the
Customize User Interface (CUI) Editor.

Tags

Lists the tags that are currently associated with a menu item or command;
you can add additional tags as needed. If no tag is present, Add a Tag is
displayed in the field.

Each tag must be separated by a comma and the total number of characters
for all the tags and separators cannot be more than 256 characters. As you
enter a tag value, if the value entered matches a previous tag or tags, the
previous tag values will be displayed in a flyout.

Select Help ID Dialog Box

Quick Reference

Access Methods

CLUI

Button
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£ Ribbon: Manage tab » Customization panel » User Interface

£ Menu: Tools » Customize » Interface

Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E Command entry: cui

B Select Help ID ==l

Chooze a help 1D from the list below:

(7] Tip: Hower the mouze over an item inthe list to
prewiew its tooltip content.

| ak. |[ Cancel ]| Help |

Assigns a Help ID found in the selected XAML file to the selected command.

Help ID List

Lists all the help IDs in the selected XAML file that can be assigned to the
selected command. A preview of the tooltip can be viewed by positioning the
cursor over the help ID in the list and letting it remain idle for a few seconds.

Edit Object Type Dialog Box

Quick Reference
Access Methods
| |
CUT
Button

£ Ribbon: Manage tab » Customization panel » User Interface
£ Menu: Tools » Customize » Interface
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Shortcut menu: Shortcut » Right-click any toolbar and click Customize
E2 Command entry: cui

A0 Edit Object Type List =5
2D Palyline

#| 3 Point Angular Dimension

m

3D Face
3D Palyline
- 3D Salid

Box
Cone
Cylinder
Pyramid
Sphere
Torus
Wedge
Extrusion
Sweep
Revolve
Loft

Mene

[ OK ]l Cancel |

Controls which object types are supported for Quick Properties and rollover
tooltips.

Object Types List

Lists all the object and subobject types that are available for Quick Properties
and rollover tooltips. Objects that support subobjects are indicated by the
appearance of a triangle to the left on the object type’s name. The list of
subobjects is revealed when you click the triangle.

CUIEXPORT

Quick Reference

Exports customized settings from the main CUIXx file to an enterprise or partial
CUIx file.
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Access Methods

o
Button

£ Ribbon: Manage tab » Customization panel » Export
£ Menu: Tools » Customize » Export Customizations
E Command entry: cuiexport

Summary

Customization information can be transferred between the main and partial
CUIx files.

Opens with the Transfer Tab (Customize User Interface Editor) opened by
default. The main CUIx file (acad.cuix) is open in the left pane. You can drag
items from one CUIXx file to the other. Click Apply to save the changes and
view the updated CUIXx file.

CUIIMPORT

Quick Reference

Imports customized settings from an enterprise or partial CUIXx file to the main
CUIXx file.

Access Methods
ra
Button

£ Ribbon: Manage tab » Customization panel » Import
£ Menu: Tools » Customize » Import Customizations
EE Command entry: cuiimport

Summary

Customization information can be transferred between the main and partial
CUIx files.
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Opens with the Transfer Tab (Customize User Interface Editor) opened by
default. You can drag items from one CUIXx file to the other. Click Apply to
save the changes and view the updated CUIx file.

CUILOAD

Quick Reference

Loads a CUIXx file.
EE Command entry: cuiload

Opens the Load/Unload Customizations dialog box, where you can locate and
load a CUIx file to customize or transfer user interface settings.

When FILEDIA is set to 0 (off), CUILOAD displays the following Command
prompt.

Enter name of customization file to load: Enter a file name

NOTE The Legacy Menu (MNS), Legacy Menu Template (MNU), and
Customization (CUI) files used in past releases have been replaced with just one
file type, the XML-based CUIx file.

Load/Unload Customizations Dialog Box

Quick Reference

E Command entry: cuiload

Controls the display of customization groups and interface elements.
Loaded Customization Groups

Lists the currently loaded customization files.

File Name

Specifies the file to load when you choose Load. You can either enter the file
name or choose Browse to display the Select Customization File dialog box (a
standard file selection dialog box).

Unload
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Unloads the customization group selected in the Customization Groups list.
Load

Loads the file specified under File Name.

Browse

Displays the Select Menu File dialog box (a standard file selection dialog box),
in which you can select a menu file to load.

CUIUNLOAD

Quick Reference

Unloads a CUIXx file.
EE Command entry: cuiunload

Opens the Load/Unload Customizations dialog box, which has the same
options as CUILOAD. The only difference between the two commands is in
the Command prompts.

WhenFILEDIA is set to 0 (off), CUIUNLOAD displays the following Command
prompt.

Enter the name of a Customization Group to unload: Enter a name

NOTE The Legacy Menu (MNS), Legacy Menu Template (MNU), and
Customization (CUI) files used in past releases have been replaced with just one
file type, the XML-based CUIx file.

CUSTOMIZE

Quick Reference

Customizes tool palettes and tool palette groups.
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Access Methods

(3

Button

£ Ribbon: Manage tab » Customization panel » Tool Palettes
£ Menu: Tools » Customize » Tool Palettes

Shortcut menu: Right-click any tool palette and choose Customize Palettes.
EE Command entry: customize
Summary

The Customize dialog box is displayed.

Customize Dialog Box

Quick Reference

£ Menu: Tools » Customize » Tool Palettes
Shortcut menu: Right-click any tool palette and choose Customize Palettes.
EE Command entry: customize

Creates, modifies, and organizes tool palettes, tool palette groups, and block
authoring palettes. Imports and exports tool palette files.

Palettes
Lists all available tool palettes.

Click and drag a tool palette to move it up or down in the list. Right-click a
palette in the list to rename, delete, or export the palette. When you export
a palette, it is saved to a file with an .xtp extension. Right-click in the Palettes
area to import a palette or to create a new, blank one.

The shortcut menus also provide options to
B Rename an existing palette

B Create a new palette
B Delete a tool palette

B Export a tool palette (as an XTP file)
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B Import a tool palette

Palette Groups
Displays the organization of your palettes in a tree view.

Click and drag a palette to move it into another palette group. Right-click a
palette group, and then click Set Current on the shortcut menu to display the
palette group.

The shortcut menus also provide options to
Create a new palette group

Delete an existing palette group

Rename an existing palette group

Export a palette group (as an XPG file)

|

|

|

B Remove a tool palette from a group

|

B Export all palette groups (as an XPG file)
|

Import a palette group

NOTE You might need to collapse all palette groups to expose a blank area within
the Palette Groups area. Then, right-click in the blank area to display shortcut
menu options that are not specific to any existing palette groups.

Current Palette Group

Displays the name of the palette group currently shown. Displays All Palettes
when all available palettes are shown.

CUTCLIP

Quick Reference

Copies selected objects to the Clipboard and removes them from the drawing.
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Access Methods

.+
A

Button

£ Ribbon: Home tab » Clipboard panel » Cut
£ Menu: Edit » Cut

£ Toolbar: Standard %

Shortcut menu: End any active commands, right-click in the drawing area,
and choose Cut.

E Command entry: cutclip

Summary

CUTCLIP copies selected objects to the Clipboard, removing them from the
drawing. You can paste the contents of the Clipboard into a document or
drawing as an embedded OLE object (see PASTECLIP and PASTESPEC).
CUTCLIP does not create OLE link information.

When you want to use objects from a drawing file in another application, you
can cut these objects to the Clipboard and then paste them into another
application. You can also use Cut and Paste to transfer objects between
drawings.

List of Prompts
The following prompts are displayed.

Select objects:

CYLINDER

Quick Reference

Creates a 3D solid cylinder.
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Access Methods

o

Button

£ Ribbon: Home tab » 3D Modeling panel » Cylinder

£ Toolbar: Modeling U

£ Menu: Draw » Modeling » Cylinder

E Command entry: cylinder

Specify center point of base or [3P/2P/Ttr/Elliptical]: Specify a center point or

enter an option

Specify base radius or [Diameter] <default>: Specify a base radius, or enter d to
specify a diameter, or press Enter to specify the default base radius value

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an

option, or press Enter to specify the default height value

In the illustration, the cylinder was created using a center point (1), a point
on the radius (2), and a point for the height (3). The base of the cylinder is
always on a plane parallel with the workplane. You can control the smoothness
of curved 3D solids, such as a cylinder, in a shaded or hidden visual style with
the FACETRES system variable.

During a drawing session, the default value for the base radius is always the
previously entered base radius value.

3P (Three Points)

Defines the base circumference and base plane of the cylinder by specifying
three points.

Specify first point: Specify a point

Specify second point: Specify a point

Specify third point: Specify a point

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an
option, or press Enter to specify the default height value
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Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cylinder is the distance between the
two specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cylinder axis. This
endpoint is the center point of the top face of the cylinder. The axis endpoint

can be located anywhere in 3D space. The axis endpoint defines the length
and orientation of the cylinder.

Specify axis endpoint: Specify a point

2P (Two Points)
Defines the base diameter of the cylinder by specifying two points.

Specify first endpoint of diameter: Specify a point

Specify second endpoint of diameter: Specify a point

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an
option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cylinder is the distance between the
two specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cylinder axis. The axis
endpoint is the center point of the top face of the cylinder. The axis endpoint

can be located anywhere in 3D space. The axis endpoint defines the length
and orientation of the cylinder.

Specify axis endpoint: Specify a point
TTR (Tangent, Tangent, Radius)
Defines the base of the cylinder with a specified radius tangent to two objects.

Specify point on object for first tangent: Select a point on an object
Specify point on object for second tangent: Select a point on an object
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Specify base radius <default>: Specify a base radius or press Enter to specify the
default base radius value

Sometimes more than one base matches the specified criteria. The program
draws the base of the specified radius whose tangent points are closest to the
selected points.

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an
option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cylinder is the distance between the
two specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cylinder axis. The axis
endpoint is the center point of the top face of the cylinder. The axis endpoint

can be located anywhere in 3D space. The axis endpoint defines the length
and orientation of the cylinder.

Specify axis endpoint: Specify a point

Elliptical
Specifies an elliptical base for the cylinder.

Specify endpoint of first axis or [Center]: Specify a point (1)

Specify other endpoint of first axis: Specify a point

Specify endpoint of second axis: Specify a point

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an
option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.
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Center Creates the base of the cylinder by using a specified center point.
Specify center point: Specify a point

Specify distance to first axis <default>: Specify a distance or press Enter to specify
the default distance value

Specify endpoint of second axis: Specify a point

Specify height or [2Point/Axis endpoint] <default>: Specify a height, enter an
option, or press Enter to specify the default height value

Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cylinder is the distance between the
two specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cylinder axis. The axis
endpoint is the center point of the top face of the cylinder. The axis endpoint

can be located anywhere in 3D space. The axis endpoint defines the length
and orientation of the cylinder.

Specify axis endpoint: Specify a point

Diameter
Specifies the diameter for the base of the cylinder.

Specify diameter <default>: Specify a diameter or press Enter to specify the default
value

Initially, the default diameter is not set to any value. During a drawing session,
the default value for the diameter is always the previously entered diameter
value for any solid primitive.

Specify height or [2Point/Axis endpoint] <default>: Specify a height (2), enter
an option, or press Enter to specify the default height value
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Initially, the default height is not set to any value. During a drawing session,
the default value for the height is always the previously entered height value
for any solid primitive.

2Point Specifies that the height of the cylinder is the distance between the
two specified points.

Specify first point: Specify a point

Specify second point: Specify a point

Axis Endpoint Specifies the endpoint location for the cylinder axis. The axis
endpoint is the center point of the top face of the cylinder. The axis endpoint

can be located anywhere in 3D space. The axis endpoint defines the length
and orientation of the cylinder.

Specify axis endpoint: Specify a point

2Point

Specifies that the height of the cylinder is the distance between the two
specified points.

Specify first point: Specify a point
Specify second point: Specify a point
Axis Endpoint

Specifies the endpoint location for the cylinder axis. The axis endpoint is the
center point of the top face of the cylinder. The axis endpoint can be located
anywhere in 3D space. The axis endpoint defines the length and orientation
of the cylinder.

Specify axis endpoint: Specify a point
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D Commands

DATAEXTRACTION

Quick Reference

Extracts drawing data and merges data from an external source to a data
extraction table or external file

Access Methods

Button

£ Ribbon: Insert tab » Linking & Extraction panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II

E Command entry: dataextraction

Summary

Exports object property, block attribute, and drawing information to a data
extraction table or to an external file, and specifies a data link to an Excel
spreadsheet

The Data Extraction wizard on page 402 is displayed.
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If you enter -dataextraction at the Command prompt, options are displayed.
on page 432

Data Extraction Wizard

Quick Reference

Access Methods

Button

£ Ribbon: Insert tab » Linking & Extraction panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II

E Command entry: dataextraction

Summary

Provides step-by-step instructions for extracting information from objects,
blocks, and attributes, including drawing information in the current drawing
or a set of drawings. The information is used to create a data extraction table
in the current drawing, or is saved to an external file, or both.

The Data Extraction wizard includes the following pages:
B Begin on page 403

B Define Data Source on page 403
B Select Objects on page 405

B Select Properties on page 407

B Refine Data on page 408

B Choose Output on page 410

W Table Style on page 411

® Finish on page 413
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Begin

Starts the data extraction process. Options include creating a new data
extraction, using a template, or editing an existing data extraction.

A Data Extraction - Begin (Page 1 of 8) = @

The wizard extracts object data from drawings that can be exported to a table or to an external file.

Select whether to create a new data extraction, use previously saved settings from a template, or edit an existing
extraction.

@) Create a new data extraction

Use previous extraction as a template (.dxe or blk)

Edit an existing data extraction

| MNext = || Cancel |

Create a New Data Extraction Creates a new data extraction and save it to
a DXE file. Also makes the Use a Previous Extraction as a Template button
available so you can select a data extraction template (DXE) file or attribute
extraction (BLK) file.

Use a Previous Extraction as a Template Uses settings previously saved in
a data extraction (DXE) file or an attribute extraction template (BLK) file. As
you move through the wizard, each page is already filled in with the settings
in the template file. You can change these settings. Click the [...] button to
select the file in a standard file selection dialog box.

Edit an Existing Data Extraction Allows you to modify an existing data
extraction (DXE) file. Click the [...] button to select the data extraction file in
a standard file selection dialog box.

Define Data Source

Specifies the drawing files, including folders from which to extract data. Allows
selection of objects in the current drawing from which to extract information.

Data Extraction Wizard | 403



& Data Extraction - Define Data Source (Page 2 of 8) = (B[]

Data source
'@ Drawings/Sheet set
Include current drawing
_ Select objects in the current drawing |__\lk

Drawing files and folders:

! Folders Add Folder ...

Drawings

------ ™ C:\My Documents'floor_plan.dwg (Current drawing) Add Drawings ...

Settings...

< Back ][ MNext = H Cancel I

Data Source

Drawings/Sheet Set Makes the Add Folder and Add Drawings buttons available
for specifying drawings and folders for the extraction. The drawings and folders
for the extraction are listed in the Drawing Files view.

Include Current Drawing Includes the current drawing in the data extraction.
The current drawing can be empty (not contain objects) if additional drawings
are selected for extraction.

Select Objects in the Current Drawing Makes the Select Objects in the
Current Drawing button available so you can select objects for data extraction.

Select Objects button Closes the wizard temporarily so that you select objects
and blocks in the current drawing.

Drawing Files and Folders Lists the selected drawing files or folders. Checked
folders are included in the extraction.

Add Folder Displays the Add Folder Options dialog box on page 414, where
you can specify folders to include in the data extraction.

Add Drawings Displays the standard file selection dialog box, where you can
specify drawings to include in the data extraction.

Remove Removes the checked drawings or folders listed in the Drawing Files
and Folders list from the data extraction.
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Settings Displays the Data Extraction - Additional Settings dialog box on page
415, where you can specify data extraction settings.
Folders Shortcut Menu

You can see the shortcut menu for Folders (and the drawings listed within the
selected folder) only after you explicitly add a folder using the Add Folder
button.

Edit Folder Settings Displays the Add Folder Options dialog box where you
can specify the folders to be used for data extraction. Drawings in the selected
folders are monitored for data changes.

Remove Removes the selected folder.
Check All Selects all the drawings listed below the selected folder.
Uncheck All Clears all the drawings listed below the selected folder.

Invert Selection Inverts the current selected items below the selected folder.

Select Objects

Specifies the types of objects (blocks and non-blocks) and drawing information
to be extracted.

Valid objects are checked by default. Objects that do not exist in the selected
drawing are not checked. Click the column head to reverse the sort order.
Columns can be resized. Property data from checked objects is displayed on
the Select Properties on page 407 page.
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At Data Extraction - Select Objects (Page 3 of 8) = |[E] ]

Select the objects to extract data from:

Objects Preview
Object Display MName Type
| | Circle Circle Non-block
V| |Line Line Non-block
| | Polyline Polyline Non-block
Display options
/| Display all object types Display blocks with attributes only

/| Display objects currently in-use only

| < Back || Next = || Cancel

Object Displays each object by its name. Blocks are listed by block name.
Non-blocks are listed by their object name.

Display Name Provides a place to enter an optional alternative name for an
object as it will appear in the extracted information. Select a display name,
right-click in the list, and click Edit Display Name.

Type Displays whether the object is a block or non-block.
Preview Displays a preview image of the checked block in the Object list view.

Display Options
Display All Object Types Displays a list of all object types (blocks and
non-blocks) in the Object list view. This option is selected by default.

Display Blocks Only Displays only blocks in the Object list view.

Display Non-Blocks Only Displays only those objects that are not blocks in
the Object list view.

Display Blocks with Attributes Only Displays only those blocks in the Object
list view that contain attributes. Dynamic blocks are listed if they have special
properties assigned to them (for example, actions and parameters).

Display Objects Currently In-Use Only Displays objects in the Object list
view that exist in the selected drawings.

406 | Chapter 5 D Commands



Select Properties
Controls the object, block, and drawing properties to extract.
Each row displays a property name, its display name, and category.

Right-click a column head and use options on the shortcut menu to check all
or clear all items, invert the selection set, or edit the display name. Click the
column head to reverse the sort order. Columns can be resized.

A Data Extraction - Select Properties (Page 4 of &) = @
The following properties were found based on the objects you selected.
Select the properties you want to extract.
(Explore the right-click menu for additional options )
Properties Category filter
Froperty Display Name Category - V] 3D \«ﬁ;ualization
V|| Angle Angle Geometry e j grear.ltlrnagl
|| Area Area Geometry v Gfaometr','
| | Author Author Drawing ) Misc
| | Center X Center X Geometry
| | Center Y Center Y Geometry
| | Center 2 Center Z Geometry
| | Circumference Circumference Geometry
V| |Closed Closed Misc
V| | Color Color General
V| | Comments Comments Drawing
71| Detta ¥ Delta ¥ Genmetrs i
| < Back | | Next = | | Cancel |

Property Displays object properties from objects selected on the page. The
property list is filtered according to the filter categories that are selected.
Properties are the same as those listed in the Properties palette.

Display Name Provides a place to enter an optional alternative name for a
property as it will appear in the extracted information. Select the property
display name, right-click in the list, and click Edit Display Name.

Category Displays a category for each property. For example, General designates
ordinary object properties, such as color or layer. Attribute designates
user-defined attributes. Dynamic designates user-defined property data for
dynamic blocks. Categories are the same as those listed in the Properties
palette.

Category Filter
Property Category List Displays a list of categories that are extracted from
the property list. Unchecked categories filter the Properties list. Categories
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include 3D Visualization, Attribute, Drawing, Dynamic Block, General,
Geometry, Misc, Pattern, Table, and Text.

Property Grid Shortcut Menu
Check All Selects all the properties in the property grid.

Uncheck All Clears all the properties in the property grid.

Invert Selection Inverts the current checked items in the property grid.
Edit Display Name Allows in-place editing of the property display name for
the selected row.

Refine Data

Modifies the structure of the data extraction table. You can reorder and sort
columns, filter results, add formula columns and footer rows, and create a
link to data in a Microsoft Excel spreadsheet.

At Data Extraction - Refine Data (Page 5 of 8) = |[E] ]

In this view you can reorder and sort columns, filter results, add formula columns, and create extemal data
links.

Count Name Area Author Certer X Certer Y g
s 284.3716 26,1762 364337
1 Line
1 Polyline 215.4802
4 T S
Combine identical rows I'@ Link External Data... I

Show count column

I‘él Sort Columns Options... I
Show name column

IE& Full Preview... I

< Back H Next = H Cancel I

Data Grid View

Columns Displays properties in a columnar format as they were specified in
the Select Properties page. Right-click any column header to display a shortcut
menu of options. The Count column and Name column display by default.
Icons display in the column header for inserted formula columns and columns
extracted from a Microsoft Excel spreadsheet.
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Combine Identical Rows Groups identical records by row in the table. Updates
the Count column with the sum of all aggregated objects.

Show Count Column Displays the Count column in the grid.
Show Name Column Displays the Name column in the grid.

Link External Data Displays the Link External Data dialog box on page 418,
where you can create a link between the extracted drawing data and data in
an Excel spreadsheet.

Sort Columns Options Displays the Sort Columns dialog box on page 421,
where you can sort data across multiple columns.

Full Preview Displays a full preview of the final output, including linked
external data, in the text window. The preview is for viewing only.

Column Shortcut Menu
Sort Descending Sorts column data in a descending order.

Sort Ascending Sorts column data in an ascending order.

Sort Column Options Displays the Sort Columns dialog box on page 421,
where you can sort data across multiple columns.

Rename Column Allows in-place editing of the selected column name.
Hide Column Hides the selected column.

Show Hidden Columns Displays the hidden column. The flyout option
includes Display All Hidden Columns.

Set Column Data Format Displays the Set Cell Format dialog box on page
424, where you can set a data type for cells in the selected column.

Insert Formula Column Displays the Insert Formula Column dialog box on
page 422, where you can specify the formula that is inserted into the table.
Inserts the formula column to the right of the selected column. An existing
formula column cannot be used as a value for another formula column.

Edit Formula Column Displays the Edit Formula Column dialog box on page
428. This option is only available when a formula column is selected.

Remove Formula Column Removes the selected formula column. This option
is only available when a formula column is selected.

Combine Record Mode Displays numeric data in the selected column as
separate values or collapses identical property rows into one row and displays
the sum of all the numeric data in the selected column. This option is available
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when the Combine Identical Rows is checked and the selected column contains
numerical data.

Show Count Column Displays a Count column that lists the quantity of each
property.

Show Name Column Displays a Name column that displays the name of
each property.

Insert Totals Footer Displays a flyout menu with options for Sum, Max, Min,
and Average. Creates a footer row for the selected column that is placed below
all the data rows and displays values based on the selected arithmetic function.
This option is available only for columns that have a numeric data type.

Sum Displays a sum of all the values in the selected column in a footer row.
Max Displays the maximum value in the selected column in a footer row.
Min Displays the minimum value in the selected column in a footer row.
Average Displays the average value in the selected column in a footer row.

Remove Totals Footer Removes the Totals footer. This option is available
when a footer row exists.

Filter Options Displays the Filter Column dialog box on page 430, where you
can specify filter conditions for the selected column.

Reset Filter Restores the default filter for the selected column.
Reset All Filters Restores default filters for all columns that have filters.

Copy to Clipboard Copies all the data cells, including column names, to the
Clipboard.

Choose Output
Specifies the type of output to which the data is extracted.

410 | Chapter 5 D Commands



A Data Extraction - Choose Output (Page 6 of 8) = |2

Qutput options

Select the output types for this extraction:
Insert data extraction table into drawing
Output data to external file (xls .csv .mdb .tet)

Output Options

Insert Data Extraction Table into Drawing Creates a table that is populated
with extracted data. You are prompted to insert the table into the current
drawing when you click Finish on the Finish on page 413 page.

Output Data to External File Creates a data extraction file. Click the [...]
button to select the file format in a standard file selection dialog box. Available
file formats are Microsoft Excel (XLS), comma-separated file format (CSV),
Microsoft Access (MDB), and tab-separated file format (TXT). The external file
is created when you click Finish on the Finish page.

The maximum number of columns that can be exported to an XLS and MDB
file is 255.

Table Style

Controls the appearance of the data extraction table. This page is displayed
only if AutoCAD Table is selected on the Choose Output on page 410 page.
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A Data Extraction - Table Style (Page 7 of 8) = |[E ]
Table style
Select the table style to use for the inserted table: —|— i —t L e
| Standard v| @
Header Header
Formatting and structure
Jata Dota
@ Manually setup table
Enter a title for your table: D o —t Q. D Q —t Q.
Tl Dota Daota
Title cell style: Title A
Header cell style: Header A D o —t Q. D o —t =
Data cell style: Data - D o -t s} D o 't 0.
V| Use property names as additional column headers D o -t o D 0. -t 0.
| < Back | | Next = | | Cancel |

Table Style

Select the Table Style to Use for the Inserted Table Specifies the table style.
Click the Table Style button to display the Table Style Dialog Box on page 1794,
or select a table style from the drop-down list that is defined in the drawing.

Formatting and Structure

Use Table in Table Style for Label Rows Creates the data extraction table
with a set of top rows that contain label cells and a bottom set of label rows
that contain header and footer cells. Extracted data is inserted between the
top and bottom label rows. This option is only available when the selected
table style contains a template table.

Manually Setup Table Provides for manually entering a title and specification
of the title, header, and data cells style.

Enter a Title for Your Table Specifies a title for the table. This row is not
overwritten when the table is updated. The default table style, STANDARD,
includes a title row. If the selected table style does not include a title row, this
option is not available.

Title Cell Style Specifies the style for the title cell. Click the drop-down list
to select a title cell style defined in the selected table style.

Header Cell Style Specifies the style for the header row. Click the drop-down
list to select a cell style defined in the selected table style.
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Data Cell Style Specifies the style for data cells. Click the drop-down list to
select a cell style defined in the selected table style.

Use Property Names as Additional Column Headers Includes column headers
and uses the Display Name as the header row.

Display Preview Displays a preview of the table layout. If the table style does
not include a title row or header row, none is displayed.

Finish

Completes the process of extracting object property data that was specified
in the wizard and creates the output type that was specified on the Choose
Output on page 410 page. If data linking and column matching to an Excel

spreadsheet was defined in the Link External Data dialog box on page 418, the
selected data in the spreadsheet is also extracted.

If the Insert Data Extraction Table into Drawing option was selected on the
Choose Output page, you are prompted to insert the table into the drawing
when you click Finish.

If the Output Data to External File option was selected, the extracted data is
saved to the specified file type.

A Data Extraction - Finish (Page & of 8) = |2
Click Finish to complete the extraction.

If you chose to insert a table, you will be prompted for an insertion point after you click Finish.

Any external files to create will be created when clicking Finish.

< Back | | Finish | [ Cancel
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Add Folder Options Dialog Box

Quick Reference

Aw Add Folder Options (===
Faolder:
Options
m Automatically include new drawings added in this folder to the data
extraction

¥| Include subfolders

Utilize wild-card characters to select drawings

Cancel | | Help

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction
£ Toolbar: Modify II

EE Command entry: dataextraction

Summary

Specifies the folders to be used for data extraction. Drawings in the selected
folders are monitored for data changes.

List of Options

The following options are displayed.

Folder

Displays the path to the specified folder.
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Folder Button
Click the [...] button to select the folder in a standard file selection dialog box.

Options
Automatically Include New Drawings Added in this Folder to the Data
Extraction

Includes new drawings to the data extraction when they are added to the
folder. The New Drawings Found dialog box on page 417 displays when new
drawings are added. When this option is selected, the specified folders are
“live.” When this option is not selected, the folders are “static.”

Include Subfolders

Includes drawings in subfolders of selected folders in the data extraction
process.

Utilize a Wild-card Character to Select Drawings

Activates a text entry field where you can enter search criteria using wild-card
characters to select specific drawings.

Wild-Card field

Enter wild-card characters. Valid characters are * ? .

Data Extraction - Additional Settings Dialog Box

Quick Reference

A Data Extraction - Additional Settings (=3

Bxtraction settings
/| Extract objects from blocks

| Bxtract objects from xrefs

Include xrefs in block counts

Extract from

Cbjects in model space

@ All objects in drawing

[ ok |[ cancel |[ Heb |
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Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
¥ Menu: Tools » Data Extraction

£ Toolbar: Modify II

E Command entry: dataextraction

Summary

Provides options for extracting objects in nested and xref blocks, options for
counting blocks, and whether all objects are extracted or only those in model
space.

List of Options

The following options are displayed.

Extraction Settings
Extract Objects from Blocks

Includes objects nested in blocks.

Extract Objects from Xrefs

Includes objects and blocks in externally referenced (xref) files.
Include Xrefs in Block Counts

Includes xrefs when counting blocks.

Extract From
Obijects in Model Space

Includes only those objects in model space and ignores objects in paper space.
All Objects in Drawing

Includes all objects in model space and paper space in the drawing, including
drawing information. On by default.
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New Drawings Found Dialog Box

Quick Reference

3 Mew Drawings Found ==
New drawings exist in one or more folders in this data extraction.

Select the drawings that you want to include in this extraction:

Drawing Name Folder

[ Drawing13.dwg C:\Program Files \AutoCAD...

Mote: Drawings not added now can be added later by checking them on the
Define Data Source Page

oK | [ cancel |

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II
E Command entry: dataextraction

Summary

Displays a list of new drawings that were added to the folder that was selected
for the data extraction after the extraction was performed.
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List of Options
The following options are displayed.

Drawing Name Displays the name of the drawing that was added to the data
extraction folder.

Folder Displays the path and folder name for each new drawing.
Link External Data Dialog Box

Quick Reference

A | ink External Data =

Data link
Choose the source of the external data:

None - ]

Assign the match between the drawing data to the external data using the following:

Drawing column:

Se1eCt columr

Matching options:

@ Leam about data matching

Select external data columns to include:

(i) leam about using extemal data

OK || Cancel |[ Help
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Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II

E Command entry: dataextraction

Summary
Matches the extracted drawing data to a Microsoft Excel spreadsheet through

a data link and data matching.

List of Options

Data Link
Choose the Source of the External Data

Displays a list of established links to an Excel spreadsheet.
Data Link Manager Button

Displays the Data Link Manager on page 433, where you can specify a link to
a Microsoft Excel spreadsheet.

Data Matching
Drawing Data Column

Displays a list of extracted property columns.

External Data Column

Displays a list of column names from the linked data in the Excel spreadsheet.
Check Match

Compares the data in the specified drawing data key column and the external
data key column. If the data is unique across all rows in the external data key
columns, and there is at least one data match between the drawing data and
in data in the spreadsheet, a message displays the check key is successful. If
the check key is unsuccessful, a warning message is displayed.
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Matching Options Provides two options for the Check Match function: Case
Sensitive and Ignore Prefix and Suffix White Space.

Case Sensitive
When Case Sensitive is selected, the case of the data is checked.
Ignore Prefix and Suffix White Space

Removes blank spaces in front of and after each data source before the check
matching process proceeds. When this option is clear, white spaces are
evaluated.

Learn About Data Matching Displays Understand Data Linking and Matching
topic in the User’s Guide.

Additional Columns for Data Table
Select External Data Columns to Include

Displays the column names in the order in which they appear in the
spreadsheet. Selected columns are linked to the drawing data through data
matching.

Use Top Row of External Data as Column Names

Uses the top row of data in the data link as the column name for the linked
data. Otherwise, column names are labeled “Column 1, Column 2” and so
on.

Learn About Using External Data

Displays the New Features Workshop.
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Sort Columns Dialog Box
Quick Reference

Define sort order:

Column

Select column

Order

Ascending

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II

EE Command entry: dataextraction

Summary

Specifies a sort order for columns.

List of Options
Define Sort Order

Specifies the sort order of columns. The Column section contains column
names from the Refine Data on page 408 page.

Add

Adds a new item of sorting criteria to the Column list.
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Remove

Removes the currently selected sort criteria.
Move Up

Moves the selected item up in the list view.

Move Down

Moves the selected item down in the list view.

Insert Formula Column Dialog Box

Quick Reference

ﬂ Insert Formula Column (=3
Column name:
Column
Formula: |1 Columns: |1
Column Name
Angle
Area
Author
E] E] Center X
[ Validate ] 4 [l 3
[ ok J[ Cancel |[ Hebp

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II
EE Command entry: dataextraction

422 | Chapter 5 D Commands



Summary

Specifies the formula for the column that is inserted into the extracted data.

List of Options
The following options are displayed.
Column Name

Specifies a name for the column that can be edited. Duplicate column names
cannot be used.

Formula

Displays the selected formula or functions that are available for QUICKCALC
on page 1498 and CAL on page 287.

Addition (+) Button

Adds the numerical data from one column to another.
Minus (-) Button

Subtracts the numerical data from one column to another.
Multiply (*) Button

Multiplies the numerical data from one column to another.
Division (/) Button

Divides the numerical data from one column to another.
Validate

Checks the validity of the specified equation. A formula column can only be
inserted when the formula is validated.

Columns

Displays the column names from the extracted drawing data and external
data (if data linking was established). Column names can be double-clicked
to be added to the Formula field or dragged from the Column list to the
Formula field. Existing formula columns are not listed and cannot be used as
values for creating additional formula columns.
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Set Cell Format Dialog Box

Quick Reference

ﬂ Set Cell Format (=3
Data type: Preview:
Angle 345,347860
gg;reencv Format:
-
General Current units =
Percentage Decimal |i|
Point Architectural
Text Engineering -
Whole Number —

Additional Format. ..

OK ][ Cancel ][ Help ]

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data
£ Menu: Tools » Data Extraction

£ Toolbar: Modify II

E Command entry: dataextraction

Summary

Defines the formatting for cells in the table.

List of Options

The following options are displayed.
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Data Type
Displays a list of data types (Angle, Date, Decimal Number, and so on) that
you can format for table rows.

Preview Displays a preview of the option you selected in the Format list.

Format Depending on the data type you select, displays a list of relevant
format types. For example, if you select Angle as the data type, Format includes
options such as Decimal Degrees, Grads, Radians, and so on.

Precision For Angle, Decimal Number, and Points data types only, sets the
precision for applicable formats. For example, if you select Angle as the data
type and Radians as the format type, Precision includes options such as Current
Precision, 0.0r, 0.00r, 0.000r, and so on.

List Separator For a Point data type only, displays a list of options (comma,
semicolon, or colon) that you can use to separate list items.

Symbol For Currency data types only, displays a list of currency symbols that
you can use.

Append Symbol For Currency data types, places the currency symbol after
the number. For Percentage data types, the percent symbol is placed after the
number.

Negative Numbers For Currency data types only, lists options for displaying
negative numbers.

X, Y, and Z Coordinates For Point data types only, filters X, Y, or Z
coordinates.

Additional Format For Angle, Decimal Number, Point, and Whole Number
data types only, opens the Additional Format dialog box on page 426, where
you set additional formatting options for table cells.

Examples For the Date data types only, displays a list of date display options
in the Format field. Click a date in the Format field to see an example.
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Additional Format Dialog Box

Quick Reference

Aﬂ Customize Layer Columns (3]

Check the columns you want to display.

Status
Name
On
Freeze
Lock
Color Clear All
i
Lineweight
Plot Style

Plot

MNew VP Freeze
Diescription

Select All

[ ok |[ Cancel |[ Help

Access Methods

£ Menu: Format » Data Extraction

Summary

Provides additional formatting options for fields and table cells.
List of Options

Current Value Displays the value in base drawing units.

Preview Displays updates to the format as you change the conversion factor
and other settings.

Conversion Factor Specifies the conversion factor to use on the current value.
The default is 1 for no conversion.

Additional Text Specifies a prefix or a suffix for the value.
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Number Separators Specifies a decimal separator and the formatting for
numbers over 1000.

Decimal
Specifies the separator for decimal values. Select a period, a comma, or a
space.

Thousands
Inserts a comma to group thousands in a field value.

Zero Suppression Controls the suppression of leading and trailing zeros, and
of feet and inches that have a value of zero.

Leading
Suppresses leading zeros in all decimal values. For example, 0.5000 becomes
.5000.

Trailing
Suppresses trailing zeros in all decimal values. For example, 12.5000
becomes 12.5, and 30.0000 becomes 30.

0 Feet
Suppresses the feet portion of a feet-and-inches value when the distance
is less than one foot. For example, 0'-6 1/2" becomes 6 1/2".

0 Inches
Suppresses the inches portion of a feet-and-inches value when the distance
is an integral number of feet. For example, 1'-0" becomes 1'.
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Edit Formula Column Dialog Box

Quick Reference

ﬂ Edit Formula Column (=3
Column name:
Colurmn
Formula: |1 Columns: (1
| Column Name -
Angle
Area
Author
B B Center X -
l Validate I 4 [ 3
[ ok J[ Cancel |[ Hep

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data.
£ Toolbar: Modify II

£ Menu: Tools » Data Extraction

EE Command entry: dataextraction

Summary

Displays the equation for the selected formula column.

List of Options

The following options are displayed.

Column Name

Specifies a name for the column that can be edited.

Formula
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Displays the existing formula or function.

Plus (+)

Adds the numerical data from one column to another.
Minus (-)

Subtracts the numerical data from one column to another.
Multiply (¥)

Multiplies the numerical data from one column to another.
Division (/)

Divides the numerical data from one column to another.
Validate

Checks the validity of the specified equation. A formula column can only be
inserted when the formula is validated.

Columns

Displays the column names from the extracted drawing data and external
data (if data linking was established). Column names can be double-clicked
to be added to the Formula field or dragged from the Column list to the
Formula field.
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Filter Column Dialog Box

Quick Reference

ﬁ Filter Area (=3
Filter based on the following conditions:
[ Mo fitter -

Filter across these values:

Values
2933661212888

0K | [ Cancsl

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data.
£ Toolbar: Modify II

£ Menu: Tools » Data Extraction

E Command entry: dataextraction

Summary

Filters column data by specified filters.

List of Options
Filter Based on the Following Conditions
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Displays conditions based on the type of data in the selected column.
First Column

Specifies the first condition.

Second Column

Available when the specified filter uses two conditions.

Filter Across These Values

Displays a list of values depending on the type of data being filtered. Filters
for numeric data include Greater than >, Equal To, Between, and so on. Filters
for textual data include Equal To, Not Equal To, Contains, and Begins With.

Data Extraction - Outdated Table Dialog Box

Quick Reference

Access Methods

Button

£ Ribbon: Annotate tab » Tables panel » Extract Data.

£ Toolbar: Modify II

£ Menu: Tools » Data Extraction

EE Command entry: dataextraction

Summary

Offers options to update the data extraction table, update all tables, skip the
update, or skip all updates.

List of Definitions

The following options are displayed.

Update

Updates the data extraction table in the current drawing.
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Update All

Updates all the data extraction tables.
Skip Update

Does not update the table.

Skip All Updates

Does not update any tables.

-DATAEXTRACTION

Quick Reference

Extracts data as specified in an existing attribute extraction template (BLK)
file created with the Attribute Extraction wizard in AutoCAD 2006 or data
extraction (DXE) file created in AutoCAD 2007.

If you enter -dataextraction at the Command prompt, the following prompts
are displayed.

Enter the template file path for the extraction: type: Specify the path and file
name for the attribute extraction template (BLK) or data extraction (DXE) file that
describes how to extract the information

Subsequent prompts depend on the information set up in the template file.
If the template specifies extracting data to an external file, the following
prompts are displayed:

Enter the output filetype [Csv/Txt/X1s/Mdb] <Csv>: Enter c for comma-separated
(CSV), t for tab-separated (TXT), x for Microsoft Excel (XLS), or m for Microsoft Access
(MDB)

Enter output filepath: Specify the names of the path and file where the data will be
extracted

NOTE The maximum number of columns that can be exported to an XLS and
MDB file is 255.

If the template specifies a table, the following prompt is displayed:

Specify insertion point:
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DATALINK

Quick Reference

The Data Link dialog box is displayed.
Access Methods

@

Button

£ Ribbon: Insert tab » Linking & Extraction panel » Data Link
£ Menu: Tools » Data Links » Data Link Manager
E Command entry: datalink

Summary

A table can be linked to data in a Microsoft Excel (XLS, XLSX, or CSV) file.
You can link to an entire spreadsheet, individual row, column, cell, or cell
range in Excel.

The Data Link Manager on page 433 is displayed.

Data Link Manager

Quick Reference

Creates, edits, and manages data links.
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ﬁ Data Link Manager ==

Links:

B%

Bl Create a new Excel Data Link

Details

Mo details available.

Preview

Mo preview available.

[ oK. ][ Cancel ][ Help

Access Methods

ﬁ
Button

£ Ribbon: Insert tab » Linking & Extraction panel » Data Link
£ Menu: Tools » Data Links » Data Link Manager
E Command entry: datalink

Data Link Tree View

Displays links contained within the drawing. Also gives options for creating
new data links.

Excel Links

Lists the Microsoft Excel data links within the drawing. If the icon displays a
linked chain, then the data link is valid. If the icon displays a broken chain,
then the data link is broken.

Create a New Excel Data Link Launches a dialog box where you enter the
name for a new data link. Once a name has been created, the New Excel Data
Link dialog box on page 435 is displayed.
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Details

Lists information for the data link selected in the tree view above.

Preview

Displays a preview of the linked data as it would appear in the drawing table.
When a data link is not currently selected then no preview is displayed.

New and Modify Excel Link Dialog Box

Quick Reference

Links data from a spreadsheet created in Microsoft Excel to a table within your
drawing.

Access Methods
ﬁ
Button

£ Ribbon: Insert tab » Linking & Extraction panel » Data Link
£ Menu: Tools » Data Links » Data Link Manager
E Command entry: datalink

ﬂ Data Link Manager @

Links:
=8 ExcelLinks

8 ot 2 nen excl o i

Details

No details available.

Preview

No preview available.

[ oK H Cancel II Help
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File
Specifies the file and file path from which to create a data link.
Choose an Excel File

Allows you to choose an established Microsoft XLS, XLSX, or CSV file to link
to your drawing. At the bottom of this drop-down list, you can select a new
XLS, XLSX, or CSV file from which to create a data link.

Click the [...] button to browse for another Microsoft Excel file on your
computer.

Path Type Determines the path that will be used to find the file specified
above. There are three path options: full path, relative path, and no path.

Full Path Uses the full path of the file specified above, including the root
directory and all subdirectories that contain the linked Microsoft Excel file.

Relative Path Uses the file path relative to the current drawing file to reference
the linked Microsoft Excel file. To use a relative path, the linked file must be
saved.

No Path Uses only the filename of the linked Microsoft Excel file for
referencing.

Link Options

Specifies the data in your Excel file to link to your drawing.

Select the Excel Sheet to Link to

Displays the names of all sheets within the specified XLS, XLSX, or CSV file.
The link options specified below are applied to the sheet you choose here.

Link whole sheet
Links the entire specified sheet within your Excel file to a table in your drawing.
Link to a named range

Links a named range of cells already contained within your Excel file to a table
in your drawing.

Clicking the arrow displays the available named ranges found in the linked
spreadsheet.

Link to range

Specifies a range of cells in your Excel file to link to a table in your drawing.
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In the text box, enter the range of cells you want linked to your drawing. Valid
ranges include

B Rectangular regions (for example, A1:D10)
B Entire columns (for example, A:A)

B Sets of columns (for example, A:D)

Click the button to the right of the text box to preview the linked range.

Preview Window

Displays a preview of your table using the options you have applied.

Cell Contents

Options in this box will determine how data is imported into your drawing
from your external source.

Keep Data Formats and Formulas

Imports data with formulas and supported data formats attached.
Keep Data Formats, Solve Formulas in Excel

Imports data formats. Data is calculated from formulas in Excel.
Convert Data Formats to Text, Solve Formulas in Excel

Imports Microsoft Excel data as text with data calculated from formulas in
Excel (supported data formats not attached).

Allow Writing to Source File

Specifies that the DATALINKUPDATE on page 438 command can be used to
upload any changes made to linked data in your drawing to the original
external spreadsheet.

Cell Formatting
Use Excel Formatting

Imports any formatting specified in the original XLS, XLSX, or CSV file will
be brought into your drawing.

Keep Table Updated to Excel Formatting

If the option above is selected, updates any changed formatting when the
DATALINKUPDATE on page 438 command is used.
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Start With Excel Formatting, Do Not Update

Imports the formatting specified in the original XLS, XLSX, or CSV file into
your drawing, but any changes made to the formatting are not included when
the DATALINKUPDATE on page 438 command is used.

DATALINKUPDATE

Quick Reference

Updates data to or from an established external data link.

T,

£ Ribbon: Annotate tab » Tables panel » Download from Source. L
£ Menu: Tools » Data Links » Update Data Links
E Command entry: datalinkupdate

Updates changes to linked data between a table in a drawing and an external
data file.

Select an option [Update data link/Write data link] <Update data link>:

Update Data Link

Updates the linked data in a table in your drawing with data that has been
changed in the external source file.

Select objects or [Data link/All]:
Select Objects Updates selected tables containing data links with data that
has been changed in the external source file.

Data Link Specifies the name of a data link to update with data that has been
changed in the external source file.

Enter data link name or [?]:

Entering [?] lists the data links in the current drawing.

All Updates all data links in all tables in the drawing with data that has been
changed in the external source file.

Write Data Link

Updates the linked data in an external file with data that has been changed
in a table in your drawing.
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Select objects:
Select Objects Uploads data that has been changed from the original linked
content to the source file.

DBCONNECT

Quick Reference

Provides an interface to external database tables.

£ Ribbon: View tab » Palettes panel » dbConnect.
£ Menu: Tools » Palettes » dbConnect.
E Command entry: dbconnect

The dbConnect Manager is displayed and the dbConnect menu is added to
the menu bar.

The four primary interfaces (the dbConnect Manager, the Data View window,
the Query Editor, and the Link Select dialog box) are described first, followed
by descriptions of each additional dialog box presented in alphabetical order.
The Column Values dialog box, a sub-dialog box of the Query Editor, is
described in the Query Editor section. The section describing each dialog box
contains a list of methods that you can use to access it.

dbConnect Manager on page 440

Data View window on page 445

Query Editor on page 453

Column Values dialog box on page 460

Link Select dialog box on page 478

Configure a Data Source dialog box on page 461

Data View and Query Options dialog box on page 461
Export Links dialog box on page 464

Export Query Set dialog box on page 465

Export Template Set dialog box on page 465
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Find dialog box on page 465

Format dialog box on page 466

Import Query Set dialog box on page 467

Import Template Set dialog box on page 467
Label Template dialog box on page 468

Label Template Properties dialog box on page 473
Link Conversion dialog box on page 474

Link Manager on page 477

Link Template dialog box on page 481

Link Template Properties dialog box on page 482
New Label Template dialog box on page 483
New Link Template dialog box on page 484

New Query dialog box on page 484

Replace dialog box on page 485

Select a Database Object dialog box on page 486
Select Data Object dialog box on page 486

Sort dialog box on page 487

Synchronize dialog box on page 488

dbConnect Manager

Quick Reference

Provides the primary interface for the connectivity feature. You can view and
edit database tables, execute structured query language (SQL) queries, and link
table records to graphical objects. By default, the dbConnect Manager opens
as a docked window on the left side of the drawing area.
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When you open the dbConnect Manager, a small red X is displayed in the
lower right corner of each database and data object. The X indicates that these
objects are currently unconnected. To connect to a database or data object,
double-click it in the dbConnect Manager.

dbConnect Manager Buttons

Display and manipulate database objects.

b 4
o |
Eﬁ C:\Program Files\Autol
. L.®® RoomLinkl
@@ InventoryLinkl

Bl

View Table Opens an external database table in Read-only mode. This button
is not available unless a single table, link template, or label template is selected
in the tree view.

Edit Table Opens an external database table in Edit mode. This button is not
available unless a single table, link template, or label template is selected in
the tree view.

Execute Query Executes a query. This button is not available unless a query
is selected in the tree view.

New Query Displays the New Query dialog box. This button is not available
unless a single table, link template, or query is selected. If a query is selected,
you can use this button to display the Query Editor, in which you can edit
the query.

New Link Template Displays the New Link Template dialog box. This button
is not available unless a single table or link template is selected. If a link
template is selected, you can use this button to display the Link Template
dialog box, in which you can edit the link template. Not available for link
templates with links already defined in a drawing.
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New Label Template Displays the New Label Template dialog box. This
button is not available unless a single table, link template, or label template
is selected. If a label template is selected, you can use this button to display
the Label Template dialog box, in which you can edit the label template.

dbConnect Manager Tree View
Contains nodes for each drawing that's currently open and a Data Sources
node that contains all available data sources configured on your system.

Drawing Nodes Shortcut Menu

Provides options available for an open drawing. Right-click the node of an
open drawing.

Export Template Set Opens the Export Template Set dialog box, in which
you can save all link and label templates stored in the drawing to an external
file.

Import Template Set Opens the Import Template Set dialog box, in which
you can import a set of link and label templates that are stored in an external
file.

Export Query Set Opens the Export Query Set dialog box, in which you can
save all queries stored in the drawing to an external file. The exported query
set is saved with the file extension .dbg.

Import Query Set Opens the Import Query Set dialog box, in which you can
import a set of queries stored in an external file with the file extension .dbgq.

Show Labels Turns on visibility of all labels in the selected drawing.
Hide Labels Turns off visibility of all labels in the selected drawing.

Reload Labels Refreshes the field values of the labels in the selected drawing,
updating them to reflect any changes made in the source database table.

Database Objects Shortcut Menu

Provides options available for database objects (such as link templates, label
templates, and queries) attached to the drawing nodes. Different database
objects have different subsets of menu options available to them. For example,
the shortcut menu options that are displayed when you right-click a query
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differ from the options that are available when you right-click a link template.
The following shortcut menu options are available for various database objects.

View Table Opens an external database table in Read-only mode. Available
only for link templates.

Edit Table Opens an external database table in Edit mode. Available only for
link templates.

Edit Opens a dialog box in which you can edit the properties of the selected
database object. Available for link templates, label templates, and queries. Not
available for link templates with links already defined in the drawing.

Delete Deletes the selected database object. Available for link templates, label
templates, and queries.

Duplicate Makes a copy of the selected database object and inserts it in the
current drawing. Available for link templates, label templates, and queries.

Rename Opens a dialog box in which you can rename the selected database
object. Available for link templates, label templates, and queries. Not available
for link templates with links already defined in the drawing.

New Query Opens the New Query dialog box. Available only for link templates.

Link Select Opens the Link Select dialog box on page 478. Available only for
link templates.

New Label Template Opens the New Label Template dialog box. Available
only for link templates.

Show Labels Displays all labels that are associated with the selected database
object. Available for link templates and label templates.

Hide Labels Hides all labels that are associated with the selected database
object. Available for link templates and label templates.

Delete Links Deletes all links in the current drawing that use the selected link
template. Available only for link templates.

Delete Labels Deletes all labels in the current drawing that use the selected
label template. Available only for label templates.

Synchronize Verifies that all links in the current drawing based on the selected
link template contain valid values. Any detected problems are reported in the
Synchronize dialog box. Available only for link templates.
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Reload Refreshes the field values of all labels associated with the selected label
template in the current drawing, updating them to reflect any changes made
in the source database table. Available only for label templates.

Execute Executes the selected query. Available only for queries.

Delete Links Deletes all links in the current drawing that use the selected link
template. Available only for link templates.

Data Sources Node Shortcut Menu

Provides options available for data sources. Right-click the data sources node.
= %

Configure Data Source Opens the Configure a Data Source dialog box where
you can configure a new data source or edit an existing one.
Data Objects Shortcut Menu

Provides options available for data objects. Right-click a data object (such as
a catalog or table) in the data sources node.

Connect Establishes a connection to the selected data object. Available for
data sources, catalogs, and schemas.

Disconnect Closes the connection to the selected data object. Available for
data sources, catalogs, and schemas.

Synchronize Opens the Synchronize dialog box. Available only for connected
data sources.

Configure Opens the Configure a Data Source dialog box where you can
configure a new data source or edit an existing one. Available only for
disconnected data sources.

View Table Opens the selected database table in Read-only mode. Available
only for tables.

Edit Table Opens the selected database table in Edit mode. Available only for
tables.

New Link Template Opens the New Link Template dialog box. Available only
for database tables.

New Label Template Opens the New Label Template dialog box. Available
only for database tables.
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New Query Opens the New Query dialog box. Available only for database
tables.

Data View Window

Quick Reference

Provides the primary interface for viewing and editing external database tables
from within the program. You can open this dialog box using the following
methods:

£ Toolbar: dbConnect Manager buttons » Select a link template, a label
template, or a table from the dbConnect Manager and choose View Table or
Edit Table.

£ Menu: dbConnect » View Data » View External Table, Edit External
Table, View Linked Table, or Edit Linked Table. (Displays a dialog box in which
you can select a database table to open.)

Shortcut menu: Right-click a link template or a database table in the
dbConnect Manager and choose View Table or Edit Table.

Pointing device: Double-click a database table or a link template in the
dbConnect Manager. Double-clicking a link template that has no links created
in the drawing it's associated with opens the Link Template dialog box. The
database table is opened in either Edit mode or Read-only mode, depending
on the dbConnect Settings specified on the System tab of the Options dialog
box. See OPTIONS on page 1241.

The Data View window displays records from the selected database table. The
Data View contains a set of buttons, a grid window for viewing and editing
records, and a set of navigation controls for navigating through the record
set. After you open the Data View window, the Data View menu is added to
the menu bar. You can specify whether the Data View window can be docked
or anchored by right-clicking the title bar and choosing an option from the
shortcut menu.

The appearance of the Data View window is governed by your computer's
system settings, and it can be changed in the Windows Control Panel. Text
in the cells is displayed using the system window text color. If the database
table is opened in Read-only mode, the cell background is shown using the
system 3D objects button shade color (light gray by default). If it is opened
in Edit mode, the cell background is shown using the system window color
(white by default). When a cell is selected, it is shown using the system-
selected items background and text colors.
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Data View - Employee [ C:\Program Files\AutoCAD 2010\Sample\db_samp.dwg ) - Read Only  [E]
w0~ €y 3| % %S | EmployeeLinki - | EmployeeLabel
Emp_Id Last_Name First_Name Gender Title &
3 Torbati Yolanda F Programmer =
1001 Kleinn Joel M Programmer
1002 Ginsburg Laura F President
1003 Cox Jennifer F Programmer
1005 ZFiada Mauri M Product Designer
1006 Keyser Cara F Account Executive
1063 Ford Janice F Accountant
1010 Smith Roxie M Programmer
1011 Melson Robert M Programmer
1012 Sachsen Lars M Support Technician -~
H|[4] Record 1 M)« o T N G

Data View Buttons

Create links and display linked records and graphical objects.

Link

Links the currently selected database table row or rows to one or more graphical
objects. The link and, if desired, the label from the currently selected link and
label templates are created in the Data View window. To change the current
link creation setting, choose the Link and Label Settings button. Three distinct
link methods are available:

Link Creates a link to one or more graphical objects without creating a
corresponding label. If the current drawing has a selection set already
established, a link is created for each object in the selection set. If the current
drawing does not have a current selection set, you are prompted to select
objects to link to.

Create Freestanding Label Creates a freestanding label that isn't associated
with a graphical object. You are prompted to specify an insertion point for
the label.

Create Attached Label Creates a link to one or more graphical objects and
creates a corresponding label. If the current drawing has a selection set already
established, a link is created for all objects in the selection set. If the current
drawing does not have a current selection set, you are prompted to select
objects to link to.
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View Linked Objects in Drawing

Selects graphical objects in the current drawing that are linked to the currently
selected Data View row or rows.

View Linked Records in Table

Selects records in the Data View window that are linked to the current selection
set of graphical objects.

AutoView Linked Objects in Drawing

Displays linked objects automatically in the current drawing as you select
rows from the database table.

AutoView Linked Records in Table

Displays linked records automatically in the Data View window as you select
graphical objects in the current drawing.

Print Data View

Prints the contents of the Data View window to the current Microsoft®
Windows® system printer.

Data View and Query Options

Opens the Data View and Query Options dialog box, in which you can specify
a number of settings that affect the interaction and display of linked objects
in the Data View window and the current drawing.

Query, Return to Query, and Return to Link Select

Opens either the New Query dialog box, the Query Editor, or the Link Select
dialog box, depending on the method used to open the Data View window.
If the Data View window was opened to view or edit a database table, this
button's tooltip is Query, and choosing it opens the New Query dialog box.
If the Data View window was opened to return the results of a query, this
button's tooltip is Return to Query, and choosing it returns you to the Query
Editor. If the Data View window was opened to return the results of a Link
Select operation, this button's tooltip is Return to Link Select, and choosing
it returns you to the Link Select dialog box.
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Link Template List

Creates a new link template, or specifies a link template from those that are
defined for the open table. The selected link template is applied when you
create new links in the current drawing. To create a new link template, select
the New Link Template option from the Link Template list, and then choose
the Link button flyout.

Label Template List

Creates a new label template, or specifies a label template from those that are
defined for the currently selected table. The selected label template is applied
when you create new labels in the current drawing. To create a new label
template, select the New Label Template option from the Label Template list
and choose either the Create Freestanding Label or the Create Attached Label
button flyout. If there is no link template defined for the selected database
table in the current drawing, the New Link Template dialog box is displayed.

Data View Grid Window

Displays a subset of the records from a database table. You can select records
by clicking the following elements:

B Column header: Selects all records in that column. Double-clicking a column
header sorts its records in ascending order. Double-clicking a column
header a second time sorts its records in descending order.

B Record header: Selects an individual record. Double-clicking a record header
selects any graphical objects that the record is linked to in the drawing
area.

B Grid cell: Selects one field of a given record. Double-clicking a cell selects
it for editing.

B Grid header: Selects the entire table. Double-clicking the grid header commits
any changes made during an editing session and closes the Data View

window.
e v Pylh| K HMEE
Emp_Id Last_ Name
» Torbat
1001 Kleinn
1002 Ginsburg
1003 Cox

448 | Chapter 5 D Commands



Column Shortcut Menu

Displays the following options when you right-click one or more selected
column headers.

Sort Opens the Sort dialog box, in which you can select a combination of up
to five columns to use in specifying a sort order for the Data View.

A small triangle in the column header indicates that the data is sorted by that
column.

Hide Removes all selected columns from the Data View display.

Unhide All Restores all hidden columns to the Data View display. Available
only if you have hidden one or more columns.

Freeze Freezes all selected columns so that they do not scroll when you use
the horizontal scroll bar. Available only if the selected columns are contiguous.

Unfreeze All Unfreezes all frozen columns so that they scroll when you use
the horizontal scroll bar. Available only if you have frozen one or more
columns.

Align Aligns the current column. Standard right-aligns numeric fields and
left-aligns all others, Left left-aligns the column cells, Center center-aligns the
cells, and Right right-aligns the cells.

Find Opens the Find dialog box, which you can use to search for a specific
value. Find is limited to the values stored in the currently selected column.

Replace Opens the Replace dialog box, which you can use to search for a
specific value to overwrite with a replacement value that you specify. Replace
is limited to the values stored in the currently selected column. Available only
for database tables that are opened in Edit mode.

Cell Shortcut Menu

Displays the following options when you right-click the selected cell.

View Linked Obijects Indicates graphical objects in the current drawing that
are linked to the selected database record.

Link Links the current row to a graphical object. The link and, if desired, the
label from the currently selected link and label templates are created in the
Data View. You can specify whether a link, a freestanding label, or an attached
label is created by changing the settings from the Link and Label Settings cell
shortcut menu option.
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Link and Label Settings Lists the currently selected link creation mode. You
can specify whether a link, a freestanding label, or an attached label is created
when the Link shortcut menu option is chosen.

Find Opens the Find dialog box, which you can use to search for a specific
value. The Find shortcut menu option limits its search to records contained
in the same column as the currently selected cell.

Replace Opens the Replace dialog box, which you can use to search for a
specific value to overwrite with a replacement value that you specify. Replace
limits its search to records contained in the same column as the currently
selected cell. Available only for database tables that are opened in Edit mode.

Edit Enables you to change the value of the currently selected cell. Available
only for database tables that are opened in Edit mode.

Cut Clears the current cell and copies its value to the Clipboard. Available
only for database tables that are opened in Edit mode.

Copy Copies the value from the current cell to the Clipboard.

Paste Inserts the value currently stored on the Clipboard into the selected
cell. Available only for database tables that are opened in Edit mode.

Clear Deletes the value in the current cell. Available only for database tables
that are opened in Edit mode.

Record Shortcut Menu

Displays the following options when you right-click one or more selected
record headers.

View Linked Obijects Indicates graphical objects in the current drawing that
are linked to the selected database records.

Link Links the selected row or rows to one or more graphical objects. The link
and, if desired, the label from the currently selected link and label templates
are created in the Data View window. You can specify whether a link, a
freestanding label, or an attached label is created by choosing the Link and
Label Settings shortcut menu option.

Link and Label Settings Lists the currently selected link creation mode. You
can specify whether a link, a freestanding label, or an attached label is created
when the Link shortcut menu option is chosen.

Copy Copies the selected records to the Clipboard.

Delete Record Deletes the selected records. Available only for database tables
that are opened in Edit mode.
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Add New Record Adds a new record with blank field values to the end of the
record set. Available only for database tables that are opened in Edit mode.

Clear All Marks Clears record selection marks from the selected records in
the Data View window.

Grid Header Shortcut Menu

Displays the following options when you right-click the grid header.

Commit Saves all changes made in the Data View window to the source
database table and closes the Data View window. Available only when a
database table is open in Edit mode and you have edited its values.

Restore Undoes any changes made to a database table during an editing session
and closes the Data View window. Available only when a database table is
open in Edit mode and you have edited its values.

Unhide All Columns Restores any hidden columns to the Data View window
display.

Unfreeze All Columns Unfreezes any frozen columns so that they scroll when
you use the horizontal scroll bar.

Clear All Marks Clears all record selection marks from the Data View window.

Print Preview Opens the Print Preview window in the Data View window, in
which you can preview your printed report.

Print Prints the contents of the Data View window to the current Windows
system printer.

Format Opens the Format dialog box, in which you can control how data is
displayed in the Data View window.

Navigation Controls

Cycle quickly through the records in the Data View window. The following
controls are available:

First Button Selects the first record.
Previous Button Selects the previous record.
Next Button Selects the next record.

Last Button Selects the last record.
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Data View Print Preview Window

Loads into the Data View window a preview image of how the current table
appears when you print it. When the Data View window is in Preview mode,
none of the primary Data View buttons is available and the navigation buttons
are removed from the bottom of the window. You can open this dialog box
using the following methods:

£ Menu: Data View » Print Preview
Shortcut menu: Right-click the grid header in the Data View window and
choose Print Preview.

Print (=)

Prirter

MName: [Microsoﬂ XPS Document Writer v] [ Properties... ]
Status: Ready

Twpe: Microsoft XPS Document Writer

Where:  XPSPort:

Comment: [ Prirt to file

Print range Copies

@ Al MNumber of copies: 1 T
~) Pages  from: 1 to:

") Selection 1'1 2'2 3'3 o

[ QK ] [ Cancel

Print Opens the default system Print dialog box.
Next Page Presents a preview image of the next page of the database table.

Prev Page Restores the preview image of the previous page of the database
table.

Two Page Toggles the display between one and two preview pages. If you
choose Two Page, the name of the button changes to One Page and vice versa.

Zoom In Magnifies the preview page so that you can view the details more
closely.
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Zoom Out Shrinks the preview page to display a larger region of the database
table.

Close Closes the Data View Print Preview window and restores the default
Data View window display.

Query Editor

Quick Reference

Consists of a series of tabs that you can use to build and execute queries. If
you are creating a new query, the New Query dialog box is displayed first. You
can open the Query Editor using the following methods:

£ Toolbar: dbConnect buttons » Select a database table or a link template
in the dbConnect Manager and choose the New Query button.

£ Toolbar: Data View buttons » Choose the Query or Return to Query
button in the Data View window.

£ Menu: dbConnect » Queries » New Query on an External Table, New
Query on a Link Template, or Edit Query. (Displays a dialog box in which you
can select a database object to query.)

Shortcut menu: Right-click a database table or link template in the
dbConnect Manager and choose New Query, or right-click a query and choose
Edit.

B Quick Query on page 453
B Range Query on page 455
B Query Builder on page 456
B SQL Queries on page 458

Quick Query Tab (Query Editor)
Quick Reference

Develops simple queries based on a single database field, single operator, and
single value.
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Field

Lists the fields from the current database table, from which you can select one
to apply to the query.

Operator

Displays a list of available operators that can be applied to the query. For
information about operators, see “Construct Simple Queries” in the User's
Guide.

Value
Specifies a value for the field that you are using to construct your query.
Look Up Values

Returns a list of all values for the specified field from the database table in the
Column Values dialog box, from which you can select the value you want.

Indicate Records in Data View
Indicates records that match your search criterion in the Data View window.
Indicate Objects in Drawing

Indicates linked objects that match your search criterion in the current
drawing.

Execute
Issues the finished query and closes the dialog box.
Close Closes the dialog box without issuing the query.

Store
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Saves the query with the current drawing.
Options
Opens the Data View and Query Options dialog box.

Range Query Tab (Query Editor)

Quick Reference

Constructs a query that returns all records or objects that fall within a given
range of values.

Field Lists the fields from the current database table, from which you can
select one to apply to the query.

From

Specifies the first value of the range. The query returns all records or graphical
objects that are greater than or equal to this value.

Look Up Values (From, Through)

Returns a list of all values for the specified field from the database table in the
Column Values dialog box, from which you can select the value you want.

Through

Specifies the second value of the range. The query returns all records or
graphical objects that are less than or equal to this value.

Indicate Records in Data View Indicates records that match your search
criterion in the Data View window.

Indicate Objects in Drawing Indicates linked objects that match your search
criterion in the current drawing.

Execute Issues the finished query and closes the dialog box.
Close Closes the dialog box without issuing the query.
Store Saves the query with the current drawing.

Options Opens the Data View and Query Options dialog box.
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Query Builder Tab (Query Editor)

Quick Reference

Constructs queries based on multiple search criteria. You can also group criteria
parenthetically, select which fields to display in the returned query, and specify
a sort order for the fields.

T Query Editor -- EmployeeQueryl ==
Query for records in table: Employee
Quick Queryl Range Queryl Query Builder ‘SQLQueryl
Field Operator Walue Logical
EDER -
] 1 b
Fields in table: Show fields: Sort by: Add | | &
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Last_Name
Pdame |
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Title
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Indicate records in data view Indicate objects in drawing

Query Builder Grid

Provides a space for you to construct queries based on multiple search
parameters.

Parenthetical Grouping Groups a series of search criteria by bracketing them
within parentheses. You can nest up to four sets of parentheses within a single
statement. To insert a beginning parenthesis, click in the cell to the left of the
first Field cell that you want to group. To insert an end parenthesis, click in
the cell to the right of the last Value cell that you want to group.

Field Provides a space where you can select the field or fields to include in
your query. Double-click in the Field cell of the current row to display a list
of available fields from the current database table that you can use in
constructing your query. To add an additional parameter, specify an operator
and a value for the current row and then select the Logical cell.

Operator Provides a space where you can select an operator to apply to the
query condition of the current row. Double-click in the Operator cell to display
a list of operators that you can use in constructing your query.
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Value Provides a space where you can specify a value for the query condition
of the current row. Click in the Value cell and enter a value, or choose the [...]
button to retrieve a list of available values for the selected field in the Column
Values dialog box.

Logical Provides either an And or an Or operator to the query statement.
Click in the Logical cell to add an And value. To change the value to Or, click
in the Logical cell again.

Fields in Table

Displays a list of available fields from the current database table, from which
you can specify the fields to display in the Data View window when the query
is executed. If you don't specify any fields to display, the query displays all
fields from the database table. Double-clicking in a field in this list or selecting
a field and choosing Add (Show Fields) adds the field to the list of those that
are displayed in the Data View window by the returned query. You can also
drag fields to add them to the Show Fields and Sort By areas.

Show Fields

Specifies the fields that are displayed in the Data View window when the query
is executed. To remove a field from this list, drag it from the list to any area
on the Query Builder tab.

Add (Show Fields)

Adds a field to include in the Data View window display of the returned query.
To add a field, select it in the Fields in Table list window and then choose
Add.

Sort By

Specifies a sort order for the returned query. The first field added to the Sort
By list is the primary sort. To change the sort order for a field, drag the field
to a new location in the Sort By list. By default, fields are added to the Sort
By list in an ascending sort order. To apply a descending sort, select a field and
choose the Ascending/Descending Sort button, or double-click in the field.
To remove a field, drag it from the list to any area on the Query Builder tab
or select the field and press DELETE.

Add (Sort By)

Adds a field to the Sort By list. To add a sort field, select it in the Fields in
Table list window and then choose Add. Repeat for additional fields that you
want to apply to the sort.
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Ascending/Descending Sort

Reverses the sort order for the currently selected field. If an ascending sort
order is currently applied, choosing this button reverses the sort to descending
order, and vice versa.

Indicate Records in Data View

Indicates records that match your search criteria in the Data View window.

Indicate Objects in Drawing

Indicates linked objects that match your search criteria in the current drawing.

Execute

Issues the finished query and closes the dialog box.

Close

Closes the dialog box without issuing the query.

Store

Saves the query with the current drawing.

Options
Opens the Data View and Query Options dialog box.

SQL Query Tab (Query Editor)

Quick Reference

Constructs any query statement that conforms with the SQL 92 protocol. The
SQL Query tab provides both a query editor text box where you can type a
free-form SQL statement and a set of tools to assist you in constructing your
query. As not all database management systems are fully compliant with the
SQL 92 standard, you should review your system's documentation to see what
SQL commands are valid for your particular database.
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SQL Text Editor

Provides a space for you to type a free-form SQL query or add elements that
you select using the various SQL Query tools.

Table

Lists all database tables that are available in the current data source. You can
add database tables to the SQL text editor by double-clicking them, by selecting
them and choosing Add in the Table area, by dragging them from the Table
list to the SQL text editor, or by entering their names directly in the SQL text
editor.

Add (Table)
Adds the currently selected database table to the SQL text editor.

Fields Displays a list of the fields in the selected database table. You can add
fields to the SQL text editor by double-clicking them, by selecting them and
choosing Add in the Fields area, or by dragging them from the Fields list to
the SQL text editor.

Add (Fields)

Adds the selected field to the SQL text editor.

Operator Displays a list of operators that you can apply to your query.
Add (Operator)

Adds the selected operator to the SQL text editor.

Values Specifies a value for the selected field.

Add (Values)
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Adds the value specified in the Values area to the SQL text editor.

[...] Button Returns a list of available values for the specified field from the
selected database table in the Column Values dialog box, from which you can
select a value to apply to the query.

Indicate Records in Data View Indicates records that match your search
criteria in the Data View window.

Indicate Objects in Drawing Indicates linked objects that match your search
criteria in the current drawing.

Execute Issues the finished query and closes the dialog box.
Close Closes the dialog box without issuing the query.
Store Saves the query with the current drawing.

Check

Checks your SQL query for proper syntax without actually executing it. This
function helps you isolate syntax errors before you issue your query.

Options Opens the Data View and Query Options dialog box.

Column Values Dialog Box

Quick Reference

Lists values for the selected database column; you can select a value to apply
to the current operation.

Column Values

Lists all values for the selected database column. Select a value from the list
and choose OK to apply it to the current operation. If you are constructing a
query using the In operator, you can add additional values to the query by
pressing the CTRL or SHIFT key as you select values.
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Configure a Data Source Dialog Box

Quick Reference

Configures an external database so it can be accessed from the program. For
detailed information about configuring a particular database system, refer to
“Configure External Databases” in the Driver and Peripheral Guide. You can open
this dialog box using the following methods:

£ Menu: dbConnect » Data Sources » Configure

Shortcut menu: Right-click the Data Sources node and choose Configure
Data Source.

Data Source Name

Specifies a name for the OLE DB data source that you are configuring.
Data Sources

Lists all OLE DB data sources configured for use with the program that are
present on your system.

OK Opens the Microsoft Data Links Properties dialog box, in which you can
continue configuring your data source.

Data View and Query Options Dialog Box

Quick Reference

Controls a number of settings related to the display of linked records and
objects and the processing of SQL queries. You can open this dialog box using
the following methods:

£ Toolbar: Data View buttons

enu: Data View tions. e Data View menu is available only 1
2 M Data View » Opti (The Data Vi i ilable only if
you currently have a database table open in the Data View window.)
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AutoPan and Zoom

Control how linked objects are displayed in the current drawing when you
select their corresponding records in the Data View window.

Automatically Pan Drawing

Pans the drawing automatically to display objects that are associated with the
current selection set of Data View records.

Automatically Zoom Drawing

Zooms the drawing automatically so that all objects associated with the current
record set are displayed.

Zoom Factor

Specifies a zoom factor that limits the size of the extents of the indicated object
set to a defined percentage of the drawing area. The available range is 20 to
90 percent with a default value of 50 percent. A value of 50 percent means
that either the height of the extents is 50 percent of the height of the window,
or the width of the extents is 50 percent of the window, whichever value is
less.

Record Indication Settings

Control the appearance of linked records in the Data View window when their
corresponding objects are selected in the current drawing.

Show Only Indicated Records

Displays in the Data View window only the record set that is associated with
the current selection set. Any records not linked to the current drawing
selection set are not displayed.
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Show All Records, Select Indicated Records

Displays all records in the current database table. All records that are linked
to the current selection set are selected in the Data View window.

Mark Indicated Records

Applies a marking color to linked Data View records to clearly differentiate
them from records without links.

Marking Color

Specifies the marking color to apply to linked Data View records. The default
color is yellow.

Query Options

Specify options for SQL query processing.

Send as Native SQL

Issues queries to database tables in the format of the source table rather than
SQL 92 format. You can use this option to issue proprietary commands in
native database format.

Automatically Store

Automatically stores queries when they are executed with the current drawing.

Accumulate Options
Control the accumulation of selection and record sets.
Accumulate Selection Set in Drawing

Adds additional objects to the selection set as you select additional Data View
records. If this option is cleared, the current drawing indicates a new set of
objects each time you select a new set of Data View records.

Accumulate Record Set in Data View

Adds additional records to the record set as you select additional graphical
objects. If this option is cleared, the Data View window indicates a new set of
records each time you select a new set of graphical objects.
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Export Links Dialog Box

Quick Reference

Exports a set of links that are associated with a selection set of graphical objects.
You can open this dialog box using the following method:

£ Menu: dbConnect » Links » Export Links

If more than one link template exists for the set of graphical objects that you
select, the Select a Database Object dialog box is displayed, in which you can
select a link template whose links you want to export.

A Export Links ==
Save o AutoCAD 2010 - Q% rE-
Include Fieds
- N temodif... Type si
& AdimRes

Link template name

InvertoryLinkl

tpe: [commadeimted fomat {od) -]

Include Fields

Specifies the database table fields to export. The key fields for the selected link
template are included automatically. The handle of the object that each link
is associated with is also exported.

File Name Specifies a name for the exported link file.

Save as Type Specifies the file format for the exported links. You can save the
file in the native database format of the current database table or as a
comma-delimited or space-delimited text file.

Link Template Name

Displays the name of the link template whose links you're exporting.
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Export Query Set Dialog Box

Quick Reference

Exports a set of queries that are associated with the current drawing. You can
open this dialog box using the following methods:

£ Menu: dbConnect » Queries » Export Query Set

Shortcut menu: In the dbConnect Manager, right-click the drawing node
of a drawing that contains one or more queries and choose Export Query Set.
File Name Specifies a name for the query set.

Save as Type Specifies the file format for the query set. Query sets are always
saved with the .dbgq file extension.

Export Template Set Dialog Box

Quick Reference

Exports a set of link templates and label templates that are associated with
the current drawing. You can open this dialog box using the following
methods:

£ Menu: dbConnect » Templates » Export Template Set

Shortcut menu: In the dbConnect Manager, right-click the drawing node
of a drawing that has one or more templates defined and choose Export
Template Set.

File Name Specifies a name for the template set.

Save as Type Specifies the file format for the template set. Template sets are
always saved with the .dbt extension.

Find Dialog Box
Quick Reference

Searches for specified text or a numeric value in the currently loaded Data
View table. The search is limited to a single table column. It is not possible to
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conduct a global search that scans all columns in the table. You can open this
dialog box using the following methods:

£ Menu: Data View » Find. (The Data View menu is available only if you
currently have a database table open in the Data View window.)

Shortcut menu: Right-click a record header or a single cell in the Data View
window and choose Find.

Find What Specifies the value to search for.

Match Case Searches for the exact value, including case, of what you enter
in Find What. If this option is cleared, the program searches for the value
regardless of case.

Find Next Finds the next occurrence of the value that you're searching for.

Direction Toggles the direction that the program searches for the specified
value in the Data View window.

Format Dialog Box

Quick Reference

Controls how database table records are displayed in the Data View window.
You can open this dialog box using the following methods:

£ Menu: Data View » Format. (The Data View menu is available only if
you currently have a database table open in the Data View window.)
Shortcut menu: Right-click the grid header in the Data View window and
choose Format.

Font

Specifies the font style that is applied to the current Data View table.
Font Style

Specifies a style to apply to the current font. The available options are Normal,
Italic, Bold, Bold Italic, Not Bold, and Not Italic.

Size
Specifies the size in points that is applied to the current font.

Effects
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Applies additional formatting to the Data View window display. Strikeout draws
a line through the center of all column data. Underline applies an underline
to all column data. Color applies a color to all column data.

Sample

Displays how the current Format option values look when applied to the Data
View window.

Script

Specifies the script that is applied to the current font.

Import Query Set Dialog Box

Quick Reference

Imports a set of queries into the current drawing. If the query set contains a
name that matches a query in the current drawing, an alert box is displayed,
and you can enter a different name for the query. You can open this dialog
box using the following methods:

£ Menu: dbConnect » Queries » Import Query Set

Shortcut menu: Right-click a drawing node in the dbConnect Manager and
choose Import Query Set.

Look In Specifies the directory where the query set is located.

File Name Specifies the name of the query set to import.

Files of Type Specifies the file extension of the query set that you're importing.
Query sets always have the .dbqg extension.

Import Template Set Dialog Box

Quick Reference

Imports a set of link templates and label templates into the current drawing.
If the template set contains a link or label template with a name that matches
a template in the current drawing, an alert box is displayed where you can
enter a different name for the template. You can open this dialog box using
the following methods:
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£ Menu: dbConnect » Templates » Import Template Set
Shortcut menu: Right-click a drawing node in the dbConnect Manager and
choose Import Template Set.

Look In Specifies the directory where the template set is located.
File Name Specifies the name of the template set to import.

Files of Type Specifies the file extension of the template set that you're
importing. Template sets always have the .dbt extension.

Label Template Dialog Box

Quick Reference

Applies formatting to labels.

Before the Label Template dialog box opens, the New Label Template dialog
box is displayed, in which you can name the label template. You can open
this dialog box using the following methods:

£ Toolbar: dbConnect Manager buttons » Select a database table, link
template, or label template and choose the New Label Template button. If a
label template is selected, the program opens the Label Template dialog box
without first displaying the New Label Template dialog box.

£ Toolbar: Data View buttons » Choose New Label Template from the
Label Template list, and then choose either the Create Freestanding Label or
the Create Attached Label button flyout. If there is no link template defined
for the selected database table in the current drawing, the program displays
the New Link Template dialog box.

£ Menu: dbConnect » Templates » New Label Template. Select a link
template in the Select a Database Object dialog box and choose Continue.
Shortcut menu: Right-click a link template or a database table in the
dbConnect Manager and choose New Label Template.

Pointing device: Double-click a label template in the dbConnect Manager.
This method opens the Label Template dialog box directly without first
displaying the New Label Template dialog box.

Character Tab

Controls character formatting for text that is entered at the keyboard or
imported.

468 | Chapter 5 D Commands



Pio L abel Template - Employees_by_Roomlabell ==
Character | Properties | Find/Replace | Label Fiekds | Label Offesi| [ ok |
" Avial ~| o200 ~ [B] [Z] (O] cu| (2] [ Bylayer ~| [Symbol v\| [ el

#(First_Name) o]

#(Last_Name) Help

Modify character properties. Ln 1Col 1

Font Specifies a font for new text or changes the font of selected text.

Height Sets the character height in drawing units for new text or changes the
height of selected text. The default value is based on the current text style. If
the current text style has no fixed height, the text height is the value stored

in the TEXTSIZE on page 2315 system variable.

Bold Turns bold formatting on and off for new or selected text. This option
is available only for characters using TrueType fonts.

Italic Turns italic formatting on and off for new or selected text. This option
is available only for characters using TrueType fonts.

Underline Turns underlining on and off for new or selected text.

Undo Undoes actions, including changes to either text content or text
formatting. You can also use CTRL+Z.

Redo Redoes actions, including changes to either text content or text
formatting. You can also use CTRL+Y.

Stack, Unstack Creates stacked text, for example, fractions, if the selected
text contains stack characters. Also, unstacks text if stacked text is selected.
When the stack characters, carat (*), forward slash (/), and pound sign (#), are
used, the text to the left of the stack character is stacked on top of the text to
the right.

By default, text that contains a carat converts to left-justified tolerance values.
Text that contains the forward slash converts to center-justified fractional
numbers; the slash is converted to a horizontal bar the length of the longer
text string. Text that contains the pound sign converts to a fraction separated
by a diagonal bar the height of the two text strings. The characters above the
diagonal fraction bar are bottom-right aligned; the characters beneath the
diagonal bar are top-left aligned.

Text Color Specifies a color for new text or changes the color of selected text.

You can assign text the color associated with the layer it is on (BYLAYER) or
the color of the block it is contained in (BYBLOCK). You can also select one
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of the colors in the color list or click Other to open the Select Color dialog
box. on page 333

Symbol Inserts a symbol or a nonbreaking space at the cursor position.
Symbols can also be inserted manually. See Symbols and Special Characters
on page 1179.

Commonly used symbols are listed on the submenu. Click Other to display

the Character Map dialog box, which contains the entire character set for each
font available on your system. Select a character and click Select to place it in
the Characters to Copy box. When you have selected all the characters that

you want to use, click Copy and close the dialog box. In the Label Template

dialog box, right-click and click Paste.

You can use the euro symbol with SHX fonts and their TrueType equivalent
fonts shipped with AutoCAD 2000 and later releases. If your keyboard does
not contain a euro symbol, hold down the ALT key and enter 0128 on the
numeric keypad.

Symbols are not supported in vertical text.

NOTE In the dialog box, the diameter symbol is displayed as %%c, but it is
displayed correctly in the label. The nonbreaking space is unavailable in double-byte
operating systems.

Properties Tab

Controls properties that apply to the whole label template.
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[ Character| Propetties | Find/Replace | Label Fields | Label Offset | [ ok |
‘St)'le [Standard = | dustication [E Top et TL | Width frowrap) + Rotation 0 - | [ cancel |
#(First_Name) o]
#(Last_Name) Help
Modify object properties. Ln 1Col 1

Style Applies a text style to the label. The current style is saved in the
TEXTSTYLE on page 2315 system variable. Character formatting for font, height,
and bold or italic attributes is overridden if you apply a new style to an existing
label template. Stacking, underlining, and color attributes are retained in
characters to which a new style is applied.Styles that have backward or
upside-down effects are not applied. If a style defined with a vertical effect is
applied to an SHX font, the text is displayed horizontally in the Label Template
dialog box.
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Justification Sets justification and alignment for the label. Top Left is the
default setting. Spaces entered at the end of a line are included as part of the
text and affect the justification of the line. Text is center-, left-, or right-justified
with respect to the left and right text boundaries. Text is middle-, top-, or
bottom-aligned with respect to the top and bottom text boundaries. See
-MTEXT on page 1175 for an illustration of the nine justification options.

Width Sets a paragraph width for new or selected text. The No Wrap option
produces a single line. The width of individual characters is not affected by
this option.

Rotation Sets the rotation angle for the label in the current unit of angle
measurement (degrees, radians, or grads).
Find/Replace Tab

Searches for specified text strings in the label template and replaces them with
new text.

& Label Ternplate - Employees_by_Roomlabell @
Find/Replace |Label Fields | Label Offset [ ok |
Find - @ Replace with - @ [] Match Case [ Whole Word | I Cancel I
#(First_Name) imporTe. )
#(Last_Name) Help

Find and replace text in this object. Ln 1Col 1

Find Defines the text string to search for.

Find Button Starts a search for the text string in Find. To continue the search,
click the Find button again.

Replace With Defines the text string to replace the text in Find What.
Replace Button Replaces the highlighted text with the text in Replace With.

Match Case Finds text only if the case of all characters in the text string is
identical to the case of the text in Find. When this option is cleared, a match
is found for specified text strings regardless of case.

Whole Word Matches the text in the Find box only if it is a single word. Text
that is part of another word is ignored. When this option is cleared, a match
is found for text strings, whether they are single words or parts of other words.
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Label Fields Tab

Specifies which database table fields are displayed when you create labels based
on this template.

A | abel Template - EmployeelinklLabell ==
|Cha|ader | Properties I Find/Replace | Label Fields | abel Offset 0K
| Fieu Table : Employes [
‘ Import Text..
Help
Modify label fields Ln1Col 1
Field

Displays a list of available fields from the current database table that you can
include in your label. You may include any number of fields from the source
table.

Add
Adds the selected field in the Field list to the label.
Table

Displays the name of the current database table.

Label Offset Tab

Defines X and Y coordinate offsets for the insertion point of both your label
and, if it is an attached label, its associated leader object.

A | abel Template - Employeelink Labell =3
|Cha|ader| Properties I Find/Replace | Label Fields | Label Offset | QK
| Start:| % Middle Center MC Leader offset 3 1" v 1" Tip offset 2 0" v 0" ‘ Cancel
Import Text..
Help
Modify label offset. Ln 1Col 1
Start

Specifies the start point for the leader object. The point is defined with respect
to the extents of the graphical object that the label is attached to. The Start
option has no effect on freestanding labels, as they have no associated leader
object.
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Leader Offset

Specifies an X and Y offset for the multiline text object with respect to the
associated leader object. By default, the X and Y Leader Offset options are set
to 1, indicating that the label text is offset 1 unit in the X and Y planes from
the tip of the leader object. The Leader Offset settings apply only to attached
labels.

Tip Offset

Specifies the leader tip or label text offset values for attached and freestanding
labels. For attached labels, the Tip Offset specifies the X and Y offset from the
value specified in Start for the tip of the leader object. For freestanding labels,
the Tip Offset specifies the X and Y offset from the insertion point you specified
for the label.

Label Template Properties Dialog Box

Quick Reference

Displays the full data source path to a label template's database table. You can
use this dialog box to update a label template with new data source
information.

Before the Label Template Properties dialog box opens, the Select a Database
Object dialog box is displayed, from which you can select a label template.

You can open this dialog box using the following method:

£ Menu: dbConnect » Templates » Label Template Properties
Template Name

Displays the name of the selected label template.
Data Source

Displays the name of the data source specified for the selected label template.
You can select a new data source from this list to apply to the label template.

Catalog

Displays the name of the catalog specified for the selected label template. You
can select a new catalog from this list to apply to the label template.

Schema
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Displays the name of the schema specified for the selected label template. You
can select a new schema from this list to apply to the label template.

Table

Displays the name of the database table specified for the selected label template.
You can select a new database table from this list to apply to the label template.

Fields
Displays the fields specified for the selected label template.

Link Conversion Dialog Box

Quick Reference

Converts links created in AutoCAD Release 12, Release 13, and Release 14 to
AutoCAD 2000 (and later) format. You can open this dialog box using the
following method:

£ Menu: dbConnect » Link Conversion

A Link Conversion
For each link that you want to use, supply the old link format and the new link format.
Old Link Format
Link Format: Ri2 @ Ri3/A14
Environment
Catalog
Schema
Table
Link path name
New Link Format
Data Source jet_dbsamples .
Catalog
Schema
Table Computer -
Link Template COMPUTERLINK1 -
(0K [ Cancel | [ sy | [ Hep |

Because legacy links are stored in formats that differ significantly from
AutoCAD 2000 and later, the link conversion process requires that you specify
a mapping of the old AutoCAD SQL Extension™ (ASE) link values to the new
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ones used by AutoCAD 2000 and later. For example, you must identify the
environment used by a particular link in Release 14 and specify the
corresponding data source that you want substituted for this environment in
AutoCAD 2000 and later. Similar mappings must be established between all
old ASE link values and the new values that you want substituted for them.
Link Format

Specifies the format of the link that you are converting. Different fields are
displayed depending on whether you select R12 or R13/R14.

R12
Specifies settings for converting R12 links.
R13/R14

Specifies settings for converting R13 and R14 links.

Old Link Format (R12)
Specifies the path to the database table used by the link that you're converting.
DBMS

Specifies the database management system used by the link that you're
converting.

Database
Specifies the database used by the link that you're converting.
Table

Specifies the database table used by the link that you're converting.

Old Link Format (R13/R14)

Specifies the path to the database table used by the link that you're converting.
Environment

Specifies the environment used by the link that you're converting.

Catalog

Specifies the catalog used by the link that you're converting.

Schema

Specifies the schema used by the link that you're converting.
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Table
Specifies the database table used by the link that you're converting.
Link Path Name

Specifies the link path name used by the link that you're converting.

New Link Format

Specifies the path to the database table used by the converted link.
Data Source

Lists available data sources that you can select for the converted link.
Catalog

Lists available catalogs that you can select for the converted link.
Schema

Lists available schemas that you can select for the converted link.
Table

Lists available database tables that you can select for the converted link.
Link Template

Lists available link templates that you can select for the converted link.

OK

Writes conversion mapping information to the asi.ini file and closes the dialog
box.

Apply

Writes conversion mapping information to the asi.ini file but keeps the dialog
box open so that you can specify conversions for additional links.

Cancel

Closes the dialog box without converting any links.
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Link Manager

Quick Reference

Edits the values of the key fields for a selected linked object. You can open
the Link Manager using the following methods:

£ Menu: dbConnect » Links » Link Manager. Select a linked graphical
object.

Shortcut menu: Select and then right-click a linked graphical object, and
then choose Link » Link Manager.

ﬂ Link Manager (=3
Update the key value of a link, or delete a link from an object.

Select the link by the link template name.

Link Templates:
InventoryLink 1 - Delete
Key Value
INV_ID 1167
OK | [ Cancel | [ Heb

Link Templates

Lists all link templates that are associated with the selected graphical object.
Select the link template whose link values you want to view or edit.

Key Displays the key fields of the currently selected link template.
Value

Displays all key values that are defined for the selected link. To display a list
of values for a specific field, click a Value cell and choose [...].

Delete

Deletes the currently selected link from the graphical object it's associated
with.
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Link Select Dialog Box

Quick Reference

Constructs iterative selection sets of graphical objects and database records.
The Link Select dialog box, known as ASE Select in previous releases, is an
advanced implementation of the Query Editor. You begin a Link Select
operation by creating an initial query or selection set of graphical objects (set
A), which can be operated on by an additional query or selection set (set B).
The results of the returned operation become the new running selection set
(set A), and you can apply additional queries or selection sets to further refine
your running query.

In order to work with the Link Select dialog box, you must have a drawing
open that has a number of links already created. You can open this dialog box
using the following methods:

£ Menu: dbConnect » Links » Link Select
Shortcut menu: Right-click a link template in the dbConnect Manager and
choose Link Select.

A | ink Select - db_samp ==
Do [sekeat = | — .
Using [RoomLink1 | O Select in Drawing <

Quick Query | Range Query | Query Builder
Execut
Feld
E_ Operator: [= Equal v]
oom_Type
e
Help
Indicate records in data view
Indicate ohjects in drawing
Drawing: db_samp Objects: 0
Table: jet_dbsamples...Room Records: 0
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The Link Select dialog box contains the Quick Query, Range Query, and Query
Builder tabs from the Query Editor, and the following additional controls.

Do

Applies a Link Select operator to the current query or selection set. The
following operators are available: Select, Union, Intersect, Subtract A-B, Subtract
A-B.

Select Creates an initial query or selection set. This selection set can be refined
through subsequent Link Select operations.

Union Adds the results of the new query or selection set to the running
selection set. This operation returns all records or objects that are members
of set A or set B.

Intersect Returns the intersection of the existing running selection and the
results of the new query or drawing selection. This operation returns all records
or objects that are members of set A and set B.

@

Subtract A-B Subtracts the results of the new query or drawing selection from
the existing running selection.

@

Subtract B-A Subtracts the existing running selection from the results of the
new query or drawing selection.

@

Using

Lists available link templates that you can apply to the current selection set.
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Use Query

Uses any of the available Query Editor tabs to construct a query that returns
a selection set to the Link Select operation.

Select in Drawing

Closes the Link Select dialog box when you choose the Select button so that
you can construct a selection set of graphical objects to return to the Link
Select operation.

Execute/Select

Executes the current Link Select query or temporarily dismisses the Link Select
dialog box so you can select graphical objects from the drawing. If the Use
Query option is selected, the Execute button is displayed. If the Select in
Drawing option is selected, the Select button is displayed. After choosing the
Execute or Select button, you can apply more queries or select additional
graphical objects to further refine your selection set.

Venn Diagram

Displays a diagram of the currently selected Do operation.

Reset

Clears the Link Select dialog box and discards all previous actions so that you
can begin a new Link Select operation.

Cancel

Closes the dialog box and discards all actions.

Finish

Completes the Link Select operation and closes the dialog box. Returns either
a selection set of graphical objects, a subset of Data View records, or both,
depending on the parameters specified in the Link Select operation.

Status Bar

Displays the current status information based on the running Link Select
operation. The current drawing and table are displayed, as well as the number
of linked objects and records that currently meet the specified Link Select
parameters.

480 | Chapter 5 D Commands



Link Template Dialog Box

Quick Reference

Specifies the key fields that are used by a link template.

Before the Link Template dialog box opens, the New Link Template dialog
box is displayed, in which you can name the link template. You can open this
dialog box using the following methods:

£ Toolbar: dbConnect Manager buttons » Select a database table and
choose the New Link Template button.

£ Toolbar: Data View buttons » Choose New Link Template from the Link
Template list, and then choose the Link button flyout.

£ Menu: dbConnect » Templates » New Link Template. Navigate to and
select a database table from the Select a Database Object dialog box and choose

Continue.

Shortcut menu: Right-click a database table in the dbConnect Manager and

choose New Link Template.

Pointing device: Double-click a link template in the dbConnect Manager.
This method opens the Link Template dialog box directly, without first
displaying the New Link Template dialog box.

A Link Tem plate

Template name:

Table:

one field.

Key Fields:

Select one field to serve as your key field. This field should be
a unigue field, and its value will identify a single record in the
table. In unusual cases. you may need to choose more than

==

ComputerLink2
Computer
iet_dbsamples...Computer

7| Tag_MNumber
Manufacturer

tem_Type
Room

Equipment_Description Character Varying 7

Integer
Character Varying 50

Character Varying 7
Character Varying 5

Template Name
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Displays the name of the link template.
Table

Displays the current database table. The first line lists the name of the table,
and the second line lists the full data source path to the table in the following
syntax: environment.catalog.schema.table

Key Fields

Displays all fields that are available for the current database table, as well as
the field type and, in the case of character fields, the field length. You specify
the link template's key fields by selecting the check box to the left of the field
name.

Link Template Properties Dialog Box

Quick Reference
Displays the full data source path to a link template's table. You can use this
dialog box to update a link template with new data source information.

Before the Link Template Properties dialog box opens, the Select a Database
Object dialog box is displayed, from which you can select a link template.

You can open this dialog box using the following method:

£ Menu: dbConnect » Templates » Link Template Properties
Template Name Displays the name of the selected link template.
Data Source

Displays the name of the data source specified for the selected link template.
You can select a new data source from this list to apply to the link template.

Catalog

Displays the name of the catalog specified for the selected link template. You
can select a new catalog from this list to apply to the link template.

Schema

Displays the name of the schema specified for the selected link template. You
can select a new schema from this list to apply to the link template.

Table
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Displays the name of the database table specified for the selected link template.
You can select a new table from this list to apply to the link template.

Keys
Displays the key fields specified for the selected link template.

New Label Template Dialog Box

Quick Reference

Creates a new label template. You can open this dialog box using the following
methods:

£ Toolbar: dbConnect Manager buttons » Select a database table and
choose the New Label Template button.

£ Toolbar: Data View buttons » Choose New Label Template from the
Label Template list, and then choose either the Create Freestanding Label or
the Create Attached Label button flyout. If there is no link template defined
for the selected database table in the current drawing, the program displays
the New Link Template dialog box.

£ Menu: dbConnect » Templates » New Label Template. Select a link
template from the Select a Database Object dialog box and choose Continue.
Shortcut menu: Right-click a database table in the dbConnect Manager and
choose New Label Template.

After you enter a name for the label template and choose Continue, the Label
Template dialog box opens, in which you specify the fields to display in your
label and how to format them.

New Label Template Name
Specifies a name for the label template.
Start with Template

Lists available label templates in the current drawing, from which you can
select one to use as a start point for your new label template.
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New Link Template Dialog Box

Quick Reference

Creates a new link template. You can open this dialog box using the following
methods:

£ Toolbar: dbConnect Manager buttons » Select a database table and
choose the New Link Template button.

£ Toolbar: Data View buttons » Choose New Link Template from the Link
Template list, and then choose the Link button flyout.

£ Menu: dbConnect » Templates » New Link Template. Navigate to and
then select a database table in the Select a Data Object dialog box and choose
Continue.

Shortcut menu: Right-click a table in the dbConnect Manager and choose
New Link Template.

After you enter a name for the link template and choose Continue, the Link
Template dialog box opens, in which you specify the key fields that the link
uses.

New Link Template Name
Specifies a name for the link template.
Start with Template

Lists all available link templates from the current drawing, from which you
can select one to use as a starting point for the new link template.

New Query Dialog Box

Quick Reference

Creates a new query and opens the Query Editor. You can open this dialog
box using the following methods:

£ Toolbar: dbConnect Manager buttons » Select a link template, database
table, or existing query and choose the New Query button.

£ Menu: dbConnect » Queries » New Query on an External Table or New
Query on a Link Template. (A dialog box is displayed in which you can select
a database object to query.)
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Shortcut menu: Right-click a link template, database table, or existing query
in the dbConnect Manager and choose New Query.

After you enter a name for the query and choose Continue, the Query Editor
is displayed, in which you can construct a new query.

Query for Records in Table

Read-only field that indicates the table to query.
New Query Name

Specifies a name for the query.

Existing Query Names

Lists all available queries from the current drawing.

Replace Dialog Box

Quick Reference

Searches for specified text or a numeric value in the currently loaded Data
View table. You can specify a replacement value that overwrites the value that
you're searching for. The search is limited to a single database table column.
It is not possible to conduct a global search that scans all columns in the
database table. You can open this dialog box using the following methods:

£ Menu: Data View » Replace. (This menu is available only if you have a
database table open in the Data View window.)

Shortcut menu: Right-click a single cell or column header in the Data View
window and choose Replace.

Find What Specifies the value to search for.

Replace With Specifies a replacement value for the value that you're searching
for.

Match Case Searches for the exact value, including case, of what you enter
in Find What. If this option is cleared, the program searches for the value
regardless of case.

Find Next Finds the next occurrence of the value that you're searching for.

Replace Replaces the next occurrence of the value that you're searching for
with the value specified in Replace With.
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Replace All Replaces all occurrences of the value that you're searching for
with the value specified in Replace With.

Select a Database Object Dialog Box

Quick Reference

Displays a list of the database objects, such as link templates, label templates,
or queries, that are associated with the current drawing. You can select a
database object from this list to apply to the current operation. You can open
this dialog box using the following methods:

£ Menu: dbConnect » Templates » New Label Template, Edit Link
Template, Edit Label Template, Delete Link Template, or Delete Label Template;
Queries » Execute Query, New Query on a Link Template, Edit Query, or
Delete Query; Links » Delete Links; Labels » Reload Labels, Show Labels,
Hide Labels, or Delete Labels; View Data » View Linked Table, Edit Linked
Table

Database Object List

Lists the available database objects that are associated with the current drawing,
from which you must select one to apply to the current operation.

OK/Continue Either completes the current operation or opens a secondary
dialog box in which you can continue the current operation.

If, for example, you are creating a new label template, the New Label Template
dialog box is displayed.

Select Data Object Dialog Box

Quick Reference

Displays the Data Sources node of the dbConnect Manager, from which you
can navigate to and select a database table that the current operation is applied
to. You can open this dialog box using the following methods:

£ Menu: dbConnect » Data Sources » Connect; Templates » New Link
Template; Queries » New Query on an External Table; View Data » View
External Table or Edit External Table

Tree View Window
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Lists the available data sources, from which you can select a database table to
apply to the current operation.

OK/Continue

Either completes the current operation or opens a secondary dialog box or
window, in which you can continue the current operation.

If, for example, you are creating a new link template, the New Link Template
dialog box is displayed.

Sort Dialog Box

Quick Reference

Specifies a sort order that is applied to the database table records displayed in
the Data View window. You can select a combination of up to five columns
to apply to the sort order. You can open this dialog box using the following
method:

Shortcut menu: Right-click a column header in the Data View window and
choose Sort.
Sort By

Specifies the primary column to apply to the sort operation. The data from
this column is sorted first, and then the data from any additional Then By
columns that are specified is sorted.

Ascending

Applies an ascending sort order to the selected column. The column data is
ordered with the smallest value at the beginning of the Data View record set
and the largest value at the end of the record set.

Descending

Applies a descending sort order to the selected column. The column data is
ordered with the largest value at the beginning of the Data View record set
and the smallest value at the end of the record set.

Then By
Specifies an additional column to apply to the sort operation.

Reset
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Clears all columns that are specified for the current sort order so that you can
specify a new sort order.

Synchronize Dialog Box

Quick Reference

Updates links that the program is unable to resolve. Links can become invalid
if you change the underlying structure of their source database table, or if you
move the source table to a new location. In these cases, the structure specified
by the link template used to create the links is no longer valid, and link
templates and any associated links must be updated.

The Synchronize dialog box provides a list of detected errors. Certain errors
(such as a resized column in the source database table) can be fixed directly
from the Synchronize dialog box. Other errors (such as links that point to
nonexistent records) must be fixed in the source database table.

You can open this dialog box using the following methods:

£ Menu: dbConnect » Synchronize
Shortcut menu: Right-click a link template in the dbConnect Manager and
choose Synchronize.

T Synchronize (=)
Ermors:

Fix

Description:

Link template: RoomLink 1
Data source name: jet_dbsamples
Table name: Room

Help

Indicate Drawing Objects

Errors
Displays a list of errors detected. You can select an error to fix.

Description
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DBLIST

DDEDIT

Provides a brief description of the error selected in the Errors list.
Fix

Fixes the currently selected error.

Delete

Deletes the invalid link template and any associated links from the current
drawing.

Close
Closes the dialog box.
Indicate Drawing Objects

Indicates all objects in the current drawing that are associated with the invalid
link template.

Quick Reference

Lists database information for each object in the drawing.
EE Command entry: dblist

The text window displays information about each object in the current
drawing. The program pauses when the window fills with information. Press
ENTER to resume output, or press ESC to cancel.

Quick Reference

Edits single-line text, dimension text, attribute definitions, and feature control
frames.

£ Toolbar: Text E

£ Menu: Modify » Object » Text » Edit
Pointing device: Double-click a text object.
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Shortcut menu: Select a text object, right-click in the drawing area, and
click Edit.

EE Command entry: ddedit

Select an annotation object or [Undo]:

Object Selection Displays the appropriate editing method for the type of text
you select:

B When the DTEXTED system variable is set to O or 2, text created using
TEXT on page 1818 or DTEXT displays the In-Place Text Editor without the
Text Formatting toolbar and the ruler. Right-click to display options on
page 1824.

B Text created using MTEXT on page 1151 displays the In-Place Text Editor.

B Attribute definitions (not part of a block definition) display the Edit
Attribute Definition dialog box.

B Feature control frames display the Geometric Tolerance dialog box.

DDEDIT repeats the prompt until you press ENTER to end the command.

Undo Returns the text or attribute definition to its previous value. You can
use this option immediately after editing.

Edit Text Dialog Box

Quick Reference

£ Toolbar: Text E

Shortcut menu: Select a text object, right-click in the drawing area, and
click Edit.
EE Command entry: ddedit

When the DTEXTED on page 2135 system variable is set to 1, modifies text
created with TEXT on page 1818 or DTEXT. Enter the new text and click OK.

To add a field to the text, right-click the text where you want to insert the
field and click Insert Field on the shortcut menu to display the Field dialog
box.
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Edit Attribute Definition Dialog Box

Quick Reference

£ Toolbar: Text E

Shortcut menu: Select a text object, right-click in the drawing area, and
click Edit.
EE Command entry: ddedit

Modifies an attribute definition's tag, prompt, and default value.
Tag

Specifies the attribute tag, which identifies the attribute in the drawing. The
tag can contain exclamation marks (!). The case change is not immediately
displayed in the tag field.

Prompt

Specifies the attribute prompt that is displayed when you insert a block
containing this attribute definition.

Default
Specifies the default attribute value.

To use a field as the value, right-click and click Insert Field on the shortcut
menu to display the Field dialog box.

DDPTYPE

Quick Reference

Specifies the display style and size of point objects.

£ Menu: Format » Point Style
EE Command entry: ddptype (or 'ddptype for transparent use)

The Point Style dialog box is displayed.
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Point Style Dialog Box

Quick Reference

£ Menu: Format » Point Style
E Command entry: ddptype (or 'ddptype for transparent use)

Shows the current point style and size. Change the point style by selecting an

Point Size:  5.0000 %

@ Set Size Relative to Screen
Set Size in Absolute Units

(=]

[

K [ Cancel || Heb

Point Display Images

Specifies the image used to display point objects. The point style is stored in
the PDMODE on page 2244 system variable.

Point Size

Sets the point display size. The value you enter can be relative to the screen
or in absolute units. The point display size is stored in the PDSIZE system
variable. Subsequent point objects that you draw use the new value.

Set Size Relative to Screen Sets the point display size as a percentage of the
screen size. The point display does not change when you zoom in or out.

Set Size in Absolute Units Sets the point display size as the actual units you

specify under Point Size. Points are displayed larger or smaller when you zoom
in or out.
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DDVPOINT

Quick Reference

Sets the 3D viewing direction.

£ Menu: View » 3D Views » Viewpoint Presets

EE Command entry: ddvpoint

The Viewpoint Presets dialog box is displayed.

Viewpoint Presets Dialog Box

Quick Reference

£ Menu: View » 3D Views » Viewpoint Presets

EE Command entry: ddvpoint

Defines 3D view settings.

A Viewpoint Presets (=3
Set Viewing Angles
@ Absolute to WCS Relative to UCS
2
T° 45°
138" 45 +
—30
*
10
1805 - 0 —0*
| Lot
;J_zE-)‘f 4 k:n B f—aa’
45°
270* 60"
90
From: From:
X Kods: 2700 XY Plane: 500
| Set to Plan View |
ok [ cancel | [ Hep |

Set Viewing Angles

Sets the direction of the view relative to either the world coordinate system

(WCS) or a user coordinate system

(UCS).
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Absolute to WCS Sets the view direction relative to the WCS.

Relative to UCS Sets the view direction relative to the current UCS.

From

Specifies viewing angles.

X Axis Specifies the angle from the X axis.

XY Plane Specifies the angle from the XY plane.

You can also use the sample image to specify viewing angles. The black arm
indicates the new angle. The gray arm indicates the current angle. Specify an
angle by selecting the inner region of the circle or half-circle. Selecting the
bounded outer regions rounds off the angle to the value displayed in that
region. If you select the inner arc or an area inside it, the angle is not rounded
off, and the result may be a fractional number.

Set to Plan View

Sets the viewing angles to display the plan view (XY plane) relative to the
selected coordinate system.

DELAY

Quick Reference

Provides a timed pause within a script.

E2 Command entry: delay (or 'delay for transparent use)
Enter delay time (in milliseconds): Enter a value from 0 through 32,767 milliseconds

Specifies the duration of a pause. Entering delay 1000 in your script delays
the start of execution of the next command for about one second. The longest
delay available is 32767, which is slightly less than 33 seconds.
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DELCONSTRAINT

Quick Reference

Removes all geometric and dimensional constraints from a selection set of
objects.

Access Methods

S

Button

£ Ribbon: Parametric tab » Manage panel » Delete Constraints
£ Menu: Parametric » Delete Constraints

£ Toolbar: Parametric

EE Command entry: delconstraint

All constraints will be removed from selected objects...Select objects: Select the
objects for which to delete all associated constraints

Removes all geometric and dimensional constraints from the selected objects.

The number of constraints removed are displayed on the command line.

DETACHURL

Quick Reference

Removes hyperlinks in a drawing.

EE Command entry: detachurl
Select objects: Use an object selection method, and press ENTER to end selection

Hyperlinks are removed from the selected objects. If an area is selected, the
polyline is deleted. You can use PURGE to remove the URLLAYER layer.
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DGNADJUST

Quick Reference
Adjust the fade, contrast, and monochrome settings of a DGN underlay.
Access Methods

’a

Button

£ Ribbon: Insert tab » Reference panel » Adjust
E Command entry: dgnadjust

Summary

You can change the default values for Fade, Contrast, and Monochrome for
a single or multiple DGN underlays. To confirm the settings on a selected
DGN underlay, use the Properties palette.

NOTE You can also use the ADJUST on page 99 command to change the fade,
contrast, and monochrome settings for DGN underlays as well as DWF, DWFx and
PDF underlays or the fade, contrast and brightness for images.

List of Prompts
The following prompts appear:

Select DGN underlay: Select one or more DGN underlays

Enter DGN underlay option [Fade/Contrast/Monochrome] <Fade>:

Enter fade value (0-100): Enter a value

Enter contrast value (0-100): Enter a value

Monochrome? [Yes/No]: Enter yes or no and then press ENTER

Fade

Controls the fade effect of the underlay. Values range from O through 100.
The greater the value, the more transparent the underlay appears against the
background. The lesser the value, the less transparent and closer to opaque
the underlay appears. A value of 0 makes the underlay appear fully opaque.
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Contrast

Controls the contrast, and indirectly, the fading effect of the underlay. Values
range from O through 100. The greater the value, the more each pixel is forced
to its primary or secondary color.

Monochrome

Controls the color saturation of all linework while maintaining the luminance.
When turned on, the linework appears in varying shades of gray starting at
black if the background color luminance is 50 percent or more. If the
background color luminance is less than 50 percent, then the colors are
inverted, with the darkest linework displaying in white, and the lightest
linework displaying in black.

DGNATTACH

Quick Reference
Insert a DGN file as an underlay into the current drawing.
Access Methods

—

Button

£ Ribbon: Insert tab » Reference panel » Attach
£ Menu: Insert » DGN Underlay

£ Toolbar: Insert

E Command entry: dgnattach

Summary

When you attach a DGN file as an underlay, you link that referenced file to
the current drawing. Any changes to the referenced file are displayed in the
current drawing when it is opened or reloaded.

The Select Reference File dialog box (a standard file selection dialog box) is
displayed. Once you select a DGN file, the Attach DGN Underlay dialog box
is displayed. After the file is attached, you can adjust and clip the underlay
through the DGN Underlay Ribbon Contextual tab on page 501.
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NOTE DGNATTACH is not limited to files with .dgn extensions. It supports all
DGN files, even those that do not have a .dgn extension.

If you enter -dgnattach at the Command prompt, options are displayed.

NOTE When a DGN file is attached as an underlay, its levels structure (layers) are
combined into a single layer. The DGN underlay is placed on the current layer.
To hide the DGN attachment, freeze the layer on which it was attached.

Attach DGN Underlay Dialog Box

Quick Reference

Access Methods

£ Toolbar: Insert DGN
£ Menu: Insert » DGN Underlay

EE Command entry: dgnattach

Summary

Names, locates, and defines the insertion point, scale, and rotation when
attaching DGN underlays.

List of Options

The following options are available in this dialog box.

Name

Identifies the DGN file you have selected to attach.

Browse

Opens the Select Reference File dialog (a standard file selection dialog box on
page 12235).

Select a design model from the DGN file

Displays all of the design models that are found in the DGN file. If the DGN
file only contains a single design model, that model is listed.
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If the DGN file contains multiple design models, only a single model can be
selected for attachment. The first model in the list is selected by default.

Conversion Units

Matches the DWF files’s drawing units to the master units and sub-units
specified in the DGN file. For example, if the DGN file has master units set to
meters, and sub-units set to millimeters, and you want the DWG to be set to
millimeters, select sub-units in the Attach DGN Underlay dialog box.

Master Units Matches the DWG drawing units to the master units set in the
DGN file.

Sub Units Matches the DWG drawing units to the sub- units set in the DGN
file.

Path Type

Selects the full (absolute) path, the relative path to the DGN file, or No Path,
the name of the DGN file (the DGN file must be located in the same folder as
the current drawing file).

NOTE The Path Type group is disabled when you’re attaching a DGN file that is
stored on the Vault client server. This information is automatically entered by the
Vault.

Insertion Point
Specifies the insertion point for the selected DGN file. Specify On-Screen is
the default. The default insertion point is 0,0,0.

Specify On-Screen Directs input at the Command prompt or the pointing
device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and
Z.

X

Sets the X coordinate value.
Y

Sets the Y coordinate value.
Z

Sets the Z coordinate value.
Scale

Specifies the scale factor of the selected DGN underlay.
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If INSUNITS is set to “unitless” or if the underlay does not contain resolution
information, the scale factor becomes the underlay width in AutoCAD units.
If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and
the underlay has resolution information, the scale factor is applied after the
true width of the underlay in AutoCAD units is determined.

Specify On-screen

Allows you to input at the Command prompt or the pointing device. If Specify
On-Screen is cleared, enter a value for the scale factor. The default scale factor
is 1.

Scale Factor Field

Enters a value for the scale factor. The default scale factor is 1.
Rotation

Specifies the rotation angle of the selected DGN underlay.
Specify on-screen

If Specify On-Screen is selected, you may wait until you exit the dialog box
to rotate the object with your pointing device or enter a rotation angle value
at the Command prompt.

Angle

If Specify On-Screen is cleared, enter the rotation angle value in the dialog
box. The default rotation angle is O.

Show Details

Displays the DGN file path.

Found In

Displays the path where the DGN file is located.
Saved Path

Displays the path that is saved with the drawing when the DGN file is attached.
The path is dependent upon the Path Type setting.
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DGN Underlay Ribbon Contextual tab

Quick Reference
Change DGN underlay display, clip, layer, and osnap options.

Summary

When you select a DGN underlay in a drawing, the DGN Underlay Contextual
tab is displayed on the ribbon.

Insert Annotate  Parametric  View Manage Output [RelciRIRLELER

1 » @ B =B %2 & 8

n 25 Display in Create  Remove Show | Enable | External Edit
Monochrome | Clipping  Clipping (| Underlay | Snap | References Layers
Adjust Clipping Cptions DGN Layers |

Adjust Panel

Contrast Controls the contrast and the fading effect of the underlay. The
greater the value, the more each pixel is forced to its primary sec-
ondary color.

Fade Controls the appearance of the linework. The greater the value, the

lighter the linework in the underlay appears.

Display in Displays the underlay in black and white.
Monochrome

Clipping Panel

Create Clipping  Deletes the old clipping boundary (if one exists) and creates a new
Boundary one.

Remove Clipping  Deletes the clipping boundary.

Options Panel

Show Underlay Hides or displays the underlay.

Enable Snap Determines whether object snapping is active for geometry in the
DGN underlay.
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External Refer- Displays the External References Palette.
ences

DGN Layers Panel

Edit Layers Controls the display of layers in a DGN Underlay.

-DGNATTACH

Quick Reference
Attach a DGN underlay from the command line.

Access Methods
EE Command entry: - dgnattach

Summary

When you attach a DGN file as an underlay, you link that referenced file to
the current drawing. Any changes to the referenced file are displayed in the
current drawing when it is opened or reloaded.

NOTE DGNATTACH is not limited to files with *.dgn extensions. It supports all
DGN files, even those that do not have a .dgn extension.

List of Prompts
The following prompts display.

TIP You can drag a DGN file onto the drawing window to start the DGNATTACH
command.

Path to DGN File to Attach Enters the full path name to the DGN underlay
file. The file name can include up to 255 characters and contain letters, digits,
spaces, and any special characters not used by Microsoft Windows or this
program.

Entering a tilde (~) displays the Select DGN File dialog box (a standard file
selection dialog box).

To avoid errors when entering a file name, it is recommended that you specify
both the DGN file and path as follows:
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path name\filename.dgn

or

“path name\filename.dgn”

If you enter a valid DGN file name without a file extension, the program adds
the extension and searches for the file.

Enter Name of Model Enter a model name. For a list of models, enter ?.

Enter Model(s) to list <*> Lists the design models available in the DGN file
in a separate text window.

Conversion Units Matches the DWF file’s drawing units to the master units
and sub-units specified in the DGN file. For example, if the DGN file has
master units set to meters, and sub-units set to millimeters, and you want the
DWSG to be set to millimeters, select sub-units in the Attach DGN Underlay
dialog box.

B Master Units - Matches the DWG drawing units to the master units set in
the DGN file.

B Sub Units - Matches the DWG drawing units to the sub- units set in the
DGN file.

Insertion Point Specifies the insertion point for the selected DGN file. Enter
the X, Y, and Z coordinates at the command prompt, or click onscreen.

Scale Factor Specifies the scale factor of the selected DGN underlay and the
scale factor units. You can enter a scale factor at the command prompt or click
onscreen with the mouse.

If INSUNITS is set to “unitless” or if the underlay does not contain resolution
information, the scale factor becomes the underlay width in AutoCAD units.
If INSUNITS has a value such as millimeters, centimeters, inches, or feet, and
the underlay has resolution information, the scale factor is applied after the
true width of the underlay in AutoCAD units is determined.

Rotation Specifies the rotation angle of the selected DGN underlay by entering
an angle value at the command prompt or by clicking onscreen.

DGNCLIP

Quick Reference

Crops the display of a selected DGN underlay to a specified boundary.
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Access Methods

'
DGHN

Button

£ Ribbon: Insert tab » Reference panel » Clip.

Shortcut menu: Select a DGN underlay to clip, right-click in the drawing
area, and click DGN Clip.

E Command entry: dgnclip

Summary

The clipping boundary determines the portion of a DGN underlay outside the
boundary that is hidden. The visibility of the clipping boundary is controlled
by the DGNFRAME on page 2076 system variable.

The boundary you specify must be in a plane parallel to the DGN underlay.

TIP Use the generic CLIP on page 328 command to clip images, external references,
viewports, and underlays.

List of Prompts
The following prompts are displayed.

On
Turns on clipping and displays the DGN underlay clipped to the previously
defined boundary.

Off
Turns off clipping and displays the entire DGN underlay.

If you reclip the DGN underlay while clipping is turned off, clipping is
automatically turned back on. You are prompted to delete the old boundary
even when clipping is turned off and the clipping boundary is not visible.

Delete
Removes a predefined clipping boundary and displays the entire DGN underlay.

New Boundary
Defines a rectangular or polygonal clipping boundary, or generates a polygonal
clipping boundary from a polyline.

Specify clipping boundary or select invert option: [Select
polyline/Polygonal/Rectangular/Invert clip] <Rectangular>:
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Select Polyline Defines the boundary with the selected polyline. The polyline
can be open but must consist of straight line segments and cannot intersect
itself.

Polygonal Defines a polygonal clipping boundary with three or more po